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Welcome to This Guide

This guide explains how to configure and work with an IT model that 
enables you to build a topology of your system. You populate the model 
with configuration items and their relationships, and then use the model to 
measure and manage critical business processes. 

This chapter includes:

➤ How This Guide Is Organized on page 11

➤ Who Should Read This Guide on page 12

➤ HP Universal CMDB Online Documentation on page 12

➤ Additional Online Resources on page 15

➤ Documentation Updates on page 16

How This Guide Is Organized

The guide contains the following chapters:

 Part I Introduction to HP Universal CMDB

Introduces the CMDB and provides general information about Topology 
Query Lanaguage, the CI Selector, and Topology Map.
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 Part II Modeling

Describes how to model your business environment by defining views and 
by building TQL queries that retrieve the required information from the 
CMDB; describes how to create Topology and custom reports for a specific 
view and how to view and modify the definitions of configuration item 
types (CITs) defined in the CMDB and the relationships that define the 
connections between them.

 Part III HP Universal CMDB Data Model

Includes documents that explain and quantify the BTO Data Model (BDM) 
version 1.1.1 and the CMS data model. 

 Part IV Reference Information

Contains general reference information.

Who Should Read This Guide

This guide is intended for the following users:

➤ HP Universal CMDB administrators

➤ HP Universal CMDB platform administrators

➤ HP Universal CMDB application administrators

➤ HP Universal CMDB data collector administrators

Readers of this guide should be knowledgeable about enterprise system 
administration, have familiarity with ITIL concepts, and be knowledgeable 
about HP Universal CMDB.

HP Universal CMDB Online Documentation

HP Universal CMDB includes the following online documentation:
12
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Readme. Provides a list of version limitations and last-minute updates. From 
the HP Universal CMDB DVD root directory, double-click readme.html. You 
can also access the most updated readme file from the HP Software Support 
Web site.

What’s New. Provides a list of new features and version highlights. In 
HP Universal CMDB, select Help > What’s New.

Printer-Friendly Documentation. Choose Help > UCMDB Help. The 
following guides are published in PDF format only:

➤ the HP Universal CMDB Deployment Guide PDF. Explains the hardware 
and software requirements needed to set up HP Universal CMDB, how 
to install or upgrade HP Universal CMDB, how to harden the system, 
and how to log in to the application.

➤ the HP Universal CMDB Database Guide PDF. Explains how to set up the 
database (MS SQL Server or Oracle) needed by HP Universal CMDB. 

➤ HP Universal CMDB Discovery and Integration Content Guide. Explains 
how to run discovery to discover applications, operating systems, and 
network components running on your system. Also explains how to 
discover data on other data repositories through integration.

HP Universal CMDB Online Help includes:

➤ Modeling. Enables you to manage the content of your IT Universe 
model. 

➤ Data Flow Management. Explains how to integrate HP Universal 
CMDB with other data repositories and how to set up HP Universal 
CMDB to discover network components.

➤ UCMDB Administration. Explains how to work with HP Universal 
CMDB.

➤ Developer Reference. For users with an advanced knowledge of 
HP Universal CMDB. Explains how to define and use adapters and how 
to use APIs to access data.

Online Help is also available from specific HP Universal CMDB windows 
by clicking in the window and clicking the Help button.

Online books can be viewed and printed using Adobe Reader, which can 
be downloaded from the Adobe Web site (www.adobe.com). 
13



Welcome to This Guide
14

Topic Types
Within this guide, each subject area is organized into topics. A topic 
contains a distinct module of information for a subject. The topics are 
generally classified according to the type of information they contain.

This structure is designed to create easier access to specific information by 
dividing the documentation into the different types of information you 
may need at different times. 

Three main topic types are in use: Concepts, Tasks, and Reference. The topic 
types are differentiated visually using icons.

Topic Type Description Usage

Concepts Background, descriptive, or 
conceptual information. 

Learn general information 
about what a feature does.

Tasks Instructional Tasks. Step-by-
step guidance to help you 
work with the application and 
accomplish your goals. Some 
task steps include examples, 
using sample data. 

Task steps can be with or 
without numbering:

➤ Numbered steps. Tasks that 
are performed by following 
each step in consecutive 
order.

➤ Non-numbered steps. A list 
of self-contained operations 
that you can perform in any 
order.

➤ Learn about the overall 
workflow of a task.

➤ Follow the steps listed in 
a numbered task to 
complete a task.

➤ Perform independent 
operations by 
completing steps in a 
non-numbered task.

Use-case Scenario Tasks. 
Examples of how to perform a 
task for a specific situation.

Learn how a task could be 
performed in a realistic 
scenario.



Welcome to This Guide
Additional Online Resources

Troubleshooting & Knowledge Base accesses the Troubleshooting page on 
the HP Software Support Web site where you can search the Self-solve 
knowledge base. Choose Help > Troubleshooting & Knowledge Base. The 
URL for this Web site is http://h20230.www2.hp.com/troubleshooting.jsp.

HP Software Support accesses the HP Software Support Web site. This site 
enables you to browse the Self-solve knowledge base. You can also post to 
and search user discussion forums, submit support requests, download 
patches and updated documentation, and more. Choose Help > HP Software 
Support. The URL for this Web site is www.hp.com/go/hpsoftwaresupport.

Most of the support areas require that you register as an HP Passport user 
and sign in. Many also require a support contract.

Reference General Reference. Detailed 
lists and explanations of 
reference-oriented material.

Look up a specific piece of 
reference information 
relevant to a particular 
context.

User Interface Reference. 
Specialized reference topics 
that describe a particular user 
interface in detail. Selecting 
Help on this page from the 
Help menu in the product 
generally open the user 
interface topics.

Look up specific 
information about what to 
enter or how to use one or 
more specific user interface 
elements, such as a 
window, dialog box, or 
wizard.

Troubleshooting 
and Limitations

Troubleshooting and 
Limitations. Specialized 
reference topics that describe 
commonly encountered 
problems and their solutions, 
and list limitations of a feature 
or product area.

Increase your awareness of 
important issues before 
working with a feature, or 
if you encounter usability 
problems in the software. 

Topic Type Description Usage
15
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To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport user ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

HP Software Web site accesses the HP Software Web site. This site provides 
you with the most up-to-date information on HP Software products. This 
includes new software releases, seminars and trade shows, customer support, 
and more. Choose Help > HP Software Web site. The URL for this Web site 
is www.hp.com/go/software.

Documentation Updates

HP Software is continually updating its product documentation with new 
information.

To check for recent updates, or to verify that you are using the most recent 
edition of a document, go to the HP Software Product Manuals Web site 
(http://h20230.www2.hp.com/selfsolve/manuals).
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Topology Query Language

This chapter includes:

Concepts

➤ Topology Query Language (TQL) Overview on page 20

➤ Creating TQL Queries in the UCMDB Managers on page 21

➤ Viewing TQL Query Results on page 22

➤ Compound Relationship on page 23

➤ Join Relationship on page 24

➤ Subgraph Definition on page 25

➤ The ALLOW_VOLATILITY Qualifier on page 25

Tasks

➤ Define a TQL Query on page 27

➤ Add Query Nodes and Relationships to a TQL Query on page 28

➤ Define a Compound Relationship – Scenario on page 30

➤ Define a Join Relationship – Scenario on page 33

➤ Create a Subgraph Definition – Scenario on page 35

Reference

➤ Shortcut Menu Options on page 37

➤ Attribute Operator Definitions on page 42

➤ TQL Logs on page 44

➤ Topology Query Language User Interface on page 49

Troubleshooting and Limitations on page 97
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Chapter 1 • Topology Query Language
Concepts

Topology Query Language (TQL) Overview

Topology Query Language (TQL) is a language and tool for discovering, 
organizing, and managing IT infrastructure data. It enables you to create 
TQL queries that retrieve business service data from the CMDB. TQL queries 
also help you to display the data in a visual representation that facilitates 
data monitoring and managing. 

This section includes the following topics:

➤ "Topology Query Language" on page 20

➤ "The Roles of TQL" on page 21

Topology Query Language
TQL extends the standard SQL language by adding two important 
capabilities:

➤ TQL enables you to draw conceptual relationships between configuration 
items (CIs), which represent their actual interdependencies. Using 
predefined operators, the different types of interconnections 
(relationships) that exist between CIs can be established, and 
consequently the infrastructure design and performance are more 
accurately represented. This representation serves as a basis and a model 
for the discovery, arrangement, query, and management of complex 
infrastructures.

➤ TQL includes a graphical aspect, consisting of visual symbols and syntax, 
that represents the resources and their interconnections. This 
visualization of an IT infrastructure simplifies the understanding, 
monitoring, and managing of the IT business operations.
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The Roles of TQL
TQL plays several roles:

➤ Builds a business service model that defines and delineates the 
interconnection between IT assets that function together as business 
services. The business service model guides the discovery and 
identification of these business services, from the ever-increasing number 
and complexity of infrastructure resources. After the resources that 
comprise the business services are discovered, the business service model 
structures the way they are organized and managed in the CMDB.

➤ Constantly searches the CMDB for changes that occur in the state of 
managed resources. When such changes are detected, the relevant 
subsystems are informed and updated. 

➤ Creates queries that retrieve business service data from the CMDB, and 
displays the data in a visual representation that facilitates data 
monitoring and managing.

Creating TQL Queries in the UCMDB Managers

The following managers enable you to create TQL queries that retrieve 
specific data from the CMDB and to display that data:

➤ Impact Analysis Manager. An Impact rule simulates how infrastructure 
changes can impact your system and enables you to determine the true 
origin of a problem and its business impact. During rule creation, you 
define the base TQL query type, which can be a new query or an existing 
query. For details, see "Impact Analysis Manager" on page 439.

➤ Enrichment Manager. An Enrichment rule enables enlarging the CMDB, 
deleting CI instances from the CMDB, or updating the attributes of a CI 
that already exists in the CMDB. During rule creation, you define the base 
TQL query type, which can be a new query or an existing query. For 
details, see "Enrichment Manager" on page 507.
21
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➤ Modeling Studio. You can build a new TQL query using the TQL Query 
Editor or you can build a new query while defining a new view, template, 
or perspective using the Pattern View Editor. You can also define the 
topology report settings for any view in the Pattern View Editor. For 
details, see "Modeling Studio" on page 265.

Viewing TQL Query Results

You view the resulting data in a visual representation in IT Universe 
Manager. The queries define the structure of the resulting topology map. 
The view displays only those CIs and relationships that meet the query 
definition. You can also view the results of a query by clicking the Preview 
button in the toolbar to open a preview display identical to IT Universe 
Manager. For more details about IT Universe Manager, see "IT Universe 
Manager" on page 201.

TQL Query Types and Priorities
When you define a TQL query, you define the type of the TQL query in the 
Type field of the Query Definition Properties dialog box. The following 
query types are available:

➤ View. TQL queries used as the basis for pattern views.

➤ Integration. TQL queries used for integrations.

➤ Discovery. TQL queries used as the basis for DFM patterns.

➤ Template Query. TQL queries used as the basis for templates.

➤ Perspective Query. TQL queries used as the basis for perspectives.

➤ Impact Analysis. TQL queries used as the basis for Impact rules. This is the 
default type for queries created in Impact Analysis Manager.

➤ Enrichment. TQL queries used as the basis for Enrichment rules. This is 
the default type for queries created in Enrichment Manager.

You cannot change the type of an existing TQL query.
22
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If a query imported though an integration is not assigned a type, it is 
considered a hidden query and does not appear in the query list in the 
Modeling Studio. To display hidden queries in the query list, change the 
setting for hidden queries in the User Preferences dialog box, under General. 
For details, see "User Preferences Dialog Box" on page 97.

You can also set the priority level of a TQL query, which determines how 
often the query is rerun automatically to include updated information. The 
following priorities are available:

➤ Low

➤ Medium

➤ High

➤ Express

➤ Not Active

If you set the priority of a TQL query to Not active, the query becomes 
inactive and is not run automatically, however it can be used for manually 
building a view.

Compound Relationship

A compound relationship represents a path in the topological graph. You use 
a compound relationship to define the allowed steps in the path between 
the source and the target CIs.

Each row represents one of the allowed steps in the path leading from the 
source CI to the target CI in the topology map.

For an example of a compound definition, see "Define a Compound 
Relationship – Scenario" on page 30. For details on defining compound 
relationships, see "Add/Edit Compound Relationship Dialog Box" on 
page 52.
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Join Relationship

A join relationship is a logical connection that represents the relationship 
between two CIs (and which appears only in the topology map containing 
the TQL query results). It does not exist in the CMDB. A join relationship is 
created by defining an attribute for each query node, whose values are used 
for comparison.

The TQL results retrieve all CIs whose attribute values meet the conditions 
defined in the join definition.

For example, you can create a join definition that links all node CIs 
connected to IP Address CIs whose Created by attribute values are equal (see 
the example below).

Each join definition represents one condition defined for the join 
relationship.

Note: You can define multiple conditions.

For an example of a join definition, see "Define a Join Relationship – 
Scenario" on page 33. For details on defining join relationships, see 
"Add/Edit Join Relationship Dialog Box" on page 56.
24
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Subgraph Definition

A subgraph definition enables you to create a graph that represents 
additional TQL query data related to a specific CI. The DFM job searches for 
the results from both the TQL query and the subgraph definitions. The 
query recursively retrieves all related CIs for a defined depth matching the 
definition of the subgraph. For details on defining subgraph definitions, see 
"Subgraph Definition Dialog Box" on page 95.

In the graph, you can define the relationship that is connected to a specific 
query node. For example, if one of the query nodes is of type node, you can 
specify different relationships for Windows, router, and IP Address. You can 
also define attribute conditions for query nodes. For details, see "Subgraph 
Condition Definition Dialog Box" on page 93.

DFM jobs retrieve data that meets the criteria defined in the subgraph. 

For an example of a subgraph definition, see "Create a Subgraph Definition – 
Scenario" on page 35.

The ALLOW_VOLATILITY Qualifier

This qualifier is used to mark attributes that enable minor deviations to their 
value. For example, there is probably no need to report a small disk size 
change (from 8.00008 to 8.00009 GB).

When updating an attribute that is marked with this qualifier, HP Universal 
CMDB checks the new value against the old value. This check is performed 
on the server as part of the record update. If the difference between the two 
values is lower that the allowed deviation, an update is not performed (the 
action is considered a false update).
25
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This qualifier must contain one of the following data items that hold the 
allowed deviation:

➤ ALLOWED_DEVIATION_FIX. The type of deviation is the same as the 
attribute type for numeric attributes, and the integer type for date 
attributes. Deviation is measured by a fixed value, of the same unit as the 
attribute value. (For date attributes, the deviation is measured in seconds.)

➤ ALLOWED_DEVIATION_PERCENT. Deviation is measured by percentage. 
For date values, the percentage is checked against the millisecond date 
representation. This data item type is always integer, and the value range 
is 0 to 100. 

To deactivate the qualifier:

Access the Infrastructure Settings Manager (Managers > Administration > 
Infrastructure Settings Manager). Locate the Allow Volatility option. 
Change the value to False.
26
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Tasks

Define a TQL Query

This task describes how to create a TQL query in the Modeling Studio.

Note: You can also create a TQL query during the procedure for creating 
Impact rules, Enrichment rules, Views, Templates, and Perspectives. 

This task includes the following steps:

➤ "Create a TQL Query" on page 27

➤ "Add Query Nodes and Relationships to the Query" on page 27

 1 Create a TQL Query

In the Modeling Studio, select New > Query to open the TQL Query 
Editor. For details, see "TQL Query Editor" on page 355. 

 2 Add Query Nodes and Relationships to the Query

Add the TQL query nodes and relationships that define the query. The 
TQL query nodes represent the CITs, as defined in the CI Type Manager, 
and the relationships represent the connections between them. 
Relationships are defined one at a time for each pair of TQL query nodes 
in the query. For details, see "Add Query Nodes and Relationships to a 
TQL Query" on page 28. 

Note: You can also define a self-relationship from a query node to itself.
27
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Example of a TQL Query Definition:

The direction of the relationship indicates which query node is 
dependent on the other. The following example displays two nodes, an IP 
Service Endpoint, and a Client Port, which are linked to one another via a 
client/server connection. The TQL query results must comply with the 
direction of the arrows.

Note: A TQL query is subject to certain validation restrictions. For details, 
see "Troubleshooting and Limitations" on page 97.

Add Query Nodes and Relationships to a TQL Query

This section explains how to add query nodes and relationships to a TQL 
query. It is relevant for Impact Analysis Manager, Enrichment Manager, and 
the Modeling Studio.

Note: For TQL queries to be valid, they must comply with certain 
restrictions. For details, see "Troubleshooting and Limitations" on page 97.
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To add query nodes and relationships to a TQL query:

 1 In Impact Analysis Manager or Enrichment manager, select the required 
query from the tree in the left pane or click the New button to create one.

In the Modeling Studio, select the Resources tab in the left pane, select 
Queries as the Resource type, and select the required query from the tree 
or click New > Query to create a new one.

 2 In Impact Analysis Manager or Enrichment manager, click and drag one 
or more required TQL query nodes from the tree displayed in the CI Type 
Selector, onto the editing pane. In the Modeling Studio, select the CI 
Types tab in the left pane and drag the required TQL query nodes from 
the tree onto the editing pane. These are the TQL query nodes that are 
included in the query.

 3 To add a relationship between two query nodes:

➤ Select the required TQL query nodes by holding down CTRL and 
clicking the TQL query nodes, right-click and select Add Relationship. 
The Add Relationship dialog box opens. Select the required 
relationship. For details, see "Add/Edit Relationship Dialog Box" on 
page 59.

or

➤ Click the Create Relationship icon and draw a line between the 
required query nodes. The Select Relationship Type dialog box opens. 
Select the required relationship type. For details, see "Select 
Relationship Type Dialog Box" on page 92.

 4 Click OK. The selected query nodes are linked by the relationship you 
have selected.
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Define a Compound Relationship – Scenario

This section describes how to define the allowed steps that form a 
compound relationship between a IP Subnet CI and an IP Address CI.

Note: To reach the required result, you must implement each one of the 
following steps.

To define a compound relationship between a IP Subnet CI and an IP 
Address CI:

 1 Create a TQL query of type view and drag the following query nodes onto 
the editing pane:

➤ IP Subnet

➤ IP Address

 2 Right-click the IP Subnet and IP Address query nodes and select Add 
Compound Relationship to open the Add Compound Relationship dialog 
box.

 3 Click the Add button. In Enrichment Manager and Impact Analysis 
Manager, the Add Triplet dialog box opens. In the Modeling Studio, a row 
is added to the table. Make the following selections:

➤ From the Source list, select IP Subnet.

➤ From the Target list, select Node.

➤ From the Relationship list, select Membership.

➤ Select the required Relationship direction.

In Enrichment Manager and Impact Analysis Manager, click OK to save 
your changes.

 4 Click the Add button again and make the following selections:

➤ From the Source list, select Node.

➤ From the Target list, select IP Address.

➤ From the Relationship list, select Containment.
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➤ Select the required Relationship direction.

In Enrichment Manager and Impact Analysis Manager, click OK to save 
your changes.

 The following shows an example of compound definitions following the 
changes: 

 5 Click OK to save your changes.

The TQL query in the editing pane now looks like this:

 6 Create a view based on your TQL query and save it.

 7 Go to the required view in IT Universe Manager to view the results. If you 
did not select the Show full path between source and target CIs option, 
then the results display the names of the relationships that link the CIs as 
Virtual-Compound rather than the actual names of the relationships. See 
the illustration below:
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You can double-click the Virtual - Compound relationship in IT Universe 
Manager to open the Link Map, which displays the CIs and relationships 
that comprise the allowed steps used to link the IP Subnet and IP Address 
CIs.

In the example above, the 192.168.168.0 (IP Subnet) CI is linked to the 
192.168.0.1 (IP Address) CI through the labm1ccm15 (Node) CI.
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If you selected the Show full path between source and target CIs option, 
then the results in IT Universe Manager display the actual names of the 
relationships that link the CIs and the full path between the source and 
target CIs. See the illustration below:

Define a Join Relationship – Scenario

This section explains how to define a join relationship that links Node CIs 
to IP Address CIs whose Created by attribute values are equal.

Note: To reach the required result, you must implement each one of the 
following steps.
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To define a join relationship that links all IP Address and Node CIs whose 
Created by attribute values are equal:

 1 Create a TQL query and drag the following query nodes from the CI Type 
Selector onto the editing pane:

➤ Node

➤ IP Address

 2 Select the Node and IP Address query nodes and right-click to open the 
Add Join Relationship dialog box.

 3 Click the Add button to add a row to the table and do the following:

➤ In the Node Attribute box, select Created by.

➤ In the Operator box, select Equal.

➤ In the IP Address Attribute box, select Created by.

In Enrichment Manager and Impact Analysis Manager, you make these 
selections in the Join Relationship Condition dialog box.

The Join Definition area now looks like this.

 4 Click OK to save your changes.

The TQL query in the editing pane now looks like this:
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Create a Subgraph Definition – Scenario

This section describes how to create a subgraph definition. In this example, 
the TQL query results retrieve all CIs that are connected to a Business Service 
CI by a Containment relationship up to a depth of 3.

Note: To reach the required result, you must implement each one of the 
following steps.

To create this sample subgraph definition:

 1 Create a TQL query and drag a query node of type Business Service onto 
the editing pane.

 2 Right-click the Business Service query node and select Subgraph 
Definition to open the Subgraph Definition dialog box.

 3 Click the Add  button. In Enrichment Manager and Impact Analysis 
Manager, the Add Triplet dialog box opens. In the Modeling Studio, a row 
is added to the table. Make the following selections: 

➤ From the Source drop-down list, select Managed Object.

➤ From the Target drop-down list, select Managed Object.

➤ From the Relationship drop-down list, select Containment.

➤ Set the direction of the relationship as left to right.

In Enrichment Manager and Impact Analysis Manager, click OK to save 
your changes.

The Subgraph Definition dialog box now looks like this.

 4 Set the Depth setting to 3.

 5 Click OK in the Subgraph Definition dialog box.
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Go to the required view in IT Universe Manager to view the results.

The results show the Business Service CI aaa and all of the CIs linked to it 
in succession by Containment relationships down to three levels.
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Reference

Shortcut Menu Options

This section includes a list of TQL query shortcut menu options (listed 
alphabetically):

UI Elements (A-Z) Description

Add Calculated 
Relationship

Enables you to create a calculated relationship.

➤ For details on how to create a calculated relationship, 
see "Triplets Page" on page 493.

➤ For details about Impact Modeling, see "Using 
Calculated Relationships" on page 103

Add Compound 
Relationship

Enables you to define the connection between two query 
nodes using a compound relationship.

For details, see "Add/Edit Compound Relationship Dialog 
Box" on page 52.

Add Join Relationship Enables you to define join relationships. You create them 
by defining an attribute for each query node, These query 
node values are used for comparison during federation.

For details, see "Add/Edit Join Relationship Dialog Box" 
on page 56.

Add Related Query 
Node Wizard

Displays the Add Related Query Node Wizard dialog box 
which enables you to build a TQL query. For details, see 
"Add Related Query Node Wizard" on page 61.
37



Chapter 1 • Topology Query Language
Add Relationship Enables you to create a relationship for your query nodes 
by selecting it from a predefined list. Displays the Add 
Relationship dialog box.

For details, see "Add/Edit Relationship Dialog Box" on 
page 59.

Note: In Enrichment Manager, this option adds an 
Enrichment relationship to the rule when working in 
Enrichment mode. Applicable for regular and Enrichment 
query nodes. For details, see "Enrichment Manager" on 
page 507. Added relationships are denoted by an added 

 indicator.

Add to Hierarchy Adds the selected query node to the hierarchy as a 
separate query node.

Note: Only relevant for the Modeling Studio.

Add to Model Output Designates the selected query node as output for the 
pattern-based model.

Note: Only relevant for pattern-based models in the 
Modeling Studio.

Change Query 
Node/Relationship 
Type

Displays the Change Query Node Type dialog box. 
Enables you to change the CI type of the query node after 
you have created it. For details, see "Change Query 
Node/Relationship Type Dialog Box" on page 303.

Note: Only relevant for the Modeling Studio.

Clear Available by right-clicking a query node or relationship 
when working in Enrichment mode in the Enrichment 
Manager. Clears the query node/relationship’s 
Enrichment rule definition. For details, see "Enrichment 
Manager" on page 507.

Appears only if you have updated or deleted a query 
node/relationship using an Enrichment rule.

Note: Only relevant for Enrichment Manager.

UI Elements (A-Z) Description
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Copy/Paste Copy/paste an existing TQL query node/relationship in 
the same query or into another TQL query.

The copied TQL query node/relationship includes all TQL 
definitions.

You can copy and paste relationships provided that the 
TQL query nodes to which the relationships are 
connected are also selected. A relationship on its own 
cannot be copied without its connecting TQL query 
nodes.

You can select multiple TQL query nodes/relationships as 
well.

Note: The Paste option is available only after using the 
Copy option to copy an existing TQL query 
node/relationship.

Define Impacted Define which query node in the TQL query is the trigger 
Impact Analysis query node and which query nodes are 
impacted by the changes that occur in the system. For 
details, see "Impacted Query Nodes Dialog Box" on 
page 455.

Note: Only relevant for Impact Analysis Manager.

Delete Deletes the selected query node/relationship/CI.

Note: This option is not available for calculated 
relationships.

Delete 
Relationship/Query 
Node

Available by right-clicking a query node or relationship 
when working in Enrichment mode.

Creates a specific Enrichment rule that is designed to 
delete CIs/relationships from the CMDB. Applicable to 
regular query nodes and relationships only. You can use 
this option, for example, for removing unnecessary data 
from the CMDB. For details, see "Enrichment Manager" 
on page 507.

Deleted query nodes and relationships are denoted by a 
removed  indicator.

Note: Only relevant for Enrichment Manager.

UI Elements (A-Z) Description
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Edit Relationship Displays the Refine Relationship Type dialog box. For 
details, see "Refine Query Node Type Dialog Box" on 
page 91.

Note: Not relevant in the Modeling Studio.

Note: This option appears only when the selected 
relationship has descendants.

Query 
Node/Relationship 
Properties

Displays the Query Node/Relationship Properties dialog 
box, enabling you to define the attribute conditions for 
the selected TQL query node/relationship. For details, see 
"Query Node/Relationship Properties Dialog Box" on 
page 80.

Note: This option is not available for calculated 
relationships.

Refine Query Node 
Type

Displays the Refine Query Node Type dialog box. Enables 
you to change the CI type of the query node after you 
have created it. For details, see "Refine Query Node Type 
Dialog Box" on page 91.

Note: This option only appears if a child of the CI type 
exists. Only relevant for Impact Analysis Manager and 
Enrichment Manager.

Remove Subgraph Only appears if you have defined a subgraph definition. 
For details, see "Subgraph Definition Dialog Box" on 
page 95.

Reset Impacted Removes the Define Impacted definition applied to that 
query node. For details on the Define Impacted 
definition, see "Impacted Query Nodes Dialog Box" on 
page 455.

Note: Only relevant for Impact Analysis Manager.

Reset Inner 
Relationship

Redraws a self-referential relationship in the Topology 
map as a square for ease of viewing.

Note: Only relevant for self-referential relationships that 
are not square.

UI Elements (A-Z) Description
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Set As Contact Query 
Node

Designates the selected query node as a contact query 
node for the perspective.

Note: Only relevant for perspectives in the Modeling 
Studio.

Set Data Sources Opens the Set Data Sources dialog box which enables you 
to select the required data sources for a TQL query node.

Note: Only relevant for the Modeling Studio.

Set Element Invisible When this option is selected, an invisible indicator  
appears to the right of the selected TQL query node in the 
editing pane.

Any query results pertaining to that TQL query node are 
not displayed in the topology map. This can be useful 
when certain relationships or TQL query nodes are 
required to build the query but are not needed in the 
results. At least one query node must be visible for the 
view to be valid.

Note: Only relevant for the Modeling Studio.

Set Element Visible When this option is selected, the results pertaining to the 
TQL query node are displayed in the topology map.

Note: Only relevant for the Modeling Studio.

Show Element 
instances

Displays the Element Instances dialog box which displays 
all the instances found for each query node in a table. For 
details, see "Element Instances Dialog Box" on page 73.

Show Parameters Opens the Template Parameter Values dialog box, which 
enables you to set the values of the query node’s 
parameters.

Note: Only relevant for template-based views in the 
Modeling Studio.

Subgraph Definition Displays the Subgraph Definition dialog box, where you 
can create a graph that represents additional TQL query 
data related to a specific query node. For details, see 
"Subgraph Definition Dialog Box" on page 95.

UI Elements (A-Z) Description
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Attribute Operator Definitions

This section contains a list of operators used to define attribute conditions 
in various dialog boxes, such as the Subgraph Condition dialog box, the Add 
Relationship dialog box, Impact Rules Definition dialog box, or the Query 
Node/Relationship Properties dialog box.

Update 
Relationship/Query 
Node

Use an Enrichment rule to update the value of CI 
attributes in the CMDB, or to add data to attributes that 
currently do not have values. Opens the Query Node 
Definition - Attributes dialog box. For details, see "Query 
Node/Relationship Definition Dialog Box" on page 531. 
This is applicable for both regular and Enrichment query 
nodes. 

Updated query nodes are denoted by an updated  
indicator.

Note: Only relevant for Enrichment Manager.

Operator Description

Changed during (Displayed only when you select an attribute of type 
Date.) Displays only the instances that changed 
during the period specified in the Value comparison 
box.

Equal Checks whether the attribute value is equal to the 
value specified in the Value Comparison box.

Equal ignore case Checks whether the attribute value is equal to the 
value specified in the value box regardless of the 
case.

Greater than or equal Checks whether the attribute value is greater than 
or equal to the value specified in the Value 
comparison box.

Greater Checks whether the attribute value is greater than 
the value specified in the Value comparison box.

UI Elements (A-Z) Description
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In Displays only the instances where this attribute 
value equals one of the selected values. For 
example, for CIs that have a Change state that 
equals Plan and New, select the operator In from the 
Operator list and select both Plan and New from 
the Value box.

Is null Checks whether the attribute value is null.

Less Checks whether the attribute value is less than the 
value specified in the Value comparison box.

Less than or equal Checks whether the attribute value is less than or 
equal to the value specified in the Value comparison 
box.

Like Uses a wildcard (%). Use Like when you are not sure 
of the complete name for which you are searching.

Like ignore case Uses a wildcard (%). Use Like ignore case when you 
are not sure of the complete name for which you 
are searching. The case of the string is ignored.

Not equal Checks whether the attribute value is not equal to 
the value specified in the Value Comparison box.

Unchanged during (Displayed when you select a date type attribute.) 
Displays only the instances that did not change 
during the period specified in the Value comparison 
box.

Operator Description
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Note: 

➤ For the Not equal operator, query results do not include data from the CI 
instances that are not assigned a value. For example, a system contains 
three nodes: Node1 is assigned the value A, Node2 is assigned the value 
B, and Node3 is not assigned a value. If you create a query to retrieve all 
nodes that are Not equal to A, the results of your query include Node2 
only, because Node3 is not assigned a value.

➤ HP Universal CMDB supports both Microsoft SQL Server and Oracle 
Server databases. Microsoft SQL Server is not case sensitive by default 
(unlike Oracle database which is case sensitive). Consequently, if you are 
using Microsoft SQL Server, the Equal operator retrieves the same query 
results as the Equal ignore case operator. For example, if you select the 
attribute City, the operator Equal, and type NEW YORK in the Value 
comparison box, case differences are ignored and query results include 
NEW YORK, New York and new york. 

TQL Logs

This section contains definitions for TQL parameter log files.

This section includes the following topics:

➤ "Pattern Log" on page 45

➤ "Pattern Statistics Log" on page 46

➤ "Audit Short/Detailed Log (TQL Perspective)" on page 46

➤ "Incremental Statistics Log" on page 47

➤ "Incremental Splitter Log" on page 48

➤ "Incremental Detailed Log" on page 49
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Pattern Log
The log name is cmdb.pattern.log.

Log File Description

Purpose Information about the lifecycle of a TQL query that is handled 
and calculated in the CMDB. 

Only TQL queries stored in the CMDB are included. 
Information about ad hoc TQL queries is not included.

Information 
Level

Not available.

Error Level Not available.

Debug Level Possible actions performed on each TQL query include:

➤ status changes

➤ model changes

➤ query changes

➤ completed calculations

Basic 
Troubleshooting

Check if a TQL query has the same status for a long time:

➤ new – the query is in lazy loading

➤ inactive 

➤ calculation – the calculation may have failed but the 
scheduler was not informed

You can also view the number of notifications that a TQL 
query received.
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Pattern Statistics Log
The log name is cmdb.pattern.statistics.log.

Audit Short/Detailed Log (TQL Perspective)
The log name is cmdb.audit.short.log.

Log File Description

Purpose General calculation data for each TQL query, updated at 
predefined intervals.

Information 
Level

The following information is given for each TQL query:

➤ name

➤ average, minimum, and maximum calculation times

➤ number of calculations

➤ last calculation time

➤ result size

Error Level Not available.

Debug Level Not available.

Basic 
Troubleshooting

➤ Verify that a specific TQL query was updated.

➤ Evaluate a TQL query’s calculation time.

➤ Evaluate a TQL query’s result size. 

Log File Description

Purpose CMDB state changes, CI Type changes, and TQL query results.

You can use this log to follow the results of TQL queries.

Information 
Level

Not available.

Error Level Not available.
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Incremental Statistics Log
The log name is cmdb.incremental.statistics.log. 

Debug Level ➤ Final calculation for TQL queries is logged.

➤ If the final TQL query calculation is unchanged from the 
previous calculation, this is noted.

➤ If the final TQL query calculation is changed from the 
previous calculation, results of the CIs and relationships are 
recorded in the detailed log. The number of CIs and 
relationships are recorded in the short log.

Basic 
Troubleshooting

➤ Use this log to verify which notifications are published by 
the TQL query subsystem.

➤ Check the section at the end of each result. This section 
includes added, removed, and updated CIs and 
relationships.

➤ Track the CIT changes and see if the query results also 
change. You can thus correlate the CIT changes to the 
results of the query calculations.

Log File Description

Purpose Traces the calculation procedure, full or incremental, of every 
query.

Information 
Level

Not available.

Error Level Not available.

Log File Description
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Incremental Splitter Log
The log name is cmdb.incremental.splitter.log.

Debug Level ➤ Gives the date, time, query name, and whether an 
incremental statistic calculation was performed (yes/no). 

➤ If an incremental statistic calculation was not performed, 
states the reason, the number of subcalculations (relevant 
for incremental calculations only), and the complete 
calculation time.

Basic 
Troubleshooting

Monitors the calculation process.

If a specific query calculation takes a long time, check if it is a 
full or incremental calculation:

➤ If full, check whether a full calculation is necessary.

➤ If incremental, check how many subcalculations have been 
performed.

Log File Description

Purpose Monitors the incremental splitter result made during an 
incremental calculation.

Information 
Level

Not available.

Error Level Not available.

Debug Level Gives the set of query node numbers of each query graph 
created by the incremental splitter.

Basic 
Troubleshooting

If the TQL result calculated by the incremental calculator is 
wrong, verify that the splitter result is correct.

Log File Description
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Incremental Detailed Log
The log name is cmdb.incremental.detailed.log.

Topology Query Language User Interface

This section includes (in alphabetical order):

 ➤ Add/Edit Calculated Relationship Dialog Box on page 50

 ➤ Add/Edit Compound Relationship Dialog Box on page 52

 ➤ Add/Edit Join Relationship Dialog Box on page 56

 ➤ Add/Edit Relationship Dialog Box on page 59

 ➤ Add Related Query Node Wizard on page 61

 ➤ Add Triplet Dialog Box on page 69

 ➤ Element Instances Dialog Box on page 73

 ➤ Filter CI Instances Dialog Box on page 76

 ➤ Join Relationship Condition Dialog Box on page 77

Log File Description

Purpose Monitors the incremental calculation process. 

Information 
Level

Not available.

Error Level Not available.

Debug Level Each incremental subcalculation entry includes the following:

➤ the trigger query node 

➤ the number of elements classified to the trigger query node 

➤ whether the subcalculation step is driven by new elements 
added to the model or by existing elements

➤ the calculated query graph

Basic 
Troubleshooting

Follows the basic steps of an incremental calculation.
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 ➤ Layout Settings Dialog Box on page 79

 ➤ Query Node/Relationship Properties Dialog Box on page 80

 ➤ Refine Query Node Type Dialog Box on page 91

 ➤ Select Relationship Type Dialog Box on page 92

 ➤ Subgraph Condition Definition Dialog Box on page 93

 ➤ Subgraph Definition Dialog Box on page 95

 ➤ User Preferences Dialog Box on page 97

Add/Edit Calculated Relationship Dialog Box

This dialog box enables you to define the connection between two query 
nodes using a calculated relationship from the CI Type model.

To access To access in Enrichment Manager, Impact Analysis 
Manager, and the Modeling Studio:
Right-click the required query node in the editing pane in 
Enrichment Manager, Impact Analysis Manager, or the 
Modeling Studio and select Add Calculated Relationship.

Note: If you are using Enrichment Manager, select Query 
mode at the top of the editing pane to display the Add 
Calculated Relationship option.

To access in Adapter Management in Data Flow 
Management (DFM):
1  Select an adapter in the Discovery Resources pane.

2  In the Adapter Definition tab, click the  Edit Input 
Query button to the right of the Input Query box to 
open the Input Query Editor.

3  Right-click the required query node and select Add 
Calculated Relationship.
50



Chapter 1 • Topology Query Language
User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Relevant tasks ➤ "Define an Impact Rule – Workflow" on page 442

➤ "Define an Enrichment Rule – Scenario" on page 510

➤ "Define a TQL Query" on page 27

➤ "Implement a Discovery Adapter" in the HP Universal 
CMDB Developer Reference Guide

➤ "Create a Pattern View" on page 285

➤ "Create a Template" on page 286

➤ "Create a Perspective" on page 288

See also ➤ "Using Calculated Relationships" on page 103

➤ "CI Type Relationships" on page 468

UI Elements (A-Z) Description

Click Expand All to expand all the folders in the tree.

Click Collapse All to collapse all the folders in the tree.

Tree View Click Tree View to select the display format of the 
calculated relationship tree. The following options are 
available:

➤ Display label

➤ Class name

➤ Legacy class name

<Calculated 
relationship tree>

Select the calculated relationship that defines the 
connection between two query nodes.

Relationship 
Direction

The direction of the relationship that indicates which 
query node is dependent on the other.

Relationship Name The name of the calculated relationship.
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Add/Edit Compound Relationship Dialog Box

This dialog box enables you to define the connection between two query 
nodes using a compound relationship.

Relationship 
Restrictions

Select an option to define how to handle relationships 
between identical query nodes or self relationships in the 
query results. A self relationship is a relationship that 
leads from a query node to itself.

Note: This list appears only when you select one query 
node or two identical query nodes.

➤ Allow All Relationships. All relationships appear in the 
query results.

➤ Allow Self Relationships only. Only self-relationships (a 
relationship that leads to itself) appear in the query 
results.

➤ Allow Non Self Relationships only. Self-relationships do 
not appear in the query results.

To access To access in Enrichment Manager, Impact Analysis 
Manager, and the Modeling Studio:

Right-click the required query nodes in the editing pane 
in Enrichment Manager, Impact Analysis Manager, or the 
Modeling Studio and select Add Compound Relationship.

Note: If you are using Enrichment Manager, select Query 
mode at the top of the editing pane to display the Add 
Compound Relationship option.

To access in Adapter Management in DFM:
1  Select an adapter in the Discovery Resources pane. 

2  In the Adapter Definition tab, click the  Edit Input 
Query button to the right of the Input Query box to 
open the Input Query Editor.

3  Right-click the required query node and select Add 
Compound Relationship.

UI Elements (A-Z) Description
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User interface elements are described below:

Important 
information

You can create as many compound definitions as 
necessary.

Relevant tasks ➤ "Define an Impact Rule – Workflow" on page 442

➤ "Define an Enrichment Rule – Scenario" on page 510

➤ "Define a TQL Query" on page 27

➤ "Implement a Discovery Adapter" in the HP Universal 
CMDB Developer Reference Guide

➤ "Create a Pattern View" on page 285

➤ "Create a Template" on page 286

➤ "Create a Perspective" on page 288

See also ➤ "Compound Relationship" on page 23

➤ "Define a Compound Relationship – Scenario" on 
page 30

UI Elements (A-Z) Description

Add a compound definition. 

In Impact Analysis Manager and Enrichment Manager, it 
opens the Add Triplet dialog box. In the Modeling Studio, 
it enters a default compound definition in the table. Click 
the Edit buttons to edit the definition components.

Delete the selected compound definition.

Edit the selected compound definition. 

In Impact Analysis Manager and Enrichment Manager, it 
opens the Add Triplet dialog box. In the Modeling Studio, 
it opens the Compound Relationship Condition 
Definition dialog box.

Max steps The longest path allowed between the two CIs in the 
CMDB to be included in the discovery process.

Default is: 5

Min steps The shortest path allowed between the two CIs in the 
CMDB to be included in the discovery process.

Default is: 1
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Relationship The relationship connecting the two query nodes. 

Relationship 
Direction

The direction of the relationship that indicates which 
query node is dependent on the other.

Relationship Name The name of the compound relationship.

Relationship 
Restrictions

Select an option to define how to handle relationships 
between identical query nodes or self relationships in the 
query results. A self relationship is a relationship that 
leads from a query node to itself.

Note: This list appears only when you select one query 
node or two identical query nodes.

➤ Allow All Relationships. All relationships appear in the 
query results.

➤ Allow Self Relationships only. Only self-relationships (a 
relationship that leads to itself) appear in the query 
results.

➤ Allow Non Self Relationships only. Self-relationships do 
not appear in the query results.

Show full path 
between source and 
target CIs

If you select this option, then the query results display 
the actual names of the relationships that link the CIs 
and the full path between the source and target CIs.

Source The required source query node.

UI Elements (A-Z) Description
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Stop at first 
compound level

Select this option if you want the system to stop looking 
for TQL query results once it reaches the first target in the 
path. 

In the following sample compound link definition, Depth 
is defined as 10 and Stop at first compound level is 
selected.

The TQL query results include the Target 1, Target 3, and 
Target 4 because they are all at level 1 (the first CI found 
in the path). Target 2 is not included in the TQL results 
because it is at level 2 (the second CI found in the path).

Target The required target query node.

Visible Select Visible to include query results relating to a join or 
compound relationship. By default, Visible is selected. 
When Visible is cleared, a box  appears to the left of the 
of the relationship’s name in the editing pane, denoting 
that any query results pertaining to the relationship are 
not displayed in the topology map.

UI Elements (A-Z) Description
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Add/Edit Join Relationship Dialog Box

This dialog box enables you to define join relationships.

To access To access in Enrichment Manager, Impact Analysis 
Manager, and the Modeling Studio:

Right-click the required query nodes in the editing pane 
in Enrichment Manager, Impact Analysis Manager, or the 
Modeling Studio and select Add Join Relationship.

Note: If you are using Enrichment Manager, select Query 
mode at the top of the editing pane to display the Add 
Join Relationship option.

To access in Adapter Management in DFM:
1  Select an adapter in the Discovery Resources pane. 

2  In the Adapter Definition tab, click the  Edit Input 
Query button to the right of the Input Query box to 
open the Input Query Editor.

3  Right-click the required query node and select Add Join 
Relationship.

Important 
information

When you access the dialog box from the Modeling 
Studio, you select the attributes and operator within the 
dialog box itself. When you access the dialog box from 
Impact Analysis Manager or Enrichment Manager, you 
select the attributes and operator from the Join 
Relationship Condition dialog box.

Relevant tasks ➤ "Define an Impact Rule – Workflow" on page 442

➤ "Define an Enrichment Rule – Scenario" on page 510

➤ "Define a TQL Query" on page 27

➤ "Implement a Discovery Adapter" in the HP Universal 
CMDB Developer Reference Guide

➤ "Create a Pattern View" on page 285

➤ "Create a Template" on page 286

➤ "Create a Perspective" on page 288

See also "Join Relationship" on page 24

"Define a Join Relationship – Scenario" on page 33
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

Define a join definition. In Impact Analysis Manager and 
Enrichment Manager, it opens the Join Relationship 
Condition dialog box. In the Modeling Studio, it adds the 
selected attributes and operator to the list.

Delete the selected join definition.

Edit the join definition. Opens the Join Relationship 
Condition dialog box.

Note: This option is not relevant in the Modeling Studio.

<Query node1 
Attribute> box

Select an attribute for the <end_1> query node.

Note: This option is only available in the Modeling 
Studio.

<Query node2 
Attribute> box

Select an attribute for the <end_2> query node.

Note: This option is only available in the Modeling 
Studio.

<Selected query 
node1> column

A selected query node. The first attribute applies to 
<end_1>. 

<Selected query 
node2> column

A selected query node. The second attribute applies to 
<end_2>.

And All join definitions are linked by the And operator.

Note: This is not relevant in the Modeling Studio.

Operator box Select an operator. For details on the available operators, 
see "Join Relationship Condition Dialog Box" on page 77.

Note: This option is only available in the Modeling 
Studio.

Operator column The operator selected in the Join Relationship Condition 
dialog box. For details about operator definitions, see 
"Attribute Operator Definitions" on page 42.

Relationship 
Direction

The direction of the relationship that indicates which 
query node is dependent on the other.
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Relationship Name The name of the join relationship.

Relationship 
Restrictions

Select an option to define how to handle relationships 
between identical query nodes or self relationships in the 
query results. A self relationship is a relationship that 
leads from a query node to itself.

Note: This list appears only when you select one query 
node or two identical query nodes.

➤ Allow All Relationships. All relationships appear in the 
query results.

➤ Allow Self Relationships only. Only self-relationships (a 
relationship that leads to itself) appear in the query 
results.

➤ Allow Non Self Relationships only. Self-relationships do 
not appear in the query results.

Visible Select Visible to include query results relating to a join or 
compound relationship. By default, Visible is selected. 
When Visible is cleared, an invisible box  appears to 
the left of the of the relationship’s name in the editing 
pane. Any query results pertaining to the relationship are 
not displayed in the topology map.

UI Elements (A-Z) Description
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Add/Edit Relationship Dialog Box

This dialog box enables you to define the connection between two query 
nodes in a TQL query.

To access To access in Enrichment Manager, Impact Analysis 
Manager, and the Modeling Studio:
➤ Right-click the required query node in the editing pane 

in Enrichment Manager, Impact Analysis Manager, or 
the Modeling Studio and select Add Relationship.

or

➤ Click the Create Relationship  icon and draw a line 
between the required query nodes. The Select 
Relationship Type dialog box opens. Select Regular 
Relationship.

Note: If you are using Enrichment Manager, select Query 
mode at the top of the editing pane to display the Add 
Relationship option.

To access in Adapter Management in DFM:
1  Select an adapter in the Discovery Resources pane.

2  In the Adapter Definition tab, click the  Edit Input 
Query button to the right of the Input Query box to 
open the Input Query Editor.

3  Right-click the required query node and select Add 
Relationship.

Relevant tasks ➤ "Define an Impact Rule – Workflow" on page 442

➤ "Define an Enrichment Rule – Scenario" on page 510

➤ "Define a TQL Query" on page 27

➤ "Implement a Discovery Adapter" in the HP Universal 
CMDB Developer Reference Guide

➤ "Create a Pattern View" on page 285

➤ "Create a Template" on page 286

➤ "Create a Perspective" on page 288

See also This option does not appear when two selected query 
nodes (or a single selected query node) do not have a 
valid relationship between them.
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

Click Expand All to expand all the folders in the 
relationship tree.

Click Collapse All to collapse all the folders in the 
relationship tree.

Tree View Click Tree View to select the display format of the 
relationship tree. The following options are available:

➤ Display label

➤ Class name

➤ Legacy class name

<Relationship tree> Select the relationship that defines the connection 
between two query nodes.

Relationship 
Direction

The direction of the relationship that indicates which 
query node is dependent on the other.

Relationship Name The name of the relationship.

Relationship 
Restrictions

Select an option to define how to handle relationships 
between identical query nodes or self relationships in the 
query results. A self relationship is a relationship that 
leads from a query node to itself.

Note: This list appears only when you select one query 
node or two identical query nodes.

➤ Allow All Relationships. All relationships appear in the 
query results.

➤ Allow Self Relationships only. Only self-relationships (a 
relationship that leads to itself) appear in the query 
results.

➤ Allow Non Self Relationships only. Self-relationships do 
not appear in the query results.
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Add Related Query Node Wizard

This wizard enables you to build a TQL query.

To access To access in Enrichment Manager, Impact Analysis 
Manager, and the Modeling Studio:
In the editing pane, right-click the required query node 
and select Add Related Query Node.

Note: If you are using Enrichment Manager, select Query 
mode at the top of the editing pane to display the Add 
Related Query Node option.

To access in Discovery Control Panel in DFM:
1  Select a job in the Discovery Modules pane. 

2  Select a Trigger Query in the Properties tab. Click the 
Open the Query Editor  button to open the Trigger 
Query Editor.

3  Right-click the required query node and select Add 
Related Query Node Wizard.

To access in Adapter Management in DFM:
1  Select an adapter in the Discovery Resources pane. 

2  In the Adapter Definition tab, click the  Edit Input 
Query button to the right of the Input Query box to 
open the Input Query Editor.

3  Right-click the required query node and select Add 
Related Query Node Wizard.

Important 
information

If the TQL query is empty, drag the required TQL query 
nodes on to the editing pane from the tree displayed in 
the CI Type Selector or the CI Types tab of the left pane.

Relevant tasks ➤ "Define an Impact Rule – Workflow" on page 442

➤ "Define an Enrichment Rule – Scenario" on page 510

➤ "Define a TQL Query" on page 27

➤ "Implement a Discovery Adapter" in the HP Universal 
CMDB Developer Reference Guide

➤ "Create a Pattern View" on page 285

➤ "Create a Template" on page 286

➤ "Create a Perspective" on page 288
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Related Query Node Type Page
This wizard page enables you to add a query node to the TQL query.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Wizard map The Add Related Query Node Wizard contains:

Related Query Node Type Page > Relationship Type Page > 
Related Query Node Properties Page > Related Query 
Node Instances Page

See also "Topology Query Language (TQL) Overview" on page 20

Important 
information

If the TQL query is empty, drag the required TQL query 
node on to the editing pane from the tree displayed in 
the Configuration Item Types pane.

For general information on the Add Related Query Node 
Wizard, see "Add Related Query Node Wizard" on 
page 61.

Wizard map The Add Related Query Node Wizard contains:

Related Query Node Type Page > Relationship Type 
Page > Related Query Node Properties Page > Related 
Query Node Instances Page

UI Elements (A-Z) Description

Click Expand All to expand all the folders in the tree.

Click Collapse All to collapse all the folders in the tree.

Tree View Click Tree View to select the display format of the CI type 
tree. The following options are available:

➤ Display label

➤ Class name

➤ Legacy class name

Note: This feature is only available in the Modeling 
Studio.
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<query node> is 
required

Define the relationship cardinality. For details, see 
"Cardinality Tab" on page 84.

➤ Select the <query node> is required check box for each 
query node to include a minimum of one instance of 
the query node at the other end of the relationship in 
the query results. Selecting the check box gives the 
relationship a cardinality value of 1..*.

➤ Clear the <query node> is required check box to give 
the relationship a cardinality value of 0..*.

<TQL Query Node 
hierarchy tree>

Select the required query node. The query node you select 
appears in the Element name box.

This list only includes the query nodes of the CI type that 
have valid relationships to the selected (source) query 
node. 

To the right of each query node, the number of CI 
instances that exist in the CMDB for that CI type is 
displayed. The number of instances is only updated after 
you close the Add Related Query Node Wizard and open 
it again.

Note: The first query node in the hierarchy tree is selected 
by default.

Element name (Optional) Contains the name of the selected query node. 
By default, the CI type is assigned as the element’s name.

You can rename a TQL query node in the Element name 
box giving it a unique label. This can be helpful when 
there is more than one query node of the same CI type in 
the TQL query.

Show only CITs with 
instances

Select this check box to display only the CITs of which 
there are instances in the CMDB. If this box is not 
selected, the tree includes all CITs with a valid link to the 
source query node.

Note: The Show only CITs with instances check box is 
selected by default.

UI Elements (A-Z) Description
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Relationship Type Page
This wizard page enables you to add a relationship to a TQL query.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Wizard map The Add Related Query Node Wizard contains:

Related Query Node Type Page > Relationship Type Page 
> Related Query Node Properties Page > Related Query 
Node Instances Page

UI Elements (A-Z) Description

Tree View Click Tree View to select the display format of the 
Relationship tree. The following options are available:

➤ Display label

➤ Class name

➤ Legacy class name

Note: This feature is only available in the Modeling 
Studio.

<TQL Query 
Relationship 
hierarchy tree>

Select the required relationship. 

Relationship 
direction

Select the required relationship direction. The direction 
indicates which query node is dependent on the other.

Relationship Name The name of the relationship.

Note: This feature is only available in the Modeling 
Studio.

Relationship 
Restrictions

Select an option to define how to handle relationships 
between identical query nodes or self relationships in the 
query results. A self relationship is a relationship that 
leads from a query node to itself.

Note: This feature is only available in the Modeling 
Studio.
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Related Query Node Properties Page
This wizard page enables you to create an expression that restricts the 
number of query nodes that appear in the query by adding an attribute 
condition to a query node or relationship.

User interface elements are described below:

Relationship Type A valid relationship that defines the connection between 
the selected query nodes. The box displays the 
relationship you selected in the relationship hierarchy 
tree.

Note: This feature is only available in Enrichment 
Manager and Impact Analysis Manager.

Show only 
relationships with 
instances

Display only the relationships of which there are 
instances in the CMDB. If this box is not selected, the tree 
includes all valid relationships between the selected 
query nodes.

Important 
information

When you access the wizard from the Modeling Studio, 
this wizard page has two tabs: Attribute and Qualifier. The 
Attribute tab includes the elements described below. For 
details on the Qualifier tab, see "Qualifier Tab" on 
page 87.

Wizard map The Add Related Query Node Wizard contains:

Related Query Node Type Page > Relationship Type Page > 
Related Query Node Properties Page > Related Query 
Node Instances Page

UI Elements (A-Z) Description

Add an attribute condition.

Delete an attribute condition.

Move a selected row up.

UI Elements (A-Z) Description
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Move a selected row down.

View the condition definition.

Advanced layout 
settings

Opens the Layout Settings dialog box which enables you 
to determine which attributes are used in the calculation 
of the TQL query when querying the CMDB using third-
party or custom tools. 

Note: This option is only relevant when accessing the 
wizard from the Modeling Studio.

And/Or Click inside the And/Or field and select either And or Or 
to link multiple conditions.

Attribute name Choose an attribute from the list.

Brackets Click inside the Brackets box to display a list of brackets 
you can use to build more complex, logical statements.

Criteria Contains the attribute condition definition as defined in 
the Element Instances Dialog Box.

Include subtypes Display both the selected CI and its children in the 
topology map.

Not Select NOT if you want the condition statement to do the 
opposite of what is defined.

Note: If you select NOT, query results do not include data 
from the CI instances that were not assigned a value. For 
example, your system contains three nodes: Node1 is 
assigned the value A, Node2 is assigned the value B and 
Node3 is not assigned a value. You create a query to 
retrieve all nodes that are equal to A and select NOT; the 
results of your query only include Node2 because Node3 
is not assigned a value.

Operator Select the required operator. For details, see "Attribute 
Operator Definitions" on page 42.

Update Update an attribute condition that has been modified.

UI Elements (A-Z) Description
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Value Enter or select the value of the attribute. The Value 
options vary according to the attribute type you select.

Visible Select Visible to display the selected TQL query node in 
the editing pane. When Visible is cleared, an invisible 
box  appears to the right of the selected TQL query 
node in the editing pane.

Any query results pertaining to that TQL query node are 
not displayed in the topology map. This can be useful 
when certain relationships or TQL query nodes are 
required to build the query but are not needed in the 
results. For example, Windows are connected to the 
network by defining specific IP Addresses, but in any 
query results you may want to view the IP Address 
elements only and not the Windows elements.

UI Elements (A-Z) Description
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Related Query Node Instances Page
This wizard page displays all the instances found for the selected TQL query 
node in a table. 

Important 
information

The columns displayed in the report vary according to 
the CI type selected. 

By default, only columns corresponding to attributes that 
have been defined with the Asset Data, Change 
Monitored, and Comparable attribute qualifiers in the CI 
Type Manager are displayed as columns in the dialog box. 
For details, see "Attributes Page" on page 488. 

If required, you can click the Display Hidden Columns 
button to display the attributes that are defined as Visible 
but not Static. For details on Static attributes, see 
"Attributes Page" on page 488.

Note: For information on the elements included in the 
Related Query Node Instances page, see "Element 
Instances Dialog Box" on page 73.

Wizard map The Add Related Query Node Wizard contains:

Related Query Node Type Page > Relationship Type Page > 
Related Query Node Properties Page > Related Query 
Node Instances Page
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Add Triplet Dialog Box

This dialog box enables you to define the allowed steps in a path in the 
topology graph leading from the source CI to the target CI when creating a 
subgraph definition, a compound relationship, or a calculated relationship.

To access ➤ In the Add Compound Relationship dialog box, click 
the Add  button. For details, see "Add/Edit 
Compound Relationship Dialog Box" on page 52.

➤ In the Subgraph Definition dialog box, click  Add. 
For details, see "Subgraph Definition Dialog Box" on 
page 95.

➤ In CI Type Manager, select Calculated Relationships 
from the drop-down list in the CI Types pane. In the 
editing pane, select the Triplets page and then click 

 Add.

Important 
information

Select the query nodes and relationships to be included 
in the topology graph.

Important: The Condition fields are displayed only when 
you access the Add Triplet dialog box from the Subgraph 
Definition dialog box.  

Relevant tasks ➤ "Define an Impact Rule – Workflow" on page 442

➤ "Define an Enrichment Rule – Scenario" on page 510

➤ "Define a TQL Query" on page 27

➤ "Implement a Discovery Adapter" in the HP Universal 
CMDB Developer Reference Guide

➤ "Create a Pattern View" on page 285

➤ "Create a Template" on page 286

➤ "Create a Perspective" on page 288

See also ➤ "Compound Relationship" on page 23

➤ "Define a Compound Relationship – Scenario" on 
page 30

➤ "Subgraph Definition" on page 25
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User interface elements are described below:

UI Elements (A-Z) Description

Define attribute conditions for the source and target 
query nodes you selected. Opens the Subgraph Condition 
Definition dialog box. 

The Condition button is enabled only after you select a 
query node from the Source or Target lists.

Note: You cannot define attribute conditions for the 
source and target query nodes in the CI Type Manager.

Relationship Select an available relationship connecting the two query 
nodes. The list of available relationships appears only 
after defining both query nodes. 

Relationship 
Direction

Select the required direction. Setting different 
relationship directions can achieve different query 
results. For an example, see "Setting Different 
Relationship Directions for Compound Definitions" on 
page 71.

Note: The Relationship list remains empty until you have 
selected a source and target.

Source Select the required source query node.

Target Select the required target query node.
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Setting Different Relationship Directions for Compound 
Definitions

You can achieve different TQL results by setting different relationship 
directions. For example, in your business world, as illustrated below, you 
want to create a compound relationship that connects between a query 
node of the CIT a and a query node of the CIT b. Depth is defined at 5 (for 
details, see "Depth" on page 96). 

In the Add Triplet dialog box, you can create compound definitions to link 
query nodes a and b using different relationship directions.

➤ Compound definitions 1 and 2 result in the following query:

Compound 
Definition

Source Target Relationship
Relationship 
Direction

#1 query node a query node c <relationship> source --> target

#2 query node c query node b <relationship> source --> target

#3 query node c query node b <relationship> source <-- target
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➤ Compound definitions 1 and 3 result in the following query:

➤ Compound definitions 1, 2, and 3 result in the following query:
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Element Instances Dialog Box

This dialog box displays all of the CI instances found for the selected TQL 
query node in a table. 

To access To access in Enrichment Manager, Impact Analysis 
Manager, and the Modeling Studio:
In the editing pane, right-click the required query node 
and select Show Element Instances.

Note: If you are using Enrichment Manager, select Query 
mode at the top of the editing pane to display the Show 
Element Instances option.

To access in Adapter Management in DFM:
1  Select an adapter in the Discovery Resources pane.

2  In the Adapter Definition tab, click the  Edit Input 
Query button to the right of the Input Query box to 
open the Input Query Editor.

3  Right-click the required query node and select Show 
Element’s Instances.

Important 
information

The columns in the table display the attributes of the 
selected CI type. The attributes displayed vary according 
to the CI type selected.

By default, only columns corresponding to attributes that 
have been defined with the Asset Data, Change 
Monitored, and Comparable attribute qualifiers in the 
CIT Manager are displayed as columns in the dialog box. 
For details, see "Attributes Page" on page 488. 

Relevant tasks ➤ "Define an Impact Rule – Workflow" on page 442

➤ "Define an Enrichment Rule – Scenario" on page 510

➤ "Define a TQL Query" on page 27

➤ "Create a Pattern View" on page 285

➤ "Create a Template" on page 286

➤ "Create a Perspective" on page 288
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

Specify the CIT you want displayed in the table. The table 
also includes the children of the selected CIT.

Click to delete the selected CI.

Click Show CI Properties to open the Configuration Item 
Properties dialog box for the selected CI.

Click to refresh the list of CI instances.

Filters the CI instances you want to display for the 
selected query node. Opens the Filter CI Instances dialog 
box.

Clears the filter definitions you created in the Filter CI 
Instances dialog box.

Enables you to select the columns to be displayed. For 
details, see "Select Columns Dialog Box" on page 558.

Enables you to set the sort order of the CI instances. For 
details, see "Sort Column Content Dialog Box" on 
page 559.

Click Find to display the Find toolbar.

Click Send Mail to send the table data in an email.
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Choose the export format for the table data. The available 
options are: 

➤ Excel. The table data is formatted as an .xls (Excel) file 
that can be displayed in a spreadsheet.

➤ PDF. The table data is exported in PDF format.

➤ RTF. The table data is exported in Rich Text Format.

➤ CSV. The table data is formatted as a comma-separated 
values (CSV) text file that can be displayed in a 
spreadsheet.

Note: For the CSV formatted table data to display 
correctly, the comma (,) must be defined as the list 
separator. In Windows, to verify or modify the list 
separator value, open Regional Options from the 
Control Panel, and on the Numbers tab ensure that the 
comma is defined as the List Separator value. In Linux, 
you can specify the list separator in the application 
that opens the CSV file.

➤ XML. The table data is formatted as an XML file that 
can be opened in a text or XML editor. 

Tip: To extract HTML code from the report: 

➤ Save the file as HTML

➤ Open the file in an HTML editor

➤ Copy the relevant table into the target file 

Rows per 
page

Select the number of rows to be displayed on each page.

Click to navigate through the results page by page or to 
jump to the first or last page.

<Element Instances> The CI instances found for the selected TQL query node.

You can double-click an instance to open the 
Configuration Item Properties dialog box for that CI.

UI Elements (A-Z) Description
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Filter CI Instances Dialog Box

This dialog box enables you to reduce the number of CI instances to be 
displayed in a list by selecting a condition and a value for a specific CI.

<Element instances 
shortcut menu>

For details, see "IT Universe Manager Shortcut Menu" on 
page 250.

Display Label The name of the CI instance as it appears in the topology 
map.

To access Click the Filter  button in the Element Instances 
dialog box.

Important 
information

A description of the filter condition you defined appears 
above the table columns in the Element Instances dialog 
box. For example, the following illustration shows that a 
filter condition was created to display only CI instances 
whose CI type is Windows.

Relevant tasks ➤ "Define an Impact Rule – Workflow" on page 442

➤ "Define an Enrichment Rule – Scenario" on page 510

➤ "Define a TQL Query" on page 27

➤ "Implement a Discovery Adapter" in the HP Universal 
CMDB Developer Reference Guide

➤ "Create a Pattern View" on page 285

➤ "Create a Template" on page 286

➤ "Create a Perspective" on page 288

UI Elements (A-Z) Description
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User interface elements are described below:

Join Relationship Condition Dialog Box

This dialog box enables you to define the connection between two query 
nodes using a join relationship.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

Attribute Displays all the attributes of the CI type to which the CI 
belongs.

Condition Select the required operator. For details, see "Attribute 
Operator Definitions" on page 42.

NOT Select to filter the results by the negation of a condition 
and value.

Value Select or enter the required value.

To access In Enrichment Manager or Impact Analysis Manager, 
click the Add  button in the Add Join Relationship 
dialog box.

Relevant tasks ➤ "Define an Impact Rule – Workflow" on page 442

➤ "Define an Enrichment Rule – Scenario" on page 510

➤ "Define a TQL Query" on page 27

➤ "Implement a Discovery Adapter" in the HP Universal 
CMDB Developer Reference Guide.

UI Elements (A-Z) Description

<Selected query 
node1>

A selected query node. The first attribute applies to 
<end_1>.
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<Selected query 
node2>

A selected query node. The second attribute applies to 
<end_2>.

Operator Select one of the following operators: 

➤ Equal. The system checks whether two selected 
attributes are equal.

➤ Not equal. The system checks whether two selected 
attributes are not equal.

➤ Sub string. The system checks whether the value of the 
first attribute is a substring of the value of the second 
attribute.

➤ Sub string ignore case. The system checks whether the 
value of the first attribute is a substring of the value of 
the second attribute regardless of the string’s case.

Important: When using the operator Not equal, ensure 
that both sides of the join relationship have a limited 
result size. It is recommended to define more specific 
conditions so as not to overload the system with large 
results.

UI Elements (A-Z) Description
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Layout Settings Dialog Box

This dialog box enables you to determine which attributes are used in the 
calculation of the TQL query when using the UCMDB API. For details, see 
"HP Universal CMDB Web Service API" in the HP Universal CMDB Developer 
Reference Guide. 

User interface elements are described below:

To access Click Advanced layout settings in the Query 
Node/Relationship Properties dialog box.

Important 
information

Since this option is only relevant when querying the 
CMDB API, the query results in the user interface is not 
impacted by the attributes you select in this dialog box.

Relevant tasks ➤ "Define an Impact Rule – Workflow" on page 442

➤ "Define an Enrichment Rule – Scenario" on page 510

➤ "Define a TQL Query" on page 27

➤ "Implement a Discovery Adapter" in the HP Universal 
CMDB Developer Reference Guide

➤ "Create a Pattern View" on page 285

➤ "Create a Template" on page 286

➤ "Create a Perspective" on page 288

UI Elements (A-Z) Description

Attribute name The name of the attribute.

Calculate Select this check box to include the attribute in the 
query’s calculation.
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Query Node/Relationship Properties Dialog Box

This dialog box enables you to define the attribute conditions for the 
selected TQL query node/relationship.

To access To access in Enrichment Manager, Impact Analysis 
Manager, and the Modeling Studio:
In the editing pane, right-click the required query node 
and select Query Node/Relationship Properties.

Note: If you are using Enrichment Manager, select Query 
mode at the top of the editing pane to display the Query 
Node Properties option.

To access in DFM:
1  To access from the Adapter Definition tab, select an 

adapter. Click the  Edit Input Query button to the 
right of the Input Query box to open the Input Query 
Editor. 

2  Right-click the required query node/relationship and 
select Query Node Properties or Relationship 
Properties.

Relevant tasks ➤ "Define an Impact Rule – Workflow" on page 442

➤ "Define an Enrichment Rule – Scenario" on page 510

➤ "Define a TQL Query" on page 27

➤ "Implement a Discovery Adapter" in the HP Universal 
CMDB Developer Reference Guide

➤ "Create a Pattern View" on page 285

➤ "Create a Template" on page 286

➤ "Create a Perspective" on page 288
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User interface elements are described below:

UI Elements (A-Z) Description

Element name (Optional) The Element name box contains the name of 
the selected query node/relationship. By default, the CI 
type is assigned as the element’s name. You can rename a 
TQL query node in the Element name box giving it a 
unique label. This can be helpful when there is more than 
one query node of the same CI type in the TQL query.

Include subtypes Select to display both the selected CI and its children in 
the topology map.

Query Result Count Click Query Result Count to display a topology map of 
the TQL query showing the number of instances of each 
query node/relationship.

Note: This feature is only available in the Modeling 
Studio.

Visible Select Visible to display the selected TQL query node in 
the editing pane. When this option is cleared, an invisible 
box  appears to the right of the selected TQL query 
node in the editing pane.

Any query results pertaining to that TQL query node are 
not displayed in the topology map. This can be useful 
when certain relationships or TQL query nodes are 
required to build the query but are not needed in the 
results. For example, Windows are connected to the IP 
Subnet by defining specific IP Addresses, but in any query 
results you may want to view the IP Address elements 
only and not the Windows elements.
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Attribute Tab

This area enables you to create an expression defining conditions that 
restrict the number of query nodes that appear in the query. You can add an 
attribute condition to a query node or relationship and filter the query 
results.

User interface elements are described below:

To access Click the Attribute tab in the Query Node/Relationship 
Properties dialog box.

Relevant tasks ➤ "Define an Impact Rule – Workflow" on page 442

➤ "Define an Enrichment Rule – Scenario" on page 510

➤ "Define a TQL Query" on page 27

➤ "Implement a Discovery Adapter" in the HP Universal 
CMDB Developer Reference Guide

➤ "Create a Pattern View" on page 285

➤ "Create a Template" on page 286

➤ "Create a Perspective" on page 288

UI Elements (A-Z) Description

Add the attribute condition you have defined.

Delete an attribute definition.

Move a selected row up.

Move a selected row down.

Display the criteria in a popup dialog box.

Advanced layout 
settings

Opens the Layout Settings dialog box which enables you 
to determine which attributes are used in the calculation 
of the TQL query when querying the CMDB using third-
party or custom tools. 

And/Or Click inside the And/Or field and select either And or Or 
to link multiple conditions.
82



Chapter 1 • Topology Query Language
Attribute name Select an attribute from the drop-down list.

Brackets Click inside the Brackets box to display a list of brackets 
you can use to build more complex, logical statements.

Criteria Contains the attribute condition definition as defined in 
the Element Instances dialog box.

Default Value For parameterized attributes, enter a default value for the 
parameter.

Not Select NOT if you want the condition statement to do the 
opposite of what is defined.

Note: If you select NOT, query results do not include data 
from the CI instances that were not assigned a value. For 
example, your system contains three nodes: Node1 is 
assigned the value A, Node2 is assigned the value B and 
Node3 is not assigned a value. You create a query to 
retrieve all nodes that are equal to A and select NOT; the 
results of your query only include Node2 because Node3 
is not assigned a value.

Operator Select the required operator. For details, see "Attribute 
Operator Definitions" on page 42.

Parameterized Select Yes to define a parameterized value for the 
attribute. Select No to define a fixed value for the 
attribute.

Note: This feature is only available in the Modeling 
Studio. 

Parameter Name If you are defining a parameterized value for the 
attribute, you must enter the parameter name.

Note: This feature is only available in the Modeling 
Studio.

Value Enter or select the value of the attribute. The Value 
options vary according to the attribute type you select.

UI Elements (A-Z) Description
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Cardinality Tab

In this area, you can define a relationship cardinality, which enables you to 
define how many CI instances you expect to have at the end of a 
relationship in your query result.

User interface elements are described below:

To access Click the Cardinality tab in the Query Node Properties 
dialog box.

Important 
information

Select the required relationship to which the selected 
query node is attached. Then define the lower and upper 
limits for including the query node at the other end of 
the relationship in the query results.

You can define relationship conditions that enable the 
relationship’s connecting query node to be included in 
the TQL query results by creating an expression defining 
that condition. For an example, see "Example of a 
Relationship Condition" on page 86.

Note: This tab only appears when a query node is 
selected.

Relevant tasks ➤ "Define an Impact Rule – Workflow" on page 442

➤ "Define an Enrichment Rule – Scenario" on page 510

➤ "Define a TQL Query" on page 27

➤ "Implement a Discovery Adapter" in the HP Universal 
CMDB Developer Reference Guide

➤ "Create a Pattern View" on page 285

➤ "Create a Template" on page 286

➤ "Create a Perspective" on page 288

UI Elements (A-Z) Description

Add the cardinality definition you have defined.

Delete a cardinality definition from the Cardinality area.

Move a selected row up.
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Move a selected row down.

Display the criteria in a popup dialog box.

Inserts 1 in the Min box and * in the Max box.

Note: Only relevant for the Modeling Studio.

Inserts 0 in the Min box and * in the Max box.

Note: Only relevant for the Modeling Studio.

And/Or Click inside the And/Or field and select either And or Or 
to link multiple conditions.

Brackets Click inside the Brackets box to display a list of brackets 
you can use to build more complex, logical statements.

Criteria Contains the cardinality condition definition as defined 
in the Element Instances Dialog Box.

Max Enter the value that defines the upper limits for including 
the query node at the other end of the relationship in the 
query results. 

Note: You can use an asterisk (*) in the Max box to 
represent an infinite value.

Min Enter the value that defines the lower limits for including 
the query node at the other end of the relationship in the 
query results.

For example, if <end_1> is IP and <end_2> is Windows, 
entering 1 in the Min box and asterisk (*) in the Max box 
instructs the system to retrieve only those IP Addresses 
that are connected to at least one Windows operating 
system. (The asterisk indicates an infinite value.) Entering 
3 in the Min box and asterisk (*) in the Max box instructs 
the system to retrieve only those Windows operating 
systems that are connected to at least three IP Addresses.

UI Elements (A-Z) Description
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Example of a Relationship Condition

The example of relationship conditions is based on the following TQL 
query:

 

In the Relationship Cardinality dialog box, the following relationship 
conditions are defined for the query:

Query Node Select the required relationship to which the selected 
query node is attached. The list contains all the 
relationships that are linked to the selected query node.

Not Select NOT if you want the condition statement to do the 
opposite of what is defined.

Note: If you select NOT, query results do not include data 
from the CI instances that were not assigned a value. For 
example, your system contains three nodes: Node1 is 
assigned the value A, Node2 is assigned the value B and 
Node3 is not assigned a value. You create a query to 
retrieve all nodes that are equal to A and select NOT; the 
results of your query only include Node2 because Node3 
is not assigned a value.

UI Elements (A-Z) Description
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➤ Containment – Min: 2, Max: 4

➤ Membership – Min: 1, Max: *

Using the OR operator, the definitions appear in the Cardinality section, as 
follows:

➤ [contained (Node, IP Address)] OR [member (IP Subnet, Node)] means that 
the node must either have between two and four IP Addresses OR be a 
member of the IP Subnet.

Using the AND operator, the definitions appear in the Cardinality section, as 
follows:

➤ [contained (Node, IP Address)] AND [member (IP Subnet, Node)] means that 
the node must have between two and four IP Addresses AND also be a 
member of the IP Subnet.

Qualifier Tab

This area enables you to define qualifier conditions for the selected query 
node or relationship. For example, you can use a qualifier to define a CIT as 
abstract, meaning you cannot create instances from it.

To access Click the Qualifier tab in the Query Node/Relationship 
Properties dialog box.
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User interface elements are described below:

Important 
information

By default, multiple selection links the conditions with 
the OR operator.

Relevant tasks ➤ "Define an Impact Rule – Workflow" on page 442

➤ "Define an Enrichment Rule – Scenario" on page 510

➤ "Define a TQL Query" on page 27

➤ "Implement a Discovery Adapter" in the HP Universal 
CMDB Developer Reference Guide

➤ "Create a Pattern View" on page 285

➤ "Create a Template" on page 286

➤ "Create a Perspective" on page 288

UI Elements (A-Z) Description

ABSTRACT_CLASS You cannot create instances of this CIT.

ALLOW_VOLATILITY Used to mark attributes that enable minor deviations 
to their value. For example, there is probably no need 
to report a small disk size change (from 8.00008 to 
8.00009 GB).

By default, ALLOW_VOLATILITY is enabled for the 
following numeric or date attributes only:

➤ CIT: Node

➤ MemorySize

➤ SwapMemorySize

These attributes also include comparable and static 
qualifiers.

➤ CIT: Host

➤ HostLastBootTime

➤ CIT: CPU

➤ CpuClockSpeed

➤ CIT: Filesystem

➤ Disk_size

For details of this qualifier’s attributes and the 
procedure for activating and deactivating this feature, 
see "The ALLOW_VOLATILITY Qualifier" on page 25.
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BDM_SCOPE Indicates that the CI type is part of the BDM scope of 
the class model.

BLE_LINK_CLASS Relevant to HP Business Service Management only.

CALCULATED_LINK This qualifier is assigned to calculated relationships

CONTAINER This qualifier is assigned to relationships that signify a 
containment relationship, such as Member, Container 
link, Contains, or Contained.

HIDDEN_CLASS Instances of this CIT do not appear anywhere in the 
application.

ID_CLASS_NAME_OVER
RIDE

Indicates that the class ID is calculated based on 
another class. 

ITU_HIDDEN_CLASS Instances of this CIT do not appear in the topology 
map application.

MAJOR_APP CI types that are assigned this qualifier appear in the 
Application Breakdown overview report. For details, 
see "Application Breakdown Report" on page 373.

MODELING_ENABLED Enables a CIT to act as model in Modeling Studio. For 
details, see "Business CI Models" on page 274.

NETWORK_DEVICES A qualifier common to all the CI types that represent a 
network device. It can be used for TQL queries related 
to network devices and serves as a replacement for CI 
types in a query.

Negate Qualifiers If this check box is selected, then the element is 
included in the query results only if it has no qualifier 
in the list of selected qualifiers.

PM_SUSPECT HP Business Service Management only.

RANDOM_GENERATED_
ID_CLASS

Indicates that the CMDB ID of the CIs is randomly 
generated rather than being based on the key 
attributes of the class.

READ_ONLY_CLASS This CIT cannot be edited.

UI Elements (A-Z) Description
89



Chapter 1 • Topology Query Language
Identity Tab

This area enables you to filter the TQL query results according to the 
element ID of the instances found for the selected TQL query node.

RECURSIVE_DELETE Relevant for relationships. When the CI at one end of 
a relationship is deleted, the system checks the CI at 
the other end of the relationship. If it is not related to 
any other CIs, it is also deleted.

TRACK_LINK_CHANGES Changes that occur in the specified relationship 
appear in Change reports. For details, see "CI Change 
Report" on page 381.

To access Click the Identity tab in the Query Node Properties dialog 
box.

Important 
information

Move the required element from the Optional identities 
pane on the left to the Selected identities pane on the 
right to define what you want included in the TQL query 
results using the left and right arrows.

Note: This tab only appears when a query node is 
selected.

Relevant tasks ➤ "Define an Impact Rule – Workflow" on page 442

➤ "Define an Enrichment Rule – Scenario" on page 510

➤ "Define a TQL Query" on page 27

➤ "Implement a Discovery Adapter" in the HP Universal 
CMDB Developer Reference Guide

➤ "Create a Pattern View" on page 285

➤ "Create a Template" on page 286

➤ "Create a Perspective" on page 288

UI Elements (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Refine Query Node Type Dialog Box

This dialog box enables you to change the CI type of a TQL query node after 
you have created a TQL query.

UI Elements (A-Z) Description

<Toolbar> For descriptions of the toolbar buttons, see "Element 
Instances Dialog Box" on page 73.

Optional identities 
pane 

Displays all the instances found for the selected TQL 
query node. 

Selected identities 
pane

Displays the elements that are used to define what should 
be included in the TQL query results. 

To access In Impact Analysis Manager or Enrichment Manager, right-
click the required query node and select Refine Query Node 
Type.

Note: If you are using Enrichment Manager, select Query 
mode at the top of the editing pane to display the Refine 
Query Node Type option.

Important 
information

You can change the CI type to a type from one of the CI 
type’s children, if one exists. If no such CI type exists, this 
option does not appear.

Relevant tasks ➤ "Define an Impact Rule – Workflow" on page 442

➤ "Define an Enrichment Rule – Scenario" on page 510

➤ "Define a TQL Query" on page 27

➤ "Implement a Discovery Adapter" in the HP Universal 
CMDB Developer Reference Guide

➤ "Create a Pattern View" on page 285

➤ "Create a Template" on page 286

➤ "Create a Perspective" on page 288
91



Chapter 1 • Topology Query Language
User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Select Relationship Type Dialog Box

This dialog box enables you to select the type of TQL relationship to be 
created.

UI Elements (A-Z) Description

<List of CI types from 
which to choose>

Select the required CI type.

To access In the editing pane of Impact Analysis Manager, 
Enrichment Manager, and the Modeling Studio, click the 
Create Relationship  button in the toolbar and draw a 
line between two query nodes. The Select Relationship Type 
dialog box opens automatically. 

Important 
information

Select one of the following relationship types:

➤ Regular Relationship. For details, see "Add/Edit 
Relationship Dialog Box" on page 59.

➤ Join Relationship. For details, see "Add/Edit Join 
Relationship Dialog Box" on page 56.

➤ Compound Relationship. For details, see "Add/Edit 
Compound Relationship Dialog Box" on page 52.

➤ Calculated Relationship. For details, see "Add/Edit 
Calculated Relationship Dialog Box" on page 50.

Relevant tasks ➤ "Define an Impact Rule – Workflow" on page 442

➤ "Define an Enrichment Rule – Scenario" on page 510

➤ "Define a TQL Query" on page 27

➤ "Implement a Discovery Adapter" in the HP Universal 
CMDB Developer Reference Guide

➤ "Create a Pattern View" on page 285

➤ "Create a Template" on page 286

➤ "Create a Perspective" on page 288
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Subgraph Condition Definition Dialog Box

This dialog box enables you to create conditions that restrict the number of 
query nodes that appear in the query.

User interface elements are described below:

To access In Impact Analysis Manager and Enrichment Manager, 
click Condition  in the Add Triplet dialog box.

In the Modeling Studio, click Condition  in the 
Subgraph Definition dialog box.

Important 
information

Contains the following tabs:

➤ Attribute. Enables you to define attribute conditions 
for query nodes and relationships. See a description of 
the elements in the Attribute tab in the table below.

➤ Qualifiers. Enables you to define qualifier conditions 
for the selected query node or relationship. For details, 
see "Qualifier Tab" on page 87.

Relevant tasks ➤ "Define an Impact Rule – Workflow" on page 442

➤ "Define an Enrichment Rule – Scenario" on page 510

➤ "Define a TQL Query" on page 27

➤ "Implement a Discovery Adapter" in the HP Universal 
CMDB Developer Reference Guide

➤ "Create a Pattern View" on page 285

➤ "Create a Template" on page 286

➤ "Create a Perspective" on page 288

UI Elements (A-Z) Description

Add the subgraph condition definition.

Delete the subgraph condition definition.

Move a selected row up.

Move a selected row down.
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View the subgraph condition definition.

And/Or Click inside the And/Or field and select either And or Or 
to link multiple conditions.

Attribute name Choose an attribute from the list.

Brackets Click inside the Brackets box to display a list of brackets 
you can use to build more complex, logical statements.

Criteria Contains the attribute condition definition as defined in 
the Element Instances Dialog Box.

Element Name Contains the CIT selected from the Source and Target 
lists.

Not Select NOT if you want the condition statement to do the 
opposite of what is defined.

Note: If you select NOT, query results do not include data 
from the CI instances that were not assigned a value. For 
example, let us assume that your system contains three 
nodes. Node1 is assigned the value A, Node2 is assigned 
the value B and Node3 is not assigned a value. If you 
create a query in which you want to retrieve all nodes 
that are equal to A and you select NOT, the results of your 
query only include Node2 because Node3 is not assigned 
a value.

Operator Select the required operator. For details, see "Attribute 
Operator Definitions" on page 42.

Value Enter or select the value of the attribute. The Value 
options vary according to the attribute type you select.

UI Elements (A-Z) Description
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Subgraph Definition Dialog Box

This dialog box enables you to create a graph that represents additional TQL 
query data related to a specific CI.

To access To access in Enrichment Manager, Impact Analysis 
Manager, and the Modeling Studio:
In the editing pane, right-click the required query node 
and select Subgraph Definition.

Note: If you are using Enrichment Manager, select Query 
mode at the top of the editing pane to display the 
Subgraph Definition option.

To access in Adapter Management in DFM:
1  Select an adapter in the Discovery Resources pane. 

2  In the Adapter Definition tab, click the  Edit Input 
Query button to the right of the Input Query box to 
open the Input Query Editor.

3  Right-click the required query node and select 
Subgraph Definition.

Important 
information

The following icon is displayed next to the query node 
for which you define a subgraph:

Relevant tasks ➤ "Define an Impact Rule – Workflow" on page 442

➤ "Define an Enrichment Rule – Scenario" on page 510

➤ "Define a TQL Query" on page 27

➤ "Implement a Discovery Adapter" in the HP Universal 
CMDB Developer Reference Guide

➤ "Create a Pattern View" on page 285

➤ "Create a Template" on page 286

➤ "Create a Perspective" on page 288

See also "Subgraph Definition" on page 25

"Create a Subgraph Definition – Scenario" on page 35
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User interface elements are described below:

UI Elements (A-Z) Description

Add a subgraph definition. In Enrichment Manager and 
Impact Analysis Manager, click to open the Add Triplet 
dialog box. In the Modeling Studio, click to add a row to 
the table.

Delete a subgraph definition.

Edit a subgraph definition. In Impact Analysis Manager 
and Enrichment Manager, click to open the Edit Triplet 
dialog box. In the Modeling Studio, click to open the 
Subgraph Condition Definition dialog box.

Depth A number that represents the longest path (that is, the 
maximum connecting query nodes) allowed between two 
CIs in the CMDB that should be included in the DFM 
process.

Default: 5

Element condition 
exists

A green asterisk appears next to either the source, 
relationship, or target in the subgraph definition if an 
attribute condition has been defined for one of them in 
the Subgraph Condition Definition dialog box. For 
details, see "Subgraph Condition Definition Dialog Box" 
on page 93.

Relationship The relationship selected connecting the source to the 
target query node.

Relationship 
Direction

The direction of the relationship selected, indicating 
which query node is dependent on the other.

Source The required source query node selected.

Target The required target query node selected.
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User Preferences Dialog Box

This dialog box enables you to reset system preferences.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Troubleshooting and Limitations

This section describes troubleshooting and limitations for Topology Query 
Language.

For TQL queries to be valid, they must comply with certain restrictions.

To access Select Edit > User Preferences or click Configure User 
Preferences button  in the Status Bar.

Important 
information

All the preferences you select (such as whether to display 
certain wizard pages or warning message preferences) are 
stored in the system. This dialog box enables you to reset 
those preferences.

UI Elements (A-Z) Description

<Left pane> Select the preferences page to edit. The following options 
are available:

➤ Wizard Preferences

➤ Optional Messages Preferences

➤ Discovery Preferences

➤ General

➤ Reports

Filter by Enter a search word to filter the list of options.

Preferences list The list of warning messages and their user-selected 
preferences.

Reset Page Click to reset the selected preference to its default value.

Reset All Click to reset all the preferences to their default values.
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This section includes the following topics:

➤ "Understanding Validation Restrictions" on page 98

➤ "Impact Analysis TQL Query Validation" on page 100

➤ "Enrichment TQL Query Validation" on page 101

Understanding Validation Restrictions
For Impact Analysis, Discovery, and Enrichment TQL query types to be 
valid, they must comply with the following restrictions:

➤ Unique Names. TQL query elements must have unique names.

➤ Self Relationships. A TQL query must not contain self relationships, that 
is, a relationship must not lead from a query node to itself, as the 
following example illustrates:
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➤ Cyclic Graph. The TQL query structure cannot be a closed circle, as shown 
in the following example:

➤ Separate Query Nodes and Groups. All the TQL query nodes must be 
linked to one another, that is, the TQL query cannot contain separate 
query nodes or groups, as the following example illustrates:
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Impact Analysis TQL Query Validation
Impact Analysis TQL queries must also comply with the following 
restrictions:

➤ Number of query nodes. An Impact Analysis TQL query must consist of at 
least two query nodes.

➤ Trigger and affected query nodes must be connected. There must be a 
path of relationships from the triggered query node to the affected query 
nodes.

➤ Selecting query nodes to function as Impact Analysis triggers. When 
selecting query nodes to function as Impact Analysis triggers, the query 
nodes must comply with the following restrictions:

➤ You can select more than one query node as a trigger. However, you 
cannot define a query node both as affected and as a trigger.

➤ If a query node has a relationship whose minimum limit is 0 (meaning 
that one of its ends does not necessarily have a query node linked to 
it), the query node that is linked to its other end cannot be a root cause 
query node (because it may or may not exist in the TQL query). For 
details about minimum limits, see "Cardinality Tab" on page 84. For 
example, Configuration Item cannot be either a root cause or affected 
query node because it is connected to the query node with a Min limit 
of 0. 
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Note: A query node that is not visible cannot be a root cause or an 
affected query node.

➤ The connection between trigger and affected query nodes. The trigger 
query node and affected query nodes you define must be connected by a 
path of relationships from the triggered query node to the affected query 
nodes.

Enrichment TQL Query Validation
Enrichment TQL queries must comply with the following restriction:

➤ Required elements. You cannot perform Enrichment on a non-required 
query node, that is, a query node that does not necessarily appear in the 
TQL query results.

Example 1. In this example, the TQL query results can be either A and B 
or A and C. Therefore, you cannot add an Enrichment query node to 
query nodes B or C because they are not required elements. You can add 
an Enrichment query node to query node A because it always appears in 
the TQL query results. For details on how to add Enrichment query nodes 
and relationships, see "Add Enrichment Query Nodes and Relationships 
to an Enrichment TQL Query" on page 515.
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Example 2. In this example, both A and B are required elements that 
always appear in the TQL query results. Only C is not a required element 
because it has a cardinality of 0. Therefore, you cannot add an 
Enrichment query node to it.
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Using Calculated Relationships

This chapter includes:

Concepts

➤ Calculated Relationships Overview on page 104

➤ Calculated Relationships on page 104

➤ Calculated Relationship Types on page 106
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Concepts

Calculated Relationships Overview

A calculated relationship represents the connection between two CIs, whose 
path meets the conditions defined for the triplets on which it is based in the 
CI Type Manager. For details on how to define triplets, see "Triplets Page" on 
page 493.

You can use calculated relationships to create TQL queries just like any other 
relationship in the CI Type model. This enables you to base Enrichment 
rules, Impact Analysis rules, and views on calculated relationships. 

The direction of the calculated relationship is not always the same direction 
as the physical relationship taken from the CI Type model. There can be one 
or more relationships between two CIs, depending on the way the triplets 
on which the calculated relationship is based, are defined.

Calculated Relationships

Calculated relationships are defined by one or more triplets. Each triplet is 
defined by the following components:

➤ One source CI type

➤ One target CI type

➤ A physical relationship type (for example, Containment) that links the 
two CI types

➤ The required direction. The direction can be identical to or opposite from 
the direction of the physical relationship between the source and target 
CIs. 
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Since calculated relationships are defined by physical relationships from 
within the class model, their lifetime is determined by the lifetime of the 
physical relationships. When the physical relationship in the class model is 
removed, the corresponding calculated relationship is removed from all 
view results as well.

Note: If you create a new CI type or relationship in the CI Type Manager, 
you need to define the required triplets. 

Example of a Triplet Definition:
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Calculated Relationship Types

There is one out-of-the-box calculated relationship called Impacted By. 
Impacted By contains two subtypes, each one representing a different type 
of dependency relationship (complete dependency vs. potential 
dependency.

➤ Impacted by (Directly)

➤ Impacted By (Potentially)
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Create a URL for a Direct Link

This chapter includes:

Concepts

➤ Generate a Direct Link – Overview on page 108

Tasks

➤ Generate a Direct Link – Scenario on page 110

Reference

➤ Generate a Direct Link User Interface on page 111
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Concepts

Generate a Direct Link – Overview

Direct Links enables you to create a URL that guides another user to a 
specific target view or CI in HP Universal CMDB.

You can create a URL that:

➤ Opens a specific HP Universal CMDB view or CI directly in 
HP Universal CMDB. This enables users to retrieve information from 
HP Universal CMDB without being located in the HP Universal CMDB 
context. 

Note: To open a specific view or CI directly in HP Universal CMDB, use 
the Open in context links option. For details, see "Select Command 
Page" on page 112.

➤ Enables integration with HP Universal CMDB:

➤ If you create a URL using the Embedded links option, the URL takes 
you first to the HP Universal CMDB login page. After you enter your 
login name and password, the target page opens in your browser.

Note: To open the target page in your browser, use the Embedded 
links option. For details, see "Select Command Page" on page 112.

When you create a URL, you can:

➤ Send the URL to an email recipient

➤ Copy the URL to the clipboard

➤ Test the URL to ensure that the target application page can be found
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The user to whom you are sending the URL must have an account with 
sufficient privileges to open the target page. You must apply the appropriate 
viewing and editing permissions to the users and user groups that want to 
access the target view. You set permissions in Managers > Administration > 
Security Manager. For details, see "Security Manager Page" in the HP 
Universal CMDB Administration Guide.
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Tasks

Generate a Direct Link – Scenario

This scenario describes how to generate a direct link to email the URL of a 
specific CI to another person.

Jane Harrison is a senior engineer in the ABC Software company. She has 
encountered a problematic CI in a view she has created. She wants to inform 
Henry Jones, who is working with the same view through HP ServiceCenter, 
about the problematic CI. Since the view Jane has created contains many 
hundreds of CIs, she decides to email Henry the URL of the CI so that he 
does not have to spend a lot of time searching for that specific CI.

In IT Universe Manager, Jane selects Generate Direct Link from the Edit 
menu. In the Select Command page, she selects Open in context links and 
then the Show View option, and clicks Next. 

In the Direct Link Parameters — Show View page, she selects the view she 
created, the problematic CI, and View Topology as the mode in which 
Henry should open the CI. When the URL is created, she emails Henry the 
link to the problematic CI.

For details, see "Generate Direct Link Wizard" on page 112.
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Reference

Generate a Direct Link User Interface

This section includes (in alphabetical order):

 ➤ Generate Direct Link Dialog Box on page 111

 ➤ Generate Direct Link Wizard on page 112

Generate Direct Link Dialog Box

This dialog box enables you to create a URL to send to users so that they can 
access HP Universal CMDB.

User interface elements are described below:

To access From the  Modeling main menu, select Edit > Generate 
Direct Link. After you configure the Direct Link 
parameters in the "Generate Direct Link Wizard" on 
page 112, click Finish in the Finish page.

Relevant tasks "Generate a Direct Link – Scenario" on page 110

UI Elements (A-Z) Description

Copy URL Copies the URL to the clipboard.

Description Describes the parameters that are included in the URL. 
For details on selecting the parameters, see "Select 
Command Page" on page 112.

Link URL The created URL that accesses the specified HP Universal 
CMDB function.

Mail URL Opens an email containing the URL of the link.

Test URL Checks the URL to ensure that the specified application 
page can be found.
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Generate Direct Link Wizard

This wizard enables you to create a URL that guides another user to a specific 
target view or CI in HP Universal CMDB.

Select Command Page
This wizard page enables you to select the required parameters that must be 
added to the URL. 

You can create two types of links:

➤ Open in context links. Creates a URL that opens a specific view or CI 
directly in HP Universal CMDB without having to be in the HP Universal 
CMDB context:

➤ Embedded links. Creates a URL that enables you to embed an 
HP Universal CMDB applet into external applications.

To access From the  Modeling main menu, select Edit > Generate 
Direct Link.

Important 
information

By default, this wizard is set to display a Welcome page. 
You can choose not to display the Welcome page by 
selecting the Do not show this page again check box.

Relevant tasks "Generate a Direct Link – Scenario" on page 110

Wizard map The Generate Direct Link wizard contains:

Select Command Page (<Open in context links options> 
and <Embedded links options>) > Finish Page

Important 
information

By default, this wizard is set to display a Welcome page. 
You can choose not to display the Welcome page by 
selecting the Do not show this page again check box.

Wizard map The Generate Direct Link wizard contains:

Select Command Page (<Open in context links options> 
and <Embedded links options>) > Finish Page

See also "Generate Direct Link Wizard" on page 112
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

<Left pane> A graphic illustration of the selected command.

CII Grid Creates a URL that displays all the CI instances found in 
the CMDB for a selected CI type and its children. For 
details, see "Direct Link Parameters – CII Grid Page" on 
page 119.

Note: Available when you select the Embedded links 
option.

CI Selector Creates a URL that embeds the CI Selector displaying the 
CIs of a selected view, into external applications. For 
details, see "Direct Link Parameters – CI Selector Page" on 
page 116.

Note: Available when you select the Embedded links 
option.

CI Type Selector Creates a URL that embeds the CI type selector into 
external applications. For details, see "Direct Link 
Parameters – CI Type Selector Page" on page 117.

Note: Available when you select the Embedded links 
option.

Description A description of the selected command.

Impact Map Creates a URL that embeds an impact map into an 
external application. For details, see "Direct Link 
Parameters – Impact Map Page" on page 120.

Note: Available when you select the Embedded links 
option.

Model Editor Creates a URL that embeds the Model Editor into an 
external application, highlighting the selected CIs in the 
CI Selector in the Model Editor. For details, see "Direct 
Link Parameters – Model Editor" on page 121.

Note: Available when you select the Embedded links 
option.
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Query Editor Creates a URL that embeds the Model Editor into an 
external application, displaying the selected TQL query. 
For details, see "Direct Link Parameters – Query Editor" on 
page 122.

Note: Available when you select the Embedded links 
option.

Related CIs Creates a URL that opens a topology map displaying the 
selected CI and its immediate neighbors within the 
selected view. For details, see "Direct Link Parameters – 
Related CIs Page" on page 123.

Note: Available when you select the Embedded links 
option.

Report Viewer Creates a URL that opens a specific report. For details, see 
"Direct Link Parameters – Report Viewer Page" on 
page 124.

Note: Available when you select the Embedded links 
option.

Report Viewer - 
Saved Report

Creates a URL that opens a saved topology or custom 
report. For details, see "Direct Link Parameters – Report 
Viewer – Saved Report Page" on page 124.

Note: Available when you select the Embedded links 
option.

Show change report Creates a URL that embeds a report displaying changes 
made to a specific CI into an external application. For 
details, see "Direct Link Parameters – Show Change 
Report Page" on page 126.

Note: Available when you select the Embedded links 
option.

Show change report 
on view

Creates a URL that embeds a report displaying changes 
made to a specific view into an external application. For 
details, see "Direct Link Parameters – Show Change 
Report on View Page" on page 127.

Note: Available when you select the Embedded links 
option.

UI Elements (A-Z) Description
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Show CI properties Creates a URL that displays a CI’s properties. For details, 
see "Direct Link Parameters – Show CI Properties Page" on 
page 125.

Note: Available when you select the Embedded links 
option.

Show Topology 
Report

Creates a URL that embeds a Topology Report into an 
external application. For details, see "Direct Link 
Parameters – Show Topology Report Page" on page 126.

Note: Available when you select the Embedded links 
option.

Show view Creates a URL that displays the selected view and 
optionally preselects a query node in it. For details, see 
"Direct Link Parameters – Show View Page" on page 130.

Note: Available when you select the Open in context links 
option.

Show view topology Creates a URL that displays the topology map of the 
selected view and embeds it in an external application. 
For details, see "Direct Link Parameters – Show View 
Topology Page" on page 128.

Note: Available when you select the Embedded links 
option.

Start in mode Creates a URL that opens HP Universal CMDB at the 
selected page. For details, see "Direct Link Parameters – 
Start in Mode Page" on page 131.

Note: Available when you select the Open in context links 
option.

Steps The current step in the procedure.

UI Elements (A-Z) Description
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Direct Link Parameters – CI Selector Page
This wizard page enables you to create a URL that embeds the CI Selector 
displaying the CIs of a selected view, into external applications.

View Editor Creates a URL that opens a specific view in the Pattern 
View Editor in Modeling Studio. For details, see "Direct 
Link Parameters – View Editor Page" on page 129.

Note: Available when you select the Embedded links 
option.

Views Selector Creates a URL that embeds the View Selector in an 
external application, enabling you to select and display a 
view in that application. For details, see "Direct Link 
Parameters – Views Selector Page" on page 129.

Note: Available when you select the Embedded links 
option.

Wizard map Select Command Page (Embedded links > CI Selector) > 
Finish Page

Important 
information

➤ For general information about the Generate Direct 
Link wizard, see "Generate Direct Link Wizard" on 
page 112.

➤ Click Finish to close the wizard and create a URL. For 
details, see "Generate Direct Link Dialog Box" on 
page 111.

UI Elements (A-Z) Description
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User interface elements are described below:

Direct Link Parameters – CI Type Selector Page
This wizard page enables you to create a URL to a hierarchical tree or list of 
selected CI types, which can be embedded into an external application.

User interface elements are described below:

UI Elements (A-Z) Description

Allow multi selection Allow single or multiple selection of CIs.

Selected view Select the required view from which you want to select 
the required CIs.

➤ Click  to open the View Selector dialog box. Select 
the view you want to appear in the CI Selector.

➤ Click  to delete the selected view. 

Important 
information

➤ For general information about the Generate Direct 
Link wizard, see "Generate Direct Link Wizard" on 
page 112.

➤ Click Finish to close the wizard and create a URL. For 
details, see "Generate Direct Link Dialog Box" on 
page 111.

Wizard map Select Command Page (Embedded links > CI Type 
selector) > Finish Page

UI Elements (A-Z) Description

CI type selector 
mode

View the selected CI types in either a hierarchical tree or 
list.

Invisible CITs (tree 
only)

Select the CI types you do not want to appear in the tree.

➤ Click  to open the CI Type Selector dialog box. 
Select the CI types you want to appear in the tree.

➤ Click  to delete the selected CI types. 
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Root CI Type (tree 
only)

Select the CI type you want to use as the root CI type in a 
hierarchical tree.

➤ Click  to open the CI Type Selector dialog box. 
Select the CI type you want to use as the root CI type 
in the tree. 

➤ Click  to delete the selected CI type. The default is 
IT Universe.

Selection mode Allow single or multiple selection of CI types.

Unselectable CITs 
(tree only)

Select the CI types which cannot be selected in the tree.

➤ Click  to open the CI Type Selector dialog box. 
Select the CI types which cannot be selected in the 
tree.

➤ Click  to delete the selected CI types. 

Visible CITs (list only) Select the CI types which you want to appear in the CI 
type list.

➤ Click  to open the CI Type Selector dialog box. 
Select the CI types which you want to appear in the CI 
type list.

➤ Click  to delete the selected CI types. 

Note: If you choose to view the CITs in a list, then you 
are required to select at least one CI type.

UI Elements (A-Z) Description
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Direct Link Parameters – CII Grid Page
This wizard page enables you to display all of the CI instances found in the 
CMDB for selected CI type, and its children.

User interface elements are described below:

Important 
information

➤ For general information about the Generate Direct 
Link wizard, see "Generate Direct Link Wizard" on 
page 112.

➤ Click Finish to close the wizard and create a URL. For 
details, see "Generate Direct Link Dialog Box" on 
page 111.

Wizard map Select Command Page (Embedded links > CII Grid) > 
Finish Page

See also "Element Instances Dialog Box" on page 73

UI Elements (A-Z) Description

Class type Select the required CI type. 

➤ Click  to select the required CI type. Opens the CI 
Type Selector dialog box.

➤ Click  to delete the CI type. 
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Direct Link Parameters – Impact Map Page
This wizard page enables you to run an Impact Analysis rule defined in 
Impact Analysis Manager. The URL you create enables you to embed a 
topology map showing a simulation of all the CIs that are affected by the 
selected trigger CI for the selected severity and state. For details, see "Run 
Impact Analysis Dialog Box" on page 260.

User interface elements are described below:

Important 
information

➤ For general information about the Generate Direct 
Link wizard, see "Generate Direct Link Wizard" on 
page 112.

➤ Click Finish to close the wizard and create a URL. For 
details, see "Generate Direct Link Dialog Box" on 
page 111.

Wizard map Select Command Page (Embedded links > Impact map) 
> Finish Page

See also "IT Universe Manager" on page 201

UI Elements (A-Z) Description

Filter by CI types Select the CI types you do not want to appear in the 
impact analysis results.

➤ Click  to select the required CI types.

➤ Click  to delete the selected CI types. 

Rule bundle Enables you to define where you can run Impact Analysis 
rules.
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Direct Link Parameters – Model Editor
This wizard page enables you to embed the Model Editor into an external 
application, highlighting the selected CIs in the CI Selector in the Model 
Editor.

Severity ➤ Click  to select the required severity. 

Note: The severity list was defined for the state in the 
System Type Manager. For details, see "System Type 
Manager" on page 468.

For example, you can create an Impact rule in the 
Impact Analysis Manager (see the "Impact Rules 
Definition Dialog Box" on page 457), that defines the 
severity of the trigger query node as other than No 
Change. If you select a severity other than No Change, 
for example, Plan, the condition is met and the 
simulated changes in the system are triggered.

For details, see "Run Impact Analysis Dialog Box" on 
page 260.

➤ Click  to delete the selected severity. 

Trigger CIs ➤ Click  to select the CIs that are used as the triggers 
in an impact map. These CIs represent the simulated 
changes to be made to the system. Opens the CI 
Selector dialog box. For details on how to use the CI 
Selector pane, see "CI Selector" on page 151.

➤ Click  to delete the selected CIs. 

Important 
information

➤ For general information about the Generate Direct 
Link wizard, see "Generate Direct Link Wizard" on 
page 112.

➤ Click Finish to close the wizard and create a URL. For 
details, see "Generate Direct Link Dialog Box" on 
page 111.

Wizard map Select Command Page (Embedded links > Model Editor) 
> Finish Page

See also "Business CI Models" on page 274

UI Elements (A-Z) Description
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User interface elements are described below:

Direct Link Parameters – Query Editor
This wizard page enables you to embed the Model Editor into an external 
application, displaying the selected TQL query.

User interface elements are described below:

UI Elements (A-Z) Description

Model name Select the model you want to display in the Model Editor.

➤ Click  to open the Select Model dialog box. Select 
the model you want to appear in the Model Editor.

➤ Click  to delete the selected model. 

Selected CI in search Select the CIs you want to appear highlighted in the CI 
Selector in the Model Editor.

➤ Click  to open the CI Selector.

➤ Click  to delete the selected CIs. 

Important 
information

➤ For general information about the Generate Direct 
Link wizard, see "Generate Direct Link Wizard" on 
page 112.

➤ Click Finish to close the wizard and create a URL. For 
details, see "Generate Direct Link Dialog Box" on 
page 111.

Wizard map Select Command Page (Embedded links > Query Editor) 
> Finish Page

See also "Business CI Models" on page 274

UI Elements (A-Z) Description

Query name Select the model you want to display in the Model Editor.

➤ Click  to open the Select Query dialog box. Select 
the query you want to appear in the Model Editor.

➤ Click  to delete the selected query. 
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Direct Link Parameters – Related CIs Page
This wizard page enables you to embed into an external application, a 
topology map that displays a specific CI, and all the CIs that are linked to it 
by a distance of no more than one relationship.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Important 
information

➤ For general information about the Generate Direct 
Link wizard, see "Generate Direct Link Wizard" on 
page 112.

➤ Click Finish to close the wizard and create a URL. For 
details, see "Generate Direct Link Dialog Box" on 
page 111.

Wizard map Select Command Page (Embedded links > Related CIs) > 
Finish Page

UI Elements (A-Z) Description

CIs Select the CI type you want to appear in the topology 
map. 

➤ Click  to select the required CI types. Opens the CI 
Selector dialog box.

➤ Click  to delete the value in the CI box. 

Filter by CI types Restrict the results of the topology map to related CIs of 
one or more CI types.

➤ Click  to select the required CI types.

➤ Click  to delete the value in the Filter by CI types 
box. 

Restrict to view Restrict the results of the topology map to related CIs 
from a specific view.

➤ Click  to select the required view. Opens the View 
Selector dialog box.

➤ Click  to delete the selected view in the Restrict 
results to view box.
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Direct Link Parameters – Report Viewer Page
This wizard page enables you to create a URL that opens a specific report. 

User interface elements are described below:

Direct Link Parameters – Report Viewer – Saved Report 
Page
This wizard page enables you to create a URL that opens a saved topology or 
custom report. 

Important 
information

➤ For general information about the Generate Direct 
Link wizard, see "Generate Direct Link Wizard" on 
page 112.

➤ Click Finish to close the wizard and create a URL. For 
details, see "Generate Direct Link Dialog Box" on 
page 111.

Wizard map Select Command Page (Embedded links > Report 
Viewer) > Finish Page

UI Elements (A-Z) Description

Report type Select the required report type. For information about the 
different report types, see "Reports" on page 363.

Important 
information

➤ For general information about the Generate Direct 
Link wizard, see "Generate Direct Link Wizard" on 
page 112.

➤ Click Finish to close the wizard and create a URL. For 
details, see "Generate Direct Link Dialog Box" on 
page 111.

Wizard map Select Command Page (Embedded links > Report Viewer 
- Saved Report) > Finish Page
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User interface elements are described below:

Direct Link Parameters – Show CI Properties Page
This wizard page enables you to view basic information for an existing CI.

User interface elements are described below:

UI Elements (A-Z) Description

Report Select the required saved report. 

➤ Click  to open the Select Report dialog box. Select 
the required topology or custom report.

➤ Click  to delete the selected report. 

For information about saved reports, see "Reports" on 
page 363.

Important 
information

➤ For general information about the Generate Direct 
Link wizard, see "Generate Direct Link Wizard" on 
page 112.

➤ Click Finish to close the wizard and create a URL. For 
details, see "Generate Direct Link Dialog Box" on 
page 111.

Wizard map Select Command Page (Embedded links > Show CI 
properties) > Finish Page

See also "Configuration Item Properties Dialog Box" on page 233

UI Elements (A-Z) Description

Source CI object ID Select the required CI.

➤ Click  to select the source CI and retrieve its object 
ID. Opens the Select Source CI dialog box. For details, 
see "CI Selector" on page 151.

➤ Click  to delete the value in the Source CI object ID 
box. 
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Direct Link Parameters – Show Topology Report Page
This wizard page enables you to create a URL to a specific Topology report.

User interface elements are described below:

Direct Link Parameters – Show Change Report Page
This wizard page enables you to create a URL to a specific Change report 
that displays the changes made to a specific CI and its children.

Important 
information

➤ For general information about the Generate Direct 
Link wizard, see "Generate Direct Link Wizard" on 
page 112.

➤ Click Finish to close the wizard and create a URL. For 
details, see "Generate Direct Link Dialog Box" on 
page 111.

Wizard map Select Command Page (Embedded links > Show 
Topology Report) > Finish Page

See also "Topology Reports Overview" on page 364

UI Elements (A-Z) Description

Report name Select the required Topology report.

➤ Click  to select the required Topology report. 
Opens the Reports Tree dialog box.

➤ Click  to delete the value that appears in the 
Report name box. 

Important 
information

➤ For general information about the Generate Direct 
Link wizard, see "Generate Direct Link Wizard" on 
page 112.

➤ Click Finish to close the wizard and create a URL. For 
details, see "Generate Direct Link Dialog Box" on 
page 111.

Wizard map Select Command Page (Embedded links > Show change 
report) > Finish Page
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User interface elements are described below:

Direct Link Parameters – Show Change Report on View 
Page
This wizard page enables you to create a URL to a specific Change report 
that displays the changes made to a specific view.

UI Elements (A-Z) Description

Date from: Configure a start date and time for the report.

Date until: Configure an end date and time for the report.

Source CI object ID Enables you to create a URL to a specific Change report 
that displays the changes made to a specific CI and its 
children.

➤ Click  to select the source CI and retrieve its object 
ID. Opens the Select Source CI dialog box. For details, 
see "CI Selector" on page 151.

➤ Click  to delete the value in the Source CI object ID 
box. 

Time range: Select a time range for which you want to view the 
report.

Important 
information

➤ For general information about the Generate Direct 
Link wizard, see "Generate Direct Link Wizard" on 
page 112.

➤ Click Finish to close the wizard and create a URL. For 
details, see "Generate Direct Link Dialog Box" on 
page 111.

Wizard map Select Command Page (Embedded links > Show change 
report on view) > Finish Page

See also "Changed Views Report" on page 379
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User interface elements are described below:

Direct Link Parameters – Show View Topology Page
This wizard page enables you to display the topology map of the selected 
view and embed it in an external application.

User interface elements are described below:

UI Elements (A-Z) Description

Date from: Configure a start date and time for the report.

Date until: Configure an end date and time for the report.

Selected view ➤ Click  to select the required view. Opens the Select 
View dialog box.

➤ Click  to delete the value in the Selected View box. 

Time range: Select a time range for which you want to view the 
report.

Important 
information

➤ For general information about the Generate Direct 
Link wizard, see "Generate Direct Link Wizard" on 
page 112.

➤ Click Finish to close the wizard and create a URL. For 
details, see "Generate Direct Link Dialog Box" on 
page 111.

Wizard map Select Command Page (Embedded links > Show view 
topology) > Finish Page

UI Elements (A-Z) Description

Show topology of 
view

➤ Click  to select the required view to be opened by 
the URL. Opens the Select View dialog box.

➤ Click  to delete the selected view in the Selected 
view box.
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Direct Link Parameters – View Editor Page
This wizard page enables you to create a URL that opens a specific view in 
the Pattern View Editor in Modeling Studio.

User interface elements are described below:

Direct Link Parameters – Views Selector Page
This wizard page enables you to embed into an external application, the View 
Selector, that enables you to select, and display a view in that application.

Important 
information

➤ For general information about the Generate Direct 
Link wizard, see "Generate Direct Link Wizard" on 
page 112.

➤ Click Finish to close the wizard and create a URL. For 
details, see "Generate Direct Link Dialog Box" on 
page 111.

Wizard map Select Command Page (Embedded links > View Editor) > 
Finish Page

See also "Building a Business View" on page 269

UI Elements (A-Z) Description

View name ➤ Click  to select the required view to be opened by 
the URL. Opens the View Selector dialog box.

➤ Click  to delete the selected view in the Selected 
view box.

Important 
information

➤ For general information about the Generate Direct 
Link wizard, see "Generate Direct Link Wizard" on 
page 112.

➤ Click Finish to close the wizard and create a URL. For 
details, see "Generate Direct Link Dialog Box" on 
page 111.

Wizard map Select Command Page (Embedded links > Views 
Selector) > Finish Page

See also "Building a Business View" on page 269
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Direct Link Parameters – Show View Page
This wizard page enables you to create a URL to a specific view and 
optionally select a specific query node in that view. When the view opens, 
the CI you chose is selected in the view. The view opens in IT Universe 
Manager.

User interface elements are described below:

Important 
information

➤ For general information about the Generate Direct 
Link wizard, see "Generate Direct Link Wizard" on 
page 112.

➤ Click Finish to close the wizard and create a URL. For 
details, see "Generate Direct Link Dialog Box" on 
page 111.

Wizard map Select Command Page (Open in context links > Show 
view) > Finish Page

UI Elements (A-Z) Description

<Left pane> A graphic illustration of the selected option.

Advanced pane 
(visibility)

Hide or display the Advanced pane in IT Universe 
Manager.

Select CI from view 
result

(Optional) Click to select a CI and retrieve its object ID. 
When the view opens, the CI you chose is selected in the 
view.

➤ Click  to choose the CI you want selected in the 
target view and retrieve its object ID. Opens the Select 
Source CI dialog box. For details, see "CI Selector" on 
page 151.

➤ Click  to delete the object ID for the selected CI in 
the Select CI from view result box.
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Direct Link Parameters – Start in Mode Page
This wizard page enables you to start the UCMDB application at the selected 
page, for example, in the Modeling Studio page.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Selected View The target view to be opened by the URL.

➤ Click  to select the target view to be opened by the 
URL. Opens the Select View dialog box.

➤ Click  to delete the selected view in the Selected 
view box.

View mode The view options are:

➤ View Topology. Displays an entire layer within a view.

➤ Related in View. Displays the selected CI and its 
immediate neighbors within the current view.

➤ Related in DB. Displays the selected CI and its 
immediate neighbors in the CMDB.

Important 
information

➤ For general information about the Generate Direct 
Link wizard, see "Generate Direct Link Wizard" on 
page 112.

➤ Click Finish to close the wizard and create a URL. For 
details, see "Generate Direct Link Dialog Box" on 
page 111.

Wizard map Select Command Page (Open in context links > Start in 
mode page) > Finish Page

UI Elements (A-Z) Description

<Left pane> A graphic illustration of the selected mode.

Initial mode Starts the UCMDB application in the selected mode.

UI Elements (A-Z) Description
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Finish Page
This is the final page of the Generate Direct Link wizard. Click Finish to close 
the wizard and create a URL. Opens the Generate Direct Link dialog box.

Important 
information

For general information about the Generate Direct Link 
wizard, see "Generate Direct Link Wizard" on page 112.

Wizard map Select Command Page (<Open in context links options> 
and <Embedded links options>) > Finish Page
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4
Embedding UCMDB Applets Using Direct 
Links

This document describes how to embed UCMDB applets into external 
applications using direct links.

This chapter includes:

Concepts

➤ Using the Direct Link Functionality to Embed UCMDB Applets 
on page 134

➤ UCMDB Applet Tag – Overview on page 135

Reference

➤ Direct Link Operation Flow on page 137

Note: This chapter is relevant to integration developers only.
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Concepts

Using the Direct Link Functionality to Embed UCMDB 
Applets

You can directly embed UCMDB applets into external applications using a 
direct link. A direct link is a URL that you create using the Direct Links 
wizard. For details, see "Generate Direct Link Wizard" on page 112.

You can embed UCMDB applets in the following ways:

➤ Using the URL itself to display CMDB content in an external application. 
For example, you can create a URL in the Direct Links wizard to display 
the properties of a certain CI. The login page opens if you are not already 
logged into HP Universal CMDB.

Note: Using the URL to enable the integration requires opening the link 
in an IFrame or a new window. This does not allow you to manage the 
resulting UCMDB applet using Javascript due to cross-site scripting issues. 
For example, if you use a URL that displays the properties of a specific CI 
using the object ID, you cannot use the same URL to display the 
properties of another CI.

➤ Using the UCMDB applet tag to embed the UCMDB applet in an external 
application. This enables integration developers to display a part of the 
HP Universal CMDB user interface as part of their own application. In 
addition, this enables interaction with the embedded HP Universal 
CMDB user interface using Javascript.
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UCMDB Applet Tag – Overview

The UCMDB Applet tag creates the environment needed for the UCMDB 
applet to run (HTML, Javascript, and server session parameters). The code 
behind the tag can log into the HP Universal CMDB server in one of the 
following cases:

➤ The login parameters are specified and the user is not already logged in.

➤ The clear session parameter is true. 

Once a user session is established, the tag continues to write the required 
applet environment (HTML and Javascript code) to the result of the JSP 
processor. The resulting HTML page includes the required Javascript code to 
load the UCMDB applet from the specified server. On error, the specified 
error string is printed to the page. This string can be customized using the 
userErrorMessage parameter and may include HTML elements and HTML 
wrapped Javascript code to initiate error handling scenarios.

Example of a UCMDB Applet Tag

Caution: You retrieve the directLinkParameters from the URL created in the 
Direct Links wizard. Delete the part of the parameter that precedes "cmd=", 
as it is not part of the parameter needed for the UCMDB applet tag. For 
details on how to create a direct link, see "Generate Direct Link Wizard" on 
page 112.

<ucmdb:ucmdb_applet
serverConnectionString="x.com"
serverType="BAC"
directLinkParameters="cmd=ShowProperties&objectId=2d3b0fec35431ea01625
a4&navigation=false&interfaceVersion=8.0.0"
userName="admin"
userPassword="admin"
clearSessionCookies="false"/>
135



Chapter 4 • Embedding UCMDB Applets Using Direct Links
The UCMDB applet tag is located at <HP Universal CMDB root 
folder>AppServer\webapps\site.war\WEB-INF\tags\CMS\
ucmdb_applet.tag. 

You can copy the UCMDB applet tag to an external application server. The 
UCMDB applet tag requests the login data from the HP Universal CMDB 
server provided that:

➤ The external application server can communicate with JSP tags.

➤ The HP Universal CMDB server is accessible to the external application 
server and to the browser.
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Reference

Direct Link Operation Flow

This section describes different scenarios in which direct links are used to 
embed UCMDB applets into external machines.

This section includes the flow descriptions:

➤ "Regular Login" on page 138

➤ "An Embedded UCMDB Applet Using a Direct Link URL" on page 139

➤ "An Embedded UCMDB Applet Using a UCMDB Applet Tag" on page 141
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Regular Login
This flow describes a regular login to the HP Universal CMDB server. It 
serves as a base reference for the direct link flows.  

 1 The user enters the direct link URL (into the browser) to log into the 
HP Universal CMDB server.

 2 The browser sends the login request to the HP Universal CMDB server.

 3 The server checks the user credentials and creates a user session if 
required.

 4 The server returns the requested first page of HP Universal CMDB. 
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 5 The browser loads the Java virtual machine (JVM) with the code base 
location parameter (which instructs the JVM from where to load the 
UCMDB applet files) as the HP Universal CMDB server.

 6 UCMDB applet files (jars) and data are transferred between the 
HP Universal CMDB server and the JVM loaded in the browser.

At this point, the UCMDB applet is loaded and regards HP Universal CMDB 
as the server with which it should communicate.

An Embedded UCMDB Applet Using a Direct Link URL
This flow shows how to use the direct link to open a UCMDB applet (opened 
to a specified context) in a new browser frame. 
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 1 The external application has a page that needs to show the UCMDB 
applet.

 2 The returned page includes a directive to open the direct link in an 
IFrame or new browser window.

 3 The browser opens a new frame (IFrame or new window) with the direct 
link as the frame URL.

 4 The new frame sends the direct link to the HP Universal CMDB server.

 5 If the user is not already logged into HP Universal CMDB, HP Universal 
CMDB displays the login page and waits for the user to enter credentials 
and click the login button.

 6 The user session is created, if required.

 7 The HP Universal CMDB server returns a page that includes the directive 
to load the UCMDB applet.

 8 The browser processes the page. When the browser encounters the 
directive to load the UCMDB applet, it starts the JVM. The browser then 
passes the needed parameters to the JVM, including the HP Universal 
CMDB server location as "code base."

 9 UCMDB applet files (jars) and data are transferred between the 
HP Universal CMDB server and the JVM loaded in the browser.

Caution: The HP Universal CMDB server must be accessible from the 
browser machine. 
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An Embedded UCMDB Applet Using a UCMDB Applet Tag
This flow shows how to use the UCMDB applet tag in conjunction with 
direct links to embed the UCMDB applet (opened to a specified context) in 
an external application page. 

 1 The UCMDB applet tag is included in the processed JSP in the external 
application.

 2 The UCMDB applet tag uses the parameters given to it to create an HTTP/
HTTPS connection to the HP Universal CMDB server and requests the 
applet HTML snippet code.
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 3 If the user is not already logged in, the parameters from the UCMDB 
applet tag are used (see the tag itself for reference information regarding 
this step). If login fails, the UCMDB applet tag returns an error message, 
either the preset one or the one specified in the UCMDB applet tag 
parameters.

 4 The HP Universal CMDB server returns the HTML snippet code (with 
embedded Javascript) that loads the UCMDB applet. The external 
application can now incorporate this snippet code into the page, and 
send the page to the browser. 

 5 The external application sends the complete page that includes the HTML 
snippet code to the browser.

 6 The browser processes the page. When the browser encounters the HTML 
snippet code that loads the UCMDB applet, the JVM is started. The 
browser then passes the needed parameters to the JVM, including the 
HP Universal CMDB server location as "code base".

 7 UCMDB applet files (jars) and data are transferred between the 
HP Universal CMDB server and the JVM loaded in the browser.

Caution: The HP Universal CMDB server must be accessible from the 
browser machine as well as the external application machine.
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Working with the CI Selector

This chapter includes:

Concepts

➤ CI Selector Overview on page 144

Tasks

➤ Display a View in Browse Mode on page 145

➤ Search for CIs in Search Mode on page 145

➤ Modify CI Selector Display Options on page 147

Reference

➤ CI Selector User Interface on page 149

Troubleshooting and Limitations on page 162
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Concepts

CI Selector Overview

Note: The CI Selector was known as View Explorer in earlier versions of 
HP Universal CMDB.

The CI Selector presents the elements of the IT universe model in 
HP Universal CMDB through the medium of views. HP Universal CMDB 
displays the CI Selector in the left pane of IT Universe Manager and the 
Modeling Studio.

When you select a view in the CI Selector, the configuration items (CIs) 
contained in the view are displayed in a hierarchical tree format according 
to the relationships defined between the CIs. A view may be empty if no CIs 
were found matching the TQL query. For details on views, see "View 
Formats" on page 268.

You can use the CI Selector to select views and to locate CIs. You can select a 
view and browse through the list of CIs, or you can search for a specific CI 
by name or by CI type. You can also save the search criteria for future use.

For information on the components of the CI Selector, see "CI Selector User 
Interface" on page 149.
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Tasks

Display a View in Browse Mode

When the CI Selector is set to Browse mode, you can display the contents of 
a selected view. For details on the CI Selector user interface in Browse mode, 
see "Browse Views Mode" on page 151.

This task includes the following steps:

➤ "Prerequisites" on page 145

➤ "Select a View to Display" on page 145

 1 Prerequisites

In the CI Selector pane, select Browse Views mode. 

 2 Select a View to Display

Click the ellipsis button to open the View Selector dialog box and select 
the view you want to display. The name of the selected view is shown in 
the View box. The CIs in the view appear in the CI tree in the lower part 
of the CI Selector pane. The view remains selected when you move to 
other applications in HP Universal CMDB.

Search for CIs in Search Mode

The CI Selector search tool enables you to locate a specific CI. The search is 
executed on the entire CMDB.  For details on the CI Selector search tool user 
interface, see "Search CIs Mode" on page 155.

This task includes the following steps:

➤ "Prerequisites" on page 146

➤ "Search by CI Name" on page 146

➤ "Search by Configuration Item Type" on page 146
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➤ "Run the Search and Sort the Results" on page 146

➤ "Run an Advanced Search" on page 147

Prerequisites

In the CI Selector pane, select Search CIs mode and select the Simple tab.

Search by CI Name

To search for CIs by name, enter a string in the CI Name box, representing 
the name of the CI, or part of the name. The search returns all CIs that 
contain the entered string somewhere in the name (within the boundaries 
of the other search criteria that you define).

Note: The search by CI name option is not case sensitive.

Search by Configuration Item Type

You can search for CIs using the CI type box. This search returns CIs of the 
type specified in the CI type box.

Click the ellipsis button and select the required CI type. You cannot 
manually enter a CIT in the CI type box. 

After defining a CI in the CI type box, HP Universal CMDB remembers your 
selection until you move to a different application, or until you define a 
different value.

Run the Search and Sort the Results

Run the search. The results appear in the lower part of the CI Selector pane, 
showing the CI name and type for each entry. You can sort the search results 
by clicking the appropriate heading.

When you select a CI in the search results, the CI appears in the topology 
map with its related CIs in the CMDB.

Optionally, save the search criteria by clicking the Save button and entering 
a name for the search. For details, see "Save Search Criteria Dialog Box" on 
page 161.
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Run an Advanced Search

You can select the Advanced tab for other search options. For details on the 
CI Conditional search, see "CI Conditional Search Dialog Box" on page 149. 
For details on the Running Software search, see "Running Software Search 
Dialog Box" on page 160.

Modify CI Selector Display Options

You can modify the display options for the CI Selector. These options are 
configured in the Infrastructure Settings Manager. 

Caution: Modifying certain settings in the Infrastructure Settings Manager 
can adversely affect the performance of HP Universal CMDB. Do not modify 
settings without first consulting HP Software Support or your 
HP Professional Services representative. 

This task includes the following steps:

➤ "Prerequisites" on page 147

➤ "Modify Selected Settings" on page 147

 1 Prerequisites

Access the Infrastructure Settings Manager by selecting Managers > 
Administration > Infrastructure Settings Manager. 

 2 Modify Selected Settings

The following settings can be modified:

➤ Immediate Children Count. Number of children immediately 
displayed when expanding their parent’s query node in the CI Selector.

➤ Maximal Children Count. Maximum number of children displayed 
under their parent’s query node in the CI Selector.
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➤ Maximal search results size. Maximum number of CMDB instances 
that can be returned in one search operation.

➤ Recently Used Views List size. Maximal number of recently used views 
to store per user.
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Reference

CI Selector User Interface

This section includes (in alphabetical order):

 ➤ CI Conditional Search Dialog Box on page 149

 ➤ CI Selector on page 151

 ➤ Organize Searches Dialog Box on page 159

 ➤ Running Software Search Dialog Box on page 160

 ➤ Save Search Criteria Dialog Box on page 161

CI Conditional Search Dialog Box

This dialog box enables you to search for CIs by attribute conditions, by 
related CIs, and by attribute conditions of related CIs.

User interface elements are described below:

To access In the CI Selector, select the Advanced tab in Search 
mode and click the ellipsis button next to CI Conditional 
Search.

UI Elements (A-Z) Description

Click to add an attribute condition.

Click to delete a selected row.

Click to move a selected row up.

Click to move a selected row down.
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Click to display a preview of the attribute condition list.

Attribute Name Select an attribute from the drop-down list.

CI Name Enter a CI name for which to search.

CI Type Enter the CI type for which to search.

Operator Select an operator from the drop-down list.

Related CI Name Enter the name of a related CI for the search.

Related CI Type Click the ellipsis button  to select a CI type from the 
tree for a search by related CI.

Relationship Type Click the ellipsis button  to select a relationship from 
the tree for a search by related CI.

Search by CI 
conditions

Select to run a search for CIs with the specified 
conditions.

Search by Related CI 
conditions

Select to run a search for CIs related to CIs with the 
specified conditions.

Search by Related CI 
criteria

Select to run a search for CIs related to the specified CIs 
or CI types.

Value Enter a value for the attribute condition.

UI Elements (A-Z) Description
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CI Selector

This feature enables you to select views and to locate CIs.

Browse Views Mode

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access Appears in the left pane of the IT Universe Manager page 
and the Modeling Studio.

Important 
information

The CI Selector consists of two functional formats: 
Browse Views mode and Search CIs mode.

➤ In Browse Views mode, you can search for and display 
a view, and browse through the view to locate a 
particular CI. You can also perform operations for the 
CI from a shortcut menu. 

➤ In Search CIs mode you can search for one or more 
CIs in the views or the CMDB by name or by CI type. 

Relevant tasks "Display a View in Browse Mode" on page 145

"Search for CIs in Search Mode" on page 145

UI Elements (A-Z) Description

Click to Refresh the data content of the hierarchical tree 
structure that may have been modified by other users.

Click Show Template Parameters to open the Template 
Parameter Values dialog box, which enables you to edit 
the parameters of the selected template.

Note: This button is only active when a template is 
selected.

Click Add selected CIs to model/view to add the 
selected CIs to the current model or view.

Note: This button only appears in the Modeling Studio.
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Click Add as related CI to add the selected CI to the 
model as a related CI.

Note: This button is only active in the Model Editor of 
the Modeling Studio.

Click Open selected model in a new tab to open the 
selected model in the Model Editor.

Note: This button is only active when a model is 
selected in the Modeling Studio.

Click Show models containing selected CI to display a 
list of models containing the selected CI.

Note: This button only appears in the Modeling Studio.

In IT Universe Manager, this represents Show View 
Definition, which takes you directly to the view 
definition in the Modeling Studio for the current view.

In the Modeling Studio, this represents Open Selected 
View, which opens the selected view in the Editor pane.

Click Show views containing selected CI/model to 
display a list of views containing the selected CI or 
model.

Note: This button only appears in the Modeling Studio.

Click Generate view for selected model to open the 
Creating New View dialog box which enables you to 
build a view based on the selected model.

Note: This button is only active when a model is 
selected in the Modeling Studio.

Click Show Discovery and Changes Summary to 
rediscover all the CIs in a selected view by manually 
starting the DFM jobs that originally discovered them. 
For details, see "Discovery and Changes Summary Dialog 
Box" on page 238.

Note: This button only appears in IT Universe Manager.

UI Elements (A-Z) Description
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Click Generate Direct Link to View to create a direct link 
to the view using the Direct Links wizard.

Note: This button only appears in IT Universe Manager.

Choose the export format for the table data. The 
available options are: 

➤ Excel. The table data is formatted as an .xls (Excel) file 
that can be displayed in a spreadsheet.

➤ PDF. The table data is exported in PDF format.

➤ RTF. The table data is exported in Rich Text Format.

➤ CSV. The table data is formatted as a comma-
separated values (CSV) text file that can be displayed 
in a spreadsheet.

Note: For the CSV formatted table data to display 
correctly, the comma (,) must be defined as the list 
separator. In Windows, to verify or modify the list 
separator value, open Regional Options from the 
Control Panel, and on the Numbers tab ensure that 
the comma is defined as the List Separator value. In 
Linux, you can specify the list separator in the 
application that opens the CSV file.

➤ XML. The table data is formatted as an XML file that 
can be opened in a text or XML editor. 

Tip: To extract HTML code from the report: 

➤ Save the file as HTML

➤ Open the file in an HTML editor

➤ Copy the relevant table into the target file 

UI Elements (A-Z) Description
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Click the Snapshot button to work with snapshots. The 
following options are available:

➤ Save Snapshot. Select to open the Save Snapshot 
dialog box, which enables you to save a snapshot of 
the view. For details, see "Save Snapshot Dialog Box" 
on page 262.

➤ Compare Snapshots. Select to run the Compare 
Snapshots Report. For details, see "Compare 
Snapshots Report" on page 393.

➤ Schedule Snapshot. Select to open the Schedule Job 
dialog box. For details, see "Schedule Job Dialog Box" 
on page 427.

➤ Show Scheduled Snapshot Jobs. Select to open the 
Job List dialog box. For details, see "Job List Dialog 
Box" on page 413.

Note: This button only appears in IT Universe Manager.

Click View Based Report to display the topology report 
for the selected view.

Note: This button only appears in IT Universe Manager.

Click Asset Report to open the Asset report for the 
selected view. For details, see "Asset Report" on page 375.

Note: This button only appears in IT Universe Manager.

Click the Select view from the folder tree button to the 
right of the View box, to open the View Selector dialog 
box. You can browse through the folder tree to locate 
the view you want to display.

Enables you to move to the next or previous result of the 
search for the string entered in the Find box.

<CIs> The CIs contained in the currently selected view.

<Tooltip> Hold the cursor over a CI to display a tooltip with the 
relevant CI type.

UI Elements (A-Z) Description
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Search CIs Mode

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Find Enter a CI name or a portion of a CI name in the Find 
box to locate a CI in the CI tree. 

View The View box displays the currently selected view. To 
select a view to display, click the down arrow on the 
right side of the View box; this displays an abridged list 
of views, containing the most recently accessed views. 
Click the arrow at the bottom of the list to scroll 
through the entire list. The recently accessed views 
appear at the top of the drop-down, above the dividing 
line. The complete list of views appears below the line.

Alternatively, place the cursor in the list and begin 
typing the view name. HP Universal CMDB completes 
the view name, if the first few letters that you type 
match an existing entry. If the names of several views 
begin with those letters, all matching views are 
displayed in the list.

UI Elements (A-Z) Description

Click Show Search Results in Table to open a separate 
pane with a table of the CIs in the search results.

Note: This button only appears in IT Universe Manager.

Click Add selected CIs to model/view to add the 
selected CIs to the current model or view.

Note: This button only appears in the Modeling Studio.

Click Add as related CI to add the selected CI to the 
model as a related CI.

Note: This button is only active in the Model Editor of 
the Modeling Studio.

UI Elements (A-Z) Description
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Click Open selected model in a new tab to open the 
selected model in the Model Editor.

Note: This button is only active when a model is 
selected in the Modeling Studio.

Click Show models containing selected CI to display a 
list of the models containing the selected CI.

Note: This button only appears in the Modeling Studio.

Click Show views containing selected CI/model to 
display a list of the views containing the selected CI or 
model.

Note: This button only appears in the Modeling Studio.

Click Generate View for Selected Model to open the 
Creating New View dialog box which enables you to 
build a view based on the selected model.

Note: This button is only active when a model is 
selected in the Modeling Studio.

UI Elements (A-Z) Description
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Choose the export format for the table data. The 
available options are: 

➤ Excel. The table data is formatted as an .xls (Excel) file 
that can be displayed in a spreadsheet.

➤ PDF. The table data is exported in PDF format.

➤ RTF. The table data is exported in Rich Text Format.

➤ CSV. The table data is formatted as a comma-
separated values (CSV) text file that can be displayed 
in a spreadsheet.

Note: For the CSV formatted table data to display 
correctly, the comma (,) must be defined as the list 
separator. In Windows, to verify or modify the list 
separator value, open Regional Options from the 
Control Panel, and on the Numbers tab ensure that 
the comma is defined as the List Separator value. In 
Linux, you can specify the list separator in the 
application that opens the CSV file.

➤ XML. The table data is formatted as an XML file that 
can be opened in a text or XML editor. 

Tip: To extract HTML code from the report: 

➤ Save the file as HTML

➤ Open the file in an HTML editor

➤ Copy the relevant table into the target file

Note: This button only appears in the Modeling Studio.

Click to open the Organize Searches dialog box, where 
you can edit or delete searches from the list of saved 
searches.

Click to collapse or expand the search criteria area.

Click to run the search. The search results are displayed 
in the lower part of the CI Selector pane. 

Click to save the current search criteria for future use.

Enables you to move to the next or previous result of the 
search for the string entered in the Find field.

UI Elements (A-Z) Description
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<Search results> After you run the search, the results are listed in the 
lower part of the CI Selector pane. The results are shown 
in two columns:

➤ Name. Contains the name of the CI.

➤ CI Type. Contains the CI type of the CI.

If the CI or view name is abbreviated, hold the pointer 
over the entry to see the full name. You can sort the 
search results by clicking the appropriate heading.

Advanced tab The following detailed search options are available:

➤ CI Conditional Search. Enables you to search for CIs 
by attribute conditions, by related CIs, and by 
attribute conditions of related CIs.

➤ Running Software Search. Enables you to search for 
hosts by the applications running on them and for 
applications by the host on which they are running.

For each of the searches, click the ellipsis button  to 
open the search dialog box. After running a search, click 
the Save button  to save the search for future use.

CI Name To search for a CI by name, enter the name of the CI for 
which to search.

CI Type To search for CIs by CI type, click the ellipsis button to 
select a CI from the Select Configuration Item Type 
dialog box.

Find Enter a CI name or a portion of a CI name in the Find 
box to locate a CI in the search results.

Searches Select a search from the drop-down list of saved 
searches.

Search results count The Search results count below the Find box displays the 
total number of CIs found in the search.

Simple tab The Simple tab includes the standard search 
functionality. Click the Advanced tab for more detailed 
search options.

UI Elements (A-Z) Description
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Shortcut Menu Options

Organize Searches Dialog Box

This dialog box enables you to edit or delete searches from the list of saved 
searches.

Menu Item Description

<IT Universe Manager 
shortcut menu 
options>

The regular shortcut menu for the topology map in 
IT Universe Manager is also available from the CI 
Selector. For details on the menu options, see 
"IT Universe Manager Shortcut Menu" on page 250.

Add Adds the selected CI to the current model or view.

Note: This feature only appears in the Modeling Studio.

Add to model as 
related CI

Adds the selected CI as a related CI to the current model.

Note: This feature only appears in the Modeling Studio.

Generate View from 
Model

Select to create a view based on the current model. The 
Creating New View dialog box opens which enables you 
to select a perspective to apply.

Note: This feature only appears in the Modeling Studio.

Open Selected Model Opens the selected model in the Model Editor.

Note: This feature only appears in the Modeling Studio.

Show containing 
models

Select Show models containing selected CI to display a 
list of the models containing the selected CI.

Note: This option only appears in the Modeling Studio.

Show containing 
views

Select Show views containing selected CI/model to 
display a list of the views containing the selected CI or 
model.

Note: This option only appears in the Modeling Studio.

To access Click the Manage the list of saved searches button  
in the CI Selector.
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User interface elements are described below:

Running Software Search Dialog Box

This dialog box enables you to search for hosts by the applications running 
on them and for applications by the host on which they are running.

UI Elements (A-Z) Description

Click to edit the selected search. For simple searches, the 
CI Simple Search dialog box opens, which enables you to 
edit the name and type of the CI. For CI Conditional 
searches, the CI Conditional Search dialog box opens.

Click to delete the selected search.

Click to expand the search tree.

Click to collapse the search tree.

Find Enter a search name or a portion of a search name in the 
Find box to locate it in the list.

Find Next Click to go to the next occurrence of the selected search 
phrase in the list.

Find Previous Click to go to the previous occurrence of the selected 
search phrase in the list.

Searches tree Displays all the saved searches in tree format.

To access In the CI Selector, select the Advanced tab in Search 
mode and click the ellipsis button next to Running 
Software Search.
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User interface elements are described below:

Save Search Criteria Dialog Box

This dialog box enables you to save the current search criteria for future use.

User interface elements are described below:

UI Elements (A-Z) Description

Host Name Enter the name of the node for which you are searching.

Running Software Select a running software CI from the drop-down list.

Search for Select Running Software or Node.

Note: To search for a running software CI running on a 
specific node, enter a node name, select the required 
running software CI and search for it.

To access Click the Save button  from Search mode in the CI 
Selector.

UI Elements (A-Z) Description

Existing Queries Displays a list of existing searches in tree format.

Name Enter a name for the current search.

Find Enter a search name or a portion of a search name in the 
Find box to locate it in the list.

Find Next Click to go to the next occurrence of the selected search 
phrase in the list.

Find Previous Click to go to the previous occurrence of the selected 
search phrase in the list.
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Troubleshooting and Limitations

This section describes troubleshooting and limitations for the CI Selector.

This section includes the following topics: 

Unavailable Views and CIs
The View list in the CI Selector may not display all views in the CMDB, or it 
may not display the contents of a view, for any of the following reasons:

➤ The View list includes only the views for which you have the necessary 
permissions. Similarly, Search mode is only available if you have Search 
CIs permission. To set permissions, select Managers > Administration > 
Security Manager. For more information, see "Security Manager" in the 
HP Universal CMDB Administration Guide.

➤ Views that are currently inactive appear in red in the View list, but they 
cannot be selected. In IT Universe Manager, inactive views appear in 
faded text.

➤ Out-of-the-box views for which you do not have a license may appear in 
the View list, but these views do not contain CIs. For information on the 
out-of-the-box views, see "Predefined Folders and Views" on page 273.

Note: After deleting one or more query nodes from a TQL query, it can take 
time for changes to be updated to the view; meanwhile, the removed CIs 
appear in the view. If you select one of these CIs before it is updated, an 
error message is displayed. Click the Refresh button to update the view.
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Working with Topology Map

This chapter includes:

Concepts

➤ Topology Map Overview on page 164

➤ Handling Large Views on page 165

Reference

➤ Topology Map User Interface on page 166
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Concepts

Topology Map Overview

The Topology Map provides a graphical display of a view. All the CIs in a 
given layer of the view are represented by icons and the connecting lines 
represent relationships. You can select a CI in the Topology Map or in the CI 
Selector in the left pane. You can also drill down in the CI Selector to display 
different layers of the view in the Topology Map.

The label of a CI appears under the icon. You can set the maximum number 
of characters per line and the maximum number of lines in a CI label in the 
User Preferences dialog box under General. For details, see "User Preferences 
Dialog Box" on page 97.

If a CI icon appears with a downward arrow icon in the Topology Map, there 
is an additional CI layer beneath it, created by the hierarchy set for the view. 
You can click the arrow to display the CIs contained in the sublayer.

The topology map is automatically updated dynamically with changes in 
the IT Universe data, such as new CIs discovered by the Data Flow 
Management process.

The toolbar and Main Menu above the Topology Map enable you to zoom 
in, change the layout of the Topology Map, and print the Topology Map. 
Additional functionality is available from the shortcut menu by right-
clicking a CI in the Topology Map or in the CI Selector.
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Handling Large Views

The Topology Map cannot display a view with more than 900 CIs in a single 
layer. When you select a view which contains a layer with more than this 
number of CIs, the Topology Map appears empty. A layer with more than 
900 CIs can be displayed in a table in Text mode.

To display large views in the Topology Map, use one of the following 
methods:

➤ Reduce the TQL query results by redefining the view in the Modeling 
Studio. For details, see "Change Query Node/Relationship Type Dialog 
Box" on page 303.

➤ Define a different hierarchy for the view to redistribute the CIs among the 
view’s layers. For details on defining hierarchy, see "Setting the View 
Hierarchy" on page 270.

➤ Reset the maximum number of CIs allowed in the configuration 
parameters. Select the Max Object Count GUI for TS parameter under 
Viewing Settings in the Infrastructure Settings Manager. However, be 
aware that increasing the maximum number of CIs per layer may 
significantly slow down the redrawing of the Topology Map.

For details regarding Infrastructure Settings Manager, see "Infrastructure 
Settings User Interface" in the HP Universal CMDB Administration Guide.
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Reference

Topology Map User Interface

This section includes (in alphabetical order):

 ➤ Export Map to Image Dialog Box on page 166

 ➤ Layout Properties Dialog Box on page 168

 ➤ Main Menu on page 185

 ➤ Print Dialog Box on page 186

 ➤ Print Preview Dialog Box on page 187

 ➤ Print Setup Dialog Box on page 187

 ➤ Toolbar Options on page 189

 ➤ Topology Map Sidebar on page 197

Export Map to Image Dialog Box

This dialog box enables you to save a topology map to a file.

To access From a topology map, select Operations > Export Map to 
Image.

Relevant tasks "Print and Save a Topology Map to File" on page 228
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User interface elements are described below:

UI Elements (A-Z) Description

Actual Size Save the view so that the graph node sizes are at 
maximum.

Current Zoom Level Save the view as you see it on the topology map. For 
example, if you have used the Interactive Zoom mode to 
decrease the view magnification, the graph nodes also 
appear smaller in the saved view. For details, see 
"Interactive Zoom" on page 192.

Custom Specify the size of the view you want to save in the Width 
and Height boxes.

File Name Specify the required file name and location (or click 
Browse to search for the file and location).

Fit in Canvas Expand or shrink the view so that it fits in the pane.

Image Quality The quality of the printed map. Select High, Medium, or 
Low. 

Selected Objects 
Only

Saves only the graph nodes/CIs and their relationships 
that you selected in the map.

Type Select the required file format.

Visible Window Only Saves only the part of the graph that appears in the pane.
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Layout Properties Dialog Box

This dialog box enables you to customize the layout of a specific layer in a 
view, to achieve the clearest presentation possible and to better understand 
and monitor the managed data.

Global Tab

This area enables you to define global layout parameters.

User interface elements are described below:

To access Select Layout > Layout Properties.

Important 
information

You define the layout of a view’s layers by assigning 
logical positions for the graph’s nodes and relationships 
that appear in a layer. You customize the layer layouts by 
modifying the default values.

You set layout definitions for a specific layer only. The 
definitions cannot be saved for a different layer or a 
different view.

Parameter values are in pixels.

To access Click the Global tab in the Layout Properties dialog box. 

Important 
information

The Global tab enables you to define global settings for 
the layout.

UI Elements (A-Z) Description

Drawing Fitting Select one of the following options for fitting the layout:

➤ Fit to Canvas. Fit the layout to the canvas on the 
screen.

➤ Fit for Printing. Fit the layout to a page for printing.

➤ No Fitting. Do not change the layout.
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All Styles Tab 

Labeling Select Perform Labeling to ensure that the labels appear 
when the layout is redrawn. If this field is not selected, 
labels do not appear in the redrawn layout.

Style Select Apply Style Deeply to apply the layout selected to 
all nested layers of the topology map.

To access Click the All Styles tab in the Layout Properties dialog 
box. 

Important 
information

The All Styles tab enables you to define general layout 
parameters for disconnected graph nodes and connected 
components.

➤ A disconnected graph node is a node that is not 
connected to any other graph node.

➤ A disconnected component is a component that is not 
connected to any other component. It contains a set of 
graph nodes that can be connected to each other.

This illustrates a connected component with five graph 
nodes:

This illustrates a connected component with two graph 
nodes:

This illustrates four disconnected components, each 
made up of a single, disconnected graph node:

UI Elements (A-Z) Description
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User interface elements are described below:

UI Elements (A-Z) Description

Components The spacing between the components in a disconnected 
graph consists of both a constant value and a 
proportional value based on the sizes of the components.

Select Detect Components to view the disconnected 
components. You can specify that all components be laid 
out together or individually, regardless of the other 
components. If the grouping for components is selected, 
each component is laid out, and the resulting 
components are packed together.

When Detect Components is selected, enter values for 
the following settings:

➤ Constant Spacing. Set constant spacing (horizontal 
and vertical) around each disconnected component. 
Default value: 20

➤ Proportional Spacing. Set spacing (horizontal and 
vertical) that is proportional to the size of the 
component around each disconnected component.
Default value: 0.05
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Circular Tab

Disconnected Graph 
Nodes

The spacing between the graph nodes in a disconnected 
graph consists of both a constant value and a 
proportional value based on the sizes of the graph nodes.

Select Detect Disconnected Graph Nodes to view the 
disconnected graph nodes. You can specify that 
disconnected graph nodes be grouped into one 
component or laid out individually.

When Detect Disconnected Graph Nodes is selected, 
enter values for the following settings:

➤ Constant Spacing. Set constant spacing (horizontal 
and vertical) around each disconnected graph node. 
Default value: 20

➤ Proportional Spacing. Set spacing (horizontal and 
vertical) that is proportional to the size of the 
component around each disconnected graph node.
Default value: 0.05

Margin Spacing Enter values for the right, left, top, and bottom margin 
spacing for the layout.

To access To access: Click the Circular tab in the Layout Properties 
dialog box.

Important 
information

The Circular tab enables you to group a graph’s nodes 
into groups or clusters based on the grouping options you 
select. It is particularly suited for visualizing ring and star 
network topologies, and for link analysis.

UI Elements (A-Z) Description
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User interface elements are described below:

UI Elements (A-Z) Description

Clustering Set the values for the following settings:

➤ Cluster Size Factor. Specifies the ratio between the 
average cluster size and the number of clusters. The 
size of a cluster is defined as the sum of the weights of 
all graph nodes in the cluster. You can assign a weight 
value to each graph node.

➤ Min Number of Clusters. The minimum number of 
clusters in a layer.

➤ Max Number of Clusters. The maximum number of 
clusters in a layer.

Cluster Layout Style Displays clusters either in a symmetric or circular layout 
style.

Select one of the following options:

➤ Symmetric. Displays clusters in a symmetric layout 
style.

➤ Circular. Displays clusters in a circular layout style.
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Layout Quality Adjusts the quality of the layout produced to fit your 
application’s needs. The quality reflects the number of 
steps or the method used to produce the layout. For 
example, high quality is sharper but takes more time to 
set the layout.

Select one of the following options:

➤ Draft. Set the layout to draft quality.

➤ Medium. Set the layout to medium quality.

➤ Proof. Set the layout to proof quality.

UI Elements (A-Z) Description
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Hierarchical Tab

Spacing Sets the spacing around each graph node within the same 
cluster and between clusters.

Enter values for the following settings:

➤ Between Graph Nodes. Sets the spacing around each 
graph node within the same cluster. The larger the 
spacing, the more graph nodes there are on the cluster 
boundary. 

Default value: 50

This illustration shows smaller graph node spacing.

This illustration shows larger graph node spacing.

➤ Between Clusters. Sets the spacing between clusters.

Default value: 50

This illustration shows smaller cluster spacing.

This illustration shows larger cluster spacing.

To access Click the Hierarchical tab in the Layout Properties dialog 
box. 

UI Elements (A-Z) Description
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User interface elements are described below:

Important 
information

The Hierarchical tab shows the precedence relationships 
that can represent organizational or information 
management system dependencies, as well as process 
models, software call graphs, and work flows. The 
hierarchical layout emphasizes dependencies by placing 
the graph nodes at different levels. 

UI Elements (A-Z) Description

Backward Edges Specifies how backward relationships are displayed in the 
hierarchical layout.

Select one of the following options:

➤ Minimize Backward Edges. Sets the number of 
backward relationships displayed in a layer to a 
minimum.

➤ Optimize for Feedback Flow. Sets the number of 
backward relationships displayed in a layer to a 
maximum. This mode is more appropriate for flow 
charts.

Horizontal Spacing Enables you to set the minimum horizontal distance 
between two neighboring graph nodes at each level.

Enter values for the following settings:

➤ Between Graph Nodes. Sets a space around each graph 
node horizontally in the layer. 
Default value: 28

➤ Between Edges. This setting is available only when 
you select Routing > Orthogonal. It sets a horizontal 
space between edges in the graph.
Default value: 12
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Layout Quality Adjusts the quality of the layout produced to fit your 
application’s needs. The quality reflects the number of 
steps or the method used to produce the layout. For 
example, high quality is sharper but takes more time to 
set the layout.

Select one of the following options:

➤ Draft. Set the layout to draft quality.

➤ Medium. Set the layout to medium quality.

➤ Proof. Set the layout to proof quality.

UI Elements (A-Z) Description
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Level Alignment Enables you to set the way graph nodes are vertically 
aligned.

Select one of the following options:

➤ Top. This illustration shows that the top of the graph 
nodes at the same level of the hierarchy are aligned.

➤ Center. This illustration shows that the center of the 
graph nodes at the same level of the hierarchy are 
aligned.

➤ Bottom. This illustration shows that the bottom of the 
graph nodes at the same level of the hierarchy are 
aligned.

UI Elements (A-Z) Description
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Orientation Enables you to set the orientation of the hierarchy.

Select one of the following options:

➤ Top to Bottom. The children are located above the 
parent.

➤ Left to Right. The children are located to the left of the 
parent.

➤ Bottom to Top. The children are located below the 
parent.

➤ Right to Left. The children are located to the right of 
the parent. 

Orthogonal Routing - 
Fix Node Sizes

This setting is available only when you select Routing > 
Orthogonal. Maintain the size of a graph node. Clear this 
option if you want the layout to increase the size of a 
graph node if it is necessary to maintain the specified 
relationship spacing when more than one relationship is 
attached to the same side of the graph node.

Polyline Routing - 
Spacing Between 
Bends

This setting is available only when you select Routing > 
Polyline. Polyline routing routes edges (connecting lines) 
as one or more straight line segments with arbitrary 
angles. Path nodes are added automatically to prevent 
the edges (connecting lines) from overlapping.

Default Value: 12

UI Elements (A-Z) Description
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Orthogonal Tab

Routing Select the type of routing for the layout. The available 
options are:

➤ Orthogonal

➤ Polyline

Undirected Layout Edge direction is not used to build the levels of the 
hierarchical drawing.

Variable Level 
Spacing

Variable level spacing adjusts the spacing between pairs 
of neighboring levels according to the density of edges 
between the levels. 

If the drawing’s edges are orthogonally routed, this 
ensures the desired vertical spacing between horizontal 
edges (in a top-to-bottom or bottom-to-top layout) 
routed between levels. 

If the routing is polyline, variable level spacing makes it 
easier to distinguish among edges in very dense 
drawings.

Vertical Spacing Enables you to set the minimum vertical distance 
between two neighboring graph nodes on different 
levels.

Enter values for the following settings:

➤ Between Graph Nodes. Sets a vertical space around 
each graph node in the level.
Default value: 28

➤ Between Edges. This setting is available only when 
you select Routing > Orthogonal. It sets a vertical 
space between edges in the graph.
Default value: 12

To access To access: Click the Orthogonal tab in the Layout 
Properties dialog box.

Important 
information

The Orthogonal tab enables you to set orthogonal layout 
route relationships horizontally and vertically. This 
results in relationships bending at 90-degree angles only.

UI Elements (A-Z) Description
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User interface elements are described below:

UI Elements (A-Z) Description

Fix Node Sizes Maintain the size of a graph node. Clear this option if 
you want the layout to increase the size of a graph node 
if it is necessary to maintain the specified relationship 
spacing when more than one relationship is attached to 
the same side of the graph node.

Horizontal Spacing Enables you to set the minimum horizontal distance 
between graph nodes.

Select one of the following options:

➤ Between Graph Nodes. Set a horizontal space around 
each graph node in the layer.

Default value: 20

➤ Between Edges. Set a horizontal space between 
elements in the layer.

Default value: 12

Layout Quality Adjusts the quality of the layout produced to fit your 
application’s needs. The quality reflects the number of 
steps or the method used to produce the layout. For 
example, high quality is sharper but takes more time to 
set the layout.

Select one of the following options:

➤ Draft. Set the layout to draft quality.

➤ Medium. Set the layout to medium quality.

➤ Proof. Set the layout to proof quality.

Vertical Spacing Enables you to set the minimum vertical distance 
between graph nodes.

Select one of the following options:

➤ Between Graph Nodes. Set a vertical space around 
each graph node in the layer.

Default value: 100

➤ Between Edges. Set a vertical space between elements 
in the layer.

Default value: 20
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Symmetric Tab

To access Click the Symmetric tab in the Layout Properties dialog 
box.

Important 
information

The Symmetric tab displays a clear representation of 
complex networks. The symmetric layout emphasizes the 
symmetries that may occur in a graph.
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User interface elements are described below:

Routing Tab

UI Elements (A-Z) Description

Layout Quality Adjusts the quality of the layout produced to fit your 
application’s needs. The quality reflects the number of 
steps or the method used to produce the layout. For 
example, high quality is sharper but takes more time to 
set the layout.

Select one of the following options:

➤ Draft. Set the layout to draft quality.

➤ Medium. Set the layout to medium quality.

➤ Proof. Set the layout to proof quality.

Spacing Allows you to set constant horizontal and vertical 
spacing around each graph node in the layer. The value 
you specify is a guideline for the layout, so that it is 
possible that the spacing for a particular pair of graph 
nodes might be different from the one you specified. The 
larger the graph node spacing, the farther apart the graph 
nodes are spaced in the final layout.

Default value: 50

The following figure illustrates smaller and larger 
spacing.

To access Click the Routing tab in the Layout Properties dialog box.
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User interface elements are described below:

Important 
information

The Routing tab enables you to produce drawings that 
leave graph nodes essentially where they are, and reroute 
the lines orthogonally.

UI Elements (A-Z) Description

Fix Node Positions Maintain the position of all the graph nodes in the 
display. Clear this option for the layout to move the 
graph nodes if it is necessary to improve the layout. The 
movement is minimal, avoids overlaps, and minimizes 
bend points.

Fix Node Sizes Maintain the size of a graph node. Clear this option if 
you want the layout to increase the size of a graph node 
if it is necessary to maintain the specified relationship 
spacing when more than one relationship is attached to 
the same side of the graph node.
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Horizontal Spacing Enables you to set the minimum horizontal distance 
between graph nodes.

Select one of the following options:

➤ Between Graph Nodes. Set a horizontal space around 
each graph node in the layer.

Default value: 20

➤ Between Edges. Set a horizontal space between 
elements in the layer.

Default value: 12

Vertical Spacing Enables you to set the minimum vertical distance 
between graph nodes.

Select one of the following options:

➤ Between Graph Nodes. Set a vertical space around 
each graph node in the layer.

Default value: 20

➤ Between Edges. Set a vertical space between elements 
in the layer.

Default value: 12

UI Elements (A-Z) Description
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Main Menu

This feature contains the options for working with the topology map.

User interface elements are described below:

To access Located in the upper left portion of the screen.

Important 
information

The specific options contained within the Main Menu 
drop-downs are detailed in "Toolbar Options" on 
page 189.

UI Elements (A-Z) Description

Edit Contains selection options for the topology map.

Editor Item Contains the topology map shortcut menu options for 
the current manager.

Note: This drop-down does not appear in CI Type 
Manager.

Layout Contains options for changing the layout of the topology 
map.

Note: This drop-down does not appear in Reports.

Managers Contains links to the different UCMDB modules.

Operations Contains options for printing or exporting the topology 
map.

Resources Contains the left pane shortcut menu options for the 
current manager.

Note: This drop-down does not appear in IT Universe 
Manager or Reports, and in CI Type Manager it is called CI 
Types.

Tools Contains the User Preferences, Log Configuration, and 
Screen Capture tools.

View Enables you to hide or display the different panes of the 
module.
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Print Dialog Box

This dialog box enables you to print the contents of the topology map.

User interface elements are described below:

To access Select Operations > Print.

Important 
information

The results of printing a topology map is similar to a 
screen capture. Therefore, before printing, it is 
recommended to:

➤ Define your print settings and arrange the contents of 
the topology map according to your requirements. For 
details, see "Print Setup Dialog Box" on page 187.

➤ Arrange the contents of the topology map for print. 
You can use the Layout option and Layout Properties. 
For details about the layout options, see "Layout" on 
page 193. For details about layout properties, see 
"Layout Properties Dialog Box" on page 168.

Relevant tasks "Print and Save a Topology Map to File" on page 228

UI Elements (A-Z) Description

Number of copies Enter the number of copies you want to print.

Properties Define document properties as required.
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Print Preview Dialog Box

This dialog box enables you to preview the content of the topology map 
before printing.

User interface elements are described below:

Print Setup Dialog Box

This dialog box enables you to define the print settings for a topology map.

User interface elements are described below:

To access Select Operations > Print Preview.

Relevant tasks "Print and Save a Topology Map to File" on page 228

Menu Item Description

Fit in Canvas Fit the complete view in the pane.

Print Print the map. For details, see "Print Dialog Box" on 
page 186.

Print Setup Define the print settings for the map. For details, see 
"Print Setup Dialog Box" on page 187.

Zoom Focus on specific details of the map. For details, see 
"Interactive Zoom" on page 192.

To access Select Operations > Print Setup.

Relevant tasks "Print and Save a Topology Map to File" on page 228

UI Elements (A-Z) Description

Actual Size Print the view as it really is.

Color Set the text color.

Font Set the required font.
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Page Setup Set the printer settings.

Pages Divide the map into rows and columns and print each 
section separately. Enter the number of columns and rows 
in the Page Columns and Page Rows boxes.

Position Select the position of the caption from the Position list.

Print Background Print the background behind the view.

Print Border Print the map with a border. Click Color to select the 
required border color.

Print Caption Enter the caption in the text area and click Font to select 
the required custom font.

Print Crop Marks Print the crop marks.

Print Current 
Selection

Print the selected graph nodes and their relationships.

Print Current 
Window

Print the part of the view that appears in the pane.

Print Entire Drawing Print the complete view.

Print Page Numbers Print the page numbers.

Zoom Level Print the view at the current zoom level.

UI Elements (A-Z) Description
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Toolbar Options

The following table contains a description of each Topology Map toolbar 
option, organized alphabetically.

Button Option Name Use This Option to...

Additions 
Count

Calculate the number of instances that are created as a result of 
an Enrichment Rule. The number of TQL query node instances 
and relationships that are created appear next to the 
Enrichment query nodes/relationships, as seen in the figure 
below.

Note: This option appears in the toolbar in Enrichment 
Manager only.

Advanced 
Pane

Toggle between hiding and displaying the Advanced Pane at the 
bottom center of the screen.

To access: Select View > Advanced Pane.

Calculate 
Query Result 
Count

Calculate the number of instances found for each TQL query 
node/relationship.

Change Label 
Length/Prop
erties

Enter the maximum number of characters that the labels should 
contain.

To access: In IT Universe Manager and the Modeling Studio, 
select Layout > Change label properties. In the other managers, 
select Layout > Change label length.
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CI Types Tree Toggle between hiding and displaying the CI Type Selector at 
the right of the screen.

To access: Select View > CI Types Tree.

Note: In the Modeling Studio, this option is called CI Types.

Create 
Relationship

In most managers, create a relationship between two existing 
TQL query nodes. For details, see "Add Query Nodes and 
Relationships to a TQL Query" on page 28.

In IT Universe Manager, create a relationship between existing 
CIs. For details, see "Attaching Existing CIs" on page 212. 

Delete 
Selected 
Item(s)

Delete a CI from IT Universe Manager or a TQL query node from 
Impact Analysis Manager or Enrichment Manager. 

Disable/Enabl
e Related CIs 
Retrieval

Toggle between disabling and enabling the redrawing of the 
topology map with related CIs when selecting a new CI in the 
CI Selector.

Note: This option appears only in IT Universe Manager in the 
Related in View or Related in DB tabs.

Drag Map Drag the view.

To access: Open the drop-down menu in the Mode box or select 
View > Drag Map. In IT Universe Manager and the Modeling 
Studio, select Layout > Dragging Mode.

Drill Down 
One Layer

Move down one level in the topology map. This option is 
enabled only if there is an additional CI layer below it, created 
by setting the hierarchy of the view. For details on setting the 
hierarchy, see "Setting the View Hierarchy" on page 270. 

Note: This option appears only in IT Universe Manager.

Entities Tree Toggle between hiding and displaying the manager specific 
entities tree at the left of the screen.

To access: Select View > Entities Tree.

Note: In the Modeling Studio, each of the tabs of the Left pane 
(Resources, CI Types, CI Selector) is listed as a separate option.

Button Option Name Use This Option to...
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Export Map 
to Image

Save the topology map to a file. For details, see "Export Map to 
Image Dialog Box" on page 166.

To access: Select Operations > Export Map to Image.

Fit to 
Window

Fit the complete map in the pane.

Generate 
Direct Link

Generate a direct link to a view or CI.

To access: Select Edit > Generate Direct Link.

Get Related 
CIs

Toggle between hiding and displaying the Get Related CIs 
toolbar.

Note: This option appears only in IT Universe Manager when 
the Related in View or Related in DB tabs are selected.

Go Up One 
Layer

Move up one level in the topology map. This option is enabled 
only if there is an additional CI layer above it, created by setting 
the hierarchy of the view. For details on setting the hierarchy, 
see "Setting the View Hierarchy" on page 270. 

Note: This option appears only in IT Universe Manager.

Hide All 
Inheritance 
From Map

Toggle between showing and hiding Inheritance_f relationships 
and their connecting query node.

To access: Select Layout > Hide All Inheritance From Map.

Note: This option is only active in the toolbar in CI Type 
Manager.

Hide All 
Query Node 
Labels

Toggle between showing or hiding the CI/CIT/query 
node/pattern labels.

To access: Select Layout > Hide All Query Node Labels.

Note: This option is not available in IT Universe Manager and 
the Modeling Studio.

Hide All 
Relationship 
Labels

Toggle between showing or hiding the relationship labels.

To access: Select Layout > Hide All Relationship Labels.

Note: This option is called Hide edges’ labels in IT Universe 
Manager and the Modeling Studio.

Button Option Name Use This Option to...
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Hide All 
Relationships

Toggle between showing and hiding the relationships in the 
displayed map.

To access: Select Layout > Hide All Relationships.

Note: This option is not available in IT Universe Manager and 
the Modeling Studio.

Hide/Show 
Legend

Toggle between hiding and displaying the topology map legend.

Note: This option appears only in IT Universe Manager and the 
Modeling Studio.

Interactive 
Zoom

➤ Decrease the view magnification by clicking and pushing the 
pointer upwards.

➤ Magnify the view by clicking and pulling the pointer 
downwards.

To access: Open the drop-down menu in the Mode box or select 
View > Interactive Zoom.

Note: This option is not available in IT Universe Manager and 
the Modeling Studio.

 Layout 
Properties

Define the view’s layer layout, by assigning positions for the 
query nodes and relationships of the view. For details, see 
"Layout Properties Dialog Box" on page 168. 

To access: Select Layout > Layout Properties.

Button Option Name Use This Option to...
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Layout Select the layout display from the list. The options are:

➤ Hierarchical. Enables you to display the precedence relations 
in the topology map.

➤ Symmetric. Enables you to display clear representations of 
complex networks.

➤ Circular. Groups a graph’s nodes into groups or clusters.

➤ Manual. Enables you to display the changes you have made 
manually to the topology map. 

➤ Orthogonal. Enables you to display views of outstanding 
clarity that are achieved by employing only horizontal and 
vertical edge routing.

For further details about each of the options, see "Layout 
Properties Dialog Box" on page 168. 

Note: These layout options are only relevant for Enrichment 
Manager, CIT Manager, and Impact Analysis Manager.

Log 
Configuratio
n

Open the Log Configuration dialog box.

To access: Select Tools > Log Configuration.

Map 
overview

Open a small box with a copy of the topology map. This is 
useful in large views when zooming in.

To access: Select Layout > Map Overview.

Maximize 
Workspace/R
estore 
Workspace

Toggle between the regular display and a full-screen display of 
the topology map.

Button Option Name Use This Option to...
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Navigation Take the pointer to the next connected CI/CIT/TQL query node 
in a clockwise direction.

➤ Left-click to move in a clockwise direction.

➤ Right-click to point to the next CI/CIT/query node/pattern in 
a clockwise direction. 

To access: Open the drop-down menu in the Mode box or select 
View > Navigation.

Note: 

➤ You can use this option only on CI/CIT/query 
nodes/patterns that are connected by relationships.

➤ This option is not available in IT Universe Manager and 
the Modeling Studio.

New CI Define a new unrelated CI. For details, see "Working with CIs" 
on page 206.

Note: This option appears in the toolbar in IT Universe Manager 
only.

New Related 
CI

Define a new related CI. For details, see "Working with CIs" on 
page 206.

Note: This option appears in the toolbar in IT Universe Manager 
only.

Place in 
Center

Place the selected CI/CIT/query nodes/pattern in the center of 
the map.

To access: Select Layout > Place in Center.

Note: This option is not available in IT Universe Manager and 
the Modeling Studio.

Print Print the contents of the topology map. For details, see "Print 
Dialog Box" on page 186.

To access: Select Operations > Print...

Print Preview Preview the contents of the map before printing.

To access: Select Operations > Print Preview.

Button Option Name Use This Option to...
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Print Setup Define print settings for printing the topology map. For details, 
see "Print Setup Dialog Box" on page 187.

To access: Select Operations > Print Setup...

Remove 
Enrichment 
Results

Remove the instances created from an Enrichment rule from the 
CMDB.

Note: This option appears in the toolbar in Enrichment 
Manager only.

Screen 
Capture

Take a snapshot of the screen using the Screen Capture tool.

To access: Select Tools > Screen Capture.

Select Select a CI/CIT/TQL query node or multiple CIs/CITs/TQL query 
nodes.

To access: Open the drop-down menu in the Mode box or select 
View > Select. In IT Universe Manager and the Modeling Studio, 
select Layout > Selection Mode.

Select All Select all the CIs and relationships in a selected layer.

To access: Select Edit > Select All.

Note: This option is not available in IT Universe Manager and 
the Modeling Studio.

Select All 
Query Nodes

Select all the query nodes in a selected layer.

To access: Select Edit > Select All Query Nodes.

Note: This option is not available in IT Universe Manager and 
the Modeling Studio.

Select 
Columns

Enables you to select the columns to be displayed. For details, 
see, "Select Columns Dialog Box" on page 558.

Note: This option is displayed in Text mode of IT Universe 
Manager only.

Set Change 
Timeframe

Open the Change Timeframe dialog box, which enables you to 
set the period for the display of added or changed CI indicators.

Note: This option appears in the toolbar in IT Universe Manager 
only.

Button Option Name Use This Option to...
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Show 
Candidates 
for Deletion

Identify the CIs in the current view which are candidates for 
deletion with the following icon  .

Note: This option appears in the toolbar in IT Universe Manager 
only.

Show 
Schedule Info

Display the scheduling information for the selected job. For 
details, see "Discovery Scheduler Dialog Box" in the HP Universal 
CMDB Data Flow Management Guide.

Note: This option appears in the toolbar in the Dependency 
Map tab of DFM. For details, see "Dependency Map Tab" in the 
HP Universal CMDB Data Flow Management Guide.

Sort Order Enables you to set the order of the visible columns. For details, 
see, "Sort Column Content Dialog Box" on page 559.

Note: This option is displayed in Text mode of IT Universe 
Manager only.

Straighten Straightens any selected relationship between two query nodes 
that has angles. 

To access: Select Layout > Straighten.

Note: This option is only available in Enrichment Manager and 
Impact Analysis Manager.

User 
Preferences

Opens the User Preferences dialog box which enables you to 
reset warning message preferences. For details, see "User 
Preferences Dialog Box" on page 97.

To access: Select Tools > User Preferences.

Zoom In Zoom in on a specific section of the topology map by clicking 
and drawing a selection rectangle around the part to magnify. 
The area you select is displayed at the highest percentage that 
fits in the topology map.

To access: Open the drop-down menu in the Mode box or select 
View > Zoom In. In IT Universe Manager and the Modeling 
Studio, select Layout > Zoom in.

Button Option Name Use This Option to...
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Topology Map Sidebar

The following table contains a description of each Topology Map sidebar 
option. The Topology Map sidebar appears in IT Universe Manager and the 
Modeling Studio.

Button Option Name Use This Option to...

Move to 
Right/Left

Move the sidebar to the right or left side of the screen.

Zoom In/Out Zoom in or out on the topology map.

Selection 
Mode

Enable selection mode in the topology map.

Dragging 
Mode

Enable dragging mode in the topology map.

Refresh to get 
an optimal 
layout

Refresh the topology map to optimize the layout.

Fit to Window Fit the complete map in the pane.

Hide Edges’ 
Labels

Hide the labels of all relationships.

Change label 
properties

Open the Map Label Properties dialog box which enables you 
to set the maximum label length per line and maximum 
number of lines per label.

Show Map 
Overview

Open a small box with a copy of the topology map. This is 
useful in large views when zooming in.

Hierarchical 
Layout

Display the topology map in a layout displaying the 
precedence relations.
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Hierarchical 
Layout with 
Orthogonal 
Routing

Display the topology map in a layout displaying the 
precedence relations using only horizontal and vertical edge 
routing.

Circular Layout Display the topology map in a layout that groups a graph’s 
nodes into groups or clusters.

Orthogonal 
Layout

Display the topology map in a layout using only horizontal 
and vertical edge routing.

Symmetric 
Layout

Display the topology map in a layout showing clear 
representations of complex networks.

Print Print the topology map.

Export Map to 
Image

Save the topology map to a file.

Button Option Name Use This Option to...
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IT Universe Manager

This chapter includes:

Concepts

➤ IT Universe Manager Overview on page 202

➤ Working with Views in IT Universe Manager on page 203

➤ View Tree Structure on page 205

➤ Working with CIs on page 206

➤ Working with Relationships on page 210

Tasks

➤ Create CIs and Relationships in the CMDB on page 216

➤ Check Status of Application Discovery (Rediscover a View) on page 217

➤ Retrieve Impact Analysis Results – Scenario on page 220

➤ Take a Snapshot of a View on page 228

➤ Print and Save a Topology Map to File on page 228

Reference

➤ IT Universe Manager User Interface on page 229
201



Chapter 7 • IT Universe Manager
Concepts

IT Universe Manager Overview

IT Universe Manager enables you to manage the content of your IT Universe 
model. The following tasks represent the basic functionality of the 
application:

➤ Creating CIs without creating relationships. You can define new CIs that 
are added to the CMDB individually, so that no new relationships are 
created. For details, see "Creating a Non-Related CI" on page 207.

➤ Creating CIs with relationships for them. You can define new CIs and 
attach them to existing CIs, so defining a new CI and a new relationship 
in the CMDB. For details, see "Creating a Related CI" on page 207.

➤ Adding existing CIs and creating relationships for them. You can attach 
CIs to an existing CI, so creating new relationships for existing CIs. For 
details, see "Attaching Existing CIs" on page 212.

➤ Deleting CIs. You can delete CIs from the CMDB. For details, see "Deleting 
CIs" on page 208.

➤ Get Impact Analysis results. You can run the Impact rules you defined for 
a view to simulate how certain defined changes impact your system, and 
to discover the root causes of the changes. For more information about 
Impact rules, see "Impact Analysis Manager Overview" on page 440. 

➤ Take a snapshot of a view. HP Universal CMDB enables you to display the 
status of a view in one snapshot by comparison with its status taken at a 
different time. For details on how to take snapshots, see "Take a Snapshot 
of a View" on page 228.

Populating the IT Universe Model
The IT Universe model in the CMDB contains the CIs and relationships 
produced by the CI-generating tools that operate within HP Universal 
CMDB. Most CIs and relationships originate from one of the following 
sources:
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➤ Data Flow Management (DFM). Automatically creates CIs and 
relationships based on the discovered IT resources and topology in your 
company’s infrastructure. For details, see "Data Flow Management 
Overview" in the HP Universal CMDB Data Flow Management Guide.

➤ IT Universe Manager. Enables you to manually create CIs and 
relationships that represent logical and physical elements of the business. 
For details, see "Working with CIs" on page 206.

➤ Enrichment Manager. Enables you to add CIs and relationships to the 
CMDB by receiving data from the attributes of Enrichment query nodes 
as defined in the Enrichment TQL query. For details, see "Enrichment 
Manager" on page 507.

Working with Views in IT Universe Manager

In IT Universe Manager, you analyze data at the view level. Views are subsets 
of the IT Universe, containing only those CIs relating to a specific area of 
interest. All views are based on a pattern which determines the content of 
the view. 

➤ Pattern views and template-based views are built from a TQL (Topology 
Query Language) query that defines the structure of the view. The view 
displays only those CIs and relationships that satisfy the query definition. 

➤ Perspective-based views are built manually, by selecting a group of CIs 
and applying perspectives to them. A perspective is a pattern used to 
define which related CIs are included in the view. 

You build all views in the Modeling Studio, using the appropriate editor for 
each view type. For information on the different view types and how they 
function, see "View Formats" on page 268.

Note: You must have Change permissions for a view to edit the view. If you 
do not have the necessary permissions, contact your HP Universal CMDB 
Administrator.
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CIs created by DFM are automatically added to each view where the CIs (and 
their relationships) fit the TQL definition for the view. When you open a 
view in the CI Selector, the TQL query for the view queries the CMDB for CIs 
that match the defined pattern. If there are no matches (for example, in the 
case of a view for a DFM process where the process has not yet run) then the 
view remains empty.

When you define a new CI while working in any view in IT Universe 
Manager, the CI (and any associated relationship) is created in the CMDB. 
The CI is added to your current view only if it meets the view’s TQL 
specifications.

If the created CI and relationship do not meet the TQL requirements, then 
the CI and relationship are created in the CMDB but are not visible in the 
view. Similarly, if you attach an existing CI to a CI in the view, and the new 
pattern does not meet the TQL requirements, then the attached CIs do not 
appear in the view, but the relationship is still created.

Templates and Template-based Views
If you open a template in IT Universe Manager, it is displayed in the 
topology map like a pattern view. Click the Show Template Parameters 
button in the CI Selector toolbar to open the Template Parameter Values 
dialog box, where you can change the values of the template parameters and 
thereby affect the view results displayed in the topology map. You can try 
different parameter values and see the resulting topology map, but you 
cannot save changes to the template itself. To save the view results as a 
template-based view with the selected parameters, click the Save As View 
button in the Template Parameter Values dialog box.

View Lifecycle
If you do not access a view from the CI Selector for a specified period of 
time, the view is cleared out, to save memory in the system. It is not deleted 
from the CMDB; the view can be retrieved by clicking on it. The default time 
period for clearing out unused views is one hour. 
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Note: Views defined as persistent are not cleared out and always remain in 
the memory.

Hidden Views
You can designate a view as a hidden view that does not appear in 
IT Universe Manager by defining a bundle for hidden views and assigning 
the view to that bundle.

To designate a view as a hidden view:

 1 In the Infrastructure Settings Manager, select Hidden Bundles Names in CI 
Selector.

 2 Enter the name of the new bundle as the default value and save the 
setting.

 3 In the Modeling Studio, open the relevant view and click the View 
Definition Properties button in the toolbar. 

 4 In the View Definition Properties dialog box, select the hidden views 
bundle and assign the view to it. 

View Tree Structure

Views are organized in a hierarchical tree format in the left pane of 
IT Universe Manager, which is known as the CI Selector. The view name 
appears in the View box above the tree and acts as the containing folder for 
the CIs in the view. 

The first level of the CI Selector tree consists of the query nodes for the root 
CIs. A root CI is the starting point for a view subtree. A view may contain 
any number of subtrees. Under the root CIs come the branch CIs, expanding 
down to the leaf CIs as the last query nodes at the ends of each branch.
205



Chapter 7 • IT Universe Manager
The CIs at each level in a subtree are considered to be attached to the CI on 
the branch directly above. This attachment generally depicts a dependent 
relationship, so that the higher branch (closer to the root CI) represents a 
component of your business that depends on the CIs on the next branch 
down (closer to the leaf CIs) in the business process. For example, an 
application depends on the servers running the application.

The attachment between a higher and a lower query node is referred to as a 
parent-child relationship. The parent CI may have many attached child CIs, 
and the child CIs pass operational status to the parent.  

The tree topology is determined by the hierarchy defined for the view. In a 
pattern view, these are defined for the specific view. In a template-based or a 
perspective-based view, the hierarchy is defined as part of the template or 
perspective. For details on defining the hierarchy, see "Setting the View 
Hierarchy" on page 270.

Working with CIs

In IT Universe Manager, you can create related and non-related CIs, delete 
CIs, edit the CI properties, and remove out-of-date CIs using the aging 
mechanism. 

This section includes the following topics:

➤ "Creating a Non-Related CI" on page 207

➤ "Creating a Related CI" on page 207

➤ "Deleting CIs" on page 208
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➤ "CI Properties" on page 208

➤ "Removing Out of Date CIs Using the Aging Mechanism" on page 209

Creating a Non-Related CI
You can define a new CI in IT Universe Manager by clicking the New CI 
button in the toolbar. The New CI dialog box opens, which enables you to 
define the properties for the new CI. The CI is created in the CMDB. For 
details, see "New CI/New Related CI Dialog Box" on page 253. 

Note: The CI is added to the view only if it meets the specifications of the 
pattern, template, or perspective of the view. 

A CI created in this way is added as an independent entity without any 
relationship to any other existing CI in the CMDB. 

Creating a Related CI
You can define a new CI to be added as a parent, child, or sibling of an 
existing CI. 

To define a new related CI:

 1 Select the CI in your view to which you want to attach the new CI.

 2 Click the New Related CI button in the toolbar.

 3 In the New Related CI dialog box, define the properties and relationship 
for the CI. For details, see "New CI/New Related CI Dialog Box" on 
page 253.

The CI and relationship are created in the CMDB.

Note: The CI and relationship are added to the view only if they meet the 
specifications of the pattern of the view, template, or perspective. 
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Deleting CIs
You can delete a CI by selecting Delete from CMDB from the shortcut menu 
in IT Universe Manager. The CI is deleted from the CMDB and from all 
views. If the CI has children, they are not automatically deleted when you 
delete the parent CI. If you delete a CI without first deleting the relationship 
between the CI and any child CIs that appear with the parent CI in a view, 
the child CIs are removed from the view.

If the child CIs do not appear in any other view, they remain in the CMDB 
without appearing in a view. The child CIs might appear in the future in 
views where they meet the pattern requirements.

One exception to this rule is when the relationship between a child and 
parent CI is a Composition relationship; in that case, when the parent CI is 
deleted, the contained CI is also removed from the CMDB. For example, if a 
node CI is the container for a child CPU CI, then when the node CI is 
deleted, the CPU is also removed from the CMDB.

When you delete a CI that was created by the DFM process, the CI is 
restored the next time that DFM runs (if the CI is still valid), and it reappears 
in all relevant views.

CI Properties
In IT Universe Manager, you can edit the properties of a CI. The CI 
properties are divided into several categories which appear in the New CI 
dialog box:

➤ The general properties of a CI are common to all CIs. Some general 
properties are defined automatically during CI creation; others can only 
be defined manually in the New CI dialog box. 

➤ CIT-specific properties are created as part of the CIT definition in the CI 
Type Manager. The values for the CIT-specific properties are taken from 
the CIs discovered during DFM. The values can also be entered manually, 
when you manually create CIs to represent entities in your infrastructure. 
For details, see "CI Type Manager" on page 465.

➤ Key properties can be general or CIT-specific properties, which must be 
assigned a value to create an instance of the CI type.
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You can access the Configuration Item Properties dialog box to view the CI 
properties from IT Universe Manager by right-clicking the CI and selecting 
Properties or by clicking the Properties tab in the Advanced pane. You can 
also edit the CI properties if you have the necessary permissions for editing 
CIs. For details on CI properties, see "Configuration Item Properties Dialog 
Box" on page 233.

The CIT-specific properties are displayed in the Specific Properties section of 
the Configuration Item Properties dialog box when you sort the properties 
using the Categorized button. Some properties for the automatically created 
CIs can be edited, however, if the CI is configured to Allow CI Update (in the 
General Properties), then DFM may override your changes when it updates 
the CI. A description of the selected property can be found in the 
Description area at the bottom of the Configuration Item Properties dialog 
box.

Some of the CIT-specific properties for DFM CIs are set by default to be 
monitored for changes. When one of these properties has been modified, 
information on the change can be viewed in a CI change report. For more 
information, see "CI Change Report" on page 381.

Removing Out of Date CIs Using the Aging Mechanism
If a CI or relationship is not updated or refreshed over a period of time (for 
example, a CI is not rediscovered by DFM and no manual update occurs), an 
aging mechanism deletes the CI from the CMDB. For details, see "CI 
Lifecycle and the Aging Mechanism" in the HP Universal CMDB 
Administration Guide.
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Working with Relationships

Many of the relationships between CIs in the CMDB are created 
automatically, for example, by DFM. In addition, you can create 
relationships manually in IT Universe Manager, Enrichment Manager, 
Impact Analysis Manager, or the Modeling Studio.  

This section includes the following topics:

➤ "Creating Relationships" on page 210

➤ "Creating Hierarchical Relationships" on page 211

➤ "Attaching Existing CIs" on page 212

➤ "Setting the View Hierarchy" on page 213

➤ "Viewing Related CIs" on page 213

➤ "Deleting Relationships" on page 214

➤ "Inter-Layer Links" on page 214

Creating Relationships
You can create relationships by right-clicking a CI or multiple CIs in the CI 
Selector pane or the Topology Map and selecting Relate to CI from the 
shortcut menu. In the Topology Map, you can define a relationship between 
two CIs in the view by drawing a line between the two, using the Create 
Relationship button from the toolbar. Either of these actions opens the 
Insert Relationship dialog box. For details, see "Insert Relationship Dialog 
Box" on page 240.
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You can create as many relationships as necessary between a CI in the 
CMDB and other CIs. Each new relationship exists as its own entity in the 
CMDB, and has its own properties that can be edited in IT Universe 
Manager (as described in "Configuration Item Properties Dialog Box" on 
page 233). You can also create more than one relationship between the same 
two CIs, when each relationship is based on a different relationship type. In 
the following example, host7 has both a Backbone and a Talk relationship 
with switch3.

Creating Hierarchical Relationships
By attaching one CI to another in IT Universe Manager  you create a 
hierarchical relationship (parent-child) between them, so that one CI is 
influenced by the other. 
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Certain relationships defined in this way are restricted to the relationship 
type usage (if the relationship is between two non-monitoring CIs), or the 
relationship type Monitored By (if the child CI in the relationship is a 
monitor type CI); however, other relationship types are used between 
specific types of CIs. For example, if a relationship is defined between two 
node CIs, there are several possible relationship types. 

 

Note: When you attach a child CI to a parent CI, you are creating that 
relationship in the CMDB. The child therefore impacts on the parent CI in 
every view where the relationship exists, and is displayed in every view 
where the child and relationship match the TQL query. 

Attaching Existing CIs
You can attach existing CIs using the Insert Relationship dialog box. The 
dialog box has two modes:

➤ Selecting the CIs that you want to attach.

➤ Defining the relationship between the original CI and the CIs to attach. 
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When selecting the CIs to attach, you can select multiple CIs from a view to 
attach to the original CI. However, all CIs that you want to attach in one 
operation must have the same relationship type. For example, you cannot 
attach a CI that uses the relationship usage in the same operation as a CI 
that uses the relationship Monitored By.

Setting the View Hierarchy
After setting the query node and relationship definitions of a view, you can 
set a hierarchy for the view. This enables you to define the organizational 
structure of CIs in the view by displaying selected CIs at different levels. 
When no hierarchy is defined, the Topology Map or table displays all CIs 
included in the query results on one level by default. For example, if the 
query results include nodes and IP Subnets, both CI types are displayed on 
the same level in the Topology Map or table.

Note: The maximum number of CIs that can be displayed in a single layer of 
the Topology Map is 900. If a view contains a layer with more than 900 CIs, 
the view is not displayed in the Topology Map until the hierarchy is 
changed. However, a layer with more than 900 CIs can be displayed in a 
table in Text mode.

For details on setting the hierarchy, see "Setting the View Hierarchy" on 
page 270.

Viewing Related CIs
You can view all the CIs related to a selected CI in the topology map. Select 
a CI in a view and then select the Related in View tab. The topology map 
displays only the selected CI and its related CIs in the view (no matter where 
it is in the view hierarchy). Select the Related in DB tab to display the 
selected CI and all of its related CIs in the CMDB. 

You can also display Related CIs using the Related CIs Map. For details, see 
"Related CIs Map" on page 259.
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Deleting Relationships
The Topology Map shows only the relationships for the CIs that are part of 
the current view; however, the same relationships may also be part of other 
views. When you delete a relationship in IT Universe Manager, it is deleted 
from the CMDB and from all views.

When a relationship is deleted, the CI on the other end of the relationship 
may remain in the view, if it still matches the pattern of the view. However, 
if the deleted relationship is a composition link, the target CI is deleted with 
it.

In a perspective-based view, you can remove the CI completely from the 
view (without deleting it from the CMDB), by hiding it from the view in the 
Perspective-based View Editor in the Modeling Studio.

When you delete a relationship that was created by the DFM process, the 
relationship is restored the next time that DFM runs (if the relationship is 
still valid), and it reappears in all relevant pattern views.

It can take a few minutes to delete subtrees, or multiple CIs and 
relationships, from a view.

Inter-Layer Links
In certain circumstances, IT Universe Manager displays a relationship 
between CIs in a layer of a view that does not reflect an actual relationship 
between the CIs in that layer, but rather a relationship between CIs on 
deeper layers of the view. Such a relationship is known as an inter-layer link. 
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For example, in the following view, two node CIs are related to each other 
with a dependency link. Each is also related to an IP Subnet by a 
membership link and the view hierarchy is defined such that the nodes are 
on the layer beneath the IP Subnet. 

When you consume the view in IT Universe Manager, the link between the 
node CIs (which are under different IP Subnets) is displayed in the higher 
layer of the view as a link between the parent IP Subnets, even though the 
actual relationship only exists between the CIs in the lower layer of the 
view. You can double-click the link to display the full path between the IP 
Subnets.
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Tasks

Create CIs and Relationships in the CMDB

This task describes how to create related and non-related CIs, as well as 
relationships between CIs, in the CMDB.

This task includes the following steps:

➤ "Define a New Non-related CI" on page 217

➤ "Define a New Related CI" on page 217

➤ "Attach Existing CIs" on page 217
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Define a New Non-related CI

Click the New CI button in the toolbar. In the New CI dialog box, select a CI 
type from the tree and define the properties for the new CI. For details, see 
"New CI/New Related CI Dialog Box" on page 253.

Define a New Related CI

Click the New Related CI button in the toolbar. In the New Related CI 
dialog box, select a CI type from the tree and define the properties for the 
new CI. On the Relationship page of the dialog box, select the type of 
relationship and define its properties. For details, see "New CI/New Related 
CI Dialog Box" on page 253.

Attach Existing CIs

Select a CI in a view. Right-click the CI and select Relate to CI. In the Insert 
Relationship dialog box, select a target CI. On the Relationship page of the 
dialog box, select the type of relationship and define its properties. For 
details, see "Insert Relationship Dialog Box" on page 240.

Check Status of Application Discovery (Rediscover a 
View)

You, the application owner or administrator, need to be kept informed of 
any problems to your application. So, for example, you need to know that 
discovery is working correctly and that its current configuration can 
connect to the application database. This section explains how to run the 
rediscovery procedure that enables you to check the current status of the 
discovery of an application.

Note: 

➤ Set up and configuration is performed by the UCMDB administrator. For 
details, see "Prerequisites" on page 218.

➤ Rediscovery is performed by the application owner/administrator. For 
details, see "Access the View" on page 219.
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➤ You do not need any knowledge of Data Flow Management (DFM) to run 
this procedure.

➤ By default, you can run the rediscovery procedure on views that include 
less than 10,000 CIs. For details on changing this number, see "Important 
information" on page 238.

This task includes the following steps:

➤ "Prerequisites" on page 218

➤ "Access the View" on page 219

➤ "View Results in the View" on page 219

➤ "Schedule the Rediscovery" on page 220

 1 Prerequisites

Note: This step is performed by the UCMDB administrator.

 a In DFM, create a module that contains the jobs that must discover the 
application. For details, see "Discovery Control Panel – Advanced 
Mode Workflow" in the HP Universal CMDB Data Flow Management 
Guide. 

 b Activate the module and all the jobs. The jobs must remain activated.

 c Verify that the module has run without errors. For details, see "Error 
Messages Overview" in the HP Universal CMDB Developer Reference 
Guide and "Discovery Status Pane" in the HP Universal CMDB Data Flow 
Management Guide. 

 d Correct any errors in the application and confirm that DFM finds no 
errors during the next run. 
218



Chapter 7 • IT Universe Manager
Caution: The application owner cannot rediscover a view if DFM is 
reporting errors. You must set an error-free baseline.

 e In the Modeling Studio, define a view that includes the application CI 
or CIs to be rediscovered. These are the CIs that are created when you 
activate the jobs that discover the application. For details, see "Create a 
Pattern View" on page 285. 

 f Notify the application owner of the name of the view. 

 2 Access the View

Note: This step is performed by the application owner/administrator.

In IT Universe Manager, access the view that includes the application CIs 
to be rediscovered. For details, see "Search for CIs in Search Mode" on 
page 145. 

 3 View Results in the View

 a You need to check the complete application. You click the Show 
Discovery and Changes Summary button in the CI Selector toolbar. 
The Show Discovery Status and Changes of View dialog box is 
displayed. The dialog box displays information about which jobs and 
trigger CI discovered the CIs in the view, on the last occasion that DFM 
ran the discovery for the jobs. For details, see "Discovery and Changes 
Summary Dialog Box" on page 238.

To run the discovery, click the Rerun Discovery button. To view 
information about the jobs and trigger CIs, use the links to drill down. 
For details, see "Error Messages Overview" in the HP Universal CMDB 
Developer Reference Guide.
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 b You need to check specific components of your application. You select 
the component’s CI in the Topology Map pane and display the 
Discovery tab in the Advanced pane. For details, see "Discovery and 
Changes Summary Dialog Box" on page 238.

To rediscover several CIs, press CTRL, select the CIs and display the 
Discovery tab.

To run the discovery, click the Rerun Discovery button.

 4 Schedule the Rediscovery

You can schedule how often the rediscovery procedure should run. In the 
Job Definition window, choose the Rerun Discovery on View action. For 
details, see "Job Definition Dialog Box" on page 86.

Retrieve Impact Analysis Results – Scenario

Impact Analysis Manager enables you to create an Impact rule that allows 
you to simulate the impact certain infrastructure changes have on your 
system. The results of the Impact rule are displayed in IT Universe Manager. 
The Impact Analysis results in this task describe how a change in CPU 
operation impacts the node to which it is connected.

This task includes the following steps:

➤ "Define an Impact Analysis TQL Query" on page 221

➤ "Define an Impact Rule" on page 221

➤ "Create a View in the Modeling Studio" on page 223

➤ "Get Impact Analysis Results" on page 223
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 1 Define an Impact Analysis TQL Query 

To define an Impact Analysis TQL query, you need to create an Impact 
rule and then add the TQL query nodes and relationships that define the 
query.

To create an Impact Analysis TQL query, select Managers > Modeling > 
Impact Analysis Manager. For details about how to add query nodes and 
relationships to a query, see "Add Query Nodes and Relationships to a 
TQL Query" on page 28.

Example of an Impact Analysis TQL Query:

In this Impact Analysis TQL query, a CPU and a node are linked by a 
Composition relationship.

 2 Define an Impact Rule

When you define an Impact rule, you must specify the required causal 
relationship between the query nodes. Define one query node as the 
trigger, or the query node that represents the changes you want to make 
to the system, and another query node as the one that is impacted. 

Right-click the query node you want to define as the trigger and select 
Define Impacted to open the Impacted Query Nodes dialog box. Select 
the query node you want the trigger query node to impact. Then click the 
Add button to open the Impact Rules Definition dialog box to set 
conditions for defining impacted query nodes. For details about how to 
define an Impact rule, see "Impact Rules Definition Dialog Box" on 
page 457. 
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Note: The change state option in the Impact rule definition is no longer 
relevant for Impact Analysis. The only supported state is operation.

Example of an Impact Rule:

The Conditions area in the Impact Rules Definition dialog box defines the 
conditions under which the simulated change in the system is triggered. 
The Severity area defines the severity of the impact on the impacted query 
node.

The Impact rule in this example states that when the CPU operation is 
not in the normal state, the node is impacted. Since the severity is set to 
100% of the trigger’s severity, the severity of the node is the same as the 
severity of the CPU, which is determined when Impact Analysis is run.
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In the resulting TQL query, an upward arrow appears next to the query 
node defined as the trigger query node and a downward arrow appears 
next to the query node defined as the impacted query node.

 3 Create a View in the Modeling Studio

Go to the Modeling Studio and create a view matching the TQL query of 
the Impact rule you defined. For details, see "Pattern View Editor" on 
page 333.

 4 Get Impact Analysis Results

Select Managers > Modeling > IT Universe Manager and select the 
required view in the CI Selector. To get Impact Analysis results, you need 
to run the Impact rule on a CI instance in the topology map that is a 
trigger. Right-click a trigger CI and select Run Impact Analysis to open the 
Run Impact Analysis dialog box. For details on how to run an Impact rule, 
see "Run Impact Analysis Dialog Box" on page 260.
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Example for Getting Impact Analysis Results:

An Impact Analysis TQL query is created containing a CPU and node 
connected by a Composition relationship. The CPU query node is defined 
as the trigger query node and the query node of type node is defined as 
the impacted query node.

The following Impact rule is defined for the query.
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Right-click a CPU CI in the view, and select Run Impact Analysis to open 
the Run Impact Analysis dialog box. Set the trigger severity to a value 
other than Normal.
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To see results, click one of the following:

➤ Show in Views. This assigns a status to all the CIs in the view. Only the 
node CI connected to the CPU CI (whose severity was changed), 
becomes impacted. The trigger CI and the impacted CI turn orange 
because the trigger severity was set as Major (7) on the scale in the Run 
Impact Analysis dialog box, which is assigned an orange color. 

➤ Show Map. A map appears in a separate window containing only the 
trigger CPU CI and the node CI it impacted. The relationship 
connecting the two CIs contains the name of the Impact rule defined 
in Impact Analysis Manager. 
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Note: Optionally, you can create a URL that enables you to embed the 
map. For details, see "Direct Link Parameters – Impact Map Page" on 
page 120.

➤ Generate Report. Generates an Impact Analysis report that displays a 
list of CIs that are impacted in the system as a result of the simulated 
changes. For details, see "Run Impact Analysis Dialog Box" on 
page 260.
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Take a Snapshot of a View

You can take a snapshot of a view in IT Universe Manager, save it, and then 
compare snapshots of the same view taken at different times using the 
Compare Snapshots Report. For details on how to take a snapshot of a view, 
see "Save Snapshot Dialog Box" on page 262. For details on how to view 
actual differences in the compared views, see "Compare Snapshots Report" 
on page 393.

Print and Save a Topology Map to File

You can print the content of any topology map and then save it to file. 
Before printing, it is recommended to define your print settings and arrange 
the contents of the topology map according to your requirements. For 
details on how to define print settings, see "Print Setup Dialog Box" on 
page 187. For details on how to preview the content of the topology map 
before printing, see "Print Preview Dialog Box" on page 187. For details on 
how to print the content of a topology map, see "Print Dialog Box" on 
page 186. For details on how to save a topology map to file, see "Run Impact 
Analysis Dialog Box" on page 260.
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Reference

IT Universe Manager User Interface

This section includes (in alphabetical order):

 ➤ Change Timeframe Dialog Box on page 230

 ➤ CI/Relationship History Dialog Box on page 231

 ➤ Configuration Item Properties Dialog Box on page 233

 ➤ Discovery and Changes Summary Dialog Box on page 238

 ➤ Insert Relationship Dialog Box on page 240

 ➤ IT Universe Manager Page on page 244

 ➤ New CI/New Related CI Dialog Box on page 253

 ➤ Related CIs Map on page 259

 ➤ Run Impact Analysis Dialog Box on page 260

 ➤ Save Snapshot Dialog Box on page 262

 ➤ Show Impact Pane on page 263
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Change Timeframe Dialog Box

This dialog box enables you to display changes in the topology map and set 
the time frame for the changes to display. 

User interface elements are described below:

To access Select Managers > Modeling > IT Universe Manager. Click 
the Set Change Timeframe button  in the main 
toolbar or the IT Universe status bar.

Important 
information

When the change indicators are displayed in the topology 
map, a message appears in the IT Universe status bar 
Change Timeframe is Active.

To hide the indicators, open the dialog box and select Do 
not display changes, or select the Reset Change 
Timeframe button  in the IT Universe status bar.

UI Elements (A-Z) Description

Display changes 
according to the 
selected timeframe

Select this option to display an indicator next to each CI 
that was added or changed within the selected period as 
follows:

➤  Indicator for an added CI

➤  Indicator for a changed CI

Select a time period from the drop-down list. The changes 
to the CIs of the view within this period are displayed in 
the map.

When the indicators are displayed, you can click the 
indicator to open the CI History dialog box, which 
displays the history for the CI over the selected period.

Do not display 
changes

Select this option to hide the change indicators.
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CI/Relationship History Dialog Box

This dialog box displays a list of attributes in which changes have occurred 
as well as the differences between two configuration files. 

User interface elements are described below:

To access ➤ In IT Universe Manager, right-click the selected CI or 
relationship in the CI Selector or the Topology Map 
and select CI History.

➤ In Data Flow Management, in the Discovered by 
[Module or Job Name] CIs dialog box, right-click a CI 
and choose CI History. 

UI Elements (A-Z) Description

Click Refresh to refresh the data in the table.

View the difference between two configuration files. 
Select two CIs of type configfile and click the Show 
difference button to open the Visualdiff report, which 
displays a comparison of the two files. Text added to the 
second file appears highlighted in yellow. Text removed 
from the first file appears highlighted in red. Differences 
between the files appear highlighted in green. 
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Choose the export format for the table data. The available 
options are: 

➤ Excel. The table data is formatted as an .xls (Excel) file 
that can be displayed in a spreadsheet.

➤ PDF. The table data is exported in PDF format.

➤ RTF. The table data is exported in Rich Text Format.

➤ CSV. The table data is formatted as a comma-separated 
values (CSV) text file that can be displayed in a 
spreadsheet.

Note: For the CSV formatted table data to display 
correctly, the comma (,) must be defined as the list 
separator. In Windows, to verify or modify the list 
separator value, open Regional Options from the 
Control Panel, and on the Numbers tab ensure that the 
comma is defined as the List Separator value. In Linux, 
you can specify the list separator in the application 
that opens the CSV file.

➤ XML. The table data is formatted as an XML file that 
can be opened in a text or XML editor. 

Tip: To extract HTML code from the report: 

➤ Save the file as HTML

➤ Open the file in an HTML editor

➤ Copy the relevant table into the target file 

Attribute The name of the attribute.

Change Date The date when the last change occurred.

Filter by Filter the data in the table by one or more of the 
following filters:

➤ Time Range. Select the time period for which the CI 
history is displayed.

➤ Change Type. Select the type of changes displayed in 
the table.

➤ Attribute. Select the attribute types displayed in the 
table.

UI Elements (A-Z) Description
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Configuration Item Properties Dialog Box

This dialog box enables you to view and edit basic information for an 
existing CI or relationship.

Modified By Indicates the cause of the change. For example, the field 
can contain the name of a user or a DFM job.

New Value The new value of the attribute.

Old Value The previous value of the attribute.

To access Select Managers > Modeling > IT Universe Manager and use 
one of the following:

➤ Select a CI in the topology map or the CI Selector. In the 
Advanced Pane, select the Properties tab and click Edit. 

➤ Right-click a CI in the CI Selector or the Topology map 
and select Properties.

UI Elements (A-Z) Description
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User interface elements are described below:

Important 
information

The Configuration Item Properties dialog box contains two 
types of properties: 

➤ General properties, which include general information 
about the CI or relationship. These properties are 
common to all CITs and are documented below.

➤ CIT-specific properties, which include properties specific 
to that CI. These properties vary according to the type of 
CI or relationship and are not documented .

When you sort the properties by category, the CIT-specific 
properties appear at the top of the list and the general 
properties appear at the bottom.

You can view a description of the selected property in the 
Description Area at the bottom of the dialog box. Click the 
Show/Hide Description Area button to display the 
Description Area.

Mandatory fields are denoted by an asterisk.

See also "CI Lifecycle and the Aging Mechanism" in the HP Universal 
CMDB Administration Guide

UI Elements (A-Z) Description

Click to display the properties by category.

Click to display the properties alphabetically.

Toggles between showing and hiding the description area at 
the bottom of the CI Properties dialog box.

Click Expand to expand the properties tree when the 
properties are displayed by category.

Click Collapse to collapse the properties tree when the 
properties are displayed by category.
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Choose the export format for the table data. The available 
options are: 

➤ Excel. The table data is formatted as an .xls (Excel) file 
that can be displayed in a spreadsheet.

➤ PDF. The table data is exported in PDF format.

➤ RTF. The table data is exported in Rich Text Format.

➤ CSV. The table data is formatted as a comma-separated 
values (CSV) text file that can be displayed in a 
spreadsheet.

Note: For the CSV formatted table data to display 
correctly, the comma (,) must be defined as the list 
separator. In Windows, to verify or modify the list 
separator value, open Regional Options from the Control 
Panel, and on the Numbers tab ensure that the comma is 
defined as the List Separator value. In Linux, you can 
specify the list separator in the application that opens 
the CSV file.

➤ XML. The table data is formatted as an XML file that can 
be opened in a text or XML editor. 

Tip: To extract HTML code from the report: 

➤ Save the file as HTML

➤ Open the file in an HTML editor

➤ Copy the relevant table into the target file 

Actual Deletion 
Period

The number of days after which the CI or relationship is 
deleted.

Allow CI Update When selected, this option allows the DFM process to 
automatically update the CI or relationship properties with 
information that it discovers. If you change the value of a 
property supplied by the DFM process, the value is 
overridden by the discovered value.

When this option is cleared, the CI or relationship 
properties are not overridden by the DFM process.

Apply Click Apply to save the changes made to the CI or 
relationship properties.

UI Elements (A-Z) Description
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CI Type The type of the CI or relationship (read-only value). For 
information about CITs in HP Universal CMDB, see "CI 
Type Manager" on page 465.

Created By The user name of the administrator who manually created 
the CI or relationship, where applicable (read-only value).

Create Time The date and time when the CI or relationship was created.

Deletion 
Candidate Period

The period after which the CI becomes a candidate for 
deletion when the aging mechanism is enabled.

Description A brief description of the CI or relationship.

Display Label The name of the CI or relationship as it appears in the CI 
Selector.

Edit In the Properties tab of the Advanced pane, you can view a 
CI’s properties but you cannot edit them. Click Edit to open 
the Configuration Item Properties dialog box where you can 
edit the properties.

Enable Aging If a CI or relationship is not updated or refreshed over a 
period of time (for example, a CI is not rediscovered by DFM 
and no manual update occurs), an aging mechanism deletes 
the CI from the CMDB. For details, see "CI Lifecycle and the 
Aging Mechanism" in the HP Universal CMDB Administration 
Guide.

True: the aging mechanism is enabled for this CI or 
relationship.

Default value: false. The default value for DFM CIs is true.

Note: 

➤ If the aging mechanism is disabled, this field is ignored.

➤ This field is displayed for certain CIs only.

Global Id The internal ID of the CI or relationship in the CMDB (read-
only value).

UI Elements (A-Z) Description
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Shortcut Menu

Last Access Time The time that the CI or relationship was last accessed, 
whether when being updated or being discovered by DFM. 
This field is only displayed for certain CIs or relationships.

This parameter is used by the aging mechanism. For details, 
see "CI Lifecycle and the Aging Mechanism" in the HP 
Universal CMDB Administration Guide.

Last Modified 
Time

The date and time when the CI or relationship properties 
were last updated.

Name The name of the CI or relationship.

Note Enables you to enter other information about the CI or 
relationship.

Origin An ID for the source that automatically created the CI or 
relationship, or the application where the CI or relationship 
was created (read-only value).

Reset Click the Reset button to restore the original property 
settings of the CI or relationship.

Updated by The user name of the administrator who updated the CI or 
relationship properties.

User Label Enables you to define a display label for the CI or 
relationship. If no value is entered, the CI name appears as 
the default label.

Menu Item Description

Copy Property Name Copies the name of the selected property to the memory.

Copy Property Value Copies the value of the selected property to the memory.

UI Elements (A-Z) Description
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Discovery and Changes Summary Dialog Box

This dialog box enables you to find recent changes, for example, to an 
application, by rediscovering the CIs and jobs in a view.

To access In IT Universe Manager:

➤ To rediscover all CIs of a view, click the Show 
Discovery and Changes Summary button  in the CI 
Selector toolbar. The Discovery and Changes Summary 
dialog box is displayed.

➤ To rediscover one CI or several CIs in a view, select the 
CI and display the Discovery tab in the Advanced 
pane.

To rediscover CIs, you can also select Operations > Show 
Discovery and Changes Summary.

Important 
information

By default, you can run the rediscovery procedure on 
views that include less than 10,000 CIs. 

To increase the number of CIs that you can rediscover in 
a view:
1  Access the Infrastructure Settings Manager 

(Administration > Infrastructure Settings Manager).

2  Select the Max CIs in view supported to rediscover 
setting in the infrastructure settings table. 

3  Click the Value column and change the number.

4  Restart the server for the change to take effect.

For details on working with the Infrastructure Settings 
Manager, see "Infrastructure Settings" in the HP Universal 
CMDB Administration Guide.

Relevant tasks "Check Status of Application Discovery (Rediscover a 
View)" on page 217

See also "Discovery Status Pane" in HP Universal CMDB Data Flow 
Management Guide
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User interface elements are described below:

UI Elements (A-Z) Description

Click to refresh the status of the selected CIs.

This button is disabled when there is no data to be 
reloaded.

Click to rerun the discovery.

Discovery Progress 
Status on View

For details, see "Discovery Status Pane" in the HP 
Universal CMDB Data Flow Management Guide.

History Changes on 
View

For details, see "CI/Relationship History Dialog Box" on 
page 231.
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Insert Relationship Dialog Box

This dialog box enables you to attach CIs to the CI you selected in the CI 
Selector.

User interface elements are described below:

To access In IT Universe Manager, right-click a CI in the Topology 
Map or the CI Selector, and select Relate to CI.

Important 
information

To create a relationship between two CIs, select the source 
CI in the CI Selector or the Topology Map and then select 
Relate to CI from the shortcut menu. On the first page of 
the dialog box (the CI Selection page), you select the target 
CI(s). Then click Relationship, to select the relationship type 
on the second page of the dialog box.

You can also create a relationship between two CIs 
graphically by clicking the Create Relationship button  
in the toolbar and drawing a line between the two CIs. In 
this case, a smaller version of the Insert Relationship dialog 
box opens, which contains the following tabs:

➤ Select Relationship. Displays a tree with the available 
relationship types. Select the required relationship.

Note: You can double-click the relationship you select to 
save using the default properties.

➤ Relationship Properties. Displays the properties of the 
selected relationship. You can edit the properties as 
described in "Define Relationship Properties Pane" on 
page 242.

Relevant tasks "Create CIs and Relationships in the CMDB" on page 216

See also "CI Selector" on page 151

UI Elements (A-Z) Description

Click to add the selected CIs in the left pane to the Target 
CIs pane.

Click to remove selected CIs from the Target CIs pane (this 
does not delete the CIs from the CMDB).
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Relationship Page
This page enables you to define the relationship to be created between the 
original CI and the CIs selected in the CI Selection page of the dialog box.

User interface elements are described below:

Select Relationship Pane

Select target CIs Select a view to display in the view tree and select CIs to 
move to the Target CIs pane.

For details on the Select target CIs pane, see "CI Selector" on 
page 151. 

Source CI The CI you selected as the source CI.

Target CIs Displays the CIs you have selected as target CIs for the 
relationship.

To access Click the Relationship button from the Insert Relationship 
dialog box.

Important 
information

When defining multiple relationships, you can define 
different descriptions and property values for each 
relationship. Skip the property definitions here and edit 
each relationship individually after it is created.

UI Elements (A-Z) Description

Direction Select the direction of the relationship.

For some relationship types (for example, Composition, or 
between a group CI and a monitor CI), only one direction is 
valid. 

Relationship Define the type of relationship created between the original 
CI and the CIs being attached. Select an option from the 
list. 

UI Elements (A-Z) Description
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Define Relationship Properties Pane

Source CI Displays the name of the CI on the first end of the 
relationship. This is the CI that you selected in the view.

Target CI Displays the name of the CI on the second end of the 
relationship, that is attached to the original CI.

UI Elements (A-Z) Description

Actual Deletion 
Period

The period after which the relationship is deleted when the 
aging mechanism is enabled.

Allow CI Update When the value is set to true, the DFM process 
automatically updates the relationship.

Created By The user name of the administrator who manually created 
the relationship, where applicable.

Create Time The date and time when the relationship was created.

Deletion 
Candidate Period

The number of days after which the relationship becomes a 
candidate for deletion.

Description A detailed description of the relationship.

Destination 
Network Address

Defined only for route links. Indicates the destination 
network address to which this route is configured.

Enable Aging If a CI or relationship is not updated or refreshed over a 
period of time (for example, a CI is not rediscovered by DFM 
and no manual update occurs), an aging mechanism deletes 
the CI from the CMDB. For details, see "CI Lifecycle and the 
Aging Mechanism" in the HP Universal CMDB Administration 
Guide.

True: the aging mechanism is enabled for this CI or 
relationship.

Default value: false. The default value for DFM CIs is true.

Note: 

➤ If the aging mechanism is disabled, this field is ignored.

➤ This field is only displayed for certain CIs.

UI Elements (A-Z) Description
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Last Access Time The time that the relationship was last accessed, whether 
when being updated or being discovered by DFM. This field 
is displayed only for certain CIs.

This parameter is used by the aging mechanism. For details, 
see "CI Lifecycle and the Aging Mechanism" in the HP 
Universal CMDB Administration Guide.

Last Modified 
Time

The date and time when the relationship properties were 
last updated.

Must When the value is set to true, the child CI is dominant when 
the percentage rule is used to calculate status for the parent 
CI. If the CI has low status, the parent must take the child 
CI status, if necessary overriding the percentage rule 
calculation. This is useful to give emphasis to an important 
CI. For example, you might want to define Must for a 
database CI, so that status is critical all the way up the 
subtree if the database falls, regardless of the status of the 
other CIs in the subtree.

The must status defined for a relationship applies for that 
relationship only – it is not used in any other relationships 
of the child CI. 

Name A brief description of the relationship. If no value is entered, 
the relationship type is used in place of the name.

Note Enables you to enter other information about the 
relationship.

Origin An ID for the source that automatically created the 
relationship, or the application where the relationship was 
created.

Updated By The user name of the administrator who updated the CI 
properties.

UI Elements (A-Z) Description
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IT Universe Manager Page

This page enables you to define and manage the CIs and relationships in 
your views.

User Label Enables you to define a display label for the relationship. If 
no value is entered, the relationship name appears as the 
default label.

Weight When a weight value is entered, the child CI is given more 
weight in percentage calculations, when percentage rule is 
used to calculate status for the parent CI. For example, if a 
child CI is given a weight of 3, then it has three times more 
impact on the parent status calculation than its unweighted 
siblings.

The weight defined for a relationship applies for that 
relationship only – it is not used in any other relationships 
the child CI may have. 

To access Select IT Universe Manager from the Navigation Menu or 
select Managers >  Modeling > IT Universe Manager.

Important 
information

The IT Universe Manager page contains the following 
panes:

➤ CI Selector. Displays the CIs of a selected view. You can 
select the view from a drop–down list or search for a 
specific CI. For details, see "CI Selector" on page 151.

➤ Topology Map. Displays the CIs of a selected view in 
Map mode or Text mode.

➤ Advanced Pane. Displays properties, history, and 
discovery for the selected CI or view.

In IT Universe Manager, you can create new CIs, modify 
existing CIs, or delete CIs. All of these actions have a 
direct effect on the entire IT Universe model. For 
example, if you delete a CI in your view, that CI is deleted 
from the IT Universe model and no longer appears in any 
view.

UI Elements (A-Z) Description
244



Chapter 7 • IT Universe Manager
Topology Map

This area displays the CIs of the currently selected view in graphical or table 
format. By default, the CIs are displayed in graphical format.

To access Select Managers >  Modeling > IT Universe Manager.

Important 
information

When you select a CI in the CI Selector or the Topology 
Map, the Configuration Items drop-down in the Main 
Menu becomes active. The options available under that 
drop-down are the same as those available by right-
clicking the CI.

You can customize the Topology Map shortcut menu to 
include other commands (for example, ping, run a 
program, open a URL) from within CI Type Manager. For 
details, see "Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard" on 
page 486.

Note: For grouped CIs and the relationships between 
them, not all of the shortcut menu options are active. 
Grouped CIs appear in parentheses in the CI Selector and 
in the Topology Map. You can double-click a link to a 
grouped CI to open the Link Map, which displays the 
individual CIs and relationships. Right-click a CI or 
relationship in the Link Map to display the regular 
shortcut menu. For details about grouping CIs, see "Query 
Node Grouping Dialog Box" on page 344.

See also "Working with Topology Map" on page 163
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

Specify the CIT you want displayed in the table. The table 
also includes the children of the selected CIT.

Note: This option is displayed in Text mode only.

<Breadcrumbs> At the top of the topology map, the breadcrumbs indicate 
the relevant query nodes in each layer of the view for the 
path to the selected layer. The first item in the path is the 
Top Layer. When you select a CI from the layer below, the 
parent CI forms the next item in the breadcrumb path. 
You can click on any item in the path to display that layer 
in the topology map.

<CI type attributes> The columns appearing in Text mode represent the CIT 
attributes of the selected CIs.

<IT Universe Status 
Bar>

The status bar below the topology map indicates the 
status of the following processes:

➤ if Impact Analysis is active or not

➤ if Change Timeframe is active or not

➤ if Candidates for Deletion are shown or not

➤ the time of the last update of the data
246



Chapter 7 • IT Universe Manager
<Legend> Indicates the icons displayed next to CIs with any of the 
following special statuses:

➤ Added. When Change Timeframe is active, indicates 
that the CI was added.

➤ Impacted. When Impact Analysis is active, indicates an 
impacted CI.

➤ Impacted and Trigger. When Impact Analysis is active, 
indicates a trigger CI that is impacted.

➤ Candidate for Deletion. Indicates that the CI is a 
candidate for deletion.

➤ Changed. When Change Timeframe is active, indicates 
that the CI was changed.

➤ Note. Indicates that a note was added for the CI.

➤ Trigger. When Impact Analysis is active, indicates a 
trigger CI.

<Main Menu> For details, see "Main Menu" on page 185.

<Query Node> The query nodes in the topology map represent CIs.

Hold the pointer over a query node to display its tooltip 
which describes the type of the CI.

<Relationship> The links in the topology map represent relationships.

Hold the pointer over a relationship to display its tooltip, 
which describes the type of the relationship.

Note: When you select a calculated relationship, the 
Delete  button in the toolbar is disabled. 

<Toolbar> For details, see "Toolbar Options" on page 189.

Note: When accessing the Topology map via direct links, 
the toolbar includes options from the Related CIs Map. 
For details, see "Related CIs Map" on page 259.

<Topology Map 
Sidebar>

For details, see "Topology Map Sidebar" on page 197.

UI Elements (A-Z) Description
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Get Related CIs Click to redraw the topology map to display the CIs 
related to the selected CI. The topology map is redrawn 
according to the selections in Select Options.

Note: This option appears in the Get Related CIs toolbar, 
which is only relevant when the Related in View or 
Related in DB tabs are selected. Click the Get Related CIs 
button  to display the toolbar.

Map Click Map to display the selected layer of CIs in topology 
map format.

Note: If the selected layer of the view is too large to 
display in topology map format, a message appears with a 
link to display the layer in text format.

Related in DB Click the Related in DB tab to display the 
interdependencies of the selected CI within the entire 
CMDB.

Related in View Click the Related in View tab to display the 
interdependencies of the selected CI within the current 
view.

Select options Select the required state for each of the following options:

➤ Filter related CIs. When this option is selected, Get 
Related CIs opens the Filter Related CIs dialog box 
before displaying the related CIs. When it is not 
selected, Get Related CIs automatically displays all 
related CIs.

➤ Clear before execution. When this option is selected, 
Get Related CIs clears the current content of the 
topology map before displaying the related CIs. When 
it is not selected, it adds the related CIs to the current 
topology map.

Note: This option appears in the Get Related CIs toolbar, 
which is only relevant when the Related in View or 
Related in DB tabs are selected. Click the Get Related CIs 
button  to display the toolbar.

UI Elements (A-Z) Description
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Select scope Indicates the selected mode of the topology map:

➤  Related in View mode.

➤  Related in DB mode.

Note: This option appears in the Get Related CIs toolbar, 
which is only relevant when the Related in View or 
Related in DB tabs are selected. Click the Get Related CIs 
button  to display the toolbar.

Text Click Text to display the attribute properties of the CIs in 
the selected layer in table format.

For details on some of the toolbar icons in Text Mode, see 
"Element Instances Dialog Box" on page 73.

View Results Click the View Results tab to display an entire layer 
within a view.

UI Elements (A-Z) Description
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IT Universe Manager Shortcut Menu

The IT Universe Manager page includes the following elements (listed 
alphabetically) available by right-clicking a CI or relationship in the CI 
Selector pane or the Topology Map:

Menu Item Description

Actions Select one of the following options:

➤ Add CI to Discovery Job. Displays the Add CI to 
Discovery Job dialog box, which enables you to 
manually invoke a DFM job for the selected CI. You 
can use this option to discover additional information 
about the CI through one of the available DFM jobs.

➤ Remove CI from Discovery Job. Displays the Remove 
CI from Discovery Job dialog box, which enables you 
to manually remove a CI from the DFM job.

➤ Open Credentials Information. Displays the Protocol 
Parameters dialog box, which enables you to enter 
credentials for the selected CI. This option is only 
relevant for CIs that require credentials to be viewed. 
For details, see "Domain Credential References" in the 
HP Universal CMDB Data Flow Management Guide.

➤ Show Discovery status. Opens the Discovery Status 
dialog box for the selected CI.

CI/Relationship 
History

Displays the CI History dialog box. For details, see 
"CI/Relationship History Dialog Box" on page 231.

Compare CIs Report Run a Compare CIs Report for the selected CI. For details, 
see "Compare CIs Report" on page 387.

Delete from CMDB Enables you to delete the selected CI or relationship from 
the view and from the CMDB.

Note: When you delete a parent CI, the selected CI and 
its children are removed from the view, but only the 
selected CI is removed from the database.
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Get Related CIs The following options are available:

➤ From View. Opens the Related CIs in View Map.

➤ From Database without Filter. Opens the Related CIs in 
Database without Filter Map.

➤ From Database with Filter. Opens a dialog box that 
displays the number of related CIs by type. Select the 
CI type you want to display in the Related CIs Map 
and click OK.

Label Select one of the following options:

➤ Edit Label. Opens the Edit Label dialog box which 
enables you to edit the name of the CI.

➤ Restore Default Label. Resets the CI name to its default 
value from the CMDB.

Note Select one of the following options:

➤ Add Note. Opens an editing box where you can add a 
note to the CI.

➤ Delete Note. Deletes all text saved in a note for the 
selected CI.

Properties Displays the Properties page for the selected CI or 
relationship. For details, see "Configuration Item 
Properties Dialog Box" on page 233.

Relate to CI Opens the Insert Relationship dialog box. For details, see 
"Insert Relationship Dialog Box" on page 240.

Run Impact Analysis Enables you to run the Impact rule you defined in the 
Impact Analysis Manager. Displays the Run Impact 
Analysis dialog box. For details, see "Impact Analysis 
Manager" on page 439.

Note: You can only see Impact Analysis results if you 
defined an Impact rule for that view in Impact Analysis 
Manager. 

Show Compound 
Path

Appears only for compound relationships. Displays the 
Link Map for the selected relationship, which shows the 
CIs involved in the compound relationship.

Menu Item Description
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Show Impact Enables you to select a CI that is defined by an Impact 
rule as a root cause CI, and to display all the CIs that are 
impacted by it, and their statuses, in a separate window.

This option appears only after the following has occurred:

➤ You defined an Impact rule for the selected view in 
Impact Analysis Manager (for details, see "Impact 
Analysis Manager" on page 439).

➤ You clicked Show in Views in the Run Impact Analysis 
dialog box. 

➤ Impact Analysis results appear in the Topology Map.

For example, suppose an Impact rule is defined (for an IP 
Address CI) that specifies that the rule impacts nodes, 
ports, and client-servers linked to the IP Address.

By using the Show Impact option, you can display all CIs 
that are impacted by the IP Address CI.

Show Root Cause This option enables you to retrieve root cause 
information for CIs that are impacted by a chain of 
Impact rules. The output of Show Root Cause displays a 
logical map that describes a chain of trigger/impacted 
CITs that impact the CI.

The root cause CI is displayed in a separate window. If 
only one Impact rule is defined for this CI, the Impact 
Analysis window is directly displayed.

This option appears only after the following has occurred:

➤ You defined an Impact rule for the selected view in the 
Impact Analysis Manager (for details see, "Impact 
Analysis Manager" on page 439).

➤ You clicked Show in Views in the Run Impact Analysis 
dialog box. 

➤ Impact Analysis results appear in the Topology Map.

A window is displayed containing the root cause CI and 
all the other CITs in the Impact rule chain.

To view the information about specific CIs that are 
triggered or impacted by the Impact rule, double-click the 
relationship connecting the CIs. A map is displayed.

Menu Item Description
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Advanced Pane

User interface elements are described below:

New CI/New Related CI Dialog Box

This dialog box enables you to define a new CI or a new related CI.

UI Elements (A-Z) Description

Discovery tab Displays the DFM run status for the selected CIs. For 
details, see "Discovery and Changes Summary Dialog 
Box" on page 238 and "Discovery Status Pane" in the HP 
Universal CMDB Data Flow Management Guide.

History tab  Displays the history for the selected CI. For details, see 
"CI/Relationship History Dialog Box" on page 231.  

Properties tab Displays the selected CI’s properties (the same properties 
that appear in the Configuration Item Properties dialog 
box). You can view the properties in the properties tab, 
but you must open the dialog box to edit the properties. 
For details, see "Configuration Item Properties Dialog 
Box" on page 233.

To access In IT Universe Manager, click the New CI icon  in the 
toolbar to create a non-related CI. Select a CI in the 
topology map and click the New Related CI icon  to 
create a related CI.

Important 
information

To define a new CI, select the CI type from the tree at the 
top of the dialog box. The CI types in the tree that are 
available to be instantiated appear in black. The CI types in 
faded text cannot be instantiated.

Edit the properties in the Define new CI properties area. The 
table below includes the properties which are common to 
all CIs. In addition, there are other properties specific to 
each CI.

If you are creating a related CI, click the Relationship button 
to go to the relationship mode of the dialog box. Select a 
relationship and edit its properties.
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User interface elements are described below:

Relevant tasks "Create CIs and Relationships in the CMDB" on page 216

See also ➤ "CI Selector" on page 151

➤ "CI Lifecycle and the Aging Mechanism" in the HP 
Universal CMDB Administration Guide

UI Elements (A-Z) Description

Actual Deletion 
Period

The period after which the CI is deleted when the aging 
mechanism is enabled.

Allow CI Update When the value is set to true, this option enables the DFM 
process to automatically update the CI properties with 
information that it discovers. If you change the value of a 
property supplied by the DFM process, the value is 
overridden by the discovered value.

When the value is set to false, the CI properties are not 
overridden by the DFM process.

Created By The user name of the administrator who manually created 
the CI, where applicable.

Create Time The date and time when the CI was created.

Deletion 
Candidate Period

The period after which the CI becomes a candidate for 
deletion when the aging mechanism is enabled.

Description A description of the CI.

Display Label The label that appears for the CI in the topology map.
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Enable Aging If a CI or relationship is not updated or refreshed over a 
period of time (for example, a CI is not rediscovered by DFM 
and no manual update occurs), an aging mechanism deletes 
the CI from the CMDB. For details, see "CI Lifecycle and the 
Aging Mechanism" in the HP Universal CMDB Administration 
Guide.

True: the aging mechanism is enabled for this CI or 
relationship.

Default value: false. The default value for DFM CIs is true.

Note: 

➤ If the aging mechanism is disabled, this field is ignored.

➤ This field is displayed for certain CIs only.

Last Access Time The time that the CI was last accessed, whether when being 
updated or being discovered by DFM. This field is displayed 
only for certain CIs.

This parameter is used by the aging mechanism. For details, 
see "CI Lifecycle and the Aging Mechanism" in the HP 
Universal CMDB Administration Guide.

Last Modified 
Time

The date and time when the CI properties were last updated.

Name The name of the CI.

Note Enables you to enter other information about the CI.

Origin An ID for the source that automatically created the CI, or 
the application where the CI was created.

Relationship For a related CI, click Relationship to go to the relationship 
mode of the dialog box.

Select CI Type Enables you to select the CI type from the tree for the new 
CI. The CI types that are available for the selected CI or view 
appear active in the CI type tree. The other CI types appear 
in faded text and cannot be selected.

To limit the CI type tree to CI types from the current view, 
select CI Types from the current view on the right. To 
display all CI types in the tree, select All CI Types.

UI Elements (A-Z) Description
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Relationship Dialog Box
This page enables you to define the relationship between the new CI and 
the CI selected in the view, as well as the properties of the relationship.

User interface elements are described below:

Updated By The user name of the administrator who updated the CI 
properties.

User Label Enables you to define a display label for the CI. If no value is 
entered, the CI name appears as the default label.

To access Click the Relationship button from the New Related CI 
dialog box.

Important 
information

This page only appears for new related CIs.

UI Elements (A-Z) Description

Allow CI Update When the value is set to true, the DFM process 
automatically updates the relationship.

CI Definition Click CI Definition to return to the CI properties mode of 
the dialog box.

Created By The user name of the administrator who manually created 
the relationship, where applicable.

Create Time The date and time when the relationship was created.

Description A description of the relationship.

Direction Select the relationship direction from the drop-down box.

UI Elements (A-Z) Description
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Enable Aging If a CI or relationship is not updated or refreshed over a 
period of time (for example, a CI is not rediscovered by DFM 
and no manual update occurs), an aging mechanism deletes 
the CI from the CMDB. For details, see "CI Lifecycle and the 
Aging Mechanism" in the HP Universal CMDB Administration 
Guide.

True: the aging mechanism is enabled for this CI or 
relationship.

Default value: false. The default value for DFM CIs is true.

Note: 

➤ If the aging mechanism is disabled, this field is ignored.

➤ This field is displayed for certain CIs only.

Last Access Time The time that the relationship was last accessed, whether 
when being updated or being discovered by DFM. This field 
is only displayed for certain relationships.

This parameter is used by the aging mechanism. For details, 
see "CI Lifecycle and the Aging Mechanism" in the HP 
Universal CMDB Administration Guide.

Must When the value is set to true, the child CI is dominant 
when the percentage rule is used to calculate status for the 
parent CI. If the CI has low status, the parent must take the 
child CI status, overriding the percentage rule calculation if 
necessary. This is useful to give emphasis to an important 
CI. For example, you might want to define Must for a 
database CI, so that status is critical all the way up the 
subtree if the database falls, regardless of the status of the 
other CIs in the subtree.

The Must status defined for a relationship applies to that 
relationship only – it is not used in any other relationships 
of the child CI.

Name The name of the CI.

Network Address Defined only for route links. Indicates the destination 
network address to which this route is configured.

Note Enables you to enter other information about the CI.

UI Elements (A-Z) Description
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Origin An ID for the source that automatically created the 
relationship, or the application where the relationship was 
created.

Relationship Enables you to define the type of relationship that is created 
between the two CIs. 

Source CI The name of the CI on the first side of the relationship. This 
is the CI that you selected in the view.

Target CI The name of the CI on the second side of the relationship. 
This is the new CI that you are creating.

Updated By The user name of the administrator who updated the 
relationship properties.

Update Time The date and time when the CI properties were last updated.

User Label Enables you to define a display label for the relationship.

Weight When a weight value is entered, the child CI is given more 
weight in percentage calculations, when the percentage rule 
is used to calculate status for the parent CI. For example, if a 
child CI is given a weight of 3, then it has three times more 
impact on the parent status calculation than its unweighted 
siblings.

The weight defined for a relationship applies to that 
relationship only – it is not used in any other relationships 
of the child CI.

UI Elements (A-Z) Description
258



Chapter 7 • IT Universe Manager
Related CIs Map

This dialog box enables you to view the CIs related to a specified CI in the 
view or the CMDB in map or table format.

To access In IT Universe Manager, right-click the required CI and 
select Get Related CIs > From View or From Database with 
Filter or From Database without Filter.

Important 
information

When you select From View, the Related CIs Map displays 
related CIs in the current view. When you select From 
Database without Filter, the Related CIs Map displays 
related CIs in the CMDB. When you select From Database 
with Filter, you first select the CI types you want to see in 
the map, which then displays related CIs of those types in 
the CMDB.

For details on the Related CIs map toolbar, sidebar, 
legend, and shortcut menu, see "IT Universe Manager 
Page" on page 244.

The related CIs can be viewed in map mode or in text 
mode. The text mode format of the map includes the 
icons found in the Element Instances dialog box. For 
details, see "Element Instances Dialog Box" on page 73.
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Run Impact Analysis Dialog Box

This dialog box enables you to run the Impact rule you defined in Impact 
Analysis Manager for that view.

User interface elements are described below:

To access Select Managers > Modeling > IT Universe Manager. 
Right-click a trigger query node in the Topology Map and 
select Run Impact Analysis or click the Run Impact 
Analysis Now button  in the IT Universe status bar.

Important 
information

You can:

➤ Display in a new window all the CIs that are impacted 
by the trigger CI. The relationships in the map 
represent the Impact rules. The name of the 
relationship is the name of the Impact rule you defined 
in the Impact Analysis Manager. For details, see "Show 
Map" on page 262.

➤ Simulate how the statuses of the impacted CIs are 
impacted. For details, see "Show in Views" on page 261.

➤ Generate a report that displays a list of CIs that are 
impacted in the system as a result of the simulated 
changes. For details, see "Generate Report" on 
page 261.

Note: This dialog only appears if an Impact rule is defined 
for that view. For details, see "Impact Analysis Manager" 
on page 439.

Relevant tasks "Retrieve Impact Analysis Results – Scenario" on page 220

UI Elements (A-Z) Description

All Impact rules Select to execute all impact rules in the impact analysis.

Impact rules bundle Select the bundle containing the required impact rules 
for the impact analysis.
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Generate Report Generates an Impact Analysis report, which displays 
information that is divided as follows:

➤ Grouping by CIT. All the impacted CIs (the CIs that are 
impacted in the system as a result of the simulated 
changes), sorted by CIT.

➤ Affected Application. All the impacted CIs that belong 
to a specific business service. 

➤ Triggered CIs. The CIs that represent the changes you 
want to make to the system.

For details on the Impact Analysis report, see "Impact 
Analysis Report" on page 411.

Only Impact rules 
located in specified 
bundle

Select to execute the impact rules from the specified 
bundle in the impact analysis.

Show in Views Simulates how the statuses of the impacted CIs are 
impacted for the selected state. The Topology Map 
displays the statuses of the trigger CIs as well as all 
statuses of the CIs that are impacted by it.

The Topology Map also displays the Impact Analysis 
indicators:

➤ A trigger CI is marked by this  indicator.

➤ A CI that is both an impacted and a trigger CI is 
marked by this  indicator.

➤ An impacted CI is marked by this  indicator.

Note: The statuses that appear here and the colors that 
represent each status are defined in the severity list for 
that state in the System Type Manager. For details, see 
"Create/Update List/Enumeration Definition Dialog Box" 
on page 502.

UI Elements (A-Z) Description
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Save Snapshot Dialog Box

This dialog box enables you to take a snapshot of a view and save it.

Show Map Enables you to select an Impact rule, and then display in 
a new window, a simulation of all the CIs that are 
impacted by the trigger CI for the selected state. If only 
one Impact rule is defined for this CI, the Impact Rules 
window is displayed directly. For more details, see "Show 
Impact Pane" on page 263. 

The relationships in the map represent the Impact rules 
and the name of the relationship is the name of the 
Impact rule you defined in the Impact Analysis Manager.

Note: Show Map enables you to view the results of 
multiple triggers.

Trigger Severity Select the required severity on the scale. 

Note: The severity scale was defined for the state in the 
System Type Manager. For details, see "System Type 
Manager" on page 468.

For example, you can create an Impact rule in the Impact 
Analysis Manager that defines the severity of the trigger 
query node as other than Warning (1). If you select a 
severity other than Warning (1), for example, Minor (3), 
the condition is met and the simulated changes in the 
system are triggered.

For details, see the "Impact Rules Definition Dialog Box" 
on page 457.

To access In IT Universe Manager, click the Snapshot button  in 
the CI Selector and select Save Snapshot.

Important 
information

You can compare snapshots of the same view taken at 
different times using the Compare Snapshots Report. For 
details, see "Compare Snapshots Report" on page 393.

Relevant tasks "Take a Snapshot of a View" on page 228

UI Elements (A-Z) Description
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User interface elements are described below:

Show Impact Pane

This page opens a window that displays the statuses of the trigger CI as well 
as all statuses of the CIs that are impacted by it. 

UI Elements (A-Z) Description

Description A description of the snapshot (optional).

Note A note about the snapshot (optional).

View Name The name of the view as it appears in the CI Selector. This 
field cannot be edited.

To access In the Run Impact Analysis Dialog box, click Show Map.

If Impact Analysis is already active, click on the Impact 
Analysis Is Active link in the IT Universe status bar.

Important 
information

The following tabs are available:

➤ Impact Results. Displays a map of all CIs impacted by 
the selected CI.

➤ Trigger CIs. Displays a table of information on the 
selected trigger CIs.

You can only see Impact Analysis results if you defined an 
Impact rule for that view in Impact Analysis Manager. For 
details, see "Impact Analysis Manager" on page 439.

To view information about specific CIs that are triggered 
or impacted by the Impact rule, double-click the 
relationship connecting the CIs. A map is displayed.

The relationships in the map represent the Impact rules. 
The name of the relationship is the name of the Impact 
rule you defined in the Impact Analysis Manager.

Relevant tasks "Retrieve Impact Analysis Results – Scenario" on page 220
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

<Legend> Indicates the icons displayed next to CIs with any of the 
following special statuses:

➤ Added. When Change Timeframe is active, indicates 
that the CI was added.

➤ Impacted. When Impact Analysis is active, indicates 
an impacted CI.

➤ Impacted and Trigger. When Impact Analysis is active, 
indicates a trigger CI that is impacted.

➤ Candidate for Deletion. Indicates that the CI is a 
candidate for deletion.

➤ Changed. When Change Timeframe is active, indicates 
that the CI was changed.

➤ Note. Indicates that a note was added for the CI.

➤ Trigger. When Impact Analysis is active, indicates a 
trigger CI.

<Relationship> The relationships represent the Impact rule you defined 
in the Impact Analysis Manager. For details, see "Impact 
Rules Definition Dialog Box" on page 457.

<The statuses and 
the colors that 
represent each one>

The statuses that appear and the colors that represent 
each status are the ones that are defined in the severity 
list for that state in the System Type Manager. For details, 
see "Create/Update List/Enumeration Definition Dialog 
Box" on page 502.

<Toolbar> The Show Impact pane toolbar contains most of the 
buttons in the IT Universe Manager toolbar.

<Topology Map 
Sidebar>

For details, see "Topology Map Sidebar" on page 197.
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Modeling Studio

This chapter includes:

Concepts

➤ Modeling Studio Overview on page 267

➤ View Formats on page 268

➤ Building a Business View on page 269

➤ Templates and Perspectives on page 272

➤ Predefined Folders and Views on page 273

➤ Business CI Models on page 274

➤ Building a Perspective Based View on page 276

➤ Revealed CIs and Watchpoints on page 280

Tasks

➤ Create a Pattern View on page 285

➤ Create a Template on page 286

➤ Create a Perspective on page 288

➤ Create a Template Based View on page 291

➤ Define Report Settings on page 293

➤ Build a Business CI Model on page 294

➤ Build a Pattern-based Model on page 296

➤ Build a Perspective-based View Based on a Model on page 297

➤ Build a Perspective-based View Based on a Collection of CIs on page 298
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Reference

➤ Modeling Studio User Interface on page 300
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Concepts

Modeling Studio Overview

Modeling Studio is a tool for creating and managing views. You can create 
your own views, or work with the out-of-the-box (factory) views provided 
with your HP Universal CMDB installation.

The IT Universe model in the configuration management database can be 
very large, holding thousands of configuration item (CI)s. A view enables 
you to build a subset of the overall IT universe model, containing only those 
CIs relating to a specific area of interest. You can define your own views to 
display only the information that is relevant to your organization’s business 
needs.

HP Universal CMDB supports three view formats: pattern views, template 
based views, and perspective based views, which are populated through 
different processes. For details, see "View Formats" on page 268.
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View Formats

HP Universal CMDB supports three view formats, by which to populate your 
view:

➤ Pattern views are built from a Topology Query Language (TQL) query that 
defines the structure of the view. You can create a new TQL query as you 
build the view or base the view on an existing query. The view displays 
only those CIs and relationships that satisfy the query definition. When 
the view is displayed or refreshed, the Modeling Studio queries the CMDB 
for all elements that fit the query, and automatically updates the view 
with those elements.

➤ Template based views are based on a TQL query, to which a template is 
then applied. The template is a reusable view that includes parameters, 
which are saved as part of the template. This enables you to build 
multiple views with the same settings without having to re-enter the 
parameter information. The view displays only those CIs and 
relationships that satisfy the query definition and the conditions of the 
template. For details on templates, see "Templates and Perspectives" on 
page 272.

➤ Perspective based views are built by selecting a collection of individual 
CIs and applying a special type of template, known as a perspective, to it. 
Instance views, which no longer exist, are replaced by perspective based 
views. For details on perspectives, see "Templates and Perspectives" on 
page 272. 

When you select a view for editing from the view tree in the left pane, it 
opens on the editing pane in the appropriate editor. 
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Building a Business View

In the Modeling Studio, you can define your own views to model your 
business environment. 

This section includes the following topics:

➤ "The Structure of a View" on page 269

➤ "Setting the View Hierarchy" on page 270

➤ "Topology Reports" on page 271

The Structure of a View
The views you create should provide the business users with logical 
representations of your company’s structure, processes, and goals. To meet 
these requirements, you generally build multiple views representing 
different aspects of your business; for example, you could build business 
views that revolve around any of the following:

➤ Company structure, so that data is organized by the geographical location 
of branches, or by data centers.

➤ Business processes, so that data is organized by line of business, or by 
applications.

➤ Business goals, so that data is organized by sales, or by key customers.

The views depend on the particular demands of your organization and the 
actual hierarchical structure of the views should reflect those demands.

The usual hierarchical format of a view is as follows:

➤ Top level. The highest levels of the view, consisting of the root CI and the 
branches below it, are normally built from logical Business CI types such 
as Location, Line of Business, Customer, Application, and so on.

➤ Intermediate level. The intermediate branches of the view normally 
consist of System CI types, representing actual hardware and software 
and/or monitoring group CI types, representing groups containing 
monitors.
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➤ Bottom level. The lowest level of the view, consisting of leaf CIs at the 
ends of the subtrees, is built from the Monitor CI types. 

Note: The bottom level is only relevant when a monitoring solution such as 
HP Business Service Management is connected and modeled in the CMDB. 

Setting the View Hierarchy
The Pattern View Editor enables you to set the view hierarchy using the 
Hierarchy pane on the right side of the screen. There are two methods 
available for setting the hierarchy: manual and rule-based. The manual 
method is selected by default.

Manual Hierarchy Method

In the manual hierarchy method, the query nodes of the view are displayed 
in a tree format. You can create the hierarchy by manually dragging a 
selected query node under another query node or by using the toolbar 
buttons. The system only allows you to move a query node under another 
query node when the resulting hierarchy is valid. For details, see "Hierarchy 
Pane" on page 334.

It is possible to place a single query node from the view into the hierarchy 
multiple times. You can then adjust the hierarchy so that the query node 
appears in different layers, according to the required layout. The view results 
in such an instance would be the same as if you added another query node 
to the TQL query. Using the same query node twice in the hierarchy enables 
you to achieve the desired view results using a simpler TQL query.
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Query Node Grouping

When setting the view hierarchy manually, you can create subgroups to 
group CIs by different criteria for the convenience of viewing the display. 
Click the Add Group by button and select one of the options. You can create 
a subgroup for CIs of the same type in the Topology Map using the Add 
Group by CI Type option. You can create a subgroup for a specific query 
node by selecting the Add Group by Query Node option. You can group CIs 
by a common attribute using the Add Group by Attribute button and 
entering a regular expression as described in "Query Node Grouping Dialog 
Box" on page 344. For details about regular expressions, see "Regular 
Expression Examples" on page 561.

You can also create nested groups (a query node group inside another query 
node group) to help fine-tune the TQL query results that are displayed in 
the Topology Map.

For example, after grouping query nodes of type node by their CIT, you can 
use their operation state attribute to create more focused groups.

Rule-Based Hierarchy Method

In the rule-based hierarchy method, you define hierarchy rules, using the 
Hierarchy Rules dialog box. You select a source CIT, target CIT, relationship 
type, and relationship direction, which define the conditions for a hierarchy 
rule. Any CIs in the view which satisfy the defined conditions are subject to 
the rule, that is, the target CI is placed on the layer below the source CI. For 
details on defining hierarchy rules, see "Hierarchy Rules Dialog Box" on 
page 310.

Topology Reports
You can view the data of any view in report format in the Reports module. 
Such a report is called the topology report of the view. You define the 
topology report settings in the Report tab of the Pattern View Editor in the 
Modeling Studio. For details on Topology Reports, see "Topology Reports 
Overview" on page 364.
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Templates and Perspectives

A template is a reusable pattern view with defined parameters.  You use 
templates to build template-based views, setting the values of the 
parameters for each specific view. Any changes made to a template affect all 
existing views based on that template.

Template-based views can be opened in IT Universe Manager, like pattern 
views. You can also open the template itself in IT Universe Manager to view 
the results for various parameter values. If you want to save the results, you 
must save it as a template-based view. You define templates, template-based 
views, and pattern views in the Pattern View Editor. 

Perspectives are a type of template designed to be applied to a specific 
collection of CIs, similar to the pattern in a pattern view. For example, a 
perspective could comprise a node containing an IP Address. In that case, 
the resulting perspective-based view would include all the node CIs from 
among the CIs in the CI selection, along with their contained IP Addresses. 

The most basic perspective is known as the Content Only perspective and 
consists of only the query node itself. If you apply the Content Only 
perspective to a CI collection, the resulting view contains only the selected 
CIs themselves.

Perspectives are also created and edited in the Pattern View Editor. You can 
have multiple views, templates, and perspectives open in the Pattern View 
Editor simultaneously, each with its own tab.

Perspectives do not appear in the list of views in IT Universe Manager, 
however perspective-based views can be opened in IT Universe Manager, 
like all other views. For details, see "Building a Perspective Based View" on 
page 276.

Templates and perspectives cannot be opened in the Reports module, 
however template-based views and perspective-based views have topology 
reports in the report module.
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In summary, the Views tree in the Resources tab of the CI Selector in the 
Modeling Studio can include five distinct entities: 

➤ pattern views

➤ templates

➤ template based views

➤ perspectives

➤ perspective based views

You can filter the tree to select the types of views or templates to display.

The following table summarizes the types of views and where they are 
created and viewed:

Predefined Folders and Views

The Views tree in the Resources tab of the CI Selector in the Modeling Studio 
includes predefined folders and views, as described in the following 
sections:

➤ "Predefined Folders" on page 274

➤ "Factory Views" on page 274

➤ "Predefined Perspectives" on page 274

Type of View Created in:
Can be opened in 
IT Universe Manager

Pattern view Pattern View Editor Yes

Template Pattern View Editor Yes, for the current 
session only

Template-based View Pattern View Editor Yes

Perspective Pattern View Editor No

Perspective-based 
View

Perspective-based View 
Editor

Yes
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Predefined Folders
The hierarchical file folder system in the CI Selector can help you organize 
your views. Predefined folders are provided for the out-of-the-box views; 
you can modify these folders, or add additional folders according to your 
organization’s requirements.

Factory Views
Your HP Universal CMDB installation includes out-of-the-box pattern views, 
templates, and perspectives. These views provide a quick start for working 
with the CMDB.

The out-of-the-box views are initially empty. As soon as CIs are added to the 
CMDB by one of the CI generators, the TQL query built into each pattern 
view is able to identify the CIs that meet the pattern requirements, and add 
them to the view.

Views for CIs are created when a discovery process is run; the out-of-the-box 
views that are provided correspond to the relevant Data Flow Management 
(DFM) packages. For example, the Oracle view (Root > Database > Oracle > 
Oracle) is populated with CIs that are created when Data Flow Management 
activates the Database - Oracle module. For details on running DFM, see 
"Discovery Control Panel – Advanced Mode Workflow" in the HP Universal 
CMDB Data Flow Management Guide.

Some of the out-of-the-box views are considered basic to the system and 
cannot be deleted from the folders. 

Predefined Perspectives
HP Universal CMDB also provides out-of-the-box perspectives. One example 
is the Content Only perspective, which includes only the elements of the 
view content itself, without any additional CIs. 

Business CI Models

➤ "Building a Model" on page 275

➤ "Pattern-based Models" on page 276
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The collection of CIs which compose the view content of perspective-based 
views can be selected in two ways. You can select CIs from the CI Selector 
and drag them onto the editing pane. In this case, you can build a view by 
applying a perspective to the collection and the collection cannot be reused 
in another view without repeating the selection process. The other way to 
select the CIs to appear in the view is by creating a model.

A model is a reusable collection of CI instances that define a business entity, 
such as a business service or line of business. By creating a model, you are 
building a CI collection that can be reused with other perspectives to create 
different views. Any changes you subsequently make to the model are 
reflected in all the views based on that model.

Building a Model
You build a model by first selecting a business CI to serve as its basis. The 
available business CIs include group, application, business service, business 
unit, and line of business. Then, you can add CIs to your model in the 
following ways:

➤ Manually, by dragging CIs from the CI Selector into the Model Editor

➤ Revealing related CIs using a reveal path and selecting the ones to add to 
the model

➤ Defining a watchpoint for a selected CI and automatically adding CIs to 
the model

You can also begin building a model by dragging CIs onto the empty canvas 
and selecting Create a new model.

The model you create is a CI itself and the CIs in your model are related to 
the model by Contains relationships. You must save your model before 
applying a perspective to it to build a view.
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Caution: The changes you make in a model affect the entire universe, not 
just the views based on that model. Thus, if you delete a CI from a model, 
you are deleting the relationship that existed between the CIs from the 
CMDB.

Pattern-based Models
Another type of model you can build is a pattern-based model. In a pattern-
based model, you define a TQL query to determine the CIs included, rather 
than selecting them manually. You can base your pattern-based model on an 
existing TQL query or create a new TQL query. 

You must designate at least one query node in the model’s TQL query as 
output for the model. The CIs of that type which match the pattern of the 
TQL query are the ones included in the model output.

The pattern-based model created is saved as a CI like an ordinary model, and 
can be used to form the content of a perspective-based view. The new TQL 
query created is saved as an ordinary query and can be used as the basis for a 
pattern view.

Building a Perspective Based View

A perspective based view is composed of perspectives applied to a model or a 
collection of CIs. The perspective is a special type of template which is 
designed to be applied to a subset of the IT Universe model. 

The Content pane of the Perspective-based View Editor displays the models 
or CIs you have selected to serve as the basis of your view. The Perspective 
pane displays the selected perspectives. The Preview pane displays the 
resulting view based upon your content and perspective selections. When 
you make a change in the content or perspective selections, the view is 
updated accordingly in the Preview pane. For details, see "Perspective-based 
View Editor" on page 338.
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This section includes the following topics:

➤ "Content" on page 277

➤ "Perspectives" on page 277

➤ "Views Based on Multiple Perspectives" on page 278

➤ "Including and Excluding Child CIs" on page 279

Content
The content in a perspective based view can be selected in two ways:

➤ You can add individual CIs to the view manually, using the CI Selector. 
The CIs in the collection are independent of each other. In this case, the 
collection of CIs is not defined as a model and cannot be reused in 
another view.

➤ You can add one or more models to the view, using the CI Selector. 
Alternatively, you can start by working with a model in the Model Editor 
and select Generate View for Selected Model to build a view based on that 
model. In this case, the identical content can be used to build another 
view by selecting the same models.

You can select both individual CIs and models to form the content of a 
perspective based view, however in that case, the models are treated as 
ordinary CIs. The models themselves are included in the view without their 
hierarchy of child CIs. 

Perspectives
The perspectives you select for your view determine which CIs are included 
in the view. A perspective is a reusable pattern, similar to a template. The 
difference between a perspective and a regular template is that the 
perspective includes one or more query nodes designated as contact query 
nodes. A contact query node is a query node in the pattern which is used to 
apply the pattern to specific content and it is indicated by a small icon that 
appears next to the query node.
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For example, in the following perspective, a query node of type Windows is 
designated as the contact query node and it has an IP Address related to it by 
a containment relationship.

When this perspective is applied to a CI collection, all the Windows CIs in 
the collection appear in the resulting view, along with the IP Addresses 
contained in them. The Windows CIs that do not contain IP Addresses, as 
well as CIs of any other type from the collection, do not appear in the view.

A perspective can have several contact query nodes, but every disconnected 
graph within a perspective must have at least one contact query node.

If you make a change to a perspective, all views based on that perspective are 
affected.

Views Based on Multiple Perspectives
You can select multiple perspectives to apply to the content of your view. 
There are two ways to select multiple perspectives:

➤ Perspective groups

➤ Perspective chains

In a perspective group, you select two or more perspectives to apply 
simultaneously to the same input content.
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In a perspective chain, you select two or more perspectives at different levels 
of the view creation. The perspective in the first level is applied to the 
original view content to generate results in the form of a CI collection that 
serves as input content for the next level. The perspective in the second 
level is then applied to this content to generate the view results. You can 
build views based on multiple levels of perspectives, each one generating 
input content for the following level.

It is possible to apply both of the above methods at the same time, that is, 
by selecting multiple perspectives in each of the levels of a perspective 
selection.

For example, select a collection of IP Subnet CIs as your input content and 
select a perspective that adds the node CIs related to the IP Subnets as the 
first level perspective. The results of this stage consist of the original IP 
Subnets and their related nodes. Then add a second perspective level and 
select two perspectives for it: one that adds CPU CIs related to nodes and 
one that adds File System CIs related to nodes. The final results include the 
original IP Subnets, their related nodes, and the CPUs and File Systems 
related to those nodes.

These options help to simplify the process of creating a perspective-based 
view, by breaking down the functionality of a perspective into its 
component parts. Instead of building a separate large and complex 
perspective for each required view, you can construct a custom perspective 
to match the requirements of your specific case from smaller and more basic 
perspectives.

Including and Excluding Child CIs
When adding CIs that have children to a view, the CI and its children are 
only included in the view if the pattern of the perspective includes children 
for the selected CI type. In that case, children are included for all CIs of that 
type. After creating a view, you can hide specific CIs from the view by 
selecting the CI in the View Results pane and selecting Hide CI from View 
from the shortcut menu or clicking the Hide CI from View button in the 
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toolbar. This option is only available for CIs that were added to the view via 
the perspective and were not part of the original content on which the view 
was based. Thus, if the view was based on a collection of CIs, the CIs in that 
collection cannot be hidden from the view. If the view was based on a 
model, the model cannot be hidden from the view, but the CIs contained in 
the model can be hidden.

Revealed CIs and Watchpoints

The Modeling Studio provides two advanced methods of adding CIs to an 
existing model: revealing related CIs and defining watchpoints.

This section includes the following topics:

➤ "Revealing CIs" on page 280

➤ "Watchpoints" on page 283

Revealing CIs
One approach to building a model is to add CIs related to the CIs in the 
model. The Modeling Studio provides a tool to help you reveal those CIs. 
The process of revealing related CIs involves constructing a reveal path, 
which is a chain of CI types that are related to each other. The first item in 
your reveal path is the CI type of the CI from which you started to reveal 
CIs. The Modeling Studio locates all of its related CIs and lists their CI types. 
By selecting one of those types, you build the next step of your path. All the 
related CIs of that type appear in the lower pane of the dialog box. You can 
select the ones you want to include in your model. The process is repeated 
to build the following step of the path.
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For example, if you begin to reveal CIs from a CI of type Windows, the 
Modeling Studio may reveal related CIs of types Interface, Network, and IP. 
If you select Network, the related CIs of type Network appear in the lower 
pane and can be added to the model by dragging them into the CIs Basket 
or clicking the CIs Basket icon:
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Click Next to build the next step of the path using Network as your 
selection. The Modeling Studio reveals related CIs of type Windows, Unix, 
and IP. Unix is selected and the Unix CIs appear in the lower pane and can 
be added to the model by dragging the selected ones into the CIs Basket 
pane:
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Click Next to build the next step of the path using Unix as your selection:

In this case, a reveal path of Windows > Network > Unix was constructed. At 
each step, you have the option of adding any of the revealed related CIs to 
your model. For details on revealing CIs, see "Reveal CIs Dialog Box" on 
page 346.

It is also possible to construct a reveal path without revealing CIs. For 
details, see "Create/Edit/Save Reveal Path Dialog Box" on page 307.

Watchpoints
Another method of locating related CIs to add to the model is by defining a 
watchpoint for a selected CI in the model. A watchpoint is a mechanism 
which is triggered when a new related CI of a specified type is created. Every 
watchpoint is defined in connection with a reveal path. If a new related CI 
of any CI type included in the path is created, the watchpoint is triggered 
and an indicator appears next to the model. For details on defining a 
watchpoint, see "New Watchpoint Dialog Box" on page 328.
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Note: You must save a new model before defining watchpoints for its CIs.

All the related CIs detected by the watchpoint are displayed in the 
Watchpoints Updates dialog box. The dialog box enables you to select the 
ones to add to your model and the ones to suppress, or exclude from your 
model. For details, see "Watchpoints Updates Dialog Box" on page 360.

You also have the option to include the detected CIs in your model 
automatically by selecting the check box in the New Watchpoint dialog box. 
In this case, all CIs detected by the watchpoint are added to the model. 

A watchpoint can also be used to detect CIs included in the model which are 
no longer related to the model. If such CIs are found along the reveal path 
connected to the watchpoint, they also appear in the Watchpoints Updates 
dialog box. You can accept the suggestion to remove the CIs from your 
model, or you can suppress the suggestion, thereby keeping the CIs in your 
model.

Note: Although a watchpoint is defined for an individual CI, the 
watchpoint results display related CIs of the CI types included in the reveal 
path for all CIs in the model.
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Tasks

Create a Pattern View

This task describes how to create a pattern view and define its TQL query.

This task includes the following steps:

➤ "Open a New View in the Pattern View Editor" on page 285

➤ "Add Query Nodes and Relationships to a TQL Query" on page 285

➤ "Set the View Hierarchy" on page 286

➤ "Define the Report Settings - Optional" on page 286

➤ "Set Permissions" on page 286

 1 Open a New View in the Pattern View Editor

Click the New button  and select Pattern View. In the New Pattern 
View dialog box, select the base TQL query on which your new view is 
based, or select Create new query to build a new TQL query. The Pattern 
View Editor opens. For details, see "New Pattern 
View/Template/Perspective Dialog Box" on page 327.

 2 Add Query Nodes and Relationships to a TQL Query

Add the query nodes and relationships that define the query. For details 
on how to add query nodes and relationships to a TQL query, see "Add 
Query Nodes and Relationships to a TQL Query" on page 28.

Note: If you are starting with a blank view, you must add at least one 
query node in order to save your view.
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 3 Set the View Hierarchy

Set the hierarchy for the view by moving the required query nodes in the 
hierarchy pane. For details, see "Setting the View Hierarchy" on page 270.

When you are finished, click Save  to save the view.

 4 Define the Report Settings - Optional

Select the Report tab in the Pattern View Editor. Select the attributes you 
want to include in the report for each query node of the view. You can 
also set the order of the report columns, set the sort order of each column, 
and add a chart. For details, see "Define Report Settings" on page 293.

 5 Set Permissions

Apply viewing and editing permissions to users and user groups for the 
new view. You set permissions in Managers > Administration > Security 
Manager. For details, see "Security Manager Page" in the HP Universal 
CMDB Administration Guide.

Create a Template 

This task describes how to define a new template.

This task includes the following steps:

➤ "Open a New Template in the Pattern View Editor" on page 287

➤ "Add Query Nodes and Relationships to a TQL Query" on page 287

➤ "Set Parameter Values" on page 287

➤ "Set the Template Hierarchy" on page 287

➤ "Define the Report Settings - Optional" on page 288

➤ "Set Permissions" on page 288
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 1 Open a New Template in the Pattern View Editor

Click the New button  and select Template. In the New Template 
dialog box, select the base TQL query on which your new template is 
based, or select Create new query to build a new TQL query. For details, 
see "New Pattern View/Template/Perspective Dialog Box" on page 327.

 2 Add Query Nodes and Relationships to a TQL Query

Add the query nodes and relationships that define the query. For details 
on how to add query nodes and relationships to a TQL query, see "Add 
Query Nodes and Relationships to a TQL Query" on page 28.

Note: If you are starting with a blank template, you must add at least one 
query node in order to save your template.

 3 Set Parameter Values

Right-click a query node or relationship in the TQL query and select 
Query Node Properties. In the Attributes tab, add an attribute with a 
parameterized value. For details, see "Query Node/Relationship Properties 
Dialog Box" on page 80.

Note: If you do not set any parameters, when you try to save your 
template, you must save it as a pattern view.

 4 Set the Template Hierarchy

Set the hierarchy for the template by moving the required query nodes in 
the hierarchy pane. For details, see "Setting the View Hierarchy" on 
page 270.

When you are finished, click Save  to save the template.
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 5 Define the Report Settings - Optional

Select the Report tab in the Pattern View Editor. Select the attributes you 
want to include in the report for each query node of the view. You can 
also set the order of the report columns, set the sort order of each column, 
and add a chart. For details, see "Define Report Settings" on page 293.

 6 Set Permissions

Apply viewing and editing permissions to users and user groups for the 
new template. You set permissions in Managers > Administration > 
Security Manager. For details, see "Security Manager Page" in the HP 
Universal CMDB Administration Guide.

Create a Perspective 

This task describes how to define a new perspective.

This task includes the following steps:

➤ "Open a New Perspective in the Pattern View Editor" on page 289

➤ "Add Query Nodes and Relationships to a TQL Query" on page 289

➤ "Select a Contact Query Node" on page 289

➤ "Set the Perspective Hierarchy" on page 289

➤ "Define the Report Settings - Optional" on page 290

➤ "Set Permissions" on page 290
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 1 Open a New Perspective in the Pattern View Editor

Click the New button  and select Perspective. In the New Perspective 
dialog box, select the base TQL query on which your new Perspective is 
based, or select Create new query to build a new TQL query. For details, 
see "New Pattern View/Template/Perspective Dialog Box" on page 327.

 2 Add Query Nodes and Relationships to a TQL Query

Add the query nodes and relationships that define the query. For details 
on how to add query nodes and relationships to a TQL query, see "Add 
Query Nodes and Relationships to a TQL Query" on page 28.

 3 Select a Contact Query Node

Select at least one query node in the TQL query to be a contact query 
node. Right-click the query node and select Use As Contact Query Node. 

Note: If you do not select a contact query node, when you try to save 
your perspective, you must save it as a pattern view.

 4 Set the Perspective Hierarchy

Set the hierarchy for the perspective by moving the required query nodes 
in the hierarchy pane. For details, see "Setting the View Hierarchy" on 
page 270.

When you are finished, click Save  to save the perspective.
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 5 Define the Report Settings - Optional

Select the Report tab in the Pattern View Editor. Select the attributes you 
want to include in the report for each query node of the view. You can 
also set the order of the report columns, set the sort order of each column, 
and add a chart. For details, see "Define Report Settings" on page 293.

 6 Set Permissions

Apply viewing and editing permissions to users and user groups for the 
new perspective. You set permissions in Managers > Administration > 
Security Manager. For details, see "Security Manager Page" in the HP 
Universal CMDB Administration Guide.
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Create a Template Based View

This task describes how to define a new template based view.

This task includes the following steps:

➤ "Prerequisites" on page 291

➤ "Define a New Template Based View" on page 291

➤ "Select a Template" on page 291

➤ "Set Parameters" on page 291

➤ "Set Permissions" on page 292

 1 Prerequisites

If you want to base your view on a new template, create the template first. 
For details, see "Create a Template" on page 286.

 2 Define a New Template Based View

You define a new template based view using the Template-based View 
wizard. Click the New button  and select Template Based View. 

 3 Select a Template

On the Select Template page of the wizard, select a template on which to 
base your view. For details, see "Select Template Page" on page 353.

 4 Set Parameters

On the Parameters page, enter the parameter values for the view. For 
details, see "Parameters Page" on page 354.

Note: You can also edit the parameters from within the Editor after 
creating the view, by selecting Edit Parameters  from the toolbar or the 
shortcut menu.
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When you are finished, click Save  to save the view.

 5 Set Permissions

Apply viewing and editing permissions to users and user groups for that 
view. You set permissions in Managers > Administration > Security 
Manager. For details, see "Security Manager Page" in the HP Universal 
CMDB Administration Guide.
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Define Report Settings

This task describes how to define report settings for a view, template, or 
perspective.

This task includes the following steps:

➤ "Prerequisites" on page 293

➤ "Select Attributes to Appear as Report Columns" on page 293

➤ "Add Function Columns to the Report - Optional" on page 294

➤ "Set the Sort Order of the Column Content" on page 294

➤ "Add a Chart to the Report - Optional" on page 294

 1 Prerequisites

After defining the content and hierarchy of a view, template, or 
perspective, you can define the report settings. Select the Report tab in 
the Pattern View Editor. 

 2 Select Attributes to Appear as Report Columns

For each query node in the view, select the query node in the Hierarchy 
pane and select the attributes to appear as columns in the report for that 
query node. You select attributes in the Query Node Definition pane by 
moving them from the Attributes list to the Report Layout list. Set the 
order of the columns using the arrow buttons in the Report Layout list. 
For details, see "Query Node Definition Pane" on page 336.
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 3 Add Function Columns to the Report - Optional

You have the option of adding a column for a selected query node 
consisting of data derived from a function performed on one of its child 
query nodes. Click the Add Function button  to open the Add 
Function dialog box where you can select the relevant settings. For 
details, see "Add/Edit Function Dialog Box" on page 301.

 4 Set the Sort Order of the Column Content

Click the Set Sort Order button  to open the Sort Column Content 
dialog box. Determine the columns by which to sort the report by 
moving columns from the Available Columns list to the Sorted Columns 
list. Use the arrow buttons to set the sort order of the columns. Use the 
Sort Ascending/Sort Descending buttons to set the sort direction for each 
column. For details, see "Sort Column Content Dialog Box" on page 352.

 5 Add a Chart to the Report - Optional

You have the option of adding a chart to your report, in place of a table, 
for a selected layer of the view. When the necessary conditions for adding 
a chart are satisfied, the Define Chart link in the Chart Properties section 
of the Query Node Definition pane is active. Click the link and enter the 
chart settings. For details, see "Chart Properties" on page 338.

Build a Business CI Model 

This task describes how to build a business CI model which can serve as the 
basis for a view.

This task includes the following steps:

➤ "Create the New Model" on page 295

➤ "Add CIs to the Model Manually" on page 295

➤ "Reveal CIs" on page 296

➤ "Define Watchpoints for CIs in the Model" on page 296
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 1 Create the New Model

In the Modeling Studio, click the New  button and select Model to 
open the New Model dialog box. Select a CI type and enter the values for 
its properties. For details, see "New Model Dialog Box" on page 327.

 2 Add CIs to the Model Manually

In the CI Selector, search for the CIs you want to include in your model. 
Select them and drag them into the model. 

Tip: You can select more than one CI by holding the CTRL key while 
selecting CIs.
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 3 Reveal CIs

Select a CI in the model and reveal its related CIs along a reveal path. Add 
selected CIs from among the revealed CIs to your model. When you are 
done, save the model. For details, see "Reveal CIs Dialog Box" on 
page 346.

 4 Define Watchpoints for CIs in the Model

Right-click a CI in the model and select Watchpoint > New Watchpoint. 
The New Watchpoint dialog box opens. Select a reveal path and click OK. 
A small icon appears next to the CI indicating that a watchpoint is 
defined for it. For details, see "New Watchpoint Dialog Box" on page 328.

Build a Pattern-based Model 

This task describes how to build a pattern-based model which can serve as 
the basis for a perspective-based view.

This task includes the following steps:

➤ "Define the New Model" on page 296

➤ "Enter the Model Details" on page 297

➤ "Select a TQL Query" on page 297

➤ "Add Query Nodes and Relationships to a TQL Query" on page 297

➤ "Set Output Query Nodes" on page 297

➤ "Save the Model" on page 297

 1 Define the New Model

You define a pattern-based model using the Pattern-based Model wizard. 
Click the New button  and select Pattern Based Model. 
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 2 Enter the Model Details

On the first wizard page, select a CI type for the model and enter the 
properties. For details, see "Select CI Type Page" on page 331.

 3 Select a TQL Query

On the next wizard page, select a TQL query for the model. You can create 
a new TQL query or select an existing query from the tree. The TQL Query 
Editor opens with the selected query. For details, see "Query Selection 
Page" on page 331.

 4 Add Query Nodes and Relationships to a TQL Query

Add the query nodes and relationships that define the query. For details 
on how to add query nodes and relationships to a TQL query, see "Add 
Query Nodes and Relationships to a TQL Query" on page 28.

 5 Set Output Query Nodes

Select one or more query nodes in the TQL query to serve as output for 
the model by right-clicking them and selecting Add to Model Output. 
The query node is indicated by a small icon next to it.

 6 Save the Model

When you are finished, save the model with a unique name. If you 
created a new TQL query, the query is also saved independently of the 
model and can be re-used as a regular TQL query.

Build a Perspective-based View Based on a Model 

This task describes how to build a view in the Modeling Studio based on a 
model and a perspective.

This task includes the following steps:

➤ "Open the Model" on page 298

➤ "Select a Perspective" on page 298
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➤ "Save the View" on page 298

 1 Open the Model

In the Modeling Studio, select Models as the Resource type in the left 
pane, select the relevant model, and click Open Model  in the left pane 
toolbar. 

 2 Select a Perspective

In the Model Editor, right-click the model and select Generate View for 
selected model. The Creating New View dialog box opens. Select 
perspectives to apply to the model. For details, see "Creating New View 
Dialog Box" on page 308.

 3 Save the View

The Perspective-based View Editor opens with your new view. Optionally, 
build a perspective chain by selecting perspectives for additional levels of 
the view creation. Rename the view and save it in the correct folder. For 
details, see "Perspective-based View Editor" on page 338.

Build a Perspective-based View Based on a Collection of 
CIs

This task describes how to build a view in the Modeling Studio based on a 
collection of CIs and a perspective.

This task includes the following steps:

➤ "Create the New View" on page 299

➤ "Add CIs to the View" on page 299

➤ "Select a Perspective and Save the View" on page 299
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 1 Create the New View

In the Modeling Studio, click the New  button and select Perspective 
Based View to open the Perspective-based View Editor. For details, see 
"Perspective-based View Editor" on page 338.

 2 Add CIs to the View

In the CI Selector, search for the CIs you want to include in your view. 
Select them and drag them into the view. For details on the CI Selector, 
see "CI Selector" on page 151.

Tip: You can select more than one CI by holding the CTRL key while 
selecting CIs.

 3 Select a Perspective and Save the View

In the Perspective pane, select perspectives to apply to your CI collection. 
Optionally, you can build a perspective chain by selecting perspectives for 
additional levels of the view creation. Rename the view and save it in the 
correct folder. For details, see "Perspective-based View Editor" on 
page 338.
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Reference

Modeling Studio User Interface

This section includes (in alphabetical order):

 ➤ Add/Edit Function Dialog Box on page 301

 ➤ Change Query Node/Relationship Type Dialog Box on page 303

 ➤ Choose Operation for Selected Item Dialog Box on page 304

 ➤ Conditions of Related CIs Dialog Box on page 305

 ➤ Create/Edit/Save Reveal Path Dialog Box on page 307

 ➤ Creating New View Dialog Box on page 308

 ➤ Cycle Definition Dialog Box on page 309

 ➤ Hidden CIs Dialog Box on page 310

 ➤ Hierarchy Rules Dialog Box on page 310

 ➤ Left Pane on page 311

 ➤ Manage CI Watchpoints Dialog Box on page 316

 ➤ Model Editor on page 317

 ➤ Modeling Studio Page on page 324

 ➤ Models Containing Selected CI Dialog Box on page 326

 ➤ New Model Dialog Box on page 327

 ➤ New Pattern View/Template/Perspective Dialog Box on page 327

 ➤ New Watchpoint Dialog Box on page 328

 ➤ Open Saved Reveal Path Dialog Box on page 329

 ➤ Pattern-based Model Wizard on page 330

 ➤ Pattern View Editor on page 333

 ➤ Perspective-based View Editor on page 338
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 ➤ Query Node Grouping Dialog Box on page 344

 ➤ Query/View Definition Properties Dialog Box on page 345

 ➤ Reveal CIs Dialog Box on page 346

 ➤ Save Query Dialog Box on page 348

 ➤ Save View/Template/Perspective Dialog Box on page 349

 ➤ Select Data Sources Dialog Box on page 351

 ➤ Sort Column Content Dialog Box on page 352

 ➤ Template-based View Wizard on page 353

 ➤ Template Parameter Values Dialog Box on page 355

 ➤ TQL Query Editor on page 355

 ➤ Views Containing Selected CI Dialog Box on page 359

 ➤ Watchpoints Updates Dialog Box on page 360

Add/Edit Function Dialog Box

This dialog box enables you to define which of the query node’s functions 
and parameters you want to include in the report.

To access Click the Add Function button under the Report Layout 
box in the Query Node Definition pane of the Pattern 
View Editor.

Important 
information

When defining the report columns for a selected query 
node in a view, template, or perspective, you can define a 
column consisting of data deriving from a function 
defined for one of its child query nodes. Select the 
relevant child query node, attribute, and function that 
you want to define.

First, select the required query node and function. The 
attribute list adjusts to display the relevant attribute for 
the selected combination. Select the required attribute.

Relevant tasks "Define Report Settings" on page 293
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User interface elements are described below:

UI Elements (A-Z) Description

Attribute Select an attribute from the list.

Function From the Function list, select the function you want to 
use to calculate the results on these columns. 

The following are the available options:

➤ Average. The average value of the selected attribute for 
all the CI instances of the selected query node.

➤ Concatenated List. Lists the values of the selected 
attribute for all the CI instances of the selected query 
node.

➤ Count. Calculates the number of CI instances of the 
selected query node.

➤ Distinct List. Lists the unique values of the selected 
attribute for all the CI instances of the selected query 
node.

➤ Max. The maximum value of the selected attribute for 
all the CI instances of the selected query node.

➤ Min. The minimum value of the selected attribute for 
all the CI instances of the selected query node.

➤ Sum. The sum of the selected attribute values for all 
the CI instances of the selected query node.

Related Query Node The child query node on which you want to perform the 
function.

Title The name of the function attribute displayed in the 
report.
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Change Query Node/Relationship Type Dialog Box

This dialog box enables you to change the CI type of a TQL query node or 
relationship after you have created a TQL query.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access In the TQL Query Editor or Pattern View Editor, right-
click the required query node and select Change Query 
Node Type. For relationships, right-click the required 
relationship and select Change Relationship Type.

Important 
information

You can change the CI type of the selected query node to 
any other valid type based on the existing relationships 
and conditions of the selected query node.

Relevant tasks ➤ "Define a TQL Query" on page 27

➤ "Implement a Discovery Adapter" in the HP Universal 
CMDB Developer Reference Guide

➤ "Create a Pattern View" on page 285

UI Elements (A-Z) Description

Click Expand All to expand all the folders in the tree.

Click Collapse All to collapse all the folders in the tree.

Tree View Click Tree View to select the display format of the CI 
type/Relationship tree. The following options are 
available:

➤ Display label

➤ Class name

➤ Legacy class name

<CI 
type/Relationship 
tree>

Select the required CI type or relationship.

Relationship 
Direction

Select the direction of the relationship.

Note: Only relevant for relationships.
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Choose Operation for Selected Item Dialog Box

This dialog box enables you to create models and views from selected CIs.

Relationship Name The name of the relationship.

Note: Only relevant for relationships.

Relationship 
Restrictions

Select an option to define how to handle relationships 
between identical query nodes or self relationships in the 
query results. A self relationship is a relationship that 
leads from a query node to itself.

➤ Allow All Relationships. All relationships appear in the 
query results.

➤ Allow Self Relationships only. Only self-relationships (a 
relationship that leads to itself) appear in the query 
results.

➤ Allow Non Self Relationships only. Self-relationships 
do not appear in the query results.

Note: Only relevant for relationships.

To access In the Modeling Studio, drag CIs from the CI Selector 
onto the empty canvas.

Important 
information

You can drag individual or multiple CIs onto the canvas. 
You can select ordinary CIs and/or models to drag onto 
the canvas. Use the CTRL key while selecting CIs to select 
multiple CIs.

UI Elements (A-Z) Description
304



Chapter 8 • Modeling Studio
User interface elements are described below:

Conditions of Related CIs Dialog Box

This dialog box enables you to define conditions for the CI types in a reveal 
path.

UI Elements (A-Z) Description

Create a new model Select to build a model comprising the CIs in your 
selection. If the CIs you dragged onto the canvas include 
at least one CI that has no valid links to any of the model 
CI types, this option is disabled.

Create a new view Select to build a view based on the CI collection formed 
by your selection.

Edit the model of the 
selected CI

Select to edit the selected model in the Model Editor.

Note: This option only appears when a single model is 
dragged onto the canvas.

To access Click the Add Condition or Edit Condition buttons from 
the Conditions column of the Reveal CIs dialog box.
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User interface elements are described below:

UI Elements (A-Z) Description

Add the attribute condition you have defined.

Delete an attribute condition.

Move a selected row up.

Move a selected row down.

View the condition definition.

And/Or Click inside the And/Or field and select either And or Or 
to link multiple conditions.

Attribute name Select an attribute from the list.

Brackets Click inside the Brackets box to display a list of brackets 
you can use to build more complex, logical statements.

Criteria Contains the attribute condition definition as defined in 
the Element Instances dialog box.

Not Select NOT if you want the condition statement to do the 
opposite of what is defined.

Note: If you select NOT, query results do not include data 
from the CI instances that were not assigned a value. For 
example, your system contains three node CIs: Node1 is 
assigned the value A, Node2 is assigned the value B and 
Node3 is not assigned a value. You create a query to 
retrieve all nodes that are equal to A and select NOT; the 
results of your query only include Node2 because Node3 
is not assigned a value.

Operator Select the required operator. For details, see "Attribute 
Operator Definitions" on page 42.

Value Enter or select the value of the attribute. The Value 
options vary according to the attribute type you select.
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Create/Edit/Save Reveal Path Dialog Box

This dialog box enables you to define a new reveal path or edit an existing 
path.

User interface elements are described below:

To access To define a new reveal path, click the Reveal  button 
from the Model Editor, and select Create Reveal Path. 

To edit an existing reveal path, select a path from the 
Open Saved Reveal Path dialog box and click Edit.

To save a reveal path, click Save Path from the Reveal CIs 
dialog box.

UI Elements (A-Z) Description

Description Enter a description of the path.

Name Enter the name of the path.

Preview Opens the Reveal CIs dialog box displaying the related 
CIs in the path.

Note: This button does not appear in the Save Reveal 
Path dialog box.

Reveal Path Build the path by clicking the  icon to open a dialog 
box with a CI type tree. Select the CI type for the next 
item in the path.

When you hold the pointer over a reveal path item, the 
following options are available:

➤ Delete. Deletes the item from the reveal path.

➤ Add condition. Opens the Conditions of Related CIs 
dialog box, which enables you to set conditions for 
the reveal path item.

➤ Refine Query Node Type. Opens a CI type tree, which 
enables you to change the CI type of the reveal path 
item.
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Creating New View Dialog Box

This dialog box enables you to select a perspective to create a view from a 
model.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access In the Modeling Studio, right-click a model in the Model 
Editor, Perspective-based View Editor, or CI Selector and 
select Generate view for selected Model or click the 
Generate view for selected model icon  from the 
Model Editor.

Important 
information

You select perspectives in the left pane and move them to 
the right pane using the arrow buttons.

Relevant tasks "Build a Perspective-based View Based on a Model" on 
page 297

UI Elements (A-Z) Description

Available 
Perspectives

A list of the available perspectives to apply to your 
model.

Selected Perspectives The perspectives you selected to apply to your model.
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Cycle Definition Dialog Box

This dialog box enables you to define a cyclical hierarchy in a view.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access In the Modeling Studio, right-click a query node in the 
Hierarchy pane of the Pattern View Editor and select 
Define Cycles.

Important 
information

You can extend the TQL query definition of a view by 
defining a cycle in the view hierarchy. Select a query 
node in the Hierarchy pane to be the source query node. 
The Cycle Definition dialog box displays the valid target 
query nodes for that source. The target query node in the 
cycle, along with its hierarchy, is treated as a child or 
sibling of the source query node (depending on your 
folding rule selection). 

UI Elements (A-Z) Description

Folding Rule Select one of the following options:

➤ Folded cycle under source. The target query node 
becomes a child of the source query node.

➤ Flattened cycle under parent. The target query node 
becomes a sibling of the source query node.

Target Displays the valid target query nodes for the selected 
source query node. A query node is defined as a valid 
target query node if all of the following conditions are 
true:

➤ it is related to the source query node

➤ it is an ancestor of the source query node (or the 
source query node itself)

➤ it is a query based node (not a grouping node)
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Hidden CIs Dialog Box

This dialog box enables you to restore hidden CIs to a view.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Hierarchy Rules Dialog Box

This dialog box enables you to set the hierarchy of a view by defining 
hierarchy rules.

To access From the Perspective-based View Editor, click the Show 
Hidden CIs icon from the toolbar of the View Results 
pane.

UI Elements (A-Z) Description

<check box> Select the check boxes for the CIs you want to restore.

CI Type The CI type of the excluded CI.

Name The name of the excluded CI.

Restore Click Restore to include the selected CIs in the view.

Select All Click Select All to select all the CIs in the list for 
inclusion in the view.

Unselect All Click Unselect All to clear the check boxes of all the CIs 
in the list.

To access From the Hierarchy pane of the Pattern View Editor, 
when Rule Based is selected as the hierarchy method, 
click the Add Hierarchy Rule button  from the toolbar.

Important 
information

For each hierarchy rule you define, select a source CI 
type, target CI type, relationship, and direction.
310



Chapter 8 • Modeling Studio
User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Left Pane

This area enables you to browse views and TQL queries, search for CIs or 
models to open in the Editor pane, and select CI types to use in the TQL 
Query Editor or Pattern View Editor.

UI Elements (A-Z) Description

Click to add a hierarchy rule.

Click to delete the selected hierarchy rule.

Relationship Select a relationship from the drop-down list to edit the 
selected hierarchy rule.

Relationship 
Direction

Select a direction from the drop-down list to edit the 
selected hierarchy rule.

Source Select a CI type for the source CI type from the drop-
down tree to edit the selected hierarchy rule.

Target Select a CI type for the target CI type from the drop-
down tree to edit the selected hierarchy rule.

To access Located to the left of the Editor pane in Modeling Studio.

Important 
information

The following tabs are available:

➤ CI Selector. See "CI Selector" on page 151.

➤ Resources. Enables you to select a model, view, or TQL 
query to open in the Editor pane.

➤ CI Types. Enables you to select CI types from the tree 
to add as a query node to your TQL query in the Editor 
pane.
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Resources Tab

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

Click New Folder to create a new folder in the resource 
tree.

Note: This button only appears when Queries or Views 
are selected as the resource type.

Click Delete to delete the selected resource from the 
CMDB.

Click Refresh to refresh the resource tree.

Click Expand All to expand all the folders in the resource 
tree.

Note: This button only appears when Queries or Views 
are selected as the resource type.

Click Collapse All to collapse all the folders in the 
resource tree.

Note: This button only appears when Queries or Views 
are selected as the resource type.

Click Hide Empty Folders to display only folders 
containing models, views or TQL queries.

When Views is selected as the resource type, click Filter 
Tree to filter the types of views and templates that appear 
in the tree.

When Queries is selected as the resource type, it enables 
you to filter the TQL queries that appear in the tree by 
query type.

When Models is selected as the resource type, click Filter 
Table to filter the models in the table by CI type.
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Click Open Query to open the selected TQL query in the 
Editor pane.

Note: This button only appears when Queries is selected 
as the resource type.

Click Open View to open the selected view in the Editor 
pane.

Note: This button only appears when Views is selected as 
the resource type.

Click CI Properties to view the properties of the selected 
model.

Note: This button only appears when Models is selected 
as the resource type.

Click Show views containing selected CI/model to 
display a list of views including the selected CI or model.

Note: This button only appears when Models is selected 
as the resource type.

Click Open Model to open the selected model in the 
Model Editor.

Note: This button only appears when Models is selected 
as the resource type.

Click Import From XML to import XML files that contain 
saved views or queries to the Modeling Studio.

Note: This button only appears when Queries or Views 
are selected as the resource type.

Click Export To XML to export the view or query as an 
XML script. This option can be used to move a view or 
query from one workstation to another.

Note: This button only appears when Queries or Views 
are selected as the resource type.

UI Elements (A-Z) Description
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Resources Tab Shortcut Menu

The Resources tab includes the following elements (listed alphabetically) 
available by right-clicking a resource:

<Resource tree> The available views, models, or TQL queries are displayed 
under their respective folders in tree format.

The following view types are included:

➤  Denotes a pattern view.

➤  Denotes a template.

➤  Denotes a template-based view.

➤  Denotes a perspective.

➤  Denotes a perspective-based view.

Resource Type Select the resource type to display in the resource tree. 
The available options are Models, Views, and Queries.

Menu Item Description

Delete Delete the selected resource from the CMDB.

Export Export the view or query as an XML script. This option 
can be used to move a view or query from one 
workstation to another.

New Folder Create a new folder in the resource tree.

New Template-based 
View

Edit the parameters of the selected template to define a 
new template-based view.

Note: This option is only active when a template is 
selected in the view tree.

Open Query/View Open the selected view or TQL query in the Editor pane.

Refresh Refresh the resource tree.

Rename Folder Rename the selected folder.

Save As Save the selected TQL query with a new name.

Note: This option is only relevant for queries.

UI Elements (A-Z) Description
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CI Types Tab

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

CI Types Tab Shortcut Menu

The CI Types tab includes the following elements (listed alphabetically) 
available by right-clicking a CI type:

UI Elements (A-Z) Description

Click Expand All to expand all the folders in the CI Type 
tree.

Click Collapse All to collapse all the folders in the CI Type 
tree.

Tree View Click Tree View to select the display format of the CI type 
tree. The following options are available:

➤ Display label

➤ Class name

➤ Legacy class name

Click to add the selected CI type to the TQL query which 
is open in the Editor pane.

Note: This button is only active when a view or TQL 
query is open in the Editor pane.

Click Refresh to refresh the CI Type tree.

<CI Type tree> The available CI types are displayed in tree format.

Menu Item Description

Add Selected CITs to 
Query

Select to add the selected CI type to the TQL query open 
in the Editor pane.

Go to CI Type 
Definition

Takes you directly to the selected CI type in CIT Manager.

Show Element 
Instances

Opens the CI Instances window, which displays all 
instances of the selected CIT. For details, see "Element 
Instances Dialog Box" on page 73.
315



Chapter 8 • Modeling Studio
Manage CI Watchpoints Dialog Box

This dialog box enables you to add or remove watchpoints for a CI in a 
model.

User interface elements are described below:

To access From within a model in the Model Editor, click the 
Watchpoint  button and select Manage CI 
Watchpoints or right-click a CI in the model and select 
Watchpoint > Manage CI Watchpoints.

UI Elements (A-Z) Description

Add Click to open the New Watchpoint dialog box which 
enables you to add a new watchpoint.

Remove Click to delete the selected watchpoint.

Automated A check mark indicates that the new CIs found by the 
watchpoint are to be added to the view automatically.

Source CI Displays the CI forming the beginning of the reveal path.

Watchpoint Name The name of the reveal path associated with the 
watchpoint.

Watchpoint Path Displays the reveal path for the watchpoint.
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Model Editor

This feature enables you to create and edit models.

Content Pane

User interface elements are described below:

To access In the Modeling Studio, click the New button  and 
select Instance Based Model to create a new model or 
select Models as the Resource type and open an existing 
model.

Important 
information

The Model Editor contains the following panes:

➤ Content pane. Lists the CIs and models contained in 
the model.

➤ Information pane. Displays the properties, related CIs 
and watchpoints for the selected CI or model.

You can drag CIs from the CI Selector into the Content 
pane of an existing model to add them to the model. 
However, you cannot drag in a CI that is already included 
in the model.

You can drag CIs from the CI Selector into the Related CIs 
tab of the Information pane provided that the selected 
source and target CI can be related by a usage 
relationship.

UI Elements (A-Z) Description

Select Map Mode to display the CIs as icons in a diagram.

Select Text Mode to display the CIs in a list.

Click CI Properties to open the Configuration Item 
Properties dialog box for the selected CI.

Click Show models containing selected CI to display a 
list of the models containing the selected CI.
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Click Show views containing selected CI/model to 
display a list of the views containing the selected CI or 
model.

Click Open selected model in a new tab to open the 
selected model in a separate Model Editor tab.

Click Generate view for selected model to create a view 
based on the current model. The Creating New View 
dialog box opens, which enables you to select a 
perspective to apply.

Click to remove a selected CI from the model (it remains 
in the CMDB).

Click Insert new model to open the New Model dialog 
box which enables you to define a new model within the 
existing model.

Click Expand All to expand the model hierarchy.

Click Collapse All to collapse the model hierarchy.

Click Reveal for the following options:

➤ Start Revealing. Opens the Reveal CIs dialog box. For 
details, see Reveal CIs dialog box.

➤ Create Reveal Path. Opens the Create Reveal Path 
dialog box. For details, see Create Reveal Path dialog 
box.

➤ Open Reveal Path. Opens the Open Saved Reveal Path 
dialog box. For details, see Open Saved Reveal Path 
dialog box.

UI Elements (A-Z) Description
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Click Watchpoint for the following options:

➤ Watchpoints Updates. Display the watchpoint results 
and select CIs to add to the model. For details, see 
Watchpoints Updates dialog box.

➤ New Watchpoint. Define a new watchpoint for the 
selected CI. For details, see New Watchpoint dialog 
box.

➤ Manage CI Watchpoints. Add new watchpoints to the 
CI or remove existing ones. For details, see Manage CI 
Watchpoints dialog box.

Click CI Collection to group CIs in a collection under a 
model. Select one of the following options:

➤ Insert New CI Collection. Create a new empty CI 
Collection. After creating the collection, you can drag 
CIs into it from the CI Selector, the related CIs tab, or 
from the model itself.

➤ Join to CI Collection. Select a CI or several CIs in the 
model and join them to an existing CI collection or 
form a new collection.

➤ Decompose CI Collection. Select a CI collection and 
decompose it. Its CIs remain directly under the main 
model.

Click Find to toggle between displaying and hiding the 
Find box and arrow controls.

Note: This button only appears in Text mode.

Click to refresh the map and optimize the map layout.

Note: This button only appears in Map mode.

Click Fit to Window to resize the map to fit the size of the 
pane.

Note: This button only appears in Map mode.

UI Elements (A-Z) Description
319



Chapter 8 • Modeling Studio
Select the functionality of the cursor from the Mode 
drop-down. The following options are available:

➤ Select

➤ Drag Map

➤ Zoom

Note: This feature only appears in Map mode.

Click the Print button to select Print, Print Preview or 
Print Setup.

Select a CI and click Show External Relationships to 
display the related CIs for that CI.

Note: This button only appears in Map mode.

Click Hide External Relationships to hide the related CIs.

Note: This button only appears in Map mode.

Indicates that watchpoints are defined for the current CI.

Indicates that the watchpoints have detected new CIs 
related to the current model. Click it to open the 
Watchpoints Updates dialog box.

CI Type column Displays the type of each CI in the model.

Find Enter a CI name or a portion of a CI name in the Find 
box to locate a CI in the model.

Find Next Click to go to the next occurrence of the selected search 
phrase in the model.

Find Previous Click to go to the previous occurrence of the selected 
search phrase in the model.

Highlight Click to highlight all occurrences of the search phrase in 
the model.

Name column Displays the name of each CI in the model.

UI Elements (A-Z) Description
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Shortcut Menu Options

Menu Item Description

CI Collection Click CI Collection to group CIs in a collection under a 
model. Select one of the following options:

➤ Insert New CI Collection. Create a new empty 
collection. After creating the collection, you can drag 
CIs into it from the CI Selector, the related CIs tab, or 
from the model itself.

➤ Join to CI Collection. Select a CI or several CIs in the 
model and join them to an existing CI collection or 
form a new group.

➤ Decompose CI Collection. Select a CI collection and 
decompose it. Its CIs remain directly under the main 
model.

Fit to Window Resizes the map to fit the size of the pane.

Note: This option only appears in Map mode.

Generate view for 
selected model

Select to create a view based on the current model. The 
Creating New View dialog box opens which enables you 
to select a perspective to apply.

Hide External 
Relationships

Hides the related CIs from the map.

Note: This option only appears in Map mode.

Insert New Model Opens the New Model dialog box which enables you to 
create a new model within the existing model.

Open selected model 
in a new tab

Opens the selected model in a separate Model Editor tab.

Print Select one of the following options:

➤ Print

➤ Print Preview

➤ Print Setup

Properties Opens the Configuration Item Properties dialog box for 
the selected CI.

Refresh Layout Refreshes the map and optimizes the map layout.

Note: This option only appears in Map mode.
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Reveal The following options are available:

➤ Start Revealing. Opens the Reveal CIs dialog box. For 
details, see Reveal CIs dialog box.

➤ Open Reveal Path. Opens the Open Saved Reveal Path 
dialog box. For details, see Open Saved Reveal Path 
dialog box.

Remove Selected 
CI(s) from the Model

Deletes the selected CIs from the model (it remains in 
the CMDB).

Select Select the functionality of the cursor. The following 
options are available:

➤ Select

➤ Drap Map

➤ Zoom

Note: This option only appears in Map mode.

Show Containing 
Models

Click to display a list of the models containing the 
selected CI.

Show Containing 
Views

Click to display a list of the views containing the 
selected CI or model.

Show External 
Relationships

Displays the related CIs for the selected CI.

Note: This option only appears in Map mode.

Watchpoint The following options are available:

➤ Watchpoints Updates. Display the watchpoint results 
and select CIs to add to the model. For details, see 
Watchpoints Updates dialog box.

➤ New Watchpoint. Define a new watchpoint for the 
selected CI. For details, see New Watchpoint dialog 
box.

➤ Manage CI Watchpoints. Add new watchpoints to the 
CI or remove existing ones. For details, see Manage CI 
Watchpoints dialog box.

Zoom Select the size of the map from the list of percents.

Note: This option only appears in Map mode.

Menu Item Description
322



Chapter 8 • Modeling Studio
Information Pane - Properties Tab

This area displays the properties of the selected CI.

Information Pane - Related CIs Tab

This area displays the CIs related to the model by one of the triplets that 
includes an Impacted By (Potentially) relationship.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Important 
information

This pane is identical to the Properties tab of the 
Information pane in IT Universe Manager. For details, see 
"Configuration Item Properties Dialog Box" on page 233. 

UI Elements (A-Z) Description

Click to delete the relationship to the selected CI.

Click Invert Direction to switch the direction of the 
relationship for the selected CI.

Note: This option is only active for CIs related by a usage 
relationship.

<CI list> Lists the name and CI type of the CIs related to the 
model by usage relationships, as well as the direction of 
the relationship.

Filter by Select a field by which to filter the results and enter the 
value in the by box.
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Information Pane - Watchpoints Tab

This area displays the watchpoints defined for the selected CI.

User interface elements are described below:

Modeling Studio Page

This page enables you to create and edit models and views.

UI Elements (A-Z) Description

Click to open the Manage CI Watchpoints dialog box, 
which enables you to edit the watchpoint.

Automated Indicates whether the new CIs found by the watchpoint 
are automatically added to the view.

Source CI Displays the CI forming the beginning of the reveal path.

Watchpoint Name The name of the reveal path associated with the 
watchpoint.

Watchpoint Path Displays the reveal path of the watchpoint.

To access Select Modeling Studio from the Navigation Menu or 
select Managers >  Modeling > Modeling Studio.

Important 
information

The Modeling Studio page contains the following panes:

➤ Left pane. Enables you to search for CIs or select a 
view, model, or TQL query to open. For details, see 
"Left Pane" on page 311.

➤ Editor pane. Displays the topology map of a selected 
view, model, or TQL query.

The Editor pane is a blank canvas before any views or 
models are opened. When you open a view, model, or 
TQL query, the relevant editor appears there. Multiple 
views, models, and queries can be open at the same time 
in the Editor pane, each within a separate tab.

See also Model Editor, Perspective-based View Editor, Pattern 
View Editor, TQL Query Editor
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

New Click the click the New button to select one of the 
following options:

➤ Instance Based Model. To create a new instance based 
model.

➤ Pattern Based Model. To create a new pattern based 
model.

➤ Pattern View. To create a new pattern view.

➤ Template Based View. To create a new template-based 
view.

➤ Perspective Based View. To create a new perspective-
based view.

➤ Template. To create a new template.

➤ Perspective. To create a new perspective.

➤ Query. To create a new TQL query.

Click Save to save the changes to your view, model, or 
query.

For views, a dialog box opens which enables you to 
rename your view and save it in the appropriate folder.

Click Save As to save your view, model, or TQL query 
under a new name.

Click Undo to reverse the last change you made.

Click Redo to repeat the last action you took.

Click Maximize Workspace to toggle between the regular 
display and a full-screen display of the editor.

<Menu> For details, see "Main Menu" on page 185.
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Models Containing Selected CI Dialog Box

This dialog box enables you to display a list of the models containing the 
selected CI.

User interface elements are described below:

To access Click the Show models containing selected CI  button 
in the Model Editor or select Show containing models 
from the shortcut menu.

UI Elements (A-Z) Description

Click CI Properties to open the Configuration Item 
Properties dialog box for the selected model.

Click Show views containing selected CI/model to 
display a list of views containing the selected model.

Click Remove model to delete the selected model.

CI Type Displays the CI types of the models containing the 
selected CI.

Find Enter a model name or a portion of a model name in the 
Find box to locate it in the list.

Find Next Click to go to the next occurrence of the selected search 
phrase in the list.

Find Previous Click to go to the previous occurrence of the selected 
search phrase in the list.

Name Displays the names of the models containing the selected 
CI.

Note: The name of the current model appears in faded 
text.
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New Model Dialog Box

This dialog box enables you to define a reusable model containing a 
collection of CIs.

User interface elements are described below:

New Pattern View/Template/Perspective Dialog Box

This dialog box enables you to define a new pattern view, template, or 
perspective using the Pattern View Editor.

To access Click the New  button and select Instance Based 
Model or drag a CI from the tree in the CI Selector onto 
the editing pane and select Create a new model.

Relevant tasks "Build a Business CI Model" on page 294

UI Elements (A-Z) Description

Define new CI 
Properties

Enter the values for the CI properties. You must enter 
values for key properties and required properties. The key 
properties are marked with a key symbol  and the 
required properties are marked with an asterisk.

Select CI Type Select a CI type from the list to serve as the basis for your 
model.

To access In the Modeling Studio, click the New  button and 
select Pattern View, Template, or Perspective from the 
drop-down menu.

Important 
information

After making your selection and clicking OK, you go 
directly to the Pattern View Editor to begin building your 
view. For details, see "Pattern View Editor" on page 333.

Relevant tasks "Create a Pattern View" on page 285, "Create a Template" 
on page 286, "Create a Perspective" on page 288
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

New Watchpoint Dialog Box

This dialog box enables you to define a watchpoint for a CI in a model.

UI Elements (A-Z) Description

Click to go to the next occurrence of the selected search 
phrase in the list of TQL queries.

Click to go to the previous occurrence of the selected 
search phrase in the list of TQL queries.

Click to highlight all occurrences of the search phrase in 
the list of TQL queries.

<TQL query tree> Displays the existing TQL queries in tree format.

Choose base query If you want to base your new view on an existing TQL 
query, select this option and select a TQL query from the 
tree. The Pattern View Editor opens with the selected 
TQL query on the canvas.

Create new query If you want to base your new view on a new TQL query, 
select this option. The Pattern View Editor opens with a 
blank canvas.

Find Enter a TQL query name or a portion of a query name in 
the Find box to locate a TQL query in the list.

To access From within a model in the Model Editor, click the 
Watchpoint  button and select New Watchpoint or 
right-click a CI in the model and select Watchpoint > 
New Watchpoint.
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User interface elements are described below:

Open Saved Reveal Path Dialog Box

This dialog box enables you to open an existing path.

Important 
information

If no reveal paths are found for the selected CI, no 
watchpoints can be defined.

You cannot define watchpoints for CIs in a new model 
until you save the model.

Relevant tasks "Build a Business CI Model" on page 294

UI Elements (A-Z) Description

Automatically update 
model

Select to automatically add all revealed CIs from the 
selected path to the model.

Control updates 
manually

Select to manually add revealed CIs from the selected 
path to the model.

Select Watchpoint 
reveal path

Select a reveal path from the drop-down list.

Show reveal paths 
for CI type

Select a CI type from the drop-down list. All reveal paths 
beginning with that CI type appear in the list in the 
lower drop-down box.

To access From within a model in the Model Editor, click the 
Reveal  button and select Open Reveal Path or right-
click a CI in the model and select Reveal > Open Reveal 
Path.

Important 
information

After selecting the reveal path you want to use, click 
Execute. If CIs are found on the selected path, the Reveal 
CIs dialog box opens for that path. If no CIs are found, a 
message appears stating that no CIs were found on the 
path.
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User interface elements are described below:

Pattern-based Model Wizard

This wizard enables you to build a pattern-based model.

UI Elements (A-Z) Description

Description column Displays the descriptions of the existing paths.

Edit Opens the Edit Reveal Path dialog box which enables you 
to edit the selected path.

Execute Opens the Reveal CIs dialog box for the selected reveal 
path.

Find Enter a path name or a portion of a path name in the 
Find box to locate a path in the list.

Find Next Click to go to the next occurrence of the selected search 
phrase in the list of paths.

Find Previous Click to go to the previous occurrence of the selected 
search phrase in the list of paths.

Highlight Click to highlight all occurrences of the search phrase in 
the list of paths.

Name column Displays the names of the existing paths.

Remove Deletes the selected path.

Show reveal paths 
for CI type

Select a CI type from the drop-down list. All paths 
beginning with the selected CI appear in the table below.

To access In the Modeling Studio, click the New  button and 
select Pattern Based Model from the drop-down menu.

Important 
information

When you create a pattern-based model, the model is 
saved as a CI, as with an ordinary model. If you based 
your model on a new TQL query, the query is also saved 
and appears in the TQL query tree.

Relevant tasks "Build a Pattern-based Model" on page 296
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Select CI Type Page
This wizard page enables you to select a CI type for the model and define its 
details.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Query Selection Page
This wizard page enables you to select a TQL query upon which the model is 
based.

Wizard map The Pattern-based Model Wizard contains:

Select CI Type Page > Query Selection Page

See also "Pattern-based Models" on page 276

Wizard map The Pattern-based Model Wizard contains:

Select CI Type Page > Query Selection Page

UI Elements (A-Z) Description

Define new CI 
Properties

Enter the values for the CI properties. You must enter 
values for key properties and required properties. The key 
properties are marked with a key symbol  and the 
required properties are marked with an asterisk.

Select CI Type Select a CI type from the list to serve as the basis for your 
model.

Wizard map The Pattern-based Model Wizard contains:

Select CI Type Page > Query Selection Page
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

Click to go to the next occurrence of the selected search 
phrase in the list of TQL queries.

Click to go to the previous occurrence of the selected 
search phrase in the list of TQL queries.

Click to highlight all occurrences of the search phrase in 
the list of TQL queries.

<TQL Query tree> Displays the existing TQL queries in tree format.

Choose base query If you want to base your model on an existing TQL query, 
select this option and select a query from the tree. The 
TQL Query Editor opens with the selected query on the 
canvas.

Create new query If you want to base your model on a new TQL query, 
select this option. The TQL Query Editor opens with a 
blank canvas.

Find Enter a TQL query name or a portion of a query name in 
the Find box to locate a query in the list.
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Pattern View Editor

This feature enables you to build and edit pattern views, templates, and 
perspectives.

To access To open a new view in the Pattern View Editor, go to the 
Modeling Studio, click the New  button and select the 
required type of view.

To open an existing view in the Pattern View Editor, go to 
the Resources tab of the left pane in the Modeling Studio 
and select Views as the Resource type. Right click a view 
in the tree and select Open View or double click a view or 
drag a view onto the Editor pane. The topology map of 
the view opens in the Editor pane.

Important 
information

You can access the Editor in View mode or in Report 
mode.

➤ In View mode, the following panes are included:

➤ Editing pane. For details, see "TQL Query Editor" on 
page 355.

➤ Advanced pane. For details, see "Advanced Pane" on 
page 357.

➤ Hierarchy pane. Enables you to set the hierarchy of 
the view. (Located in the right portion of the Editor 
page.)

➤ In Report mode, the following panes are included:

➤ Hierarchy pane. Enables you to set the hierarchy of 
the view. (Located in the left portion of the Editor 
page.)

➤ Query Node Definition. Enables you to select the 
attributes to be included in the report and to set 
their order.

Note: To save your view, template, or perspective, use the 
Save button in the Modeling Studio main toolbar.

Relevant tasks "Create a Pattern View" on page 285, "Create a Template" 
on page 286, "Create a Perspective" on page 288
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Hierarchy Pane

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

Click Add Group By to create a subgroup in the 
hierarchy. The following options are available:

➤ Add Group By Attribute. Opens the Query Node 
Grouping dialog box, which enables you to select an 
attribute for a subgroup in the hierarchy.

➤ Add Group By CI Type. Create a subgroup in the 
hierarchy for the CI type of the selected query node.

➤ Add Group by Query Node. Create a subgroup in the 
hierarchy for the selected query node only.

Click Edit Group By Attribute to open the Query Node 
Grouping dialog box, which enables you to edit the 
attribute for a subgroup in the hierarchy.

Click Rename to rename the selected query node.

Click Delete Query Node to delete the selected query 
node from the hierarchy tree.

Click Move Query Node Layer Up to place the selected 
query node one layer higher in the hierarchy.

Click Move Query Node Layer Down to place the selected 
query node under the query node above it in the 
hierarchy.

Note: If the selected query node is located at the top of 
the hierarchy tree, clicking Move Query Node Layer 
Down places it under the query node beneath it in the 
hierarchy.

Click Move Query Node Up to move the selected query 
node up in the hierarchy tree. The query node order in 
the hierarchy determines the query node order in the 
report generated for the view in Reports.
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Shortcut Menu

The Hierarchy pane includes the following elements (listed alphabetically) 
available by right-clicking a query node in the hierarchy tree:

Click Move Query Node Down to move the selected 
query node down in the hierarchy tree. The query node 
order in the hierarchy determines the query node order 
in the report generated for the view in Reports.

Click Preview to display a preview of the topology report.

Note: This option only appears in the Hierarchy pane 
when Report mode is selected.

<Hierarchy tree> The query nodes of the TQL query are arranged in a 
hierarchical tree reflecting the hierarchy defined for the 
view.

You can click and drag query nodes to change the 
hierarchy. When you click a query node and begin to 
drag it, the query nodes under which it is possible to 
place your query node are highlighted in green.

Hierarchy Method Select the method of setting the hierarchy:

➤ Manual. Set the hierarchy manually, by dragging 
query nodes and using the toolbar buttons.

➤ Rule Based. Open the Hierarchy Rules dialog box 
which enables you to set rules for the hierarchy.

Menu Item Description

Add Group By 
Attribute

Select Add Group By Attribute to open the Query Node 
Grouping dialog box, which enables you to select an 
attribute for a subgroup in the hierarchy.

Add Group By CI 
Type

Select Add Group By CI Type to create a subgroup in the 
hierarchy for the CI type of the selected query node.

Add Group By Query 
Node

Select Add Group By Query Node to create a subgroup in 
the hierarchy for the selected query node only.

UI Elements (A-Z) Description
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Query Node Definition Pane

User interface elements are described below:

Define Cycles Select Define Cycles to define a cyclical hierarchy. For 
details, see "Cycle Definition Dialog Box" on page 309.

Delete Query Node Select to delete the selected query node from the 
hierarchy tree.

Move Query Node 
Down

Select to move the selected query node down in the 
hierarchy tree.

Move Query Node 
Layer Down

Select Move Query Node Layer Down to place the 
selected query node under the query node above it in the 
hierarchy.

Note: If the selected query node is located at the top of 
the hierarchy tree, selecting Move Query Node Layer 
Down places it under the query node beneath it in the 
hierarchy

Move Query Node 
Layer Up

Select Move Query Node Layer Up to place the selected 
query node one layer higher in the hierarchy.

Move Query Node 
Up

Select to move the selected query node up in the 
hierarchy tree.

Rename Select to rename the selected query node.

Subgraph Hierarchy Enables you to define whether the subgraph defined for 
the selected query node is displayed as flat or as folded 
under the query node.

Note: This option is only relevant for query nodes that 
have a defined subgraph.

UI Elements (A-Z) Description

Click Up to move a selected attribute up in the report 
layout order.

Click Down to move a selected attribute down in the 
report layout order.

Menu Item Description
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Click Edit to edit the function for the selected attribute.

Click Delete to delete a selected attribute from the report 
layout.

Click to move the selected attributes to the Report Layout 
list.

Add Function Click Add Function to open the Add Function dialog box, 
which enables you to define the functions to include in 
the report for the selected query node. Each function that 
you add is treated as an attribute and becomes a column 
in the report.

Note: This button is only active if there is a query node 
below the selected query node in the view hierarchy.

Attributes The list of available attributes for the selected query 
node.

Define Chart Click Define Chart to display the data for the current 
layer of the view in a graphical chart format. The Chart 
Properties fields are displayed.

The Define Chart option is only active for a query node 
or a grouping node that:

➤ has a layer below it in the view hierarchy

➤ is the only query node on its layer of the view

➤ has at least one numeric attribute selected for the 
report layout

Report Layout Displays the list of attributes selected to appear in the 
report. Use the toolbar buttons to change the order of the 
attributes in the report and to add functions.

Set Sort Order Click to open the Set Column Sort Order dialog box 
which enables you to set the order of the report columns.

UI Elements (A-Z) Description
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Chart Properties

The Chart Properties portion of the pane includes the following elements 
(listed alphabetically):

Perspective-based View Editor

This feature enables you to create and edit perspective-based views.

UI Elements (A-Z) Description

Click Remove Chart to remove the chart from the report. 
The report is generated in table format.

Breakdown by The chart is broken down by the CI or grouping node 
display label. This is fixed for all reports.

Chart Type Select Pie to create a pie chart or Bar to create a bar chart.

Value Select a value from the drop-down list.

To access In the Modeling Studio, click the New button  and 
select Perspective Based View to create a new view or 
drag CIs from the CI Selector onto the blank canvas and 
select Create a new view. 

To open an existing view in the Editor, select Views as the 
resource type in the Resources pane, select the required 
perspective-based view from the tree, and click Open 
View  or double-click the view.
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Content Pane

User interface elements are described below:

Important 
information

The Perspective-based View Editor contains the following 
panes:

➤ Content pane. Drag CIs and/or models onto this pane 
to include them in your view.

➤ Perspective pane. Select perspectives to apply to the 
content to build a view.

➤ View Results pane. Displays a topology map with a 
preview of the current view. This pane includes most 
of the IT Universe Manager functionality.

Relevant tasks "Build a Perspective-based View Based on a Model" on 
page 297, "Build a Perspective-based View Based on a 
Collection of CIs" on page 298

UI Elements (A-Z) Description

Go directly to IT Universe Manager for the current view.

Click CI Properties to open the Configuration Item 
Properties dialog box for the selected CI.

Click Show models containing selected CI to display a 
list of the models containing the selected CI.

Click Show views containing selected CI/model to 
display a list of the views containing the selected CI or 
model.

Click Open selected model in a new tab to open the 
selected model in a separate Model Editor tab.

Click Generate view for selected model to create a view 
based on the selected model. The Creating New View 
dialog box opens which enables you to select a 
perspective to apply.

Click to remove a selected CI from the view content.
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Shortcut Menu Options

Click View Definition Properties to open the View 
Definition Properties dialog box which enables you to set 
properties for the view.

Click Find to toggle between displaying and hiding the 
Find box and arrow controls.

CI Type column Displays the type of each CI in the view.

Find Enter a CI name or a portion of a CI name in the Find 
box to locate a CI in the view

Find Next Click to go to the next occurrence of the selected search 
phrase in the view.

Find Previous Click to go to the previous occurrence of the selected 
search phrase in the view.

Highlight Click to highlight all occurrences of the search phrase in 
the view.

Name column Displays the name of each CI in the view.

Menu Item Description

Generate view for 
selected model

Select to create a view based on the selected model. The 
Creating New View dialog box opens which enables you 
to select a perspective to apply.

Open selected model 
in a new tab

Opens the selected model in a separate Model Editor tab.

Properties Opens the Configuration Item Properties dialog box for 
the selected CI.

Remove Base CIs Deletes the selected CI or model from the view content.

Show Containing 
Models

Click to display a list of the models containing the 
selected CI.

Show Containing 
Views

Click to display a list of the views containing the 
selected CI or model.

UI Elements (A-Z) Description
340



Chapter 8 • Modeling Studio
Perspective Pane

User interface elements are described below:

View Results Pane

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

Delete the selected level of the perspective selection.

Shift the perspective selection from the current level to 
the previous one.

Shift the perspective selection from the current level to 
the following one.

Add a new level to the perspective selection. The results 
of the previous perspective level serve as the input 
content for the new level.

Open a dialog box with the available perspectives. Move 
the required perspectives from the available column to 
the selected column using the arrow buttons.

Apply Over Model 
Hierarchy

For views based on models, select the Apply Over Model 
Hierarchy check box to include the model hierarchy in 
the view and apply the perspectives to the CIs included 
in the model as well as to the model itself. Clear the 
check box to exclude the model hierarchy from the view 
and apply the perspectives to the model itself only. In 
this case, the model is treated as an ordinary CI.

Note: This option is disabled for a view based on a 
collection of CIs or on a model and a collection of CIs.

Perspectives Lists the selected perspectives.

UI Elements (A-Z) Description

Map Click to display the view results in Map mode.

Text Click to display the view results in Text mode.
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Create a relationship between two CIs in the view.

Toggle between hiding and displaying the topology map 
legend.

Move up one level in the topology map.

Move down one level in the topology map. 

Delete the selected CI from the view.

Click Show CI Properties to open the Configuration Item 
Properties dialog box for the selected CI.

Click Refresh to refresh the view results.

Click Hide CI from View to hide the selected CI from the 
view. This option is only relevant for CIs that were added 
to the view via the perspective. You cannot hide CIs from 
the original view content from the view.

Note: Hidden CIs can be restored from the Hidden CIs 
dialog box.

Click Show Hidden CIs to open the Hidden CIs dialog 
box which enables you to restore CIs that were hidden 
from the view manually.

Click Create view based on selected CI/s to create a new 
view based on the CIs selected from the View Results 
pane.

Click Expand preview display to display the preview in a 
separate pane.

<Breadcrumbs> At the top of the topology map, the breadcrumbs 
indicate the relevant query nodes in each layer of the 
view for the path to the selected layer. The first item in 
the path is the Top Layer. When you select a CI from the 
layer below, the parent CI forms the next item in the 
breadcrumb path. You can click on any item in the path 
to display that layer in the topology map.

UI Elements (A-Z) Description
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Shortcut Menu Options

<Legend> Indicates the icons displayed next to CIs with any of the 
following special statuses:

➤ Added. When Change Timeframe is active, indicates 
that the CI was added.

➤ Affected. When Impact Analysis is active, indicates an 
affected CI.

➤ Affected and Trigger. When Impact Analysis is active, 
indicates a trigger CI that is affected.

➤ Candidate for Deletion. Indicates that the CI is a 
candidate for deletion.

➤ Changed. When Change Timeframe is active, 
indicates that the CI was changed.

➤ Note. Indicates that a note was added for the CI.

➤ Trigger. When Impact Analysis is active, indicates a 
trigger CI.

<Topology Map> The topology map in the View Results pane follows the 
layout of the topology map in IT Universe Manager. For 
details, see "Topology Map" on page 245.

<Topology Map 
Sidebar>

For details, see "Topology Map Sidebar" on page 197.

Menu Item Description

<IT Universe Shortcut 
Menu options>

The IT Universe Manager shortcut menu options are 
available. For details, see "IT Universe Manager Shortcut 
Menu" on page 250.

Create view based on 
selected CI/s

Select Create view based on selected CI/s to create a 
new view based on the CIs selected from the View 
Results pane.

UI Elements (A-Z) Description
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Query Node Grouping Dialog Box

This dialog box enables you to define a new grouping of CIs or to edit an 
existing grouping.

User interface elements are described below:

Hide CI from View Click to hide the selected CI from the view. This option 
is only relevant for CIs that were added to the view via 
the perspective. You cannot hide CIs from the original 
view content from the view. In the case of a view based 
on a model, the model cannot be hidden but its CIs can.

Show Hidden CIs Restore hidden CIs to the view.

To access Click the Add Group by button  in the Hierarchy pane 
of the Pattern View Editor and select Add Group by 
Attribute or right click the required query node and 
select Add Group by Attribute from the shortcut menu. 

UI Elements (A-Z) Description

Expression capture 
group index

Enter the number of the relevant portion of the regular 
expression. Enter 0 if the entire expression is relevant.

Group by Select an attribute from the drop-down list.

Mask to group by Enter a regular expression pattern representing the 
structure of the selected attribute.

For details, see "Query Node Grouping" on page 271.

Menu Item Description
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Query/View Definition Properties Dialog Box

This dialog box enables you to configure the properties of a TQL query or 
view.

User interface elements are described below:

To access In the Modeling Studio, click the Query/View Definition 
Properties  button in the TQL Query Editor or Pattern 
View Editor.

UI Elements (A-Z) Description

Base Query Select an existing TQL query on which to base your new 
query.

Note: 

➤ This field is only relevant for TQL queries.

➤ This field is optional.

Bundles A method of grouping TQL queries or views by category. 
Select the bundles associated with the current query or 
view or create a new bundle for it.

Note: This field is optional.

Description A description of the TQL query or view.

Inter-Layer Links Select to display inter-layer links in the topology results.

Note: This field is only relevant for views.

Persistent Select to define the TQL query as persistent. A persistent 
query remains in the memory permanently.

Note: This field is only relevant for TQL queries.

Priority Select a priority level for the TQL query or view from the 
drop-down list (Low, Medium, High, Express, Not 
Active). This setting determines how often the query 
should be rerun automatically by the system to include 
updated information from the CMDB.

Note: When you change the priority of a view, the 
priority of the TQL query on which the view is based is 
also changed.
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Reveal CIs Dialog Box

This dialog box enables you to search for CIs related to the CIs in a model 
and add them to the model.

Scope Select the scope of the TQL query from the drop-down 
list. 

Note: This field is only relevant for Integration TQL 
queries.

Type Select the type of the TQL query from the drop-down list.

Note: This field is only relevant for TQL queries.

To access In the Model Editor of the Modeling Studio, select a CI, 
click the Reveal  button, and select Start Revealing or 
right-click a CI in the model and select Reveal > Start 
Revealing.

Important 
information

The upper pane displays the CI types of the CIs related to 
the selected CI. The lower pane displays the CIs of the 
type selected in the upper pane.

The first step in the reveal path is the CI type of the CI 
you began with. When you select a CI type from the list 
in the upper pane, that CI type becomes the second step 
in the path. Click Next to display the CI types available 
for the next step of the path. 

The number at the top of the box in parentheses 
indicates the length of the constructed path thus far.

Relevant tasks "Build a Business CI Model" on page 294

UI Elements (A-Z) Description
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

Click to delete a selected item from the CIs basket.

Click to add a selected CI from the lower pane to the CIs 
basket.

Click to go to the next occurrence of the selected search 
phrase in the list of CIs.

Click to go to the previous occurrence of the selected 
search phrase in the list of CIs.

<Lower pane> Displays a list of related CIs of the type selected in the 
upper pane.

CI count Indicates how many related CIs of each type were found.

CIs Basket Displays the related CIs you selected to include in the 
model.

CI Type Displays a list of CI types of the CIs related to the selected 
CI. 

Conditions A check mark indicates that conditions were defined for 
the selected CI type. Click the Conditions column for the 
CI type you want to select and click the Add Condition or 
Edit Condition button to open the Conditions of Related 
CIs dialog box. This enables you to define and edit 
conditions for the CI type.

Find Enter a CI name or a portion of a CI name in the Find 
box to locate a CI in the list of CIs.

Finish Click Finish when you have finished adding CIs to the CI 
basket.

Next Click Next to display the CI types available for the next 
step of the path.
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Save Query Dialog Box

This dialog box enables you to save a new TQL query.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Reveal Path Displays the reveal path being constructed.

Clicking the blue arrows in the path  displays a drop-
down list of the CI types available for the next step of the 
path.

Clicking the CI types in the path displays the following 
options:

➤ Jump to page. Refreshes the table with the available CI 
types for the selected step of the path.

➤ Edit Condition. Opens the Conditions of Related CIs 
dialog box.

➤ Delete Selected Item(s). Deletes the selected CI type 
from the reveal path (the path ends at the previous CI 
type).

Save Path Opens the Save Reveal Path dialog box which enables 
you to save the path. This option is only active when a 
unique reveal path has been constructed.

To access In the Modeling Studio, click the Save  button when 
defining a new TQL query.

UI Elements (A-Z) Description

Click New Folder to create a new folder in the resource 
tree.

Click Delete to delete the selected resource from the 
CMDB.

UI Elements (A-Z) Description
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Save View/Template/Perspective Dialog Box

This dialog box enables you to save a new pattern view, template-based 
view, perspective-based view, template, or perspective.

Click Refresh to refresh the resource tree.

Click Expand All to expand all the folders in the resource 
tree.

Click Collapse All to collapse all the folders in the 
resource tree.

Click to go to the next occurrence of the selected search 
phrase in the list of queries.

Click to go to the previous occurrence of the selected 
search phrase in the list of queries.

Click to highlight all occurrences of the search phrase in 
the list of queries.

<Resource tree> Select a folder in the tree in which to save the query.

Find Enter a view name or a portion of a name in the Find box 
to locate a query in the list.

Query Name Enter the name of the new TQL query.

To access In the Modeling Studio, click the Save  button when 
defining a new pattern view, template-based view, 
perspective-based view, template, or perspective.

UI Elements (A-Z) Description
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

Click New Folder to create a new folder in the resource 
tree.

Click Delete to delete the selected resource from the 
CMDB.

Click Refresh to refresh the resource tree.

Click Expand All to expand all the folders in the resource 
tree.

Click Collapse All to collapse all the folders in the 
resource tree.

Click to go to the next occurrence of the selected search 
phrase in the list of views.

Click to go to the previous occurrence of the selected 
search phrase in the list of views.

Click to highlight all occurrences of the search phrase in 
the list of views.

<Resource tree> Select a folder in the tree in which to save the view, 
template, or perspective.

Find Enter a view name or a portion of a name in the Find box 
to locate a view in the list.

New query Select New query if the view is based on a new TQL 
query.

Note: This field is not relevant for template-based views 
and perspective-based views.

View Name Enter the name of the new view, template, or perspective.
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Select Data Sources Dialog Box

This dialog box enables you to select the required data sources for a TQL 
query node.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access In the Modeling Studio, right-click a TQL query node and 
select Set Data Sources.

Important 
information

You can select the data sources from which the TQL 
query generates the results for each query node. For 
details on data sources, see "Integration Studio Overview" 
in the HP Universal CMDB Data Flow Management Guide.

UI Elements (A-Z) Description

<Data Source list> A list of available data sources.

All Data Sources Select to include CIs from all UCMDB and external 
sources for the selected query node in the TQL query 
results.

Default Data Sources Select to include CIs from the default data sources for the 
selected query node in the TQL query results.

If there is a federation source defined for the selected CIT, 
the default is All. If there is a federation source defined 
for a child of the selected CIT, the default is UCMDB 
only.

Select Data Sources Select to include CIs from the selected sources only for 
the selected query node in the TQL query results.
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Sort Column Content Dialog Box

This dialog box enables you to set the order of the column content in a 
report.

User interface elements are described below:

To access In the Modeling Studio, click Set Sort Order in the Query 
Node Definition pane of the Pattern View Editor (in 
Report mode).

Important 
information

The report is sorted by columns following the order of 
the attributes in the Sorted Columns pane. Each selected 
column is sorted in ascending or descending order 
according to your selection.

Relevant tasks "Define Report Settings" on page 293

UI Elements (A-Z) Description

Click Move to Sorted Columns to move the selected 
attribute to the Sorted Columns pane.

Click Move to Available Columns to move the selected 
attribute to the Available Columns pane.

Click to move all the attributes to the Sorted Columns 
pane.

Click to move all the attributes to the Available Columns 
pane.

Click to move the selected attribute down in the Sorted 
Columns list.

Click to move the selected attribute up in the Sorted 
Columns list.

Click Sort Ascending to sort the selected column in 
ascending order.

Click Sort Descending to sort the selected column in 
descending order.
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Template-based View Wizard

This wizard enables you to define a template-based view.

Select Template Page
This wizard page enables you to select a template on which to base your 
view.

Available Columns The attributes selected to appear as columns in the 
report.

Sorted Columns The columns selected to be sorted.

To access Click the New  button and select Template Based 
View.

Relevant tasks "Create a Template Based View" on page 291

Wizard map The Template-based View Wizard contains:

Select Template Page > Parameters Page

Important 
information

If you don’t want to use any of the templates in the tree, 
you can create a new template first and then build a view 
based on it. For details on creating a template, see "Create 
a Template" on page 286.

Wizard map The Template-based View Wizard contains:

Select Template Page > Parameters Page

UI Elements (A-Z) Description
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Parameters Page
This wizard page enables you to set the values of the template’s parameters.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

Click to go to the next occurrence of the selected search 
phrase in the list of templates.

Click to go to the previous occurrence of the selected 
search phrase in the list of templates.

Click to highlight all occurrences of the search phrase in 
the list of templates.

<Template tree> Displays the existing templates in tree format.

Find Enter a template name or a portion of a name in the Find 
box to locate a template in the list.

Wizard map The Template-based View Wizard contains:

Select Template Page > Parameters Page

UI Elements (A-Z) Description

Default Value The default value of the parameter. If you do not enter a 
value for the parameter, it is assigned this value.

Name The name of the parameter.

Value Enter a value for the parameter.
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Template Parameter Values Dialog Box

For details on the Edit Parameter Values dialog box, see "Parameters Page" on 
page 354.

TQL Query Editor

This feature enables you to build and edit TQL queries.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access To open a new TQL query in the TQL Query Editor, go to 
the Modeling Studio, click the New  button and select 
Query.

To open an existing TQL query in the TQL Query Editor, 
go to the Resources tab of the left pane in the Modeling 
Studio and select Queries as the Resource type. Right click 
a TQL query in the tree and select Open Query or double 
click a TQL query or drag a TQL query onto the Editor 
pane. The TQL query opens in the Editor pane.

Important 
information

To save your TQL query, use the Save button in the 
Modeling Studio main toolbar.

Relevant tasks "Define a TQL Query" on page 27

UI Elements (A-Z) Description

Click Create Relationship to draw a relationship from 
one query node to another.

Click Hide/Show Legend to toggle between hiding and 
displaying the topology map legend.

Click Calculate Query Result Count to calculate the 
number of instances found for each TQL query node or 
relationship.

Click Preview to display a preview of the TQL query 
results as they would appear in IT Universe Manager.
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For queries, opens the Query Definition Properties dialog 
box which enables you to edit the type, scope, and 
priority of the TQL query.

For views, opens the View Definition Properties dialog 
box.

Click Delete to delete the selected query node or 
relationship from the query.

Opens the Template Parameter Values dialog box which 
enables you to edit the parameters of a query node in a 
template-based view.

Note: This button only appears for template-based views.

<Legend> Indicates the icons displayed next to CIs with any of the 
following special designations:

➤ It is defined as a contact query node in a perspective

➤ It is defined as the output query node of a pattern-
based model

➤ It has attributes defined

➤ It has selected identities defined

➤ It is set as an invisible element

➤ It has a subgraph defined

<Main menu> For details, see "Main Menu" on page 185.

<Shortcut menu 
options>

For details, see "Shortcut Menu Options" on page 37.

<Topology Map 
Sidebar>

For details, see "Topology Map Sidebar" on page 197.

UI Elements (A-Z) Description
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Advanced Pane

This area displays the properties, conditions, and cardinality for the selected 
query node and relationship.

User interface elements are described below:

Important 
information

The Advanced pane appears in the lower part of the 
window in the following managers and user interfaces: 
Modeling Studio, Impact Analysis Manager, Enrichment 
Manager, the Input Query Editor and Trigger Query 
Editor in DFM.

A small green indicator  appears next to the tabs that 
contain data.

Relevant tasks ➤ "Define an Impact Rule – Workflow" on page 442

➤ "Define an Enrichment Rule – Scenario" on page 510

➤ "Define a TQL Query" on page 27

➤ "Create a Pattern View" on page 285

➤ "Create a Template" on page 286

➤ "Create a Perspective" on page 288

UI Elements (A-Z) Description

If the window is not wide enough to display all the tabs, use 
the left and right arrows to move to the required tab.

Click Show List to display a list of the available tabs for the 
current module. You can select a tab from the list.

Attributes Displays the attribute conditions defined for the query node 
or the relationship. For details, see "Attribute Tab" on 
page 82.

Cardinality Cardinality defines how many query nodes you expect to 
have at the other end of a relationship. For example, in a 
relationship between a node and an IP Address, if the 
cardinality is 1:3, the TQL query retrieves only those nodes 
that are connected to between one and three IP Addresses. 
For details, see "Cardinality Tab" on page 84.
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Data Sources Displays the data sources set for the selected query node.

Note: This tab appears only in the Modeling Studio.

Details Displays the following information:

➤ CI Type. The CIT of the selected query node/relationship.

➤ Visible. A green check indicates that the selected query 
node/relationship is visible in the topology map. A red 
mark indicates that it is not visible.

➤ Include subtypes. A green check indicates that both the 
selected CI and its children are displayed in the topology 
map. A red mark indicates that only the selected CI 
appears.

Edit Click Edit to open the relevant dialog box for the selected 
tab.

Enrichment Rules Displays the Enrichment rule defined for the selected query 
node or relationship. If the Enrichment rule is used to 
update the attributes of a CI, click Edit to open the Query 
Node/Relationship Definition dialog box and edit the rule if 
required. For details, see "Query Node/Relationship 
Definition Dialog Box" on page 531.

Note: This tab appears only in Enrichment Manager.

Impacted Query 
Nodes

Indicates which query node is affected by the changes that 
occur in the selected trigger query node. If required, you can 
click Edit to open and modify the Affected Query Nodes 
dialog box. For details, see "Impacted Query Nodes Dialog 
Box" on page 455.

Note: This tab appears only in Impact Analysis Manager.

Qualifiers Displays the qualifier conditions defined for the query node 
or the relationship. For details, see "Qualifier Tab" on 
page 87.

Selected Identities Displays the element instances that are used to define what 
should be included in the TQL query results. For details, see 
"Identity Tab" on page 90.

UI Elements (A-Z) Description
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Views Containing Selected CI Dialog Box

This dialog box enables you to display a list of the views containing the 
selected CI.

User interface elements are described below:

To access Click the Show views containing selected CI/model  
button in the Model Editor or select Show containing 
views from the shortcut menu.

UI Elements (A-Z) Description

Click Show View Results in IT Universe to go directly to 
the selected view in IT Universe Manager.

Click Delete Selected Item(s) to delete the selected view.

Click Disconnect view from perspective to disconnect 
the selected view from its perspective. The view becomes 
a pattern view.

Find Enter a view name or a portion of a view name in the 
Find box to locate it in the list.

Find Next Click to go to the next occurrence of the selected search 
phrase in the list.

Find Previous Click to go to the previous occurrence of the selected 
search phrase in the list.

Highlight Click to highlight all occurrences of the search phrase in 
the list.

View Name Displays the list of views dependent on the selected 
template or perspective.

Note: The name of the current view appears in faded 
text.
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Watchpoints Updates Dialog Box

This dialog box displays the changes found in related CIs by a watchpoint 
defined for a model.

User interface elements are described below:

To access From within a model in the Model Editor, click the 
Watchpoint  button and select Watchpoints Updates 
or right-click a CI in the model and select Watchpoint > 
Watchpoints Updates.

Important 
information

The Watchpoints Updates dialog box indicates any 
changes found involving the CIs related to the model via 
the associated reveal path. If a new related CI is found 
which is not included in the model, the suggested update 
is an added CI. If a CI in the model is found to no longer 
be related via the path, the suggested update is a removed 
CI.

This option is only enabled when watchpoints are 
defined for the model and CIs have been found.

UI Elements (A-Z) Description

Accept Select the check boxes for the CIs you want to add to 
your model or remove from your model.

Accept All Click Accept All to apply all the suggested changes to 
your model.

CI The names of the CIs found by the watchpoint.

CI Type The types of the CIs found by the watchpoint.

Clear All Click Clear All to clear the check boxes for all the found 
CIs.

Restore Select the check boxes for the CIs in the Suppressed CIs 
pane that you want to consider for inclusion in your 
model.

Show/Hide 
Suppressions

Toggle between hiding and displaying the Suppressed CIs 
pane of the dialog box.
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Suggested Update Indicates whether the suggested change is an added CI or 
a removed CI.

Suppress Select the check boxes for the CIs you want to exclude 
from your model or leave in your model.

Suppress All Click Suppress All to decline all the suggested changes to 
your model.

UI Elements (A-Z) Description
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Reports

This chapter includes:

Concepts

➤ Topology Reports Overview on page 364

➤ Custom Reports Overview on page 364

Tasks

➤ View a Topology Report on page 365

➤ Generate a Custom Report on page 365

➤ Compare CIs on page 366

➤ Compare Snapshots on page 368

Reference

➤ Cron Expressions on page 370

➤ Reports User Interface on page 371
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Concepts

Topology Reports Overview

Topology reports provide a method of displaying the data from views in a 
report format. Every view defined in the Modeling Studio has a 
corresponding topology report in the Reports module. The report settings 
are defined in the view definition in Report mode in the Pattern View Editor. 
For details, see "Pattern View Editor" on page 333. 

For details on selecting the CIs to be displayed in a view, see "Working with 
the CI Selector" on page 143.

Templates and perspectives do not have topology reports. However, 
template-based views do have topology reports. The reports settings for such 
views are based on the settings defined in the base template or perspective.

Custom Reports Overview 

Custom reports consist of charts and tables that help you track and analyze 
the health of your monitored environment. They enable you to view and 
assess performance data collected by HP Universal CMDB and stored in the 
CMDB. When generating reports, you can specify various report settings, 
such as time range or location, as well as drill down to see further 
information
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Tasks

View a Topology Report

This task describes how to create a report based on a previously saved view 
or pattern.

 1 Prerequisite

(Optional) Use the Modeling Studio to define a view. For details, see 
"Modeling Studio" on page 265.

 2 Select a view

Double-click a view that was previously created in the Modeling Studio or 
select one of the existing Topology reports.

 3 Result

A report showing the data requested is displayed in the right pane. For 
details, see "Topology Report" on page 434.

Generate a Custom Report

This task describes how to define and generate a report based on a custom 
layout.

 1 Select the report type

In the Custom Reports pane, do one of the following:

➤ Right-click a report name and select Create New Report.

➤ Click the Create New Report button and select the required report.

➤ Double-click a report name.
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 2 Specify the required parameters

Specify the parameters required by the report type that you selected. For 
details about the parameters required by each report type, see the relevant 
report listed in "Reports User Interface" on page 371.

 3 Generate the report

Click Generate to build the report. If desired, you can refine the 
parameters and click Generate again to view an updated report.

Compare CIs

This task explains how to compare the hierarchies of two compound CIs, 
view a CI’s configuration file, and show the difference between two 
configuration files.

 1 Select the Required CIs

Select the two CIs you want to compare. The hierarchies of the two 
compound CIs are compared in the Compare CIs report (for details, see 
"Compare CIs Report" on page 387). You can choose to compare two CIs 
that appear in a selected view, or in the CMDB. For details, see "CI 
Selector" on page 151.

Example of Nonmatching CIs:

The following example displays the following:

The No Matching CI icon next to the CI LABM3QCRNDDB03 because 
it has no corresponding CI on the other side.
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The Show Different Attribute Values icon is displayed next to the 
MemorySize properties for the CIs LABM3QCRNDDB02 and 
LABM3ASTDB01 since they have different MemorySize values.
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 2 View a CI’s Configuration File

Select a CI of the CIT Configuration File and view the configuration file. 
For details, see "Compare CIs Report" on page 387.

 3 Show the Difference Between Two Configuration Files

Select two CIs of the CIT Configuration File and view the difference 
between the two configuration files. For details, see "Compare CIs Report" 
on page 387.

Compare Snapshots

This task describes how to take a snapshot of a view, and then compare two 
snapshots of a specific view taken at different times.

 1 Take a Snapshot of a View 

 a Select a Topology report.

 b Click the Snapshot button and select Save Snapshot to take a snapshot 
of a view and save it. For details, see the "Save Snapshot Dialog Box" on 
page 262.

 2 Save Snapshots on a Periodic Basis

Optionally, you can schedule snapshots to be taken of a certain view at 
specific times by defining a task. For details, see "Schedule Job Dialog Box" 
on page 427.

 3 Compare Snapshots

Compare the snapshots of a view taken at different times. Select 
Modeling > Reports and create a Compare Snapshots Report. For details, 
see "Compare Snapshots Report" on page 393.
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Example of Snapshots of a View Taken at Different Times:

In the following example, the Deleted Item icon next to the 
192.168.163.0 CI in the right pane, indicates that the CI has been deleted 
in the newer view.
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Reference

Cron Expressions

A Cron Expression is a string composed of six or seven fields separated by 
white space. Six of the fields are mandatory, and one is optional.

The following table contains the fields used in a Cron Expression.

The following table contains examples of how to use Cron expressions.

Field Name Allowed Values Allowed Special Characters

Seconds 0-59 , - * /

Minutes 0-59 , - * /

Hours 0-23 , - * /

Day of month 1-31 , - * ? / L W C

Month 1-12 or JAN-DEC , - * /

Day of week 1-7 or SUN-SAT , - * ? / L C #

Year (optional) empty, 1970-2099 , - * /

Cron Expression Meaning

0 0 12 * * ? The task runs every Wednesday at 12:00 PM.

0 15 10 ? * * The task runs at 10:15 AM every day.

0 15 10 * * ? 2005 The task runs at 10:15 AM every day during the 
year 2005.

0 0/5 14 * * ? The task runs every 5 minutes starting at 2 PM and 
ending at 2:55 PM, every day.

0 15 10 15 * ? The task runs at 10:15 AM on the 15th day of 
every month.
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For more details about Cron expressions, go to 
http://confluence.zutubi.com/display/pulse0101/Project+Cron+Triggers

Reports User Interface

This section includes (in alphabetical order):

 ➤ Application Breakdown Report on page 373

 ➤ Asset Report on page 375

 ➤ Changed Application Report on page 377

 ➤ Changed Views Report on page 379

 ➤ CI Change Report on page 381

 ➤ CMDB Utilization Report on page 385

 ➤ Compare CIs Report on page 387

 ➤ Compare Snapshots Report on page 393

 ➤ Database Breakdown Report on page 399

 ➤ Delete Candidates Report on page 401

 ➤ Dependency Report on page 403

 ➤ Generic Breakdown Report on page 405

 ➤ Gold Master Report on page 407

 ➤ Impact Analysis Report on page 411

 ➤ Job List Dialog Box on page 413

 ➤ Network Device Breakdown Report on page 416

0 15 10 ? * 6L The task runs at 10:15 AM on the last Friday of 
every month.

0 15 10 ? * 6#3 The task run at 10:15 AM on the third Friday of 
every month. 

Cron Expression Meaning
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 ➤ Node OS Breakdown Report on page 418

 ➤ Number of Changes Report on page 420

 ➤ Reports Page on page 422

 ➤ Schedule Job Dialog Box on page 427

 ➤ Toolbar Options on page 431

 ➤ Topology Report on page 434

 ➤ View Change Report on page 436
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Application Breakdown Report

This report displays an application breakdown and their versions. Major 
applications are Running Software CITs that have been assigned the 
MAJOR_APP class qualifier. For details, see "Qualifiers Page" on page 492.
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access Select Managers > Modeling > Reports. In the Custom 
Reports pane, do one of the following:

➤ Right-click Application Breakdown Report and select 
Create New Report.

➤ Click the Create New Report button  and select 
Application Breakdown Report.

➤ Double-click Application Breakdown Report.

➤ Select Application Breakdown Report in the Custom 
Reports pane and drag it onto the right pane. 

Relevant tasks "Generate a Custom Report" on page 365

UI Elements (A-Z) Description

<Breadcrumbs> Displays the levels through which you have navigated to 
get to the current level. Appears horizontally across the 
top of the chart. 

Note: Each level in the list of breadcrumbs is a clickable 
link.

<Bar graph/Pie 
chart>

Each segment of the pie chart/column in a bar graph 
represents a different application. 

Click a slice/bar to view the application sorted by version, 
and then drill down to see the application instances and 
their attributes.

When you hold the mouse over each segment/bar, a 
tooltip indicates the name of the application, the number 
of CI instances there are for each application, the 
percentage of the pie it represents (when viewing the 
information in pie chart format), and the CI type the 
slice/bar represents.

The legend below the pie chart provides the name of each 
CI, and on the lower level, their versions.

<Toolbar> For details, see "Toolbar Options" on page 431.

Cities Currently not supported.
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Asset Report

This report displays a list of all the CIs in a specified view, their attribute 
values, as well as their child CIs in the CMDB. You use Asset reports to view 
and analyze the contents of the view and focus on the data that is of interest 
to you. For example, an Asset report can display a list of all the servers that 
are part of a specific application contained in the view.

Countries or Province Currently not supported.

States Currently not supported.

To access Select Managers > Modeling > Reports. In the Custom 
Reports pane, do one of the following:

➤ Right-click Asset Report and select Create New Report.

➤ Click the Create New Report  button and select 
Asset Report.

➤ Double-click Asset Report.

➤ Select Asset Report in the Custom Reports pane and 
drag it onto the right pane. 

Important 
information

The report contains only the attributes whose Asset Data 
check box was selected in the Attributes tab in the CI 
Type Manager. For more details, see "Add/Edit Attribute 
Dialog Box" on page 478.

Relevant tasks "Generate a Custom Report" on page 365

UI Elements (A-Z) Description
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

<Toolbar> For details, see "Toolbar Options" on page 431.

<Shortcut menu> For details, see "IT Universe Manager Shortcut Menu" on 
page 250.

Include information 
based on

Select one of the following:

➤ CMDB. Includes information from the selected view as 
well as information about the child CIs and their 
attribute values in the CMDB.

By choosing this option, the report includes CIs that 
are connected by the Container qualifier to the CIs in 
selected view. For example, the report would include 
the CPU and memory of a server that is contained in 
the view.

➤ View. Includes only information about the CIs and 
their attributes that are contained in the selected view.

View Enables you to select a view by opening the View Selector. 
For details, see "CI Selector" on page 151.

Note: When you generate an Asset report from a specific 
view, the report retains the same hierarchical structure as 
the relevant view in the Topology Map.
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Changed Application Report

This report displays a bar graph showing the number of detected changes in 
applications within a defined period.

To access Select Managers > Modeling > Reports. In the Custom 
Reports pane, do one of the following:

➤ Right-click Changed Application Report and select 
Create New Report.

➤ Click the Create New Report  button and select 
Changed Application Report.

➤ Double-click Changed Application Report.

➤ Select Changed Application Report in the Custom 
Reports pane and drag it onto the right pane. 
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Relevant tasks "Generate a Custom Report" on page 365

UI Elements (A-Z) Description

<Bar graph> Each bar represents a different application type. The 
colors in each bar represent the different types of changes 
that occurred in the application. 

Each color in the legend represents a different type of 
change. The CI type of each application is displayed 
under the relevant bar.

When you hold the mouse over each bar, a tooltip 
indicates the number of CIs that have either been added, 
removed, or updated (depending on the color), and also 
the CI type the bar represents.

Click the required color in the bar to drill down to see the 
information in table format.

<Breadcrumbs> Displays the levels through which you have navigated to 
get to the current level. Appears horizontally across the 
top of the chart. 

Note: Each level in the list of breadcrumbs is a clickable 
link.

<Toolbar> For details, see "Toolbar Options" on page 431.

Date from Configure a start date and time for the report.

Date until Configure an end date and time for the report.

Time range Select a time frame over which to display the detected 
changes. The system automatically provides the starting 
and ending dates in the Date from and Date until boxes.

Note: If you select Custom, you can manually configure a 
starting and ending date in the Date from and Date until 
boxes.
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Changed Views Report

This report displays the number of changes that occurred in a specific view 
within a defined period.

To access Select Managers > Modeling > Reports. In the Custom 
Reports pane, do one of the following:

➤ Right-click Changed Views Report and select Create 
New Report.

➤ Click the Create New Report  button and select 
Changed Views Report.

➤ Double-click Changed Views Report.

➤ Select Changed Views Report in the Custom Reports 
pane and drag it onto the right pane. 

Relevant tasks "Generate a Custom Report" on page 365
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

<Toolbar> For details, see "Toolbar Options" on page 431.

Bar graph Each bar represents a different view. The name of each 
view is displayed under the relevant bar. The colors in 
each bar represent the different types of changes that 
occurred in the view (added, removed, or updated). 

When you hold the mouse over the relevant color in each 
bar, a tooltip indicates the name of the view, the change 
type, and the number of CI instances that changed in the 
view.

See the legend to verify the change type each color 
represents.

If snapshots were taken of a view at different times, you 
can click a bar to open the Compare Views by Snapshots 
dialog box and display the differences between the views. 
For details, see "Compare Snapshots Report" on page 393.

Note: Only views with changes that reflect the differences 
between two snapshots, one taken before the Date from 
date (or, if not available, then after the Date from date) 
and another snapshot taken before the Date until date in 
the Changed Views report appear in the report.

Date from Configure a start date and time for the report.

Date until Configure an end date and time for the report.

Time range Select a time frame over which to display the changes. 
The system automatically provides the starting and 
ending dates in the Date from and Date until boxes.

Note: If you select Custom, you can manually configure a 
starting and ending date in the Date from and Date until 
boxes.
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CI Change Report

CI Change reports enable you to view and analyze the actual changes made 
to a specific CI and its children. This can help with possible troubleshooting 
issues related to this CI. For example, the changes in a CI may enable you to 
conclude that these changes are the cause of the problem. By the same 
token, the source of the troubleshooting issue could be related to expected 
changes which failed to occur. This report enables you to view CI attribute 
changes, as well as CIs that were added to or removed from a CI and its 
children.

To access Select Managers > Modeling > Reports. In the Custom 
Reports pane, do one of the following:

➤ Right-click CI Change Report and select Create New 
Report.

➤ Click the Create New Report  button and select 
CI Change Report.

➤ Double-click CI Change Report.

➤ Select CI Change Report in the Custom Reports pane 
and drag it onto the right pane.
381



Chapter 9 • Reports
User interface elements are described below:

Important 
information

➤ Only those CIs whose CIs whose properties are marked 
as either Change Monitored or Comparable appear in 
the report. For details, see "Add/Edit Attribute Dialog 
Box" on page 478.

CI Change reports display:

➤ CI Change reports display changes that occurred in a 
selected CI and all its children, which are linked, by 
default, by an impact_link. The CIs in the generated 
report are retrieved according to the Infrastructure 
Settings Manager settings. Go to Managers > 
Administration > Infrastructure Settings > Applications 
> MamWeb. For details, see "Infrastructure Settings" in 
the HP Universal CMDB Administration Guide.

➤ Select Change Report relationship name to retrieve 
CIs that are linked by the selected calculated 
relationship. In the Value box, enter the name of 
the relationship as it appears in the Name box (not 
the Display Name box) in the Details page of the 
selected relationship in the CI Type Manager. For 
details, see "Details Page" on page 487.

➤ Select Change Report relationship qualifier to 
retrieve CIs that are defined with a qualifier. In the 
Value box, enter the name of the required qualifier. 
For information about qualifiers, see "Qualifiers 
Page" on page 492.

➤ CIs with a Container link relationship that were added 
to, or removed from, a CI.

➤ CIs whose relationship is defined with a 
TRACK_LINK_CHANGES qualifier, that are added to, or 
removed from, a CI. For information about qualifiers, 
see "Qualifiers Page" on page 492.

Relevant tasks "Generate a Custom Report" on page 365

UI Elements (A-Z) Description

Date from Configure a start date and time for the report.

Date until Configure an end date and time for the report.
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CI Changes Tab

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Include information 
based on

Select one of the following:

➤ CMDB. Display the changes that occurred to the CI 
and its children in the entire CMDB.

➤ View. Display the changes that occurred to the CI and 
its children in the selected view.

Selected CI Select the required CIs. Opens the Select CI/View dialog 
box. For details, see "Working with the CI Selector" on 
page 143.

Time range Select a time frame over which to display the changes. 
The system automatically provides the starting and 
ending dates in the Date from and Date until boxes.

Note: If you select Custom, you can manually configure a 
starting and ending date in the Date from and Date until 
boxes.

Important 
Information

To view the change history of a CI, right-click anywhere 
in the row of the required CI and select CI History.

UI Elements (A-Z) Description

<Toolbar> For details, see "Toolbar Options" on page 431.

<Shortcut menu> For details, see "IT Universe Manager Shortcut Menu" on 
page 250.

Attribute Name The name of the CI attribute that was changed.

Change Date The date at which the change occurred.

Changer The name of the user that manually modified the CI’s 
property, or the name of the Data Flow Probe that 
automatically discovered a change made to the CI’s 
property.

UI Elements (A-Z) Description
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Relationship Changes Tab

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Class Name The CI type of the changed CI.

Display Label The label of the path from the root to the CI.

Note: A backslash (\) in a CI name indicates a parent-
child relationship with the format: 
<parent_CI>\<child_CI>. For example, the entry 
16.59.63.0\Windows provides change information for the 
Windows CI that is the child of the 16.59.63.0 CI.

New Value The new value of the CI attribute.

Old Value The previous value of the CI attribute (before the change).

Important 
Information

To view the change history of a CI, right-click anywhere 
in the row of the required CI and select CI History.

UI Elements (A-Z) Description

<Toolbar> For details, see "Toolbar Options" on page 431.

<Shortcut menu> For details, see "IT Universe Manager Shortcut Menu" on 
page 250.

Change Date The date at which the update was performed.

Changer The name of the user that manually modified the CI’s 
property, or the name of the Data Flow Probe that 
automatically discovered a change made to the CI’s 
property.

Container Label The label of the path from the root to the container CI.

A backslash (\) in a CI name indicates a parent-child 
relationship with the format: <parent_CI>\<child_CI>. 
For example, the entry 16.59.63.0\Windows provides 
change information for the Windows CI that is the child 
of the dancer.hp.com CI.

UI Elements (A-Z) Description
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CMDB Utilization Report

This report displays general CMDB statistics. For example, the statistics can 
contain the number of Impact rules created, how many CIs there are in the 
CMDB, or how many snapshots have been taken.

Event type You can have one of the following values:

➤ Add related CI. A contained CI was added to the 
container CI using a Container link relationship.

➤ Remove related CI. A contained CI that was linked to a 
container CI using a Container link was removed.

Related label The label of the path from the root to the contained CI.

To access Select Managers > Modeling > Reports. In the Custom 
Reports pane, do one of the following:

➤ Right-click CMDB Utilization Report and select Create 
New Report.

➤ Click the Create New Report  button and select 
CMDB Utilization Report.

➤ Double-click CMDB Utilization Report.

➤ Select CMDB Utilization Report and drag it onto the 
right pane.

Relevant tasks "Generate a Custom Report" on page 365

UI Elements (A-Z) Description
385



Chapter 9 • Reports
User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

<Toolbar> For details, see "Toolbar Options" on page 431.

Name The name of the CMDB statistic.

Value The number of instances for the CMDB statistic found in 
the system.
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Compare CIs Report

This report enables you to compare the hierarchies of two compound CIs. A 
compound CI is a CI that is linked to another CI by a relationship with 
CONTAINER qualifier. You can display the compared CIs and their child CIs 
that appear in a selected view, or in the CMDB.
387



Chapter 9 • Reports
User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access Select Managers > Modeling > Reports. In the Custom 
Reports pane, do one of the following:

➤ Right-click Compare CIs Report and select Create New 
Report.

➤ Click the Create New Report  button and select 
Compare CIs Report.

➤ Double-click Compare CIs Report.

➤ Select Compare CIs Report and drag it onto the right 
pane.

Important 
information

➤ The Compare CIs page is divided into two panes. Each 
side displays a hierarchical tree structure of the CIs you 
selected. When you select a CI on one side, the 
corresponding CI on the other side is automatically 
selected, provided Synchronize Selection is pressed. 

➤ You can compare only two CIs of the same CI type or 
one of the CI type’s children in the hierarchy.

Relevant tasks ➤ "Compare CIs" on page 366

➤ "Generate a Custom Report" on page 365

UI Elements (A-Z) Description

Finds the previous occurrence of an item marked as 
changed.

Finds the next occurrence of an item marked as changed.

Show Configuration Files Differences. Shows the 
difference between the content of the two configuration 
files. Configuration files use the .xml, .txt or .ini 
extensions.

Select a CI of the CIT Configuration File in both panes 
and click the Show Differences button. A window opens 
displaying the differences (marked in blue) in the 
configuration files.
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Show Only Different CIs in Tree. In the <Properties 
panes>, displays only the part of the tree structure 
containing CIs that do not match.

Show Only Different Attribute Values. In the <Properties 
panes>, toggles between displaying all the comparable 
attribute values of the selected CI or only the attribute 
values that are different.

Enables you to select a CI on one side and have its 
corresponding CI automatically selected on the other 
side.

The default state for the Synchronize Selection button is 
selected. Deselecting this button allows you to select 
different CIs from each of the two trees. This enables you 
to compare two different CIs and see their different 
properties. 

Contains An Updated Item. Indicates that a CI’s attribute 
value has changed. For example, a Contains an Updated 
Item icon is displayed next to the IpAddress CI in the 
figure below since the attribute of its child CI 
10.168.100.2 icon has changed.

UI Elements (A-Z) Description
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No Matching CI. Indicates that a CI in one pane does not 
match any corresponding CI in the other pane. 

The following example displays the No Matching CI icon 
next to the Windows icon because it does not have a 
corresponding CI in the other pane.

Updated Item. Indicates that the attribute value of a CI 
has changed.

For example, the figure below shows that the CIs 10.0.0.2 
and 16.59.124.1 display the Updated Item icon because 
they was updated with a new IP Network Mask value, as 
indicated by the Show Only Different Attribute Values 

 icons (see the Name and Value columns in the 
bottom panes underneath the tree structure).

UI Elements (A-Z) Description
390



Chapter 9 • Reports
Enables you to move to the next or previous result of the 
search for the string entered in the Find field.

<Toolbar> For details, see "Toolbar Options" on page 431.

<Shortcut menu> For details, see "IT Universe Manager Shortcut Menu" on 
page 250.

<Properties pane> Displays the attributes of the selected CI.

The Properties pane contains the following fields:

➤ Name. Displays the attribute name for the selected CI, 
which was marked as Comparable in the CI Type 
Manager. "Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard" on 
page 486

➤ Value. Displays the attribute value for the currently 
selected CI.

<Left and right 
panes>

Displays a tree of the compared CIs and their child CIs 
that appear in the selected view or in the CMDB, 
depending on whether you selected the View or the 
CMDB options.

Compare in Select one of the following:

➤ CMDB. Includes the selected CIs and their child CIs 
that appear in the entire CMDB.

➤ View. Includes the selected CIs and their child CIs that 
appear only in a specific view.

Compared CI Enables you to select the two CIs you want to compare. 
Click  to open the CIs Selector dialog box. For details, 
see "CI Selector" on page 151. The CI you select in the top 
box is displayed in the left pane and the CI you select in 
the bottom box is displayed in the right pane.

Find Find. Enter a search name or a portion of a search name 
in the Find field to locate it in the list.

UI Elements (A-Z) Description
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Mutual View If the CIs that you are comparing both exist within the 
same view, the name of that view is displayed in this 
field. Otherwise, the field displays the words No mutual 
view.

UI Elements (A-Z) Description
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Compare Snapshots Report

This feature enables you to compare two snapshots of a specific view taken 
at different times. It enables you to visualize the differences between the 
views by comparing the statuses of the view at the times the snapshots were 
taken.

Compare Snapshots displays the status of a view in one snapshot by 
comparison with its status taken at a different time. You can compare a 
current snapshot to a previous snapshot or two snapshots both taken in the 
past.
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access Select Managers > Modeling > Reports. In the Custom 
Reports pane, do one of the following:

➤ Right-click Compare Snapshots Report and select 
Create New Report.

➤ Click the Create New Report  button and select 
Compare Snapshots Report.

➤ Double-click Compare Snapshots Report.

➤ Select Compare Snapshots Report and drag it onto the 
right pane.

Note: You can also take and compare snapshots in 
IT Universe (for details, see "Save Snapshot Dialog Box" 
on page 262).

Important 
information

➤ You can compare a current snapshot to a previous 
snapshot or two snapshots both taken in the past.

➤ You can define a schedule that takes snapshots of a 
specific view on a periodic basis and saves them. For 
details, see "Schedule Job Dialog Box" on page 427.

➤ Snapshots of views that are marked as Track Changes 
are created on a daily basis.

Relevant tasks ➤ "Compare Snapshots" on page 368

➤ "Generate a Custom Report" on page 365

See also ➤ "Save Snapshot Dialog Box" on page 262

➤ "Schedule Job Dialog Box" on page 427

UI Elements (A-Z) Description

Expands the entire hierarchical tree structure of the CIs 
you selected.

Collapses the hierarchical tree structure of the CIs you 
selected.

Finds the previous occurrence of an item marked as 
changed.
394



Chapter 9 • Reports
Finds the next occurrence of an item marked as changed.

Show Configuration Files Differences. Shows the 
difference between the content of the two configuration 
files. Configuration files use the .xml, .txt or .ini 
extensions.

Select a CI of the CIT Configuration File in both panes 
and click the Show Differences button. A window opens 
displaying the differences (marked in blue) in the 
configuration files. 

Show Only Different CIs in Tree. In the <Properties 
panes>, displays only the part of the tree structure 
containing CIs that do not match.

Show Only Different Attribute Values. In the <Properties 
panes>, toggles between displaying all the attribute 
values of the selected CI or only the attribute values that 
have changed.

Enables you to select a CI on one side and have its 
corresponding CI automatically selected on the other 
side.

The default state for the Synchronize Selection button is 
selected. Deselecting this button allows you to select 
different CIs from each of the two trees. This enables you 
to compare two different CIs and see their different 
properties. 

UI Elements (A-Z) Description
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Contains An Updated Item. Indicates that a CI’s attribute 
value has changed. For example, a Contains an Updated 
Item icon is displayed next to the 10.0.0.0 CI in the figure 
below since the attribute of its child CI 10.168.100.3 icon 
has changed.

Deleted Item. Indicates that a CI has been deleted from 
the view.

New Item. Indicates that a new CI has been added to the 
view. 

UI Elements (A-Z) Description
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Updated Item. Indicates that the attribute value of a CI 
has changed.

For example, the figure below shows that the CIs 
LABM3MAM16 displays the Updated Item icon because it 
was updated with a new Version value, as indicated by 
the Show Only Different Attribute Values  icons (see 
the Name and Value columns in the bottom panes 
underneath the tree structure).

<Left and right 
panes>

Displays a hierarchical tree structure of all the CIs in the 
view for that snapshot version. The left side always 
represents the newer of the two versions. 

<Properties pane> Displays the attributes of the selected CI.

The Properties pane contains the following fields:

➤ Name. Displays the name of the selected CI as defined 
in the CI’s label.

➤ Value. Displays the attribute value for the currently 
selected CI.

<Toolbar> For details, see "Toolbar Options" on page 431.

UI Elements (A-Z) Description
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Available Snapshots Displays the current status and previously saved 
snapshots of the view selected in the View with 
Snapshots field. Select the two snapshots you want to 
compare.

Note: Visible when Show Report Parameters button is 
pressed.

View with snapshots Displays the name of the view whose snapshots you want 
to compare. Only views for which snapshots have been 
taken are displayed.

Note: Visible when Show Report Parameters button is 
pressed.

UI Elements (A-Z) Description
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Database Breakdown Report

This report displays the breakdown of database types and versions. You can 
view all databases deployed in the system or databases at a certain location.

To access Select Managers > Modeling > Reports. In the Custom 
Reports pane, do one of the following:

➤ Right-click Database Breakdown Report and select 
Create New Report.

➤ Click the Create New Report  button and select 
Database Breakdown Report.

➤ Double-click Database Breakdown Report.

➤ Select Database Breakdown Report and drag it onto 
the right pane.

Relevant tasks "Generate a Custom Report" on page 365
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

<Bar graph/Pie 
chart>

Each segment of the pie chart/column in a bar graph 
represents a different database. 

Click a slice/bar to view the database sorted by version, 
and then click again to drill down to see the version 
information in table format.

When you hold the mouse over each segment/bar, a 
tooltip indicates the name of the database, the number of 
CI instances there are for each database, the percentage of 
the pie it represents (when viewing the information in 
pie chart format), and the CI type the slice/bar represents.

The legend below the pie chart provides the name of each 
CI, and on the lower level, their versions.

<Toolbar> For details, see "Toolbar Options" on page 431.

Cities Currently not supported.

Countries or Province Currently not supported.

States Currently not supported.
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Delete Candidates Report

This report displays the CITs and relationships that were deleted within a 
defined period, and the ones that are about to be deleted.

To access Select Managers > Modeling > Reports. In the Custom 
Reports pane, do one of the following:

➤ Right-click Delete Candidates Report and select Create 
New Report.

➤ Click the Create New Report  button and select 
Delete Candidates Report

➤ Double-click Delete Candidates Report. 

➤ Select Delete Candidates Report and drag it onto the 
right pane.

Relevant tasks "Generate a Custom Report" on page 365
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

<Bar graph> Each segment of the column in a bar graph represents a 
CIT of a CI or a relationship.

Click a bar to drill down to display the CITs and 
relationships that were deleted/are about to be deleted in 
table format.

When you hold the mouse over the relevant color of each 
bar, a tooltip indicates the number of CIs and 
relationships that were deleted or the ones that are about 
to be deleted and the CI type the bar represents.

The legend shows which color represents the CIs and 
relationships that were deleted, and which color 
represents those that are about to be deleted. The CIT of 
each CI or relationship is displayed underneath.

<Toolbar> For details, see "Toolbar Options" on page 431.

Date from Configure a start date and time for the report.

Date until Configure an end date and time for the report.

Time range Select a time frame over which to display the detected 
changes. The system automatically provides the starting 
and ending dates in the Date from and Date until boxes.

Note: If you select Custom, you can manually configure a 
starting and ending date in the Date from and Date until 
boxes.
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Dependency Report

This report enables you to generate a list of all the relationships of the type 
Dependency that connect between servers in the selected view, or between 
the servers in the CMDB and the servers within the selected view.

The report includes relationships that:

➤ Exist between databases and clients

➤ Exist between clients and servers
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➤ Are created as a result of an MQ connection

To access Select Managers > Modeling > Reports. In the Custom 
Reports pane, do one of the following:

➤ Right-click Dependency Report and select Create New 
Report.

➤ Click the Create New Report  button and select 
Dependency Report.

➤ Double-click Dependency Report.

➤ Select Dependency Report and drag it onto the right 
pane.

Important 
information

You can create new TQL queries in Enrichment Manager 
using the Dependency relationship to describe the 
connection between nodes. Every new Dependency 
relationship that is used appears in the Dependency 
report.

Relevant tasks "Generate a Custom Report" on page 365
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

The generated report includes the following elements (listed alphabetically):

Generic Breakdown Report

This report displays the breakdown of CI types by the following:

➤ The CITs grouped under the selected CIT in the CIT tree

➤ A CIT attribute

UI Elements (A-Z) Description

<Shortcut menu> For details, see "IT Universe Manager Shortcut Menu" on 
page 250.

<Toolbar> For details, see "Toolbar Options" on page 431.

Include information 
based on

Select one of the following:

➤ CMDB. Display all the servers in the CMDB that are 
dependent on the servers in the selected view.

➤ View. Display all the dependencies between the servers 
in the selected view.

View Select the required view.

UI Elements (A-Z) Description

Clients The list of clients that are linked to the servers.

Counter The number of clients to which the server is connected.

Node The servers in the selected view.

Relationship The display label of the relationship in the Topology 
Map.
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For more details about CI types, see "CI Type Manager" on page 465.

To access Select Managers > Modeling > Reports. In the Custom 
Reports pane, do one of the following:

➤ Right-click Generic Breakdown Report and select 
Create New Report.

➤ Click the Create New Report  button and select 
Generic Breakdown Report.

➤ Double-click Generic Breakdown Report.

➤ Select Generic Breakdown Report and drag it onto the 
right pane.

Relevant tasks "Generate a Custom Report" on page 365
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Gold Master Report

This report compares one or more CIs to another CI that has been 
designated as a Gold Master, and specifies which of the compared CIs are 
configured differently from the Gold Master CI.

The report compares the attribute values of the Gold Master CIs to the 
attribute values of the Compared CI of the same CIT. 

Note: The Gold Master report only displays a CI attribute comparison if the 
values are different.

UI Elements (A-Z) Description

<Bar graph/Pie 
chart>

Each segment of the pie chart/column in a bar graph 
represents a CIT or a CIT attribute, depending on how 
that level has been broken down.

Click a slice/bar to drill down to the next level, if one has 
been defined. You can generate a report that has up to 
three different levels. You can also display the 
information in table format.

When you hold the mouse over the relevant segment/bar, 
a tooltip indicates the number of CI instances there are 
for that CIT or CIT attribute, the percentage of the pie it 
represents (when viewing the information in pie chart 
format), and the CIT or CIT attribute the slice/bar 
represents.

<Toolbar> For details, see "Toolbar Options" on page 431.

Breakdown by Select the required breakdown for the first level.

Then by (Optional) Select the required breakdown for the second 
and third levels.
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If a section is empty, it means that all attribute values of the Gold Master CIs 
and the Compared CIs for that CIT are identical. In such a case, the 
attributes in the next layer in the subgraph are compared, and the next one, 
and so on. 
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Once the compared CIs in a layer are found to have different attributes, the 
Gold Master report does not continue the comparison of other layers in the 
subgraph for differences.

To access Select Managers > Modeling > Reports. In the Custom 
Reports pane, do one of the following:

➤ Right-click Gold Master Report and select Create New 
Report.

➤ Click the Create New Report  button and select 
Gold Master Report.

➤ Double-click Gold Master Report.

➤ Select Gold Master Report and drag it onto the right 
pane.

Important 
information

Only attributes that have been assigned the Comparable 
qualifier in the CIT Manager can be compared. For 
details, see "CI Type Manager" on page 465.

Relevant tasks "Compare Snapshots" on page 368
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User interface elements are described below:

UI Elements (A-Z) Description

<Toolbar> For details, see "Toolbar Options" on page 431.

<Shortcut menu> For details, see "IT Universe Manager Shortcut Menu" on 
page 250.

Attribute Name The name of the CI attribute.

Compared CIs Enables you to select the CIs whose attribute values you 
want to compare to the Gold Master CI. Opens the CI 
Selector. For details, see "CI Selector" on page 151.

Display Label The display name of the Compared CI.

Exclude classes Select the CI types to exclude from the report.

Include Similar Items Select this check box if you want to include the compared 
CIs whose configuration is identical to that of the Gold 
Master CI.

Master CI Enables you to select the CI you want to use as a Gold 
Master CI. Opens the CI Selector. For details, see "CI 
Selector" on page 151.

Value in Compared 
CI

The value of the attribute in the Compared CI.

Value in Gold Master 
CI

The value of the attribute in the Gold Master CI.
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Impact Analysis Report

This report displays a list of CIs that are impacted in the system as a result of 
simulated changes. For details, see "Run Impact Analysis Dialog Box" on 
page 260.

To access Select Managers > Modeling > Reports. In the Custom 
Reports pane, do one of the following:

➤ Right-click Impact Analysis Report and select Create 
New Report.

➤ Click the Create New Report  button and select 
Impact Analysis Report.

➤ Double-click Impact Analysis Report.

➤ Select Impact Analysis Report and drag it onto the 
right pane.

Relevant tasks "Generate a Custom Report" on page 365

See also ➤ "Impact Analysis Manager" on page 439

➤ "Run Impact Analysis Dialog Box" on page 260
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Affected Application Tab

This tab displays all the CIs that belong to a specific business application, 
which were affected by the triggered CI severity change.

User interface elements are described below:

Grouping by CIT Tab

This tab displays all the CIs related to the triggered CIs that are impacted in 
the system as a result of the simulated changes, sorted by CI type.

User interface elements are described below:

UI Elements (A-Z) Description

<Toolbar> For details, see "Toolbar Options" on page 431.

Rule Bundle  Enables you to select the rule group with which the 
Impact Analysis rule works. 

Severity Sets the severity level that we want to simulate for the 
triggered CIs.

Triggered CIs Select the CIs that represent the changes you want to 
make to the system. Opens the CI Selector.

UI Elements (A-Z) Description

Display Label The name of the CI or relationship as it appears in the 
toplogy map.

Trigger Severity The severity selected in the Severity box.

UI Elements (A-Z) Description

Display Label The name of the CI or relationship as it appears in the 
toplogy map.

Trigger Severity The severity selected in the Severity box.
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Triggered CIs Tab

This tab displays all the CIs that represent the changes you want to make to 
the system. The CIs in this tab are the CIs selected in the Triggered CIs box.

User interface elements are described below:

Job List Dialog Box

This dialog box displays a list of the reports/snapshots that were scheduled 
to run in the "Schedule Job Dialog Box" on page 427. 

User interface elements are described below:

UI Elements (A-Z) Description

Display Label The name of the CI or relationship as it appears in the 
toplogy map.

To access ➤ To display a list of reports scheduled to run, select 
Managers > Modeling > Reports. On the Reports page, 
click the Show Scheduled Report Jobs  button. 

➤ To define a schedule for taking snapshots, select 
Managers > Modeling > Reports. In the Topology 
Reports pane, select the required view, click the 
Snapshots  button, and then select Show Scheduled 
Snapshot Jobs.

Relevant tasks ➤ "View a Topology Report" on page 365

➤ "Generate a Custom Report" on page 365

UI Elements (A-Z) Description

Insert New Scheduled Report. Define a new job using the 
Schedule Job dialog box.

Edit Job. Edit the selected job using the Schedule Job 
dialog box.
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Create Copy. Enables you to create a copy of the selected 
job. Opens a new job in the Schedule Job dialog box that 
uses the details of the selected job.

Remove Job. Deletes the selected job from the list of 
scheduled jobs.

Run Job Immediate. Runs the selected job.

Pause Job. Pauses the selected job. Enabled only if the job 
has a Pending status.

Resume Job. Resumes the selected job.

Note: The Resume button is enabled only for jobs that 
have a Paused status.

Refreshes the list of scheduled jobs.

Clears the current filter.

Change visible columns. Enables you to select the 
columns to be displayed.

Current Status The current status of each scheduled job:

➤ Running. The job is currently executing.

➤ Pending. The job is waiting for the scheduling 
requirements to be fulfilled.

➤ Completed. The job has finished executing.

➤ Paused. The job has been paused.

Note. If a job has a Completed status, and you want to 
resume running the job, you can either click Run Job 
Immediate or change the Next Execution Time to the 
current time. If you change it to a future time, the status 
changes to Pending. 

Description A description of the scheduled job as defined in the 
Schedule Job dialog box.

UI Elements (A-Z) Description
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Execution Status The job’s current execution status:

➤ Success. The job completed successfully.

➤ Failure. The job failed to execute.

➤ None. The job has not yet been executed.

Job Type A scheduled job can either be Schedule Report or 
Schedule Snapshot.

Last Execution Time The last time the report ran.

Name The name of the scheduled job as defined in the Schedule 
Job dialog box.

Next Execution Time The next time the report is scheduled to run.

UI Elements (A-Z) Description
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Network Device Breakdown Report

This report displays a breakdown of network devices. Only the network 
devices that meet the following conditions appear in the report:

➤ The CIT of the network device has been assigned the qualifier 
NETWORK_DEVICES. For details, see "Qualifier Tab" on page 87.

➤ The network device is defined with the following attribute condition: 
Host is complete = True. For details, see "Attribute Tab" on page 82.
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access Select Managers > Modeling > Reports. In the Custom 
Reports pane, do one of the following:

➤ Right-click Network Device Breakdown Report and 
select Create New Report.

➤ Click the Create New Report  button and select 
Network Device Breakdown Report.

➤ Double-click Network Device Breakdown Report.

➤ Select Network Device Breakdown Report and drag it 
onto the right pane.

Relevant tasks "Generate a Custom Report" on page 365

UI Elements (A-Z) Description

<Bar graph/Pie 
chart>

Each segment of the pie chart/column in a bar graph 
represents a different network device. 

Click a slice/bar to drill down to see the number of CI 
instances per network device.

When you hold the mouse over each segment/bar, a 
tooltip indicates the name of the network device, the 
number of CI instances there are for each network device, 
the percentage of the pie it represents (when viewing the 
information in pie chart format), and the CI type the 
slice/bar represents.

Click a segment/bar to view a specific network device 
sorted by manufacturer. Click a segment/bar again to 
view the details of the CI instances found for that 
network device for that manufacturer in table format.

Each color in the legend represents a different network 
device.

<Toolbar> For details, see "Toolbar Options" on page 431.

Cities Currently not supported.

Countries or Province Currently not supported.

States Currently not supported.
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Node OS Breakdown Report

This report displays a breakdown of operating systems. You can view all 
deployed operating systems or you can view data for operating systems at a 
certain location or running on a certain subnet.

To access Select Managers > Modeling > Reports. In the Custom 
Reports pane, do one of the following:

➤ Right-click Node OS Breakdown Report and select 
Create New Report.

➤ Click the Create New Report  button and select 
Node OS Breakdown Report.

➤ Double-click Node OS Breakdown Report.

➤ Select Node OS Breakdown Report and drag it onto the 
right pane.
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Relevant tasks "Generate a Custom Report" on page 365

UI Elements (A-Z) Description

<Bar graph/Pie 
chart>

Each segment of the pie chart/column in a bar graph 
represents a different operating system. 

Click a slice/bar to drill down to see the number of CI 
instances per operating system in table format.

When you hold the mouse over each segment/bar, a 
tooltip indicates the name of the operating system, the 
number of CI instances there are for each operating 
system, the percentage of the pie it represents (when 
viewing the information in pie chart format), and the CI 
type the slice/bar represents.

<Toolbar> For details, see "Toolbar Options" on page 431.

Cities Currently not supported.

Countries or Province Currently not supported.

Filter Select one of the following:

➤ By Location. Select the required location.

➤ By Subnet. Enter the required subnet. You can use the 
wildcard character asterisk (*) to include several 
subnets. For example, 1 1 *. 

States Currently not supported.
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Number of Changes Report

This report displays the number of detected changes in a CIT (additions, 
deletions, or updates) within a defined time period.

To access Select Managers > Modeling > Reports. In the Custom 
Reports pane, do one of the following:

➤ Right-click Number of Changes Report and select 
Create New Report.

➤ Click the Create New Report  button and select 
Number of Changes Report.

➤ Double-click Number of Changes Report.

➤ Select Number of Changes Report and drag it onto the 
right pane.
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Relevant tasks "Generate a Custom Report" on page 365

UI Elements (A-Z) Description

<Bar graph/Pie 
chart>

On the first level, each segment of the pie chart/column 
in a bar graph represents a CIT of a CI or a relationship in 
which there was a detected change. The legend displays 
the colors that represent each CIT. 

When you hold the mouse over the relevant color of each 
segment/bar, a tooltip indicates the number of changes 
that occurred for that CIT the percentage of the pie it 
represents (when viewing the information in pie chart 
format), and the CI type the slice/bar represents

Click a slice/bar to drill down to the second level. to view 
the types of changes that occurred for each CIT and the 
CIT’s children. The colors in each segment/bar represent 
the different types of changes that occurred in the 
application. See the legend to verify the change type each 
color represents. 

Click the required color to drill down to see the number 
of CIs or relationships for that type of change in table 
format. Once you do the second drill down, you get the 
instances that represent the changes described.

Changes of type added or updated are taken from the 
CMDB. Changes of type deleted are taken from History 
Database.

<Toolbar> For details, see "Toolbar Options" on page 431.

Date from Configure a start date and time for the report.

Date until Configure an end date and time for the report.
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Reports Page

This page enables you to create Topology reports based on the data in views, 
as well as a number of predefined Custom report types.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Time range Select a time frame over which to display the detected 
changes. The system automatically provides the starting 
and ending dates in the Date from and Date until boxes.

Note: If you select Custom, you can manually configure a 
starting and ending date in the Date from and Date until 
boxes.

To access Select Managers > Modeling > Reports.

Relevant tasks ➤ "View a Topology Report" on page 365

➤ "Generate a Custom Report" on page 365

➤ "Compare CIs" on page 366

➤ "Compare Snapshots" on page 368

See also ➤ "Toolbar Options" on page 431

➤ "Custom Reports Overview" on page 364

➤ "Topology Reports Overview" on page 364

UI Elements (A-Z) Description

Show Scheduled Reports Jobs. Opens the Job List dialog 
box, which displays the reports that have been scheduled 
to run. For details, see "Job List Dialog Box" on page 413.

UI Elements (A-Z) Description
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Left Pane
User interface elements are described below:

<Left pane> The following panes are included:

➤ Topology Reports. Displays reports of the views and 
templates that were created using the Modeling Studio. 
For details, see "Topology Report" on page 434.

➤ Custom Reports. Displays various preset types of 
reports in chart or table format. For details, see 
"Reports User Interface" on page 371.

<Right pane> Displays the selected report.

UI Elements (A-Z) Description

Create New Report. Enables you to select the type of 
report that you want to create. 

Note: This option is relevant to Custom Reports only.

Open Report. Generates an existing report in the Report 
pane.

Show View Definition. Displays the selected view’s 
definition in the Modeling Studio. For details, see 
"Modeling Studio" on page 265.

Note: This option is available only for Topology Reports.

Delete Report.

➤ In the Custom Reports pane, deletes the selected 
report.

➤ In the Topology Reports pane, deletes the archived 
report.

UI Elements (A-Z) Description
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Schedule Report. Opens the Schedule Job dialog box, 
which enables you to define a job that:

➤ Schedules the generation of a report

➤ Specifies one or more formats in which to send the 
report, and the report’s recipients

➤ Specifies the recurrence of the job

For more information on the Schedule Job dialog box, 
see, "Schedule Job Dialog Box" on page 427.

Note: This option is available only before you generate a 
report or when you open a saved report.

Send Mail. Opens the Send Mail dialog box. You can send 
an email containing the generated report in various 
formats, or as a direct link. For details on the various 
formats, see "Export Report." on page 432.

Select one or more of the available formats for the 
generated report to be sent as attachments to an email 
recipient.

Note: Required fields are marked with an asterisk.

Generate Direct Link. Creates a direct link to the specific 
location on the server of the selected report, or to the 
data that you have exported as a specific format.

UI Elements (A-Z) Description
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Export Report.

Enables you to select the export format for the report. The 
available options are: 

➤ Excel. The report data is formatted as an .xls (Excel) file 
that can be displayed in a spreadsheet.

➤ PDF. The report data is exported in PDF format.

➤ CSV. The report data is formatted as a comma-
separated values (CSV) text file that can be displayed in 
a spreadsheet.

Note: For the CSV formatted table data to display 
correctly, the comma (,) must be defined as the list 
separator. In Windows, to verify or modify the list 
separator value, open Regional Options from the 
Control Panel, and on the Numbers tab ensure that the 
comma is defined as the List Separator value. In Linux, 
you can specify the list separator in the application 
that opens the CSV file.

➤ XML. The report data is formatted as an XML file that 
can be opened in a text or XML editor. 

Tip: To extract HTML code from the report: 

➤ Open the file in an HTML editor

➤ Copy the relevant table into the target file 

Snapshots. Enables you to do the following:

➤ Save a snapshot of the active report. For details, see 
"Save Snapshot Dialog Box" on page 262.

➤ Compare a previously saved snapshot to the active 
report or to another snapshot. For details, see 
"Compare Snapshots Report" on page 393.

➤ Schedule snapshots to be saved. For details, see 
"Schedule Job Dialog Box" on page 427.

➤ Display the currently scheduled snapshot jobs. or 
details, see "Job List Dialog Box" on page 413.

Note: This option is available only for Topology Reports.

Refresh. Refreshes the report tree.

UI Elements (A-Z) Description
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Expand All. Expands the tree structure.

Collapse All. Collapses the tree structure.

Hide Empty Folders. Toggles between displaying all 
folders and only folders that contain reports.

Find the next occurrence of the phrase/Find the previous 
occurrence of the phrase. Enables you to move to the 
next or previous result of the search for the string entered 
in the Find field.

Highlights all occurrences of the phrase. Highlights all 
occurrences in the CI tree of the string entered in the Find 
field.

Find Enter a search name or a portion of a search name in the 
Find field to locate it in the list.

UI Elements (A-Z) Description
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Schedule Job Dialog Box

This dialog box enables you to define a schedule for running reports, and 
then send them by email to specified recipients. You can also define a 
schedule for taking snapshots of a specific view. You can see the list of 
reports/snapshots that have been scheduled to run in the "Job List Dialog 
Box" on page 413.

The following elements are included:

To access ➤ To schedule reports to run, select Managers > 
Modeling > Reports. In the Topology Reports or 
Custom Reports pane, select a report and click the 
Schedule Report  button.

➤ To define a schedule for taking snapshots, select 
Managers > Modeling > Reports. In the Topology 
Reports pane, select the required view, click the 
Snapshots  button, and then select Schedule 
Snapshot. Alternatively, in IT Universe Manager, click 
the Snapshots  button in the CI Selector, and then 
select Schedule Snapshot.

Relevant tasks ➤ "Compare CIs" on page 366

➤ "Compare Snapshots" on page 368

UI Elements (A-Z) Description

Click to validate the Cron expression you entered in the 
Cron Expression box.

Actions Note: Available only when defining a schedule for 
running reports.

The available options are:

➤ Mail. Sends the report to the mail recipient in the Send 
box.

➤ Archive. Archives the report result in the database. 

Cron Expression Enter a Cron expression to schedule a job. For a 
description of the fields used in Cron expressions and 
examples of how to use them, see, "Cron Expressions" on 
page 370.
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Description A description of the scheduled job.

Ends Select one of the following options:

➤ Never. Do not specify an end date. Not relevant if you 
define a report to run only once.

➤ Until. Choose the date and time by which you want 
the action to stop running. Relevant only if you are 
using Cron expressions.

Formats Note: Available only when defining a schedule for 
running reports.

Select the format in which you want to send the report. 
Available when you select the Mail action option.

The available options are:

➤ Excel. The report data is formatted as an .xls (Excel) file 
that can be displayed in a spreadsheet.

➤ PDF. The report data is exported in PDF format.

➤ CSV. The report data is formatted as a 
comma-separated values (CSV) text file that can be 
displayed in a spreadsheet.

Note: For the CSV formatted table data to display 
correctly, the comma (,) must be defined as the list 
separator. In Windows, to verify or modify the list 
separator value, open Regional Options from the 
Control Panel, and on the Numbers tab ensure that the 
comma is defined as the List Separator value. In Linux, 
you can specify the list separator in the application 
that opens the CSV file.

➤ XML. The report data is formatted as an XML file that 
can be opened in a text or XML editor. 

➤ Direct Link. Send an email containing the report data 
as a direct link.

Locale Select the language for the report.

Name The name of the scheduled job.

UI Elements (A-Z) Description
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Repeat Select one of the following actions:

➤ Once. Activates a job only once.

➤ Daily. Runs a job on a daily basis.

➤ Weekly. Runs a job on a weekly basis. Select the day or 
days on which you want the action to run.

➤ Monthly. Runs a job on a monthly basis. Select the 
month or months in which you want the job to run.

➤ Yearly. Runs a job on a yearly basis. 

➤ Cron. Use a Cron expression to schedule a job. For a 
description of the fields used in Cron expressions and 
examples of how to use them, see, "Cron Expressions" 
on page 370.

Repeat every (Appears only when you select Daily, Weekly, Monthly or 
Yearly.) Select a value for the interval between successive 
runs. 

For example, if you select Weekly and then 2, the job runs 
every second week.

Report Enables you to select the Topology or Custom report you 
want to run. Opens the Select Report dialog box.

Send to Note: Available only when defining a schedule for 
running reports.

Define the recipients who can automatically receive 
scheduled reports through mail. Click the Open Address 
Book  button to open the Message Recipients dialog 
box and select an mail recipient. 

You can use the Add, Edit, and Delete buttons in the 
Message Recipients dialog box to modify the mail list.

Note: The recipients that appear in the Message 
Recipients dialog box are updated with the email 
recipients defined in the "Recipients Manager Page" in the 
HP Universal CMDB Administration Guide.

Server Time The exact server time according to the client’s time zone.

UI Elements (A-Z) Description
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Starts Choose the time and date when you want the job to 
begin running.

Time Zone Set the required time zone.

UI Elements (A-Z) Description
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Toolbar Options

This section describes the toolbar options for the Report pane.

UI Elements (A-Z) Description

Displays the parameters that are defined for the report.

Save Report. Saves the selected report.

Schedule Report. Opens the Schedule Job dialog box, 
which enables you to define a job that:

➤ Schedules the generation of a report

➤ Specifies one or more formats in which to send the 
report, and the report’s recipients

➤ Specifies the recurrence of the job

For more information on the Schedule Job dialog box, 
see, "Schedule Job Dialog Box" on page 427.

Note: This option is available only before you generate a 
report or when you open a saved report.

Send Mail. Opens the Send Mail dialog box. You can send 
an email containing the generated report in various 
formats, or as a direct link. For details on the various 
formats, see "Export Report." on page 432.

Select one or more of the available formats for the 
generated report to be sent as attachments to an email 
recipient.

Note: Required fields are marked with an asterisk.

Archive Report. Enables you to save the report results in 
the database. After the report is archive, a  icon 
appears next to the report name.

Note: Enabled only for Topology and Gold Master 
reports.

Generate Direct Link. Creates a direct link to the specific 
location on the server of the selected report, or to the 
data that you have exported as a specific format.
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Export Report.

Enables you to select the export format for the report. The 
available options are: 

➤ Excel. The report data is formatted as an .xls (Excel) file 
that can be displayed in a spreadsheet.

➤ PDF. The report data is exported in PDF format.

➤ CSV. The report data is formatted as a comma-
separated values (CSV) text file that can be displayed in 
a spreadsheet.

Note: For the CSV formatted table data to display 
correctly, the comma (,) must be defined as the list 
separator. In Windows, to verify or modify the list 
separator value, open Regional Options from the 
Control Panel, and on the Numbers tab ensure that the 
comma is defined as the List Separator value. In Linux, 
you can specify the list separator in the application 
that opens the CSV file.

➤ XML. The report data is formatted as an XML file that 
can be opened in a text or XML editor. 

Tip: To extract HTML code from the report: 

➤ Open the file in an HTML editor

➤ Copy the relevant table into the target file 

Bar Chart. Displays the generated report as a bar chart.

Pie Chart. Displays the generated report as a pie chart.

Table. Displays the generated report in tabular format.

Show Short Labels. Toggles between displaying the chart 
labels minimal/maximum information.

Note: This option is available only for pie charts.

Show Legend. Toggles between hiding and displaying the 
chart’s legend.

Note: This option is available only for pie charts.

UI Elements (A-Z) Description
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Slice chart. Toggles between displaying the pie chart with 
exploded and unexploded segments.

Note: This option is available only for pie charts.

Expand All. Expands the tree structure.

Collapse All. Collapses the tree structure.

Delete from CMDB. Deletes the selected CI from the 
CMDB. 

Opens the Configuration Item Properties dialog box for 
the selected CI.

Refresh. Refreshes the report tree.

Select Columns. Select the columns you want to display 
in the report.

Sort Column Content. Enables you to set the sort order of 
the selected column’s content.

Find. Toggles between displaying and hiding the Find 
utility.

Find the next occurrence of the phrase/Find the previous 
occurrence of the phrase. Enables you to move to the 
next or previous result of the search for the string entered 
in the Find field.

Highlights all occurrences of the phrase. Highlights all 
occurrences in the CI tree of the string entered in the Find 
field.

Generate Report. Enables you to generate the selected 
report.

Note: This button appears disabled prior to defining the 
report parameters.

UI Elements (A-Z) Description
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Topology Report

This report displays the topology of a view in report format. 

<breadcrumbs> Displays the levels through which you have navigated to 
get to the current level. Appears horizontally across the 
top of the chart. 

Note: Each level in the list of breadcrumbs is a clickable 
link.

<Generated report> Displays the active generated report.

Find Enter a search name or a portion of a search name in the 
Find field to locate it in the list.

To access Select Modeling > Reports. In the Topology Reports pane, 
select the required report from the tree. 

Important 
information

Every view in UCMDB can be displayed in report format. 
You define the settings for the report in the Report tab of 
the view in Modeling Studio.

Relevant tasks "View a Topology Report" on page 365

UI Elements (A-Z) Description
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User interface elements are described below: 

UI Elements (A-Z) Description

<Bar graph/Pie 
chart>

Each segment of the pie chart/column in a bar graph 
represents a CI on the selected level of the view.

Click a slice/bar to drill down to the next level, if one 
exists. You can also display the information in table 
format.

When you hold the mouse over the relevant segment/bar, 
a tooltip indicates the number of instances there are for 
that CIT, the percentage of the pie it represents (when 
viewing the information in pie chart format), and the CIT 
or CIT attribute the slice/bar represents.

<Toolbar> For details, see "Toolbar Options" on page 431.
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View Change Report

This report displays the changes to CIs or relationships, in a selected view. 
This can help with possible troubleshooting issues related to these CIs. For 
example, the changes in a CI may enable you to conclude that these 
changes are the cause of the problem. By the same token, the source of the 
troubleshooting issue could be related to expected changes which failed to 
occur.

To access Select Modeling > Reports. In the Custom Reports pane, 
do one of the following:

➤ Right-click View Change Report and select Create New 
Report.

➤ Click the Create New Report  button and select 
View Change Report.

➤ Double-click View Change Report.

➤ Select View Change Report and drag it onto the right 
pane.
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Important 
information

➤ Only those CIs whose CIs whose properties are marked 
as either Change Monitored or Comparable appear in 
the report. For details, see "Add/Edit Attribute Dialog 
Box" on page 478.

View Change reports display:

➤ Changes on only CIs that exist in the view.

➤ Changes that occurred in a selected CI and all its 
children, which are linked, by default, by an 
impact_link. The CIs in the generated report are 
retrieved according to the Infrastructure Settings 
Manager settings. Go to Managers > Administration > 
Infrastructure Settings > Applications > MamWeb. For 
details, see "Infrastructure Settings" in the HP Universal 
CMDB Administration Guide.

➤ Select Change Report relationship name to retrieve 
CIs that are linked by the selected calculated 
relationship. In the Value box, enter the name of 
the relationship as it appears in the Name box (not 
the Display Name box) in the Details page of the 
selected relationship in the CI Type Manager. For 
details, see "Details Page" on page 487.

➤ Select Change Report relationship qualifier to 
retrieve CIs that are defined with a qualifier. In the 
Value box, enter the name of the required qualifier. 
For information about qualifiers, see "Qualifiers 
Page" on page 492.

➤ CIs with a Container link relationship that were added 
to, or removed from, a CI.

➤ CIs whose relationship is defined with a 
TRACK_LINK_CHANGES qualifier, that are added to, or 
removed from, a CI. For information about qualifiers, 
see "Qualifiers Page" on page 492.

Relevant tasks "Generate a Custom Report" on page 365
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User interface elements are described below: 

CI Changes Tab

For information on the CI Changes tab, see "CI Changes Tab" on page 383.

Relationship Changes Tab

For information on the Relationship Changes tab, see "Relationship 
Changes Tab" on page 384.

UI Elements (A-Z) Description

<Toolbar> For details, see "Toolbar Options" on page 431.

Date from Configure a start date and time for the report.

Date until Configure an end date and time for the report.

Time range Select a time frame over which to display the changes. 
The system automatically provides the starting and 
ending dates in the Date from and Date until boxes.

Note: If you select Custom, you can manually configure a 
starting and ending date in the Date from and Date until 
boxes.

View Select the view for which you want to review changes. 
Opens the Select CI/View dialog box. For details, see 
"Working with the CI Selector" on page 143.
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Impact Analysis Manager

This chapter includes:

Concepts

➤ Impact Analysis Manager Overview on page 440

Tasks

➤ Define an Impact Rule – Workflow on page 442

Reference

➤ Impact Analysis Manager User Interface on page 446
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Concepts

Impact Analysis Manager Overview

Impact Analysis Manager enables you to define the interdependencies 
between components in your IT infrastructure to simulate how 
infrastructure changes (for example, a new software installation or upgrade) 
can impact your system.

By creating Impact rules based on TQL queries, you can determine the true 
origin of a problem and its business impact. Each Impact rule you define is 
attached to a specific Impact Analysis TQL query. For more information 
about TQL queries, see "Topology Query Language" on page 19.

You define Impact rules to specify a causal relationship between two or more 
Impact Analysis query nodes. Define one query node as the trigger, or the 
query node that represents the changes you want to make to the system, 
and another query node as the one that is impacted. After the causal 
relationship is established, Impact Analysis Manager enables you to 
determine the effect of the changes occurring in root cause query nodes.

You then run the Impact rules in IT Universe Manager to simulate how the 
changes impact your system and discover the root causes of the changes (for 
details, see "Run Impact Analysis Dialog Box" on page 260). This enables you 
to evaluate and handle accordingly, the possible implications of any action, 
update, new deployment, or a failure of the service delivery.

A simulated change in an impacted CI can alter the CI’s map status, which is 
manifested through an addition of a status icon to the CI’s symbol. The 
Topology Map displays the statuses of the trigger CIs as well as all statuses of 
the CIs that are impacted by it. Each color represents a different status.

For details about the status icons and the colors that represent them, see 
"Show Impact Pane" on page 263.
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You can then generate a report displaying the following:

➤ CIs in the system that are impacted by the changes.

➤ Trigger CIs (the CIs that represent the changes you want to make to the 
system).

➤ CIs that belong to a specific business service. 
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Tasks

Define an Impact Rule – Workflow

This section describes how to define an Impact rule whereby a change in 
CPU operation impacts the node to which it is connected.

This task includes the following steps:

➤ "Create an Impact Analysis TQL Query" on page 442

➤ "Define an Impact Rule" on page 443

 1 Create an Impact Analysis TQL Query

To create an Impact Analysis TQL query, you need to create an Impact 
Analysis TQL and then add the TQL query nodes and relationships that 
define the query. 

Select Managers > Modeling > Impact Analysis Manager to open the 
Impact Analysis Manager. For details about how to create an Impact 
Analysis TQL query, see "New Impact Rule/Impact Rule Properties/Save As 
Impact Rule Wizard" on page 459. For details about how to add query 
nodes and relationships to a query, see "Add Query Nodes and 
Relationships to a TQL Query" on page 28.
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Example of an Impact Analysis TQL Query:

In this Impact Analysis TQL query, a CPU and a node are linked by a 
Composition relationship. The TQL query results must comply with the 
direction of the arrows.

Note: An Impact Analysis TQL query is subject to certain validation 
restrictions. For details, see "Troubleshooting and Limitations" on 
page 97.

 2 Define an Impact Rule

When you define an Impact rule, you must specify the required causal 
relationship between the query nodes. Define one query node as the 
trigger, or the query node that represents the changes you want to make 
to the system, and another query node as the one that is impacted.

Right-click the query node you want to define as the trigger query node 
and select Define Impacted to open the Impacted Query Nodes dialog 
box. Select the query node you want the trigger query node to impact. 
Then click the Add button to open the Impact Rules Definition dialog box 
to set conditions for defining impacted query nodes. For details about 
how to define an Impact rule, see "Impact Rules Definition Dialog Box" on 
page 457. 

Note: The change state option in the Impact rule definition is no longer 
relevant for Impact Analysis. The only supported state is operation.
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Example of an Impact Rule:

The Conditions area in the Impact Rules Definition dialog box defines the 
conditions under which the simulated change in the system is triggered. 
The Severity area defines the severity of the impact on the impacted query 
node.

The Impact rule in this example states that when the CPU operation is 
not in the normal state, the node is impacted. Since the severity is set to 
100% of the trigger’s severity, the severity of the node is the same as the 
severity of the CPU, which is determined when Impact Analysis is run.
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In the resulting TQL query, an upward arrow appears next to the query 
node defined as the trigger query node and a downward arrow appears 
next to the query node defined as the impacted query node.

Note: To retrieve the Impact Analysis results, you must run the Impact 
rule in IT Universe Manager. For details, see "Retrieve Impact Analysis 
Results – Scenario" on page 220.
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Reference

Impact Analysis Manager User Interface

This section includes (in alphabetical order):

 ➤ Details Dialog Box on page 447

 ➤ Impact Analysis Manager Page on page 448

 ➤ Impacted Query Nodes Dialog Box on page 455

 ➤ Impact Rules Definition Dialog Box on page 457

 ➤ New Impact Rule/Impact Rule Properties/Save As Impact Rule Wizard 
on page 459
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Details Dialog Box

This dialog box displays the new Impact rule you created in the Impact 
Rules Definition dialog box.

User interface elements are described below:

To access In the Impact Analysis Manager, click Next in the 
Impacted Query Nodes dialog box.

Relevant tasks "Define an Impact Rule – Workflow" on page 442

UI Elements (A-Z) Description

Description The description of the new Impact rule.

State The category you chose from the State list in the Impact 
Rules Definition dialog box.
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Impact Analysis Manager Page

This page enables you to define Impact rules.

Impact Rules Pane

This area displays a hierarchical tree structure of predefined folders and 
Impact rules. Each Impact rule is associated with a TQL query.

User interface elements are described below:

 

To access Select Impact Analysis Manager from the Navigation 
Menu or select Managers > Modeling > Impact Analysis 
Manager.

Important 
information

When selecting query nodes to function as Impact 
Analysis triggers, they must comply with certain 
restrictions. For details, see "Troubleshooting and 
Limitations" on page 97.

Relevant tasks "Define an Impact Rule – Workflow" on page 442

See also "Impact Analysis Manager Overview" on page 440

Important 
information

You can create your own query, or work with the 
default queries provided with your HP Universal 
CMDB installation.

The predefined folders are provided for the default 
queries; you can modify these folders, or add 
additional folders according to your organization’s 
requirements.

UI Elements (A-Z) Description

Create a new folder.

Creates an Impact rule. Opens the New Impact Rule 
Wizard.

Deletes the selected folder or Impact rule.
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The following elements are available by right-clicking a folder or Impact 
rule:

 

Refreshes the data content of the hierarchical tree 
structure that may have been modified by other users.

(Enabled only when a new Impact rule is created or when 
changes are made to an existing one.) Saves the Impact 
rule to the CMDB.

Opens the Impact Rule Properties Wizard. Enables you to 
change the description of the rule.

Generates  a preview of the results of the selected Impact 
rule.

Represents a folder.

Represents an Impact rule.

UI Elements (A-Z) Description

Delete Delete the selected folder or Impact rule.

Export To XML Displays a standard Save As dialog box, enabling you to 
save the Impact rule as an XML script. This option can be 
used to move an Impact rule from one workstation to 
another, provided the related TQL query is also relocated.

Import From XML Imports XML files that contain saved Impact rules to 
Impact Analysis Manager.

New Creates an Impact rule. Opens the New Impact Rule 
Wizard.

New Folder Creates a new folder.

Preview Generates  a preview of the results of the selected Impact 
rule.

Properties Opens the Impact Rule Properties Wizard. Enables you to 
change the description of the rule.

UI Elements (A-Z) Description
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Editing Pane

This area displays the selected Impact rule, which consists of query nodes 
that are defined in the TQL query and the relationships between them.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Rename Folder Rename the folder.

Save (Enabled only when a new Impact rule is created or when 
changes are made to an existing one.) Saves the Impact 
rule to the CMDB.

Save As Displays the Save As Impact Rule Wizard, enabling you to 
create new Impact rules based on an existing query.

Important 
information

➤ When you select a folder in the Impact Rules pane, the 
editing pane is empty. 

➤ When you select an Impact rule in the Impact Rules 
pane, the editing pane displays the selected rule, which 
consists of TQL query nodes that are defined in the 
TQL query and the relationships between them.

Relevant tasks  "Add Query Nodes and Relationships to a TQL Query" on 
page 28

See also When selecting query nodes to function as Impact 
Analysis triggers, they must comply with certain 
restrictions. For details, see "Troubleshooting and 
Limitations" on page 97.

UI Elements (A-Z) Description

Indicates a trigger query node. Located to the right of the 
trigger query node's icon. 

Indicates an impacted query node. Located to the right of 
the impacted query node’s icon.

UI Elements (A-Z) Description
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Indicates query nodes that are both impacted and trigger 
query nodes.

<Main Menu> For details, see "Main Menu" on page 185.

<Query Node> A component from which TQL queries are built.

<Relationship> The entity that defines the relationship between two 
query nodes.

<Shortcut menu 
options>

For details, see "Shortcut Menu Options" on page 37.

<Toolbar> For details, see "Toolbar Options" on page 189.

<Tooltip> Hold the cursor over a query node or relationship to view 
its tooltip.

The tooltips contain the following information:

➤ Element name. The name of the query node.

➤ CI Type. The CIT of the query node as defined in the CI 
Type Manager. For details, see "CI Type Manager" on 
page 465.

➤ Definitions of the selected query nodes and 
relationships. The attribute conditions, as described in 
"Query Node/Relationship Properties Dialog Box" on 
page 80.

➤ Names of the trigger and the impacted query nodes. 
This is only relevant if the query node over which the 
cursor is hovering is the trigger query node.

Define Impacted Displays the Impacted Query Nodes dialog box.

UI Elements (A-Z) Description
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CI Type Selector

This area displays a hierarchical tree structure of the CI Types found in the 
CMDB. 

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Important 
information

The CI Type Selector is part of Enrichment Manager, 
Impact Analysis Manager, and Trigger TQL Editor. 

To create or modify a TQL query, click and drag query 
nodes to the Editing pane and define the relationship 
between them. Your changes are saved to the CMDB. For 
details, see "Add Query Nodes and Relationships to a TQL 
Query" in Modeling Guide.

Note: The number of instances of each CIT in the CMDB 
is displayed to the right of each CIT.

Relevant tasks ➤ "Define an Impact Rule – Workflow" on page 442

➤ "Define an Enrichment Rule – Scenario" on page 510

➤ "Define a TQL Query" on page 27

➤ "Create a Pattern View" on page 285

UI Elements (A-Z) Description

Click Add CI Type to Map to move the selected CI type 
to the Editing pane.

Click Refresh to refresh the CI type tree.

Click Search to search for the CI type entered.

Click Expand All to expand all subtrees within the CI 
type tree.

Click Collapse All to collapse the subtrees within the CI 
type tree.

<Search window> Enter the name or part of a name of a CI type for which 
to search.
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Shortcut Menu Options

The CI Type Selector includes the following elements (listed alphabetically) 
available by right-clicking a CI Type:

Advanced Pane

This area displays the properties, conditions, and cardinality for the selected 
query node and relationship.

Menu Item Description

Add CI Type to Map Select to add the selected CI type to the Editing pane.

Go to CI Type 
Definition

Takes you directly to the selected CI type in CIT Manager.

Show CIT Instances Opens the CIT Instances window, which displays all 
instances of the selected CIT. For details, see "Element 
Instances Dialog Box" in Modeling Guide.

Important 
information

The Advanced pane appears in the lower part of the 
window in the following managers and user interfaces: 
Modeling Studio, Impact Analysis Manager, Enrichment 
Manager, the Input Query Editor and Trigger Query 
Editor in DFM.

A small green indicator  appears next to the tabs that 
contain data.

Relevant tasks ➤ "Define an Impact Rule – Workflow" on page 442

➤ "Define an Enrichment Rule – Scenario" on page 510

➤ "Define a TQL Query" on page 27

➤ "Create a Pattern View" on page 285

➤ "Create a Template" on page 286

➤ "Create a Perspective" on page 288
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User interface elements are described below:

UI Elements (A-Z) Description

If the window is not wide enough to display all the tabs, use 
the left and right arrows to move to the required tab.

Click Show List to display a list of the available tabs for the 
current module. You can select a tab from the list.

Attributes Displays the attribute conditions defined for the query node 
or the relationship. For details, see "Attribute Tab" on 
page 82.

Cardinality Cardinality defines how many query nodes you expect to 
have at the other end of a relationship. For example, in a 
relationship between a node and an IP Address, if the 
cardinality is 1:3, the TQL query retrieves only those nodes 
that are connected to between one and three IP Addresses. 
For details, see "Cardinality Tab" on page 84.

Data Sources Displays the data sources set for the selected query node.

Note: This tab appears only in the Modeling Studio.

Details Displays the following information:

➤ CI Type. The CIT of the selected query node/relationship.

➤ Visible. A green check indicates that the selected query 
node/relationship is visible in the topology map. A red 
mark indicates that it is not visible.

➤ Include subtypes. A green check indicates that both the 
selected CI and its children are displayed in the topology 
map. A red mark indicates that only the selected CI 
appears.

Edit Click Edit to open the relevant dialog box for the selected 
tab.
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Impacted Query Nodes Dialog Box

This dialog box enables you to define which query node in the TQL query is 
the trigger Impact Analysis query node and which query nodes are impacted 
by the changes that occurred in the system.

Enrichment Rules Displays the Enrichment rule defined for the selected query 
node or relationship. If the Enrichment rule is used to 
update the attributes of a CI, click Edit to open the Query 
Node/Relationship Definition dialog box and edit the rule if 
required. For details, see "Query Node/Relationship 
Definition Dialog Box" on page 531.

Note: This tab appears only in Enrichment Manager.

Impacted Query 
Nodes

Indicates which query node is affected by the changes that 
occur in the selected trigger query node. If required, you can 
click Edit to open and modify the Affected Query Nodes 
dialog box. For details, see "Impacted Query Nodes Dialog 
Box" on page 455.

Note: This tab appears only in Impact Analysis Manager.

Qualifiers Displays the qualifier conditions defined for the query node 
or the relationship. For details, see "Qualifier Tab" on 
page 87.

Selected Identities Displays the element instances that are used to define what 
should be included in the TQL query results. For details, see 
"Identity Tab" on page 90.

To access Right-click the query node or relationship that functions 
as a trigger and select Define Impacted. The Impacted 
Query Nodes dialog box opens to display the query nodes 
in the TQL query.

UI Elements (A-Z) Description
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User interface elements are described below:

Important 
information

Before creating the TQL query, you must know which 
query node in the query is the trigger Impact Analysis 
query node and which are impacted by the changes 
beforehand. The definition is performed here.

Relevant tasks "Define an Impact Rule – Workflow" on page 442.

UI Elements (A-Z) Description

Impacted Query 
Nodes pane

Contains a list of the Impact Analysis query nodes in 
the Impact rule. Select the query nodes to be impacted by 
the trigger query node.
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Impact Rules Definition Dialog Box

This dialog box enables you to set conditions for defining impacted query 
nodes, define the scope of the trigger conditions, and define the severity of 
the impact.

User interface elements are described below:

To access In the Impact Analysis Manager, click Add in the Details 
dialog box.

Important 
information

➤ In the Conditions area, set conditions for defining 
impacted query nodes. When this condition is met, 
the simulated change in the system is triggered.

For example, you can define an Impact Analysis 
condition that states that the operational state of the 
query node is other than Normal. When the 
operational state of the query node instance changes 
and is no longer Normal, the condition is met and the 
simulated changes in the system are triggered.

➤ In the Scope area, define how many instances of the 
trigger query node should fulfill the conditions for 
triggering the changes in the system.

You can apply the trigger conditions to a single 
instance of a trigger query node, to a certain 
percentage of the trigger instances, or to all of them. 

For example, you can define that impact is calculated 
when at least 10% of the system’s nodes are down.

➤ In the Severity area, define the severity of the Impact 
Analysis impact.

Relevant tasks "Define an Impact Rule – Workflow" on page 442

UI Elements (A-Z) Description

All All instances should fulfill the conditions.

Any One instance or more should fulfill the conditions.

Description A description of the Impact rule you are defining.
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Fixed severity Define a fixed severity level for every system change 
generated. Then, select the required severity level from 
the list.

Function Select Function (displayed when you selected the All and 
Range options in the Scope area) to define a severity level 
for the system changes, as a function of the severity levels 
of all the trigger query node instances that are included 
in the range. From the list, select either Average or Max.

For example, if you select Average, the severity level of 
the system changes is the average severity of all the 
trigger instances.

Operator Select the required operator. For a list of the operators you 
can use for defining an attribute condition, see "Attribute 
Operator Definitions" on page 42.

Range A certain percentage of all instances should fulfill the 
conditions. For example, if you enter a range of 50% to 
100%, the changes are triggered when 50% or more of 
the instances meet the conditions.

Severity relative to 
trigger severity (%)

Select Severity relative to trigger severity (%) (displayed 
when you selected the Any option in the Scope area) to 
define a severity level for each system change that is 
relative (as a percentage) to the severity of the trigger 
event.

Enter the percentage in the box provided.

State Choose the required state. The states that appear in the 
list are the states that are defined in the State Manager. 
For details, see "State Manager" in the HP Universal CMDB 
Administration Guide.

Value Comparison Select the required attribute.

UI Elements (A-Z) Description
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New Impact Rule/Impact Rule Properties/Save As Impact 
Rule Wizard

This wizard enables you to create or modify an Impact rule.

To access ➤ To create an Impact rule, right-click anywhere in the 
Impact Rules pane and click New or click the New  
button.

➤ To modify an Impact rule, right-click an Impact rule in 
the Impact Rules pane and select Properties.

➤ To create a new Impact rule based on an existing 
query, right-click an Impact rule in the Impact Rules 
pane and select Save As.

Important 
information

➤ Any major change made to the TQL query after 
creating an Impact rule causes the system to delete the 
rule. These changes include deleting a root cause or 
impacted query node or changing the Min and Max 
relationship definitions. For details, see "Cardinality 
Tab" on page 84.

➤ Minor changes, such as adding a query node to the 
TQL query, do not cause the deletion of the rule.

➤ The Impact Analysis TQL query that serves as the basis 
of the Impact rule, is subject to certain validation 
restrictions. For details, see "Troubleshooting and 
Limitations" on page 97. If the TQL query is not valid, 
it cannot be used for the creation of an Impact rule.

Relevant tasks "Define an Impact Rule – Workflow" on page 442

Wizard map The New Impact Rule/Impact Rule Properties/Save As 
Impact Rule Wizard contains:

Impact Rule General Attributes Page > Impact Rule Base 
Query Page > Impact Rule Groups Page
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Impact Rule General Attributes Page
This wizard page enables you to enter a unique name and description for the 
Impact rule.

User interface elements are described below:

Important 
information

➤ The Impact Analysis TQL query that serves as the basis 
of the Impact rule, is subject to certain validation 
restrictions. For details, see "Troubleshooting and 
Limitations" on page 97. If the TQL query is not valid, 
it cannot be used for the creation of an Impact rule.

➤ For important information on the effects of making 
changes to the TQL query after creating it, see "New 
Impact Rule/Impact Rule Properties/Save As Impact 
Rule Wizard" on page 459.

➤ By default, this wizard is set to display a Welcome 
page. You can choose not to display the Welcome page 
by changing the user preferences. For details, see "User 
Preferences Dialog Box" on page 97.

Wizard map The New Impact Rule/Impact Rule Properties/Save As 
Impact Rule Wizard contains:

Impact Rule General Attributes Page > Impact Rule 
Base Query Page > Impact Rule Groups Page

See also "IT Universe Manager" on page 201

UI Elements (A-Z) Description

Rule Description (Optional) Enter a description of the Impact rule.

Rule Name Enter a unique name for the Impact rule. 

The rule name cannot contain any of the following 
characters: \ / : " < > | % ?

Note: If the Impact rule name is either empty, contains a 
name used by another Impact rule, or uses invalid 
characters, the Next and Finish buttons are disabled.
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Impact Rule Base Query Page
This wizard page enables you to define the properties of the TQL query on 
which the Impact rule is based. You can use an existing query or create a 
new query.

User interface elements are described below:

Important 
information

➤ The Impact Analysis TQL query that serves as the basis 
of the Impact rule is subject to certain validation 
restrictions. For details, see "Troubleshooting and 
Limitations" on page 97. If the TQL query is not valid, 
it cannot be used for the creation of an Impact rule.

➤ For important information on the effects of making 
changes to the TQL query after creating it, see "New 
Impact Rule/Impact Rule Properties/Save As Impact 
Rule Wizard" on page 459.

Wizard map The New Impact Rule/Impact Rule Properties/Save As 
Impact Rule Wizard contains:

Impact Rule General Attributes Page > Impact Rule Base 
Query Page > Impact Rule Groups Page

See also "IT Universe Manager" on page 201

UI Elements (A-Z) Description

Base the Impact rule 
on a new Query

Select this check box if you want to base the Impact rule 
on a new TQL query. The query results are based on the 
attributes defined for the new TQL query.

Base the Impact rule 
on an existing Query

Select this check box if you want to base the Impact rule 
on an existing TQL query. Select the required Impact 
Analysis TQL query from the drop-down list.

Base Query 
Description

(Optional) Enter a description of the TQL query.
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Impact Rule Groups Page
This wizard page enables you to define where you can run Impact rules.

Base Query Name Enter a unique name for the Impact Analysis TQL query.

If you selected the Base the Impact rule on an existing 
TQL option, select the Impact Analysis TQL query on 
which you want to base the rule.

Base Query Priority Select a priority level for the new TQL query (Low, 
Medium, High, Express). This setting determines how 
often the query is rerun automatically by the system to 
include updated information from the CMDB.

Important 
information

➤ The Impact Analysis TQL query that serves as the basis 
of the Impact rule, is subject to certain validation 
restrictions. For details, see "Troubleshooting and 
Limitations" on page 97. If the TQL query is not valid, 
it cannot be used for the creation of an Impact rule.

➤ For important information on the effects of making 
changes to the TQL query after creating it, see "New 
Impact Rule/Impact Rule Properties/Save As Impact 
Rule Wizard" on page 459.

➤ By default, this wizard is set to display a Completion 
page after clicking Next in this page. You can choose 
not to display the Completion page by changing the 
user preferences. For details, see "User Preferences 
Dialog Box" on page 97.

Wizard map The New Impact Rule/Impact Rule Properties/Save As 
Impact Rule Wizard contains:

Impact Rule General Attributes Page > Impact Rule Base 
Query Page > Impact Rule Groups Page

See also "IT Universe Manager" on page 201

UI Elements (A-Z) Description
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User interface elements are described below:

UI Elements (A-Z) Description

UCMDB Enables you to run an Impact rule in IT Universe 
Manager. For details, see "IT Universe Manager Overview" 
on page 202.
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CI Type Manager

This chapter includes:

Concepts

➤ CI Types Overview on page 466

➤ CI Type Attributes on page 467

➤ CI Type Relationships on page 468

➤ System Type Manager on page 468

Tasks

➤ Create a CI Type on page 470

➤ Create a Relationship Type on page 471

➤ Create a Calculated Relationship Type on page 473

➤ Create List and Enumeration Definitions on page 474

➤ Create an Enumeration Definition – Workflow on page 475

Reference

➤ View Descriptions for CI Types and Relationships on page 477

➤ CI Type Manager User Interface on page 477

Note to HP Software-as-a-Service customers: The data in CI Type Manager 
can be viewed but not edited.
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Concepts

CI Types Overview

A configuration item (CI) can represent hardware, software, services, 
business processes, or any component of your IT infrastructure. CIs with 
similar properties are grouped under a CI type (CIT). Each CIT provides a 
template for creating a CI and its associated properties. 

Every CI must belong to a CI type. The following are the main categories of 
CITs:

➤ Business Element. CITs that correspond to the logical elements of your 
business, such as processes and organizational groups.

➤ IT Process Record. CITs that correspond to changes that occur in your IT 
infrastructure.

➤ Monitor. CITs that handle incoming metrics collected from your business 
universe.

➤ Location. CITs that correspond to the location of devices and business 
organizations or people supporting a function.

➤ Party. CITs that correspond to an active entity such as a person or 
organization.

➤ CI Collection. A logical collection of CIs.

➤ Infrastructure Element. CITs that correspond to the physical elements 
(hardware and software) installed in your business environment.

The CITs are arranged in a tree structure under these categories in the CI 
Types pane. You can browse the CI Type model by expanding the tree in the 
CI Types pane. The CIT selected in the left pane is displayed in the topology 
map along with all the potential valid relationships to other CITs.

You can also define new CITs to match your business needs. For details on 
defining new CITs, see "Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard" on page 486.
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CI Type Attributes

Every CI type has attributes which define it such as name, description, and 
default value. The CITs grouped under other CITs in the CI Type tree inherit 
attributes from the higher-level CITs. 

When you define a new CI type, you first select a Base Configuration Item 
Type from a list of existing CITs. Your new CIT inherits the attributes of the 
existing CIT. You can then set the attributes for the new CIT. You edit the 
attributes of an existing CIT by selecting a CIT from the tree in the CI Types 
pane and selecting the Attributes tab of the topology map. For details on 
CIT attributes, see "Attributes Page" on page 488.

Every CIT must have at least one key attribute. A key attribute is an attribute 
that is used as an identifier of the CIT. When you define an instance of a 
CIT, the CIT’s key attributes are mandatory fields for CIs of that type. You 
can assign as many key attributes as you want to a given CIT. If you do not 
assign a key attribute when defining a new CIT, the CIT is created, but it 
remains abstract, that is, you are unable to create instances of it (you are 
prompted to include the ABSTRACT_CLASS qualifier on the Qualifier page 
of the wizard).

Entity names in HP Universal CMDB for CMDB-based applications follow 
the conventions described below: 

➤ CIT attributes values. All primitive types are supported: long, double, 
float, string, and so on.

➤ CIT attributes values-type string. All special characters are supported. The 
maximum length is 4000 characters.

➤ CIT names and attributes names. The following are permitted: a-z, A-Z, 
and underscore (_). The length is limited to 200 characters. The CIT name 
must be in English. The number 0-9 are also permitted, but they must not 
be the first character in the CIT name.

➤ CIT attribute length. The total length of all the attributes in one CIT 
cannot exceed 8K due to a Microsoft SQL Server limitation.
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CI Type Relationships

A relationship defines the link between two CIs. Relationships represent the 
dependencies and connections between the entities in your IT environment. 
When you select relationships or calculated relationships in the drop-down 
box in the CI Types pane, the topology map displays all the valid instances 
of CITs linked by the selected relationship. For details about calculated 
relationships, see "Using Calculated Relationships" on page 103.

The same attributes defined for CITs are also defined for relationships. You 
can also assign key attributes for relationships but it is not required. For 
details on defining new relationship types, see "Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard" on page 486.

System Type Manager

System Type Manager enables you to create a predefined list whose values 
define an attribute type. For more details on System Type Manager, see 
"System Type Manager Dialog Box" on page 505.

You can create the following attribute types:

➤ List. Enables you to create a predefined list of values, for example, 
Location.

➤ Enumeration. Enables you to create a predefined list of values, as well as 
assign each value a color. Enumerations are designed to be used as severity 
value lists by states. For details, see "State Manager" in the HP Universal 
CMDB Administration Guide. 

Severity lists are used for:

➤ Retrieving Impact Analysis results in IT Universe Manager. For details, see 
"IT Universe Manager" on page 201.

➤ Creating an Impact rule. For details, see "Impact Analysis Manager" on 
page 439. 
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You can use both List and Enumeration values for:

➤ Editing the attributes of a CIT. For details, see "Create a CI Type" on 
page 470.

➤ Defining an attribute condition for a TQL query node or relationship. For 
details, see "Query Node/Relationship Properties Dialog Box" on page 80.
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Tasks

Create a CI Type

This task describes the process you follow to create a CIT using the Create CI 
Type wizard.

This task includes the following steps:

➤ "Prerequisites" on page 470

➤ "Define the CI Type" on page 470

➤ "Set the CI Type Attributes" on page 470

➤ "Assign Qualifiers to the CI Type" on page 471

➤ "Assign an Icon to the CI Type" on page 471

➤ "Customize the CI Type Menu" on page 471

➤ "Define the CI Type Default Label" on page 471

 1 Prerequisites

From the CI Type Manager, select CI Types from the list box in the CI 
Types pane. Then select New to start the Create CI Type Wizard.

 2 Define the CI Type

Enter the name, description and base configuration item type for the new 
CI type. For details, see "Details Page" on page 487.

 3 Set the CI Type Attributes

Edit the attributes of the new CI type and define key attributes for it. For 
details, see "Attributes Page" on page 488.
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Note: List and Enumeration definitions are created in the System Type 
Manager. If required, you can create additional List and Enumeration 
definitions. For details, see "Create List and Enumeration Definitions" on 
page 474.

 4 Assign Qualifiers to the CI Type

Assign qualifiers to the definition of the new CI type. For details, see 
"Qualifiers Page" on page 492.

 5 Assign an Icon to the CI Type

Select an icon to assign to the new CI type. For details, see "Icon Page" on 
page 495.

 6 Customize the CI Type Menu

Select the menu items and commands to appear in the shortcut menu for 
the new CI type. For details, see "Attached Menu Page" on page 496.

 7 Define the CI Type Default Label

Define the attributes to appear in the CI type label. For details, see 
"Default Label Page" on page 500.

Create a Relationship Type

This task describes the process you follow to create a relationship type using 
the Create Relationship wizard.

This task includes the following steps:

➤ "Prerequisites" on page 472

➤ "Define the Relationship" on page 472
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➤ "Set the Relationship Attributes" on page 472

➤ "Assign Qualifiers to the Relationship" on page 472

➤ "Customize the Relationship Menu" on page 472

➤ "Define the Relationship Default Label" on page 473

 1 Prerequisites

From the CI Type Manager, select Relationships from the list box in the CI 
Types pane. Then select New to start the Create Relationship Wizard.

 2 Define the Relationship

Enter the name, description and base CI type for the new relationship. For 
details, see "Details Page" on page 487.

 3 Set the Relationship Attributes

Edit the attributes of the new relationship and define key attributes for it. 
For details, see "Attributes Page" on page 488.

Note: List and Enumeration definitions are created in the System Type 
Manager. If required, you can create additional List and Enumeration 
definitions. For details, see "Create List and Enumeration Definitions" on 
page 474.

 4 Assign Qualifiers to the Relationship

Assign qualifiers to the definition of the new relationship. For details, see 
"Qualifiers Page" on page 492.

 5 Customize the Relationship Menu

Select the menu items and commands to appear in the shortcut menu for 
the new relationship. For details, see "Attached Menu Page" on page 496.
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 6 Define the Relationship Default Label

Define the attributes to appear in the relationship label. For details, see 
"Default Label Page" on page 500.

Create a Calculated Relationship Type

This task describes the process you follow to create a calculated relationship 
type using the Create Calculated Relationship wizard.

This task includes the following steps:

➤ "Prerequisites" on page 473

➤ "Define the Calculated Relationship" on page 473

➤ "Assign Qualifiers to the Relationship" on page 473

➤ "Add Required Triplets" on page 473

 1 Prerequisites

From the CI Type Manager, select Calculated Relationships from the list 
box in the CI Types pane. Then select New to start the Create Calculated 
Relationship Wizard.

 2 Define the Calculated Relationship

Enter the name, description and base CI type for the new calculated 
relationship. For details, see "Details Page" on page 487.

 3 Assign Qualifiers to the Relationship

Assign qualifiers to the definition of the new relationship. For details, see 
"Qualifiers Page" on page 492.

 4 Add Required Triplets

Add the required triplets. For details, see "Triplets Page" on page 493.
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Create List and Enumeration Definitions

This section describes the tasks for creating List and Enumeration 
definitions.

This task includes the following steps:

➤ "Create a List Definition" on page 474

➤ "Create an Enumeration Definition" on page 474

 1 Create a List Definition

You can create a List definition of predefined values. For example, a List 
definition called Location might contain:

➤ New York

➤ Boston

➤ Baltimore

For details, see "Create/Update List/Enumeration Definition Dialog Box" 
on page 502.

 2 Create an Enumeration Definition

You can create an Enumeration definition, which enables you to assign a 
color for each value on the list. For details, see "Create/Update 
List/Enumeration Definition Dialog Box" on page 502. For an example of 
an Enumeration definition, see "Create an Enumeration Definition – 
Workflow" on page 475.
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Create an Enumeration Definition – Workflow

The following steps describe how to create an Enumeration definition.

Note: To retrieve the required results, you must follow each step in this 
task.

To create an Enumeration definition:

 1 Select Managers > Modeling > CI Type Manager.

 2 From the Main Menu, select CI Types > System Type Manager to open the 
System Type Manager dialog box.

 3 Click the Add button to open the Create List Definition dialog box.

Note: Alternatively, you can select Managers > Administration > State 
Manager and then click the New Enumeration button to open the Create 
Enumeration Definition dialog box.

 4 Select Enumeration.

 5 In the Name box, enter the required name. 

 6 (Optional) In the Display Name box, enter the required display name.

This example describes how to create the following severity list:

Key Value Severity Represented

0 Green Normal

1 Orange Major

2 Red Critical
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 7 Click the Add  button to create a new row.

 8 In the Value box, enter Normal, in the Key box, enter 0, and in the Color 
section, select Green.

 9 Click the Add  button to create another row.

 10 In the Value box, enter Major, in the Key box, enter 1, and in the Color 
section, select Orange.

 11 Click the Add  button to create another row.

 12 In the Value box, enter Critical, in the Key box, enter 2, and in the Color 
section, select Red.

The following image shows the Enumeration Definition section after the 
changes:

 13 Click OK to save your changes.
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Reference

View Descriptions for CI Types and Relationships

You can view a complete list of available CI types in tree format in the left 
pane of CI Type Manager. You can search incrementally for a specific CI type 
as described in "CI Type Manager" on page 481. To see a description for a 
particular CI type, select it from the tree and hold the pointer over the icon 
which corresponds to it in the Topology Map. A tooltip containing a 
description of the CI type is displayed.

For relationships, select Relationships in the left pane and search 
incrementally by the first letter of the relationship. Select the relationship 
you want and hold the pointer over its icon in the Topology Map to display 
a tooltip containing a description of the relationship.

For detailed information on CI types and relationships, refer to the 
HP Software BTO Data Model Reference file. 

CI Type Manager User Interface

This section includes (in alphabetical order):

 ➤ Add/Edit Attribute Dialog Box on page 478

 ➤ Add/Remove Relationship Dialog Box on page 481

 ➤ CI Type Manager on page 481

 ➤ Create Configuration Item Type/Relationship/Calculated Relationship 
Wizard on page 486

 ➤ Create/Update List/Enumeration Definition Dialog Box on page 502

 ➤ System Type Manager Dialog Box on page 505
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Add/Edit Attribute Dialog Box

This dialog box enables you to define a new attribute to add to a CIT or to 
edit an existing attribute of a CIT.

Details Tab

User interface elements are described below:

To access In the CI Type Manager, select the Attributes tab, then click 
the Add  button, or select an attribute and click the Edit 
button or double-click the attribute.

Important 
information

In Edit mode, fields that cannot be changed are disabled.

UI Elements (A-Z) Description

Attribute Name Enter a unique name for the new attribute. The name can 
contain all characters except the following: " \ / [ ] : | < > + = 
; , ? *

Note: The attribute name is not case sensitive.

Attribute Type Select one of the following options:

➤ Primitive. Choose from one of the following field types: 
boolean, bytes, date, double, float, integer, integer_list, long, 
string, string_list, xml.

➤ Enumeration/List. Contains a list of Enumerations and 
Lists defined in the System Type Manager. For details, see 
"System Type Manager" on page 468.

This option enables you to define an attribute with a 
predefined value. For example, a location attribute might 
be defined by a location list containing the following 
values: Singapore, Paris, New York. 

Default Value Enter or select a default value for the attribute. The options 
for the Default Value field vary depending on the attribute 
type you selected. 

Note: If you select the integer_list or string_list Primitive 
attribute type, you can enter multiple values.
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Advanced Tab

User interface elements are described below:

Description Enter a description for the new attribute.

Note: This field is optional.

Display Name Enter a name for the new attribute to identify it in 
HP Universal CMDB.

Note: This field is optional.

Scope Select the scope of the new attribute (the class model to 
which it belongs).

Value Size Enter a value for the maximum physical size of the new 
attribute. (Enabled for bytes and string only).

UI Elements (A-Z) Description

Asset Data Select to display the attribute value in the Asset Report.

Change 
Monitored

Select to define attributes whose values are being marked as 
Change Monitored in CI Type Manager. The changes in the 
values of such attributes are saved in the CMDB History 
database.

Note: 

➤ When this qualifier is selected for a given attribute, the 
attribute appears as a visible column in the Element 
Instances dialog box. For details, see "Element Instances 
Dialog Box" on page 73.

➤ Change Monitored is only relevant for attributes of CI 
types and not for attributes of relationships.

➤ Change Monitored is not relevant for attributes of the 
type list of integers or list of strings.

Comparable Select to enable this attribute to be used for comparing 
compound CIs.

UI Elements (A-Z) Description
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Editable Select to enable future editing of the attribute. Only 
attributes that are marked as Editable (or ones that have 
values) are displayed in the Properties tab in IT Universe 
Manager.

Enable Auto 
Truncate by DFM

If selected, when attributes of type STRING exceed the size 
limit, Discovery truncates the value. For details, see "Data 
Validation on the Data Flow Probe" in HP Universal CMDB 
Data Flow Management Guide.

Index Select to accelerate the attribute retrieval performance. This 
option is recommended for attributes that are used 
frequently in search conditions. For example, IP address is 
usually an index attribute of a node.

Lower Case When this option is selected, the attribute value appears in 
lower case.

Password When this option is selected, the attribute value appears as 
asterisks (a hidden value).

Required Select to define this attribute as a required one, if its value is 
required for the creation of the CIT.

Static Select to define this attribute as static.

Unique When this option is selected, different instances of this CI 
type must have unique values.

Upper Case When this option is selected, the attribute value appears in 
upper case.

Use Update Value 
Policy

Select this option to add the ALLOW_VOLATILITY qualifier. 
For details on this qualifier, see "The ALLOW_VOLATILITY 
Qualifier" on page 25.

Visible Select to display this attribute in the Properties tab in 
IT Universe Manager.

UI Elements (A-Z) Description
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Add/Remove Relationship Dialog Box

This dialog box enables you to add or remove default or new relationships 
between CITs, which define their physical or logical connections.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

CI Type Manager

This page enables you to view the information in the CI Type model, which 
contains the definitions of all configuration item types (CITs) defined in the 
system and the relationships that define the connections between them. 
Each CIT has its own attributes, as well as the attributes inherited from its 
parent CIT.

To access In the CI Type Manager, right-click a CIT or two CITs 
and select Add/Remove Relationship.

Important 
information

When adding a relationship between two CITs, select 
the two CITs to be linked by holding down CTRL and 
clicking the CIT names. Then right-click one of them 
and select Add/Remove Relationship.

UI Elements (A-Z) Description

<query node1 to 
query node2>

Select the relationships to add in the direction of the 
first query node to the second.

<query node2 to 
query node1>

Select the relationships to add in the direction of the 
second query node to the first.

Relationship Name A list of the possible relationships.

To access Select CI Type Manager from the Navigation Menu or select 
Managers > Modeling > CI Type Manager.
481



Chapter 11 • CI Type Manager
User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

Click the New button to open the Create Configuration 
Item Type Wizard which enables you to define a new CI 
type. For details, see "Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard" on 
page 486.

Click Delete to delete the selected CI type or relationship.

Click to refresh the data content of the hierarchical tree 
structure that may have been modified by other users.

Click the Save button to save changes made to a CI type.

Enables you to import CITs from an external file.

Enables you to export a CIT as an XML file. Use this option 
to move CITs from one server to another.

Enables you to export a CIT as a PDF.

<CI 
Type/Relationship 
Box>

Select one of the following options:

➤ CI Types. Display the CI types in the CIT model.

➤ Relationships. Display the relationships in the CIT model.

➤ Calculated Relationships. Display the calculated 
relationships in the CIT model.

<Main Menu> For details, see "Main Menu" on page 185.

<Toolbar> For details, see "Toolbar Options" on page 189.
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CI Types Pane A hierarchical tree structure of the CI Type model containing 
the inheritance relationships among CITs, and displaying 
the number of instances of each CIT in the CMDB. All CITs 
included in the CI Type model are classified as either a CIT 
or a relationship. You can drill down and view the 
relationships and neighbors of the selected CIT in the 
topology map. You can search in the list of CITs or 
relationships using the Incremental Search by entering the 
first letter of the CIT or relationship repeatedly until you 
reach the required selection. You can also search for a CIT or 
relationship by entering its full name. 

UI Elements (A-Z) Description
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Editing Pane The following tabs are available:

➤ Dependencies. Displays the CI Type model in a topology 
map, including the CITs and the relationships between 
them. The name of the selected CI type or relationship 
appears in the border at the top of the pane. When you 
point to a CIT, a tooltip displays the display name of the 
CIT and its description.

➤ Details. Enables you to edit the basic information about 
the CI type selected in the left pane. For details, see 
"Details Page" on page 487.

➤ Attributes. Enables you to edit the attributes of the 
selected CIT. For details, see "Attributes Page" on 
page 488.

➤ Qualifiers. Enables you to assign qualifiers to the selected 
CIT. For details, see "Qualifiers Page" on page 492.

➤ Triplets. Enables you to create a calculated relationship. 
For details, see "Triplets Page" on page 493. This page 
appears only for calculated relationships.

➤ Icon. Enables you to assign an icon to the selected CIT. 
For details, see "Icon Page" on page 495. This tab does not 
appear for relationships.

➤ Attached Menu. Enables you to customize the shortcut 
menu of a CI by adding menu items and commands (for 
example, ping, run a program, open a URL). The 
customized menu is displayed when you right-click a CI 
instance in IT Universe Manager. For details, see 
"Attached Menu Page" on page 496.

➤ Default Label. Enables you to define attributes that appear 
in the CIT label. You can include more than one attribute 
by using the function buttons. For details, see "Default 
Label Page" on page 500.

UI Elements (A-Z) Description
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Shortcut Menu

CI Type Manager includes the following options available by right clicking a 
CI type in the CI Types pane or the Dependencies map:

UI Elements (A-Z) Description

Add/Remove 
Relationship

Opens the Add/Remove Relationship dialog box, which 
enables you to add or remove relationships from CITs. For 
details, see "Add/Remove Relationship Dialog Box" on 
page 481.

Delete Selected 
Item

Deletes the selected CI type. This option is only available for 
CI types that have no children and no instances.

Export To XML Enables you to export a CIT as an XML file. Use this option 
to move CITs from one server to another.

New Opens the Create Configuration Item Type Wizard which 
enables you to define a new CI type. For details, see "Create 
Configuration Item Type/Relationship/Calculated 
Relationship Wizard" on page 486.

Show CIT 
Instances

Opens the Show All Instances dialog box, which displays all 
instances of the selected CIT. For details, see "Element 
Instances Dialog Box" on page 73.
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Create Configuration Item Type/Relationship/Calculated 
Relationship Wizard

This wizard enables you to define a new configuration item type or 
relationship.

The Create Configuration Item Type wizard includes the following pages:

➤ "Details Page" on page 487

➤ "Attributes Page" on page 488

➤ "Qualifiers Page" on page 492

➤ "Triplets Page" on page 493

➤ "Icon Page" on page 495

➤ "Attached Menu Page" on page 496

➤ "Default Label Page" on page 500

To access Click a CI type or relationship in the topology map or CI 
Types pane of the CI Type Manager and select New or click 
the New button  in the CI types pane.

Wizard map The Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard 
contains:

Details Page > Attributes Page > Qualifiers Page > Triplets 
Page > Icon Page > Attached Menu Page > Default Label Page
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Details Page
This wizard page enables you to enter basic information about the new CI 
type you are defining.

User interface elements are described below:

Important 
information

For general information about the Create Configuration 
Item Type Wizard, see "Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard" on 
page 486.

Wizard map The Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard 
contains:

Details Page > Attributes Page > Qualifiers Page > Triplets 
Page > Icon Page > Attached Menu Page > Default Label Page

UI Elements (A-Z) Description

Base CI Type Select a base CIT for the CIT you are creating. The new CIT 
inherits the base CIT’s attributes.

Note: This field only appears in the Create CI Type Wizard. 
It is not relevant when editing an existing CIT in the Details 
tab of CI Type Manager.

Created By The user who created the new CIT.

Note: This field is optional.

Description A description for the new CIT.

Note: This field is optional.

Display Name The name of the CIT as it appears in the HP Universal CMDB 
interface.

Note: This field is optional.

Identification Displays the key attributes or reconciliation rule by which 
the CIT is identified.

Note: This field only appears when editing an existing CIT 
in the Details tab of CI Type Manager. It is not relevant in 
the Create CI Type Wizard. 
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Attributes Page
This wizard page enables you to edit the attributes of the CI type.

Name The unique name of the new CIT. The name can contain all 
characters except the following: " \ / [ ] : | < > + = ; , ? *

Note: The name field is case sensitive, but you cannot use 
the same name with different cases for two different CITs.

Scope Select the scope of the new CIT (the class model to which it 
belongs).

Wizard map The Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard 
contains:

Details Page > Attributes Page > Qualifiers Page > Triplets 
Page > Icon Page > Attached Menu Page > Default Label Page

UI Elements (A-Z) Description
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

To define an attribute as a key attribute, click in the Key 
column beside the attribute name. A key icon appears in the 
cell. A key attribute is an attribute that must be defined for 
CIs of that CI type.

To remove the key attribute definition, click in the Key 
column again. The key icon disappears.

For more information on key attributes, see "CI Type 
Attributes" on page 467.

Denotes a static attribute. A static attribute takes the same 
value for all the CIs of that type. If it is changed, all the CIs 
of that type are affected and automatically display the new 
value. A static attribute cannot be defined as a key attribute.

Note: You cannot define an attribute as static from within 
the CIT Manager. It is done by deploying the relevant 
package. Static attributes are for internal use only.

Click the Add button to define a new attribute. For details, 
see "Add/Edit Attribute Dialog Box" on page 478.

Select a row and click the Edit button to open the Edit 
Attribute dialog box. For details, see "Add/Edit Attribute 
Dialog Box" on page 478.

Note: If you modify an attribute belonging to a CIT’s parent, 
the text turns light blue. If you modify an attribute 
belonging to the CIT itself, the text remains dark blue.

Click the Delete button to delete a selected attribute. This 
option is only active for newly defined attributes.

Click the Reset button to reset the attribute settings after 
editing a pre-existing attribute.

Click Select Columns to select the columns to appear using 
the Select Columns dialog box.
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<Attributes> Displays all attributes associated with the new CIT. 
Attributes appearing in black are ones that the new CIT 
inherits from the base CIT. Attributes appearing in dark blue 
are ones that are private to this CIT and its descendants. 
Attributes appearing in light blue are inherited ones that 
have been modified for the new CIT.

Asset Data Indicates whether the attribute value is displayed in the 
Asset Report. For details see "Asset Report" on page 375.

Note: When this qualifier is selected for a given attribute, 
the attribute appears as a visible column in the Element 
Instances dialog box. For details, see "Element Instances 
Dialog Box" on page 73.

BDM Scope Indicates whether the attribute is included in the BDM class 
model.

Change 
Monitored

Select to define attributes whose values are being marked as 
Change Monitored in CI Type Manager. The changes in the 
values of such attributes are saved in the CMDB History 
database.

Note: 

➤ When this qualifier is selected for a given attribute, the 
attribute appears as a visible column in the Element 
Instances dialog box. For details, see "Element Instances 
Dialog Box" on page 73.

➤ Change Monitored is only relevant for attributes of CI 
types and not for attributes of relationships.

➤ Change Monitored is not relevant for attributes of the 
type list of integers or list of strings.

Comparable Indicates wheher this attribute is to be used for comparing 
compound CIs. For details, see "Compare CIs Report" on 
page 387.

Note: When this qualifier is selected for a given attribute, 
the attribute appears as a visible column in the Element 
Instances dialog box. For details, see "Element Instances 
Dialog Box" on page 73.

UI Elements (A-Z) Description
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Default Value The default value for the attribute. This value appears when 
the new CIT is defined and there is no runtime value for the 
attribute.

Description A description of the attribute.

Display Name The attribute name that appears in the HP Universal CMDB 
interface.

Editable Indicates whether the attribute can be edited.

Only attributes that are marked as Editable (or ones that 
have values) are displayed in the Properties tab in 
IT Universe Manager.

Enable Auto 
Truncate by DFM

Indicates whether the auto-truncate feature for attributes of 
type STRING is enabled. 

Index Indicates whether the attribute has been defined as an index 
attribute, which enables you to accelerate the attribute 
retrieval performance. 

This option is recommended for attributes that are used 
frequently in search conditions. For example, IP address is 
usually an index attribute of a node. 

Key When the key icon  appears in this column, it indicates 
that the attribute is defined as a key attribute.

When the static attribute icon  appears in this column, it 
indicates that the attribute cannot be defined as a key 
attribute.

Lower Case Indicates whether to keep the attribute value in lower case.

Name The actual name of the attribute (compare to Display Name).

Required Indicates whether this attribute is defined as a required one, 
whose value is required for the creation of the CIT.

Static Indicates whether this attribute is defined as static.

Type The type of the attribute.

Unique Indicates whether this attribute is defined as unique, for 
which different instances of this CI type must have unique 
values

UI Elements (A-Z) Description
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Qualifiers Page
This wizard page enables you to assign qualifiers to a CI type definition.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Upper Case Indicates whether to keep the attribute value in upper case.

Visible Indicates whether this attribute is displayed in the Properties 
tab in IT Universe Manager.

Important 
information

Qualifiers enable you to define added attribute definitions 
to the CIT. In the Qualifiers list, select the required qualifiers 
using the Add buttons to move your selections to the 
Configuration Item Type Qualifiers list. You can make 
multiple selections by holding down the CTRL key.

Wizard map The Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard 
contains:

Details Page > Attributes Page > Qualifiers Page > Triplets 
Page > Icon Page > Attached Menu Page > Default Label Page

UI Elements (A-Z) Description

Click this button to move all qualifiers to the Configuration 
Item Type Qualifiers list.

Select the qualifier and click this button to add the qualifier 
to the Configuration Item Type Qualifiers list. Select 
multiple qualifiers by holding down the CTRL key.

To remove a qualifier from the CIT definition, select the 
qualifier from the Configuration Item Type Qualifiers list 
and click this button.

Click this button to remove all qualifiers from the 
Configuration Item Type Qualifiers list.

UI Elements (A-Z) Description
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Triplets Page
This wizard page enables you to create a calculated relationship. Each row 
on the Triplets page represents one of the allowed steps in the path leading 
from the source CI to the target CI in the topology map.

Note: This step of the wizard is only relevant for calculated relationships.

To define a new, custom qualifier, enter the qualifier name 
in the text box and click Insert. The qualifier appears in the 
Configuration Item Type Qualifiers list.

<Configuration 
Item Type 
Qualifiers>

The list of qualifiers that define attributes of the new CIT. 
For example, you can use a qualifier to define a CIT as 
abstract, which means that you cannot create instances from 
it.

<Qualifiers> For a list of the available qualifier options, see "Qualifier Tab" 
on page 87. 

Important 
information

➤ This page is displayed if you select Calculated 
Relationships in the drop-down box in the CI Types 
pane.

➤ For details about calculated relationships, see "Using 
Calculated Relationships" on page 103.

➤ For general information about the Create Configuration 
Item Type Wizard, see "Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard" on 
page 486.

UI Elements (A-Z) Description
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User interface elements are described below:

Wizard map The Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard 
contains:

Details Page > Attributes Page > Qualifiers Page > Triplets 
Page > Icon Page > Attached Menu Page > Default Label 
Page

See also "Using Calculated Relationships" on page 103

UI Elements (A-Z) Description

Click to define the allowed steps in a path in the topology 
graph leading from the source CI to the target CI in the 
calculated relationship. Opens the Add Triplet dialog box. 
For details, see "Add Triplet Dialog Box" on page 69.

Select a row and click the Edit button to edit the triplet. 
Opens the Edit Triplet dialog box. For details, see "Add 
Triplet Dialog Box" on page 69.

Click the Delete button to delete a selected triplet.

Relationship The required relationship connecting the two query nodes.

Relationship 
Direction

The source and target of a relationship.

➤  The direction is from source to target.

➤  The direction is from target to source.

Source The required source query node.

Target The required target query node.
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Icon Page
This wizard page enables you to select an icon to assign to the new CI Type.

Note: This step of the wizard is not relevant for relationships.

User interface elements are described below:

Important 
information

Each CIT is displayed with a default icon. However, you can 
attach different icons to the same CIT when certain 
conditions apply. For example, you can associate different 
icons with the same CIT when one of its attribute values 
changes.

Wizard map The Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard 
contains:

Details Page > Attributes Page > Qualifiers Page > Triplets 
Page > Icon Page > Attached Menu Page > Default Label 
Page

UI Elements (A-Z) Description

Click to add a row.

Note: Only active if Change the Configuration Item Type 
icon according to its attribute value is selected.

Click to remove a row.

Note: Only active if Change the Configuration Item Type 
icon according to its attribute value is selected.

Attributes Select an attribute to determine the icon assigned to the CIT.
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Attached Menu Page
This wizard page enables you to customize the shortcut menu of a CI by 
adding menu items and commands (for example, ping, run a program, open 
a URL). The customized menu is displayed when you right-click a CI 
instance in IT Universe Manager.

Change the 
Configuration 
Item Type icon 
according to its 
attribute value

Enables you to assign an icon for each attribute value. For 
example, you could define two values for the City attribute: 
if City=London, one icon is displayed. If City=Beijing, another 
icon is displayed.

Note: If you change the icon of a CIT that appears in an 
existing view, the CIT's icon is not updated in the view.

Configuration 
Item Type Main 
Icon

Select the group to which the CIT belongs.

Icon Select an icon to associate with the value you entered in the 
Value column.

Value Enter a value corresponding to the attribute you selected. 
You can add a new line for each value you enter.

Important 
information

If a CIT does not have a method defined specifically for it, 
the CIT inherits all the menus from its parent CIT or the 
nearest ancestor that does have a method defined for it.

If you create or modify a menu, the change occurs only in 
the specific CIT that is being edited.

Wizard map The Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard 
contains:

Details Page > Attributes Page > Qualifiers Page > Triplets 
Page > Icon Page > Attached Menu Page > Default Label 
Page

UI Elements (A-Z) Description
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User interface elements are described below:

UI Elements (A-Z) Description

Select a menu item from the tree and click the button. A 
new entry appears under the selected item.

Click to remove a menu item.

Click to move a selected menu item up in the menu.

Click to move a selected menu item down in the menu.

<Tree> Hierarchical tree containing the default menu items.

Caution: It is not recommended to edit the definitions of the 
default menu items.

Command To connect to a specific location on the World Wide Web, 
select URL, and enter the exact Internet address, for 
example, http://www.hp.com/go/software. (Available only if 
you select the URL command type option.)

Note: If you use a variable in the Command field, use the 
format command name %1 and define the CIT attributes as 
described in Parameters. The parameter values replace %1 
according to their order in the list. For example, %1 is 
replaced by the first parameter in the list, %2 is replaced by 
the second parameter in the list, and so on.

Description Enter a description for the method. (This is for internal use 
only and does not appear in the menu.)

Existing Method Select to choose a command from a list of defined methods 
inherited from the IT Universe CIT and all its ancestors.

Icon Select the icon to appear next to the menu option in the 
shortcut menu.

Note: This field is optional.

Menu Item Name Enter a name for the new menu item as it should appear in 
the menu.
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Method Enables you to add a command to the menu.

Note: To create a method and not override the existing 
method, it is recommended to create a new menu item and 
place the new method there. 

Method Name Enter a name for the command.

New Method Select to add an action (for example, ping) to the menu 
item.

Parameters To add attributes to the command or URL, click the Add 
Parameter button and select the attribute from the list.

To delete an existing entry, select it and click the Remove 
Parameter button.

Note: Parameters are not relevant when Inner Process is 
selected.

Require user 
confirmation?

Select the check box for users to confirm access to a menu 
item before the item is displayed.

Separator To place a separator between two menu items:

Click OK to place a separator underneath the selected menu 
option. 

Shortcut Press any key combination to create a shortcut for the menu 
item, for example, CTRL+H. 

Note: This field is optional.

UI Elements (A-Z) Description
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Sub-Menu Select to create a sub-menu under the selected menu option.

Type Choose a command type:

➤ URL. Opens a web page to the specified URL. Enter the 
URL of a Web page for the command to open in the URL 
box.

➤ Inner Process. Triggers an internal HP Universal CMDB 
action. Select an action from the drop-down list of 
actions. 

➤ Execute. Triggers an executable action. Enter an 
executable command in the Executable box.

UI Elements (A-Z) Description
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Default Label Page
This wizard page enables you to define attributes that appear in the CI type 
label. You can include more than one attribute by using the function 
buttons. This is the final step of the Create Configuration Item Type Wizard.

User interface elements are described below:

Important 
information

You build a label by selecting attributes in the CI Type 
Attributes pane and adding them to the Format pane, using 
the operators in the Format pane to connect them.

The label appears as the title under a CI of the new CI Type. 
The label definition can be customized to include different 
attribute values. For example, if the function label of the 
node CIT is composed of hostname and network, the 
displayed label is: server1 10.0.65.0.

Labels can also be created using regular expressions.

Wizard map The Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard 
contains:

Details Page > Attributes Page > Qualifiers Page > Triplets 
Page > Icon Page > Attached Menu Page > Default Label 
Page

UI Elements (A-Z) Description

Click to add the selected attribute to the Format pane. 

Adds parentheses to the formatted text (use in conjunction 
with the other functions).

Places an AND operator between two attributes in the 
formatted text. For example, 
network_netaddr&network_domain displays the network 
address and the domain of a query node.

Places an OR operator between two attributes in the 
formatted text.
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Adds a regular expression (using regular expression syntax) 
to the label definition. The structure of the entry is (v1, v2, 
v3), where v1 represents the selected attribute, v2 represents 
the regular expression itself (which divides the value into 
groups), and v3 represents the number of the selected group.

For example, if the selected attribute is a name, consisting of 
a first name, a space, and a surname, the regular expression 
would be (name, (\S*)(\s*)(\S*), 3), which indicates that the 
surname can be used for the name attribute in the default 
label.

For examples of how to use regular expression syntax, see 
"Regular Expression Examples" on page 561.

Click to undo the last change in the Format pane.

Click to clear the Format pane.

CI Type Attributes Displays the available options of attributes to be included in 
the CIT label.

CI Type Label 
Definition Format

Displays the attributes that you select to appear in the CIT 
label.

For example, to label a node by its host name and operating 
system, choose the host_hostname and host_os attributes. 
The CIT label is host1 UNIX.

You can define conditions using AND and OR combinations.

Note: To delete an attribute from the Format pane, highlight 
it and press the DELETE key.

UI Elements (A-Z) Description
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Create/Update List/Enumeration Definition Dialog Box

This dialog box enables you to define a new List or Enumeration definition. 
The List or Enumeration definition you have created appears in the System 
Type Manager dialog box, where you can edit it if required (for details, see 
"System Type Manager Dialog Box" on page 505).

User interface elements are described below:

To access Click the Add button in the System Type Manager dialog 
box.

Important 
information

You can access the Create/Update Enumeration Definition 
dialog box from the State Manager as well. For details, see 
"State Manager" in the HP Universal CMDB Administration 
Guide.

Relevant tasks "Create List and Enumeration Definitions" on page 474

UI Elements (A-Z) Description

Display Name Enter the name you want to appear in the list of System 
Type Definitions. If you leave this field empty, the entry in 
the Name field is used.

Enumeration Enables you to create a predefined list of values, as well as 
assign each value a color. For details, see "Enumeration 
Definition Area" on page 504.

List Enables you to create a predefined list of values. For details, 
see "List Definition Area" on page 503.

Name Enter a unique name for the definition.
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List Definition Area

This area enables you to create a predefined list of values. 

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

To access Select List in the Create List/Enumeration Definition 
dialog box.

Important 
information

For example, a Location attribute might be defined by a 
location list containing the following values:

➤ New York

➤ Boston

➤ Baltimore

UI Elements (A-Z) Description

Add a List definition. Double-click inside the row and 
either select a date from the calendar that appears (if 
you chose the type Date) or type the required value.

Delete a List definition.

Type Choose one of following field types:

➤ Date

➤ Double

➤ Integer

➤ Long

➤ String
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Enumeration Definition Area

This area enables you to create a list from a predefined list of values (similar 
to List), with capabilities such as assigning a color for every value.

User interface elements are described below:

To access Select Enumeration in the Create List/Enumeration 
Definition dialog box.

Important 
information

Enumerations are designed to be used as severity value 
lists by states. You can use Enumerations for lists that 
require key values. 

See also "Create an Enumeration Definition – Workflow" on 
page 475

UI Elements (A-Z) Description

Add an Enumeration definition.

Remove an Enumeration definition.

Color Select a color that indicates the severity level.

Key Type a number to create an enumeration that describes 
a severity list for a category.

Assign key values according to the following rules:

➤ The list of key values must always begin with zero 
(0). (Zero represents the Normal state.) Otherwise, it 
does not appear in the State Manager (for details, see 
"State Manager") in the HP Universal CMDB 
Administration Guide.

➤ The list must always be numbered consecutively.

For an example of an Enumeration definition, see 
"Create an Enumeration Definition – Workflow" on 
page 475.

Value Type a value, either a string or a number, for example, 
Red or my value. The value appears in the tooltip for 
the CI in IT Universe.
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System Type Manager Dialog Box

This dialog box enables you to display the attribute types you defined in the 
Create List/Enumeration Definition dialog box.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access From the CI Type Manager, select CI Types > System 
Type Manager.

Relevant tasks "Create List and Enumeration Definitions" on page 474

See also "Create an Enumeration Definition – Workflow" on 
page 475

UI Elements (A-Z) Description

Create a predefined list whose values define an attribute 
type. You can create a definition for the following attribute 
types:

➤ List definition.

➤ Enumeration definition.

For a description of these attribute types, see "Create/Update 
List/Enumeration Definition Dialog Box" on page 502.

Enables you to edit an existing definition. For details, see 
"Create/Update List/Enumeration Definition Dialog Box" on 
page 502.

Delete an existing definition. Select the system type 
definition you want to delete and click the Delete button.

<System Type 
Definitions>

The list of Enumeration and List definitions created in the 
System Type Manager.
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Enrichment Manager

This chapter includes:

Concepts

➤ Enrichment Manager – Overview on page 508

Tasks

➤ Define an Enrichment Rule – Scenario on page 510

➤ Add Enrichment Query Nodes and Relationships to an Enrichment TQL 
Query on page 515

Reference

➤ Enrichment Manager User Interface on page 517
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Concepts

Enrichment Manager – Overview

Enrichment rules can be used for several purposes:

➤ Adding new CIs and relationships to the CMDB.

➤ Deleting specific CI instances from the CMDB.

➤ Updating the attribute values of specific CI instances in the CMDB.

Enrichment query nodes and relationships differ from other query nodes 
and relationships in that they are conceptual deductions that represent real 
relationships and CIs that cannot be discovered automatically by the 
discovery process.

Enrichment query nodes and relationships are created as part of a TQL 
query, whose other TQL query nodes are regular ones, meaning TQL query 
nodes that already exist in the CMDB. For more information about TQL 
queries, see "Topology Query Language" on page 19.

The following example displays a regular query node of type Node linked to 
an IBM Websphere MQ Enrichment query node by an Enrichment 
Container link relationship.
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By placing an Enrichment query node within a TQL query context, the 
query receives data from its attributes, and uses it to insert new information 
into the CMDB.

When you create Enrichment rules, the following results can occur:

➤ The CMDB is enlarged. Add Enrichment query nodes and relationships 
that are currently not included in the CMDB.

The following Enrichment rule example displays a regular Windows query 
node (that already exists in the CMDB) connected to a File Enrichment 
query node by an Enrichment Container link relationship.

This Enrichment rule states that for every Windows CI instance that is 
found in the CMDB, a new File CI instance is created, and linked to the 
Windows CI with a Container link relationship.

➤ Specific CI instances are deleted from the CMDB. For an example, see 
"Define an Enrichment Rule – Scenario" on page 510.

➤ The values of CI attributes are updated. Use an Enrichment rule to update 
the attributes of a CI that already exists in the CMDB.

The following Enrichment rule example illustrates that a regular File 
System query node (that already exists in the CMDB) has been updated 
with an Enrichment rule.

This Enrichment rule states that every File System CI found in the CMDB 
is updated with the attribute value defined in the Enrichment rule.
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Tasks

Define an Enrichment Rule – Scenario

This task describes how to create the following Enrichment rule:

An IP Address CI is connected to two identical Node CIs: one Node CI is 
identified by its IP address and the other is identified by its lowest MAC 
address. For every such instance, delete the Node CI that is identified by its 
IP address from the CMDB.

Note: To reach the required result, you must implement each one of the 
following steps.

This task includes the following steps:

➤ "Create an Enrichment TQL Query" on page 511

➤ "Define the Query Node of Type Node that Is Identified by its Lowest 
MAC Address" on page 513

➤ "Define the Query Node of Type Node that is Identified by its IP Address" 
on page 513

➤ "Define the Enrichment Rule" on page 514
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 1 Create an Enrichment TQL Query

To create an Enrichment TQL query, you need to define an Enrichment 
rule and then add the regular TQL query nodes and relationships that 
define the query.

Note: You can add Enrichment query nodes and relationships only after 
at least one regular query node has been added to the query. 

Select Managers > Modeling > Enrichment Manager. For details about 
how to create an Enrichment TQL query, see "New Enrichment 
Rule/Enrichment Rule Properties/Save As Enrichment Rule Wizard" on 
page 526. For details about how to add query nodes and relationships to a 
query, see "Add Query Nodes and Relationships to a TQL Query" on 
page 28.

Example of an Enrichment TQL Query:

A new Enrichment TQL query called doubleHosts1 (located under the 
Network folder) is created in Enrichment Manager.
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The doubleHosts1 Enrichment rule is displayed in the Enrichment Rules 
pane.

a

In this Enrichment TQL query, an IP Address query node is linked to two 
query nodes of type Node by a Containment relationship. The TQL results 
must comply with the direction of the arrows.

Note: A TQL query is subject to certain validation restrictions. For details, 
see "Troubleshooting and Limitations" on page 97.
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 2 Define the Query Node of Type Node that Is Identified by its 
Lowest MAC Address

At the top of the Enrichment Manager page, select Query mode. In the 
editing pane, right-click the required query node of type Node, select 
Query Node Properties to open the Query Node Properties dialog box. 
Then define an attribute condition in the Attribute tab. For details on 
how to define an attribute condition, see "Attribute Tab" on page 82.

Example of an Attribute Condition Definition that Identifies the Node by 
its Lowest Mac Address:

In the Attribute tab, this attribute condition definition identifies the 
required Node by its lowest MAC address.

➤ Attribute name — Node is Complete

➤ Operator — Equal

➤ Value — True

 3 Define the Query Node of Type Node that is Identified by its 
IP Address

At the top of the Enrichment Manager page, select Query mode. In the 
editing pane, right-click the required query node of type Node, and select 
Query Node Properties to open the Query Node Properties dialog box. 
Then define two attribute conditions in the Attribute tab. For details on 
how to define an attribute condition, see "Attribute Tab" on page 82.

Example of an Attribute Condition that Enables a Node to Be Identified 
by its IP Address:

This attribute condition is the first attribute condition you need to define 
in the Attribute tab to enable the query node of type node to be identified 
by its IP Address.

Attribute name — Node is Complete

Operator — Equal

Value — False
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This is the second attribute condition you need to define in the Attribute 
tab to enable the query node of type node to be identified by its IP 
address.

Attribute name — Node is Complete

Operator — Is null

Value — Value cannot be changed

 4 Define the Enrichment Rule

Define the Enrichment rule that deletes all instances of the query node of 
type Node that are identified by their IP addresses. From the toolbar, 
select Enrichment mode. In the Enrichment Rules pane, select the 
doubleHosts1 Enrichment rule. Then right-click the query node of type 
Node that is identified by its IP address and select Delete 
Relationship/Query Node Item.

Example of a Query Node of Type Node Containing a Removed Indicator:

The query node of type Node now has a removed indicator to denote that 
all node instances that have identical attribute and cardinality settings are 
removed from the CMDB. The Enrichment query now looks like this.
514



Chapter 12 • Enrichment Manager
Add Enrichment Query Nodes and Relationships to an 
Enrichment TQL Query

This section describes how to add Enrichment query nodes and 
relationships to an Enrichment TQL query in Enrichment Manager. 

To add Enrichment query nodes and relationships to a TQL query:

 1 From the tree in the Enrichment Rules pane, select the Enrichment rule to 
which you want to add Enrichment query nodes and relationships or 
create a new one. For details, see "New Enrichment Rule/Enrichment Rule 
Properties/Save As Enrichment Rule Wizard" on page 526.

 2 From the Query/Enrichment drop-down at the top of the page, select 
Enrichment mode.

 3 From the tree displayed in the CI Type Selector, click and drag the query 
nodes you want to function as an Enrichment query node on to the 
editing pane. These are the TQL query nodes that are included in the 
query. Added Enrichment query nodes are displayed by an added 
indicator.

Note: You can add more than one Enrichment query node to a rule.

 4 Link the Enrichment query node to an existing TQL query node or query 
nodes, to provide the Enrichment query node with the needed context 
for its operation.

Following are the Enrichment rule validations:

➤ You must link the new Enrichment query node to at least one of the 
existing TQL query nodes in the rule.

➤ Enrichment query nodes can only be linked to one another with an 
Enrichment relationship.
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➤ If the new Enrichment query node must be contained (according to its 
CIT definition) in another query node, you must use the Composition 
relationship to connect this Enrichment query node to an existing 
TQL query node.

➤ You cannot link an Enrichment query node to a TQL query node that 
is not visible.

 5 To add a relationship between two query nodes:

➤ Select the required query nodes by holding down CTRL and clicking 
the TQL query nodes, right-click and select Add Relationship.

or

➤ Click the Create Relationship icon and draw a line between the 
required query nodes.

Added Enrichment relationships are displayed by an added indicator. 

The Add Relationship dialog box opens. For details, see "Add/Edit 
Relationship Dialog Box" on page 59.

 6 Click OK. The selected query nodes are linked by the relationship you 
have selected.
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Reference

Enrichment Manager User Interface

This section includes (in alphabetical order):

 ➤ Enrichment Manager Page on page 517

 ➤ New Enrichment Rule/Enrichment Rule Properties/Save As Enrichment 
Rule Wizard on page 526

 ➤ Query Node/Relationship Definition Dialog Box on page 531

 ➤ Query Node Definition – Advanced Attribute Dialog Box on page 533

Enrichment Manager Page

This page enables you to define Enrichment rules. These rules, which are 
based on a specific TQL query, can be used for several purposes, including:

➤ Adding new CIs and relationships to the CMDB.

➤ Deleting specific CI instances from the CMDB.

➤ Updating the attribute values of specific CI instances in the CMDB.

To access Select Enrichment Manager from the Navigation Menu 
or select Managers > Modeling > Enrichment Manager.

Important 
information

Enrichment Manager has two modes in which you can 
work. Always check the Enrichment/Query mode list in 
the toolbar to verify the currently selected mode.

Relevant tasks "Define an Enrichment Rule – Scenario" on page 510
517



Chapter 12 • Enrichment Manager
Enrichment Rules Pane

This area displays a hierarchical tree structure of predefined folders and 
Enrichment rules. Each Enrichment rule is associated with a TQL query.

User interface elements are described below:

Important 
information

You can create your own query, or work with the out-of-
the-box (factory) queries provided with your 
HP Universal CMDB installation.

The default folders are provided for the out-of-the-box 
queries. You can modify these folders, or add additional 
folders according to your organization’s requirements.

UI Elements (A-Z) Description

Creates a new folder.

Creates an Enrichment rule. Opens the New Enrichment 
Rule/Properties wizard.

Deletes the selected folder or Enrichment rule.

Refreshes the data content of the hierarchical tree 
structure that may have been modified by other users.

(Enabled only when an Enrichment rule is created or 
when changes are made to an existing one.) Saves the 
Enrichment rule to the CMDB.

Opens the New Enrichment Rule/Properties wizard. 
Enables you to change the description and the activation 
state of the Enrichment rule.

Generates a preview of the results of the selected 
Enrichment rule.

Represents a folder.

Represents an Enrichment rule.
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The following elements are available by right-clicking a folder or 
Enrichment rule:

UI Elements (A-Z) Description

Delete Deletes the selected folder or Enrichment rule.

Export To XML Displays a standard Save As dialog box, enabling you to 
save the Enrichment rule as an XML script. This option 
can be used to move an Enrichment rule from one 
workstation to another, provided the related TQL query is 
also relocated.

Import From XML Imports XML files that contain saved Enrichment queries 
to the Enrichment Manager.

New Creates an Enrichment rule. Opens the New Enrichment 
Rule wizard.

New Folder Creates a new folder.

Preview Generates a preview of the results of the selected 
Enrichment rule.

Properties Opens the New Enrichment Rule/Properties wizard. 
Enables you to change the description and the activation 
state of the rule.

Rename Folder Renames the folder.

Save (Enabled only when a new Enrichment query is created 
or when changes are made to an existing one.) Saves the 
Enrichment rule to the CMDB.

Save As Displays the Save As Enrichment Rule wizard, enabling 
you to define a new name and description for a query. 
This option can be used for creating a new Enrichment 
rule based on an existing one.
519



Chapter 12 • Enrichment Manager
Editing Pane

This area enables you to create and define Enrichment query nodes and 
relationships.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Important 
information

➤ When you select a folder in the Enrichment Rules 
pane, the editing pane is empty.

➤ When you select an Enrichment rule in the 
Enrichment Rules pane, the editing pane displays the 
selected rule, which consists of TQL query nodes that 
are defined in the TQL query and the relationships 
between them, and the Enrichment query nodes and 
relationships that are created and added to the rule.

➤ The Enrichment Manager has two modes in which 
you can work: Enrichment mode and Query mode.

The mode in which you are working determines the 
options that appear in the shortcut menu. For details, 
see the editing pane description below.

➤ You can calculate the number of instances that were 
created as a result of an Enrichment rule and remove 
the instances created from an Enrichment rule from 
the CMDB. For details, see "Additions Count" on 
page 189 and "Remove Enrichment Results" on 
page 195.

Relevant tasks "Define an Enrichment Rule – Scenario" on page 510

See also For details on how to create a TQL query, see "Add Query 
Nodes and Relationships to a TQL Query" on page 28.

UI Elements (A-Z) Description

Indicates an added Enrichment query node or 
relationship.

Indicates a query node or relationship that has 
been deleted from the CMDB.

Indicates an updated query node or relationship.
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Query and Enrichment 
mode

The Enrichment Manager has two modes in 
which you can work: Enrichment mode and 
Query mode.

Working in:

➤ Query mode enables you to define regular 
(non-Enrichment) relationships and query 
nodes and add them to the TQL query you 
defined.

➤ Enrichment mode enables you to define 
Enrichment relationships and query nodes and 
add them to the TQL query you defined.

<Shortcut menu> options For details, see "Shortcut Menu Options" on 
page 37.

<Main Menu> For details, see "Main Menu" on page 185.

<Query Node> A component from which TQL queries are built.

<Relationship> The entity that defines the relationship between 
two query nodes.

<Toolbar> For details, see "Toolbar Options" on page 189.

<Tooltips> Hold the cursor over a query node or relationship 
to view its tooltip.

The tooltips contain the following information:

➤ Element name. The name of the query node.

➤ CI Type. The CIT of the query node as defined 
in the CI Type Manager. For details, see "CI 
Type Manager" on page 465.

➤ Definitions of the selected query nodes and 
relationships. The attribute conditions, as 
described in "Query Node/Relationship 
Properties Dialog Box" on page 80.

UI Elements (A-Z) Description
521



Chapter 12 • Enrichment Manager
CI Type Selector

This area displays a hierarchical tree structure of the CI Types found in the 
CMDB. 

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Important 
information

The CI Type Selector is part of Enrichment Manager, 
Impact Analysis Manager, and Trigger TQL Editor. 

To create or modify a TQL query, click and drag query 
nodes to the Editing pane and define the relationship 
between them. Your changes are saved to the CMDB. For 
details, see "Add Query Nodes and Relationships to a TQL 
Query" in Modeling Guide.

Note: The number of instances of each CIT in the CMDB 
is displayed to the right of each CIT.

Relevant tasks ➤ "Define an Impact Rule – Workflow" on page 442

➤ "Define an Enrichment Rule – Scenario" on page 510

➤ "Define a TQL Query" on page 27

➤ "Create a Pattern View" on page 285

UI Elements (A-Z) Description

Click Add CI Type to Map to move the selected CI type 
to the Editing pane.

Click Refresh to refresh the CI type tree.

Click Search to search for the CI type entered.

Click Expand All to expand all subtrees within the CI 
type tree.

Click Collapse All to collapse the subtrees within the CI 
type tree.

<Search window> Enter the name or part of a name of a CI type for which 
to search.
522



Chapter 12 • Enrichment Manager
Shortcut Menu Options

The CI Type Selector includes the following elements (listed alphabetically) 
available by right-clicking a CI Type:

Advanced Pane

This area displays the properties, conditions, and cardinality for the selected 
query node and relationship.

Menu Item Description

Add CI Type to Map Select to add the selected CI type to the Editing pane.

Go to CI Type 
Definition

Takes you directly to the selected CI type in CIT Manager.

Show CIT Instances Opens the CIT Instances window, which displays all 
instances of the selected CIT. For details, see "Element 
Instances Dialog Box" in Modeling Guide.

Important 
information

The Advanced pane appears in the lower part of the 
window in the following managers and user interfaces: 
Modeling Studio, Impact Analysis Manager, Enrichment 
Manager, the Input Query Editor and Trigger Query 
Editor in DFM.

A small green indicator  appears next to the tabs that 
contain data.

Relevant tasks ➤ "Define an Impact Rule – Workflow" on page 442

➤ "Define an Enrichment Rule – Scenario" on page 510

➤ "Define a TQL Query" on page 27

➤ "Create a Pattern View" on page 285

➤ "Create a Template" on page 286

➤ "Create a Perspective" on page 288
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User interface elements are described below:

UI Elements (A-Z) Description

If the window is not wide enough to display all the tabs, use 
the left and right arrows to move to the required tab.

Click Show List to display a list of the available tabs for the 
current module. You can select a tab from the list.

Attributes Displays the attribute conditions defined for the query node 
or the relationship. For details, see "Attribute Tab" on 
page 82.

Cardinality Cardinality defines how many query nodes you expect to 
have at the other end of a relationship. For example, in a 
relationship between a node and an IP Address, if the 
cardinality is 1:3, the TQL query retrieves only those nodes 
that are connected to between one and three IP Addresses. 
For details, see "Cardinality Tab" on page 84.

Data Sources Displays the data sources set for the selected query node.

Note: This tab appears only in the Modeling Studio.

Details Displays the following information:

➤ CI Type. The CIT of the selected query node/relationship.

➤ Visible. A green check indicates that the selected query 
node/relationship is visible in the topology map. A red 
mark indicates that it is not visible.

➤ Include subtypes. A green check indicates that both the 
selected CI and its children are displayed in the topology 
map. A red mark indicates that only the selected CI 
appears.

Edit Click Edit to open the relevant dialog box for the selected 
tab.
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Enrichment Rules Displays the Enrichment rule defined for the selected query 
node or relationship. If the Enrichment rule is used to 
update the attributes of a CI, click Edit to open the Query 
Node/Relationship Definition dialog box and edit the rule if 
required. For details, see "Query Node/Relationship 
Definition Dialog Box" on page 531.

Note: This tab appears only in Enrichment Manager.

Impacted Query 
Nodes

Indicates which query node is affected by the changes that 
occur in the selected trigger query node. If required, you can 
click Edit to open and modify the Affected Query Nodes 
dialog box. For details, see "Impacted Query Nodes Dialog 
Box" on page 455.

Note: This tab appears only in Impact Analysis Manager.

Qualifiers Displays the qualifier conditions defined for the query node 
or the relationship. For details, see "Qualifier Tab" on 
page 87.

Selected Identities Displays the element instances that are used to define what 
should be included in the TQL query results. For details, see 
"Identity Tab" on page 90.

UI Elements (A-Z) Description
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New Enrichment Rule/Enrichment Rule Properties/Save 
As Enrichment Rule Wizard

This wizard enables you to create or modify an Enrichment rule.

To access ➤ To create a new Enrichment rule, right-click anywhere 
in the Enrichment Rules pane and click New or click 
the New  button.

➤ To modify an existing Enrichment rule, right-click an 
Enrichment rule in the Enrichment Rules pane and 
select Properties. 

➤ To create a new Enrichment rule based on an existing 
query, right-click an Enrichment rule in the 
Enrichment Rules pane and select Save As.

Important 
information

➤ When creating a new Enrichment rule, bear in mind 
that the application does not allow you to make any 
changes in the TQL query that are necessary for the 
rule. These changes include the following:

➤ Deleting, from the Enrichment TQL query, the 
query nodes or relationships connected to the 
Enrichment query node, causing a query node to 
become unattached to any relationship.

➤ You cannot change the cardinality definition to 0 
(not required) of a query node or relationship that is 
used in an Enrichment rule. For details on 
relationship cardinality, see "Query 
Node/Relationship Properties Dialog Box" on 
page 80.

➤ An Enrichment TQL query that serves as the basis for 
Enrichment rules, is subject to certain validation 
restrictions. For details, see "Troubleshooting and 
Limitations" on page 97. If the TQL query is not valid, 
you cannot save it.

Relevant tasks ➤ "Define an Enrichment Rule – Scenario" on page 510

Wizard map The New Enrichment Rule /Enrichment Rule 
Properties/Save As Enrichment Rule wizard contains:

Rule General Attributes Page > Rule Base Query Page

See also "Topology Query Language" on page 19
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Rule General Attributes Page
This wizard page enables you to enter a unique name and description for the 
Enrichment rule.

Important 
information

➤ An Enrichment TQL query that serves as the basis for 
Enrichment rules is subject to certain validation 
restrictions. For details, see "Troubleshooting and 
Limitations" on page 97. If the TQL query is not valid, 
you cannot save it.

➤ For important information on the effects of making 
changes to the TQL query after creating it, see "New 
Enrichment Rule/Enrichment Rule Properties/Save As 
Enrichment Rule Wizard" on page 526.

➤ By default, this wizard is set to display a Welcome 
page. You can choose not to display this page by 
changing the user preferences. For details, see "User 
Preferences Dialog Box" on page 97.

Wizard map The New Enrichment Rule/Enrichment Rule 
Properties/Save As Enrichment Rule Wizard contains:

Rule General Attributes Page > Rule Base Query Page

See also "Topology Query Language" on page 19
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User interface elements are described below:

UI Elements (A-Z) Description

Rule Description (Optional) Enter a description of the rule.

Rule is Active (Optional) Select this option to activate the rule in the 
system as soon as it is saved.

Default: Not selected.

Note: 

➤ If an active Enrichment rule is deactivated (by clearing 
the Rule is Active check box), all changes that occur in 
the CMDB relating to the rule are deleted from the 
system. When you deactivate an Enrichment rule, a 
red X appears next to the Enrichment rule in the 
Enrichment Rules pane.

➤ To reactivate the rule, right-click the rule in the 
Enrichment Rules pane and select Properties. In the 
General Attributes page, select Rule is Active.

Rule Name Enter a unique name for the Enrichment rule. 

The rule name cannot contain any of the following 
characters: \ / : " < > | % ?

Note: If the rule name is either empty, contains a name 
used by another Enrichment rule, or uses invalid 
characters, the Next and Finish buttons are disabled.
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Rule Base Query Page
This wizard page enables you to define the properties of the TQL query on 
which the Enrichment rule is based.

User interface elements are described below:

Important 
information

➤ An Enrichment TQL query that serves as the basis for 
Enrichment rules, is subject to certain validation 
restrictions. For details, see "Troubleshooting and 
Limitations" on page 97. If the TQL query is not valid, 
you cannot save it.

➤ For important information on the effects of making 
changes to the TQL query after creating it, see "New 
Enrichment Rule/Enrichment Rule Properties/Save As 
Enrichment Rule Wizard" on page 526.

➤ By default, this wizard is set to display a Completion 
page after clicking Next in this page. You can choose 
not to display the Completion page by changing the 
user preferences. For details, see "User Preferences 
Dialog Box" on page 97.

Wizard map The New Enrichment Rule/Enrichment Rule 
Properties/Save As Enrichment Rule Wizard contains:

Rule General Attributes Page > Rule Base Query Page

See also "Topology Query Language" on page 19

UI Elements (A-Z) Description

Base the Enrichment 
rule on a new Query

Select this check box if you want to base the Enrichment 
rule on a new TQL query. The TQL results are based on 
the attributes defined for the new TQL query.

Base the Enrichment 
rule on an existing 
Query

Select this check box if you want to base the Enrichment 
rule on an existing TQL query. Select the required 
Enrichment TQL query from the drop-down list.

Base Query 
Description

(Optional) Enter a description of the TQL query.
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Base Query Name Enter a unique name for the Enrichment TQL query.

If you selected the Base the Enrichment rule on an 
existing TQL option, select the Enrichment TQL query on 
which you want to base the rule.

Base Query Priority Select a priority level for the new TQL query (Low, 
Medium, High, or Express). This setting determines how 
often the query is rerun automatically by the system to 
include updated information from the CMDB.

Save a new Query 
based on the current 
definition

Select to save a new TQL query based on your 
Enrichment rule definition.

Note: This field only appears in the Save As Enrichment 
Rule wizard.

UI Elements (A-Z) Description
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Query Node/Relationship Definition Dialog Box

This dialog box displays the attributes of the selected query 
node/relationship. The key attributes and the required attributes of the 
selected query node appear in bold.

To access Right-click a query node or relationship when in 
Enrichment mode (select Enrichment from the 
Query/Enrichment drop-down at the top of the 
Enrichment Manager page) and select Update 
Relationship/Query Node.

Important 
information

Use an Enrichment rule to update the value of CI 
attributes in the CMDB, or to add data to attributes that 
currently do not have values. You can use this option, for 
example, for simultaneously adding a note to all CI 
instances.

You must fill in the value of the key attributes and the 
required attributes of the Enrichment query node. The 
method you use to define these values determines the 
number of instances created.

If you enter a dynamic value, you can create numerous 
instances. For example, entering the dynamic value of a 
host_key for the CIT Node or an IP address attribute for 
the CIT IpAddress.

Relevant tasks "Define an Enrichment Rule – Scenario" on page 510
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Attributes Area

User interface elements are described below:

Set Attributes Area

User interface elements are described below:

UI Elements (A-Z) Description

Name The attribute name.

Type The field type of the selected attribute.

Value The value as defined in one of the following:

➤ The Value box in the Set Attributes area.

➤ The combination of the values in the By Attribute 
boxes in the Set Attributes area.

➤ The Value column if you selected Simple in the Type 
column in the Query Node Definition - Advanced 
Attribute dialog box.

➤ The combination of the values in the Value column 
and the column to the right of the Value column if you 
selected By Attribute in the Type column in the Query 
Node Definition - Advanced Attribute dialog box.

UI Elements (A-Z) Description

(Appears only if you selected an attribute of the field type 
string.) Opens the Query Node Definition - Advanced 
Attribute dialog box.

Define query node and relationship attributes of the type 
string using simple or complex expressions. You can also 
create complex expressions using regular expression 
format.

Advanced (Appears only if you selected an attribute of the field type 
string.) Displays the attribute value you defined in the 
Query Node Definition - Advanced Attribute dialog box.
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Query Node Definition – Advanced Attribute Dialog Box

This dialog box enables you to define query node and relationship attributes 
of the type String using simple or complex expressions. You can also create 
complex expressions using regular expression format.

By Attribute Define an attribute using attributes from other query 
nodes in the TQL query.

➤ In the box to the left, select the required query node.

➤ In the box to the right, select the query node’s required 
attribute.

The attribute definition appears in the Value column in 
the Attributes area.

RegExp Group (Appears only when you select an attribute of the field 
type string.) Enter the group number only if you are 
adding a regular expression using regular expression 
syntax. This is the part of the regular expression pattern 
to focus on when creating the attribute. A set of 
parentheses ( ) constitutes a group.

Regular Expression (Appears only when you select an attribute of the field 
type string.) Add a regular expression using regular 
expression syntax. Enter the regular expression pattern.

Value (in the Set 
Attributes area)

Define a constant value. Enter the required value in the 
Value box or select a value from the Value list.

Note: The value definition appears in the Value column 
in the Attributes area.

To access Select an attribute of the type string in the Query Node 
Definition dialog box. Select Advanced and then click the 
Advanced button.

Relevant tasks "Define an Enrichment Rule – Scenario" on page 510

UI Elements (A-Z) Description
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User interface elements are described below:

UI Elements (A-Z) Description

Define an attribute value using simple or complex 
expressions. Creates a new entry in the Type column. 
Click the new entry and select either Simple or By 
Attribute. For details, see the description for the Type 
column below.

Delete an attribute value.

Move a selected row up.

Move a selected row down.

Advanced Value (This list is only available if you select By Attribute in the 
Type column.) Click the entry inside the box and select 
the required attribute.

Concatenate Use all the attribute values listed in this dialog box.

RegExp Group (This list is available only if you select By Attribute in the 
Type column.) Click inside the RegExp Group column, 
click the  button, and enter the group number 
in the Value for RegExp Group dialog box that opens. 
This is the part of the regular expression pattern to focus 
on when creating the attribute. A set of parentheses ( ) 
constitutes a group.

Regular Expression (This list is only available if you select By Attribute in the 
Type column.) Click inside the Regular Expression 
column, click the  button, and enter the regular 
expression pattern in the Value for Regular Expression 
dialog box that opens.
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Type Click the entry inside the Type column and select one of 
the following options:

➤ Simple. Define a constant value using a simple 
expression.

➤ By Attribute. Define an attribute using attributes from 
other query nodes in the TQL.

Default is: Simple

Use first attribute 
with value

Use the first attribute value listed in this dialog box that is 
not empty.

Value ➤ If you select Simple in the Type column, click inside 
the Value column, click the  button, and 
enter the required value in the Value for Simple dialog 
box.

➤ If you select By Attribute in the Type column, click 
inside the Value column and select the required value 
from the list.

UI Elements (A-Z) Description
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UCMDB Data Model Introduction

This chapter includes:

Concepts

➤ The BDM Data Model Overview on page 540

Reference

➤ Data Model Documents on page 541

➤ Upgrade Documents on page 542
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Concepts

The BDM Data Model Overview

The BTO Data Model (BDM) enables you to manage the business functions, 
services, processes, and activities of your IT Universe model.

The BDM documents are located in the following folder: 

C:\hp\UCMDB\UCMDBServer\deploy\ucmdb-docs\docs\eng\pdfs
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Reference

Data Model Documents

BDM – Conceptual Data Model
The conceptual model presents a high level picture of the BTO Data Model 
(BDM) organized in structured layers. This document is a map of the 
concepts being modeled, as well as the scope of the model. This conceptual 
data model provides a starting point for understanding the semantics of the 
domain modeled.

Note: As this is an abstract representation of the model, the document does 
not include every entity or relationship.

BDM – Data Model UMLs
This document represents the data model in a visually appealing set of UML 
diagrams. Rather than a single, large, complex UML diagram of the entire 
model, small diagrams with specific points of view are presented. The 
purpose of the UML diagrams is to provide a pictorial representation of the 
model entities and their relationships to each other.

Note: To make the UML diagrams easier to understand, some relationships 
and entities may have been excluded.

BDM – Data Model HTML
This document includes all the BDM class information in HTML format.
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BDM – Business Model and Best Practices
This document covers the business part of the UCMDB data model, as well 
as some best practices and guidelines on how to model your business.

CMS Data Model 9.01 Documentation
This document covers all BDM classes and a subset of the CMS classes. It 
includes the following information:

➤ class descriptions

➤ attribute information

➤ object scoping (BDM/CMS)

➤ qualifier information

➤ hierarchy information

Note: This document can be automatically generated from the UCMDB user 
interface. 

Upgrade Documents

UCMDB Class Mapping Upgrade
This mapping document presents a high level view of the class mappings 
between versions 8.0x and 9.01, including the hierarchy changes.

UCMDB Upgrade Documentation
This document covers the differences between the 8.0x class model and the 
9.01 data model in greater detail. The document includes the following 
information:

➤ class and attribute mapping

➤ new classes and attributes 
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➤ qualifier changes

➤ deprecation information

➤ removed classes

➤ key attribute changes

➤ hierarchy changes
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Exporting the UCMDB Data Model to a 
UML Tool

This chapter includes:

Concepts

➤ Export to UML Tool – Overview on page 546

Tasks

➤ Export the Class Model on page 547

➤ Convert XML of Selected Part of Class Model on page 548

Reference

➤ Export to UML Tool User Interface on page 550

➤ Tool Plug-in Input on page 553

Note: Currently, Altova UModel versions 2008 and 2009 are supported.
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Concepts

Export to UML Tool – Overview

The Export to UML tool enables you to export selected sections of the 
UCMDB class model to a format compatible with UML tools, and to view 
the model as a UML diagram.

The input for the tool is the UCMDB class model XML file retrieved by the 
JMX service UCMDB:service=Class Model Services/
exportClassModelToXml() for UCMDB 9.01.

Note: To access the JMX console, enter the following address in your 
browser: http://<server_name>:8080/jmx-console, where <server_name> is 
the name of the machine on which HP Universal CMDB is installed.
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Tasks

Export the Class Model

This task describes how to use the Export Class Model to UML tool wizard.

This task includes the following steps:

➤ "Prerequisites" on page 547

➤ "Run the UML Tool" on page 547

➤ "View the Exported File in Altova" on page 547

 1 Prerequisites

Set up the tool by extracting the following zip file to any location: 

<Volume>:\hp\UCMDB\UCMDBServer\tools\ExportClassModel.zip

 2 Run the UML Tool

You use the Export Class Model to UML wizard to choose the CIT and its 
attributes to be exported to the UML tool.

For details on working with the Export to UML wizard, see "Export Class 
Model to UML Wizard" on page 550.

 3 View the Exported File in Altova

 a In Altova, select File > Import From XMI File.

 b Select the XMI file. The class model entry appears in the Model Tree 
pane.

 c Right-click the entry and select Show in new diagram > Content. 
Click OK.
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Convert XML of Selected Part of Class Model

This task describes how to use the custom plug-in to convert the XML of a 
selected part of the class model to the UML tool format.

The plug-in can be either a Java class or an XSLT text file. If you use a Java 
class, it must implement the ITransformToUML(ExportToUML.jar) interface; 
the transformToUML() method receives an XML string as a parameter and 
returns a byte array that is written to the output file.  

For details on the custom plug-in input, see "Tool Plug-in Input" on 
page 553.

This task includes the following steps:

➤ "Activate the Plug-in Using a Java Class" on page 548

➤ "Activate the Plug-in Using an XSLT Text File" on page 549

Activate the Plug-in Using a Java Class

Add the display name and fully-qualified class name to the config.xml file in 
the ExportToUML directory, as follows:

Continue with the procedure for exporting the class model. For details, see 
"Export the Class Model" on page 547.

<ConverterToUML>
<Name><display name></Name>
<Class><fully qualified class name></Class>

</ConverterToUML>
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Activate the Plug-in Using an XSLT Text File

In this case, XSLT from the specified file is applied to the class model XML 
and is written to the output file.

Add the display name and full path of the XSLT file to the config.xml file in 
the ExportToUML directory, as follows:

Continue with the procedure for exporting the class model. For details, see 
"Export the Class Model" on page 547.

<ConverterToUML>
<Name><display name></Name>
<XsltFile><Full_path_of_the_XSLT_file></XsltFile>

</ConverterToUML>
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Reference

Export to UML Tool User Interface

This section includes (in alphabetical order):

 ➤ Export Class Model to UML Wizard on page 550

Export Class Model to UML Wizard

This wizard enables you to choose the CIT and its attributes to be exported 
to the UML tool.

To access Browse to the location where you extracted the tool. 
Right-click ExportClassModel.jar in the 
ExportClassModel directory. Select Open With > Java 2 
Platform SE binary.

Important 
information

By default the tool opens the ClassModel.xml file in the 
ExportClassModel directory. You open other files 
through the File > Open Class Model File menu.

Relevant tasks "Export the Class Model" on page 547

Wizard map The Export Class Model to UML wizard contains:

Export Class Model to UML Wizard > Select Valid Links 
> Export Selected Items

See also "Tool Plug-in Input" on page 553
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User interface elements are described below:

Select Valid Links
This wizard page enables you to select links that can be used between two 
CITs.

UI Elements (A-Z) Description

File Displays a list of XML files. Open the file that contains 
the class model.

Select Attributes 
Pane

Select the attributes to be displayed in the UML tool.

The attributes of the selected CIT are displayed in this 
pane. The attributes are colored as follows:

➤ Attributes inherited from the parent CIT are black.

➤ Attributes specific to this CIT are dark blue.

Select CI Types Pane The CITs displayed here are retrieved from the 
ClassModel.xml file.

Select the CIT and its sub nodes to be exported to the 
UML tool.

Use the buttons to select or clear all subindex.

Important 
information

General information about the wizard is available in 
"Export Class Model to UML Wizard" on page 550.

Wizard map The Export Class Model to UML wizard contains:

Export Class Model to UML Wizard > Select Valid Links 
> Export Selected Items
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User interface elements are described below:

Export Selected Items
This wizard page enables you to export the selected CITs and their attributes 
to the UML tool.

User interface elements are described below:

UI Elements (A-Z) Description

Click to remove the filter from the list of CITs.

Filter by Enables you to filter the list of valid links. You can filter 
the list of CITs and you can sort the list by CIT or 
relationship.

Important 
information

General information about the wizard is available in 
"Export Class Model to UML Wizard" on page 550.

Wizard map The Export Class Model to UML wizard contains:

Export Class Model to UML Wizard > Select Valid Links > 
Export Selected Items

UI Elements (A-Z) Description

Export Click to browse to the UML file, in XMI format, to which 
you want to add the UCMDB CITs and their attributes.

If there are no valid links for a pair of CITs, a no valid 
links message is displayed in the Select Valid Links page.
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Tool Plug-in Input

The input for the plug-in is an XML string (selected classes/attributes/valid 
links) in the following form:  

<?xml version="1.0" encoding="ISO-8859-1"?>
<Class-Model>

    <Class class-name="hostresource" display-name="Host Resource" 
visibility="public">
        <Attribute name="isvirtual" display-name="Is Virtual" visibility="public"/>
        <Attribute name="city" display-name="City" visibility="public"/>
    </Class>
    <Class class-name="host_node" display-name="Computer" visibility="public">
        <Derived-From class-name="host"/>
    </Class>
    <Class class-name="vax" display-name="VAX" visibility="public">
        <Attribute name="root_actualdeletionperiod" display-name="Actual Deletion 
Period" visibility="public"/>
        <Attribute name="data_allow_auto_discovery" display-name="Allow CI Update" 
visibility="public"/>
        <Derived-From class-name="host_node"/>
    </Class>
    <Class class-name="host" display-name="Host" visibility="public">
        <Attribute name="host_iscomplete" display-name="Host Is Complete" 
visibility="public"/>
        <Attribute name="host_isroute" display-name="Host Is Route" visibility="public"/>
        <Attribute name="host_hostname" display-name="Host Name" visibility="public"/>
        <Attribute name="host_os" display-name="Host Operating System" 
visibility="public"/>
    </Class>
    <Class class-name="unix" display-name="Unix" visibility="public">
        <Derived-From class-name="host_node"/>
    </Class>
    <Valid-Link ID="host_member_host" display-name="Member" visibility="public">
        <End1 class-name="host"/>
        <End2 class-name="host"/>
    </Valid-Link>
    <Valid-Link ID="host_container_f_hostresource" display-name="Container link" 
visibility="public">
        <End1 class-name="host"/>
        <End2 class-name="hostresource"/>
    </Valid-Link>

</Class-Model>
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Working with Tables

This chapter includes:

Reference

➤ Columns User Interface on page 558
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Reference

Columns User Interface

This section includes (in alphabetical order):

 ➤ Select Columns Dialog Box on page 558

 ➤ Sort Column Content Dialog Box on page 559

Select Columns Dialog Box

This dialog box enables you to choose the information you are interested in 
displaying. You can hide a column or display a hidden column.

The following elements are included:

Description Click the Select Columns  button. This button appears 
above every table in a report. 

GUI Element (A-Z) Description

Displays a column. Moves the selected column from the 
Available Columns pane to the Visible Columns pane.

Hides a selected column. Moves the selected column from 
the Visible Columns pane to the Available Columns pane.

Displays all hidden columns. Moves all the columns from 
the Available Columns pane to the Visible Columns pane.

Available Columns The columns in this pane do not appear in the table.

Default Restores the report columns to their original display 
status.

Visible Columns The columns in this pane are visible in the table.
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Sort Column Content Dialog Box

This dialog box enables you to set or change the sort order for the entries 
displayed in a table.

The following elements are included:

Description Click the  Sort Column Content button.

Important 
Information

To sort a table by one column:
Move the column name from the Available Columns to 
the Sorted Columns list. Select the name and decide 
whether to sort in ascending (upward triangle) or 
descending (downward triangle) order by clicking the 
relevant button.

To sort a table by more than one column:
Move the column names from the Available Columns to 
the Sorted Columns list. For each column, decide 
whether to sort in ascending or descending order. 

To change the order in which columns are sorted:
In the Sorted Columns list, select an entry, and click the 
Up or Down arrow to change the order. (Entries higher in 
the list are sorted before entries lower in the list.) A 
number is displayed in the table’s column headers.

Note: Only columns that are displayed can be sorted. For 
details on how to define which columns are displayed in 
the table and in which order, see "Select Columns Dialog 
Box" on page 558.

GUI Element (A–Z) Description

Moves the selected column from the Available Columns 
pane to the Sorted Columns pane. You can double-click 
the selection to perform the same procedure.

Moves the selected column from the Sorted Columns 
pane to the Available Columns pane.

Moves all the columns from the Available Columns pane 
to the Sorted Columns pane.
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Moves all the columns from the Sorted Columns pane to 
the Available Columns pane.

Moves the selected column up or down in the list to 
increase or decrease its priority in establishing the sort 
order.

Enables you to sort the column content in ascending or 
descending order.

In the Sorted Columns pane, select a column name and 
click the ascending or descending button.

Available Columns The columns whose content is not sorted.

Note: You can select multiple columns.

Sorted Columns The columns whose content is sorted in either ascending 
or descending order.

GUI Element (A–Z) Description
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Regular Expression Examples

This chapter includes:

Reference

➤ Examples of Regular Expressions on page 562
561



Chapter 16 • Regular Expression Examples
Reference

Examples of Regular Expressions

➤ Enter a regular expression to define an IP address (aa.yy.zz.mm):

➤ Enter a regular expression to create the label by the first or last letters of 
the selected attribute:

To:
In the First Field 
Enter:

In the Second Field 
Enter:

Create label by aa (.*)([.].*[.].*[.].*) 1

Create label by yy (.*[.])(.*)([.].*[.].*) 2

Create label by zz (.*[.].*[.])(.*)([.].*) 2

Create label by mm (.*[.].*[.].*[.])(.*) 2

To:
In the First Field 
Enter:

In the Second Field 
Enter:

Create label by the first letter (.)(.*) 1

Create label by the last letter (.*)(.) 2

Create label by the first two 
letters

(..)(.*) 1

Create label by the last two 
letters

(.*)(..) 2
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